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Introduction et premiers pas avec Ink/Stitch

InkStitch

Guide de tutoriels de broderie machine

Module: InkStitch

Page d'entrée du module
InkStitch

▬▶
⚐ à améliorer ☸ débutant

⚒ 2022/09/27
Prérequis

•• Inkscape

Voir aussi

•• InkStitch - Atelier d'introduction
•• Cours d'initiation à la broderie numérique (FacLab UniGE)

Autres pages du module

•• InkStitch
•• InkStitch - installation
•• InkStitch - utilisation de base
•• InkStitch - broderie ondulée
•• Inkstitch - textures de remplissage
•• InkStitch - lettrage
•• InkStitch - colonnes satin
•• InkStitch - exemples colonnes satin
•• InkStitch - broder un emoji
•• InkStitch - broder une image issue de The Noun Project
•• InkStitch - broder des codes QR
•• InkStitch - broder des patchs et des appliqués
•• InkStitch - astuces et problèmes courants
•• InkStitch - bases SVG
•• Inkscape - édition des chemins
•• InkStitch - broder avec du gros fil
•• InkStitch - broderies à partir de dessins faits à la main
•• InkStitch - points manuels
•• InkStitch - points programmables
Catégorie: InkStitch

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Guide_de_tutoriels_de_broderie_machine
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
https://edutechwiki.unige.ch/fmediawiki/index.php?title=InkStitch_-_Atelier_d%27introduction
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cours_d%27initiation_%C3%A0_la_broderie_num%C3%A9rique_%28FacLab_UniGE%29
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cat%C3%A9gorie:InkStitch
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Introduction
Ink/Stitch [1] est une extension Inkscape permettant de concevoir des motifs et des fichiers de broderie. Aux
personnes ayant quelques compétences en dessin vectoriel, nous conseillons d'installer et d'apprendre cette extension
Ink/Stitch [1] car il s'agit d'un très bon logiciel de numérisation de broderie gratuit et open source. Il offre de bonnes
fonctionnalités de base et peut également être utilisé à des fins pédagogique multiples:
•• Apprentissage du dessin vectoriel et de la manipulation d'image,
• Acquisition des principes de la CFAO,
•• Apprentissage de la gestion de projet, etc.
Actuellement, la plupart des articles concernant InkStitch sont à l'état "à améliorer". Les articles les plus importants
ont été plus ou moins adaptés à la version 2.2 (été 2022), les autres nécessitent des mises à jour. Enfin, la logique de
Ink/Stitch n'a pas changé depuis la version 1.0.
Voici une liste de tutoriels à consulter pour vous aider dans l'apprentissage de Ink/Stitch. Il impératif de lire InkStitch
- installation et ensuite InkStitch - utilisation de base. Toute belle broderie contient des satins, et il faudrait aussi
consulter l'article InkStitch - colonnes satin, un peu plus difficile.
Introduction et premiers pas avec Ink/Stitch

InkStitch
InkStitch - installation
InkStitch - utilisation de base

Opérations et utilisation de base
InkStitch - broderie ondulée
Inkstitch - textures de remplissage
InkStitch - lettrage
InkStitch - colonnes satin
InkStitch - exemples colonnes satin
InkStitch - broder un emoji
InkStitch - broder une image issue de The Noun Project
InkStitch - broder des codes QR
InkStitch - broder des patchs et des appliqués

Astuces et opérations avancés avec InkStitch et InkScape
InkStitch - astuces et problèmes courants
InkStitch - bases SVG
Inkscape - édition des chemins
InkStitch - broder avec du gros fil
InkStitch - broderies à partir de dessins faits à la main
InkStitch - points manuels
InkStitch - points programmables

Documents utilisés lors de formations
•• InkStitch - Atelier d'introduction
•• Cours d'initiation à la broderie numérique (FacLab UniGE)
Téléchargement de Ink/Stitch

https://inkstitch.org
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
https://inkstitch.org
https://edutechwiki.unige.ch/fmediawiki/index.php?title=CFAO
https://edutechwiki.unige.ch/fmediawiki/index.php?title=InkStitch_-_Atelier_d%27introduction
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cours_d%27initiation_%C3%A0_la_broderie_num%C3%A9rique_%28FacLab_UniGE%29
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Vous trouverez le lien de téléchargement de l'extension sur le site Ink/Stitch [1] ou en accédant directement à
Download Ink/Stitch [2].
Lisez, SVP InkStitch - installation, si vous n'êtes pas expert InkScape.

Fonctionnalités
Aux dernières nouvelles, l'extension InkStitch est le premier programme open source qui permet de créer des
fichier de broderie dans un outil de dessin lui-même open source

En résumé InkStitch permet de :
•• Créer des fichiers de broderie machine à partir de dessins SVG. C'est-à-dire un objet SVG doit être traduit en

un objet de chemins et à partir de là on peut le paramétrer en tant que objet de broderie.
•• Traduire des remplissages SVG en "zones de points de couture", autrement dit, des points de tatami, tatami

avec effet florentin ou des remplissages selon le contour.
•• Traduire des traits SVG en points coulés ou triples, zig-zag simples ou colonnes satins ou encore des broderies

ondulées.
•• Créer des points manuels à partir de lignes ayant des points distancés de façon appropriée,
•• Importer, réutiliser et adapter la plupart des formats de broderie
• Importer et vectoriser des images à l'aide de l'outil de tracé d'Inkscape et ensuite les numériser
•• Créer des lettrages avec des polices numérisées.
•• Prendre en charge la gestion des couleurs de fil et des projets.
•• Optimiser des colonnes satins et du "line art"

Installation et ressources

Conseils pour l'installation de Ink/Stitch
Depuis janvier 2022, l'installation de InkStitch consiste à exécuter l'installeur. Ensuite il reste un petit travail de
configuration à faire.
Voir InkStitch - installation pour les détails concernant l'installation de cette extension.

Téléchargements de fichiers depuis nos sites
Dans nos articles on met souvent à disposition les fichiers. Certains sont dans le wiki, d'autres sur un site web
"classique". En règle générale il est préférable de suivre les liens qui pointent vers le web.
Pour télécharger le SVG depuis un dossier web, il y a deux options:

•• Afficher le SVG dans votre navigateur (vous pouvez l'agrandir), puis CTRL-S pour l'enregistrer. Vous pouvez
aussi configurer votre navigateur pour afficher un menu fichier.

•• Afficher le dossier, puis clic-droit sur un fichier et "enregistrer la cible sous".
Vous pouvez ignorer les avertissements. Une page SVG téléchargée peut être dangereuse au même titre qu'une page
HTML (enfin, pas les notres!). Si vous l'ouvrez dans un navigateur elle peut vous faire faire des opérations
dangereuses, comme donner le no d'un compte etc. Ouvrir un SVG dans InkScape (ou Illustrator, CorelDraw, etc.)
ne comporte aucun risque. Pour vérifier la nature d'un SVG, il suffit de regarder le code source (CTRL-U dans un
navigateur) et vérifier qu'il n'y ait pas de script.
Pour télécharger un fichier SVG dans le wiki:
•• Afficher le SVG. Sauf contre-indication (parfois on donne un lien direct) il faut cliquer sur l'image jusqu'à ce

l'image SVG s'affiche en tant que page dans le navigateur
•• Vérifier dans la barre de navigation qu'il s'agit bien d'une page en SVG

https://inkstitch.org
https://github.com/inkstitch/inkstitch/releases/latest
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
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•• Ensuite, enregistrer cette page avec CTRL-S.

Version PDF
Une version PDF non optimisée est disponible sous forme de wikibook, EduTech Wiki:Livres/Broderie numérique
avec InkStitch

Ressources supplémentaires
Voir également :
• InkStitch - Atelier d'introduction (utilisé lors de séminaires)
• Cours d'initiation à la broderie numérique (FacLab UniGE) Notes de cours du FacLab UniGE [3]

• en:InkStitch (EduTechWiki Anglais, pages à mettre à jour)
• Ink/Stitch [4] Page d'accueil du projet
• Tutoriels officiel [5]

• Groupe Facebook InkStitch français [6] (> 5000 membres)
• http:/ / lyogau. over-blog. com/

Références
[1] https:/ / inkstitch. org
[2] https:/ / github. com/ inkstitch/ inkstitch/ releases/ latest
[3] https:/ / faclab. ch/
[4] http:/ / Inkstitch. org
[5] https:/ / inkstitch. org/ tutorials/
[6] https:/ / www. facebook. com/ groups/ 811488062586111/

InkStitch - installation

Guide de tutoriels de broderie machine

Module: InkStitch

◀▬▬▶
⚐ brouillon ☸ débutant

⚒ 2022/09/27
Prérequis

•• Inkscape

Autres pages du module

•• InkStitch
•• InkStitch - installation
•• InkStitch - utilisation de base

Sous-pages et productions:
•• Raccourcis

Catégorie: InkStitch

https://edutechwiki.unige.ch/fmediawiki/index.php?title=EduTech_Wiki:Livres/Broderie_num%C3%A9rique_avec_InkStitch
https://edutechwiki.unige.ch/fmediawiki/index.php?title=EduTech_Wiki:Livres/Broderie_num%C3%A9rique_avec_InkStitch
https://edutechwiki.unige.ch/fmediawiki/index.php?title=InkStitch_-_Atelier_d%27introduction
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cours_d%27initiation_%C3%A0_la_broderie_num%C3%A9rique_%28FacLab_UniGE%29
https://faclab.ch/
http://edutechwiki.unige.ch/en/InkStitch
http://Inkstitch.org
https://inkstitch.org/tutorials/
https://www.facebook.com/groups/811488062586111/
http://lyogau.over-blog.com/
https://inkstitch.org
https://github.com/inkstitch/inkstitch/releases/latest
https://faclab.ch/
http://Inkstitch.org
https://inkstitch.org/tutorials/
https://www.facebook.com/groups/811488062586111/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Guide_de_tutoriels_de_broderie_machine
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
https://edutechwiki.unige.ch/fmediawiki/index.php?title=InkStitch_-_installation/Raccourcis
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cat%C3%A9gorie:InkStitch
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Introduction
Inkscape est un logiciel de dessin vectoriel gratuit et open source qui fonctionne sous Windows, MacOS et divers
Linux. Son extension Inkstitch permet de créer des objets et des fichiers de broderie. Pour pouvoir utiliser Inkstitch,
vous devez vous assurer d'avoir installé les dernières versions stables de Inkscape et ensuite de Inkstitch. Donc:
1. Il faut d'abord installer Inkscape. Si vous avez une ancienne version (plus petite que 1.1 en jan. 2022), on

conseille de désinstaller tout: d'abord le logiciel InkScape, ensuite manuellement les extensions qui se trouvent
dans votre dossier extensions, y compris Ink/Stitch (voir plus loin). Ensuite vous devez installer la nouvelle
version de InkScape.

2. Ensuite, il faut ajouter l'extension Ink/Stitch.
3. Ensuite, il faut configurer InkScape
4. Pour finir, il faut configurer Ink/Stitch (surtout installer des palettes pour fil à broder)
Sans configurations, vous allez perdre beaucoup de temps ! Lisez nos conseils en bas et faites-les.

Installation de Inkscape (logiciel de dessin)
Résumé:

• Installez Inkscape ou mettez à jour Inkscape avec la version stable la plus récente depuis https:/ / inkscape. org/ .
• Sur le lien de téléchargement, vous trouverez plusieurs packages correspondant chacun à un système

d'exploitation (MacOS, Linux et Windows). Sur le site, cliquer sur Download Now, ou se rendre sur
Download -> Current ou https:/ / inks [1]cape.org/release/ [1].

Pour Windows
•• Pour Windows, il faut prendre la version 64bit en règle générale, sauf si vous avez un très vieux PC
•• Une fois téléchargé, il faut bouger ailleurs le fichier téléchargé du dossier "téléchargement" (par exemple sur le

bureau) et ensuite lancer l'installeur.

Pour Linux Debian, Ubuntu, etc.
Dans un terminal, tapez:

sudo apt-get install inkscape

Il existe d'autres moyens de distribution comme "snap", mais il paraît qu'ils sont incompatibles avec l'installation
automatique de Ink/Stitch.

Pour Mac
• Choisissez la version Intel ou Arm64 selon votre processeur. Pour savoir quel fichier télécharger, rendez-vous

dans le Menu Pomme -> About this Mac puis regarder ce qui est inscrit dans processeur.
•• Une fois le fichier téléchargé, double cliquer sur le fichier .dmg et installez Inkscape comme toute autre

application en faisant un cliquer-déposer. Une fois ceci réalisé, vérifier que le logiciel soit bien dans vos
applications.

Installation de Ink/Stitch (extension broderie)
Depuis la version 2.1.2 Ink/Stitch, le logiciel est proposé avec des installeurs. De ce fait, il faut juste (1) savoir
désinstaller une ancienne version et (2) gérer l’interférence éventuelle d'un virus scan.
Concernant l'installation/désinstallation, la page officielle installation [2] de l'extension fournit des informations avec 
en plus des vidéos explicatives selon votre OS. Nous n'allons pas répéter toutes les instructions ici, on résume juste

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkstitch
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fil_%C3%A0_broder
https://inkscape.org/.
https://inks
https://inkscape.org/release/
https://inkscape.org/release/
https://inkstitch.org/fr/docs/install/
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l'essentiel.

Sous Windows
Pour Windows, il faut prendre la version 64bit en règle générale, sauf si vous avez un très vieux PC. Une fois
téléchargé, il faut copier le fichier téléchargé du dossier "téléchargement" ailleurs (par exemple sur le bureau) et de
lancer l'installeur.
Normalement l'installation se fait tout seule, mais si vous avez un antivirus un peu trop envahissant, vous pourriez
rencontrer des problèmes. Comme le dossier dézippé contient des fichiers binaires, certains logiciels antivirus
peuvent les identifier (avec un algorithme heuristique, donc approximatif) comme des virus: c'est un faux positif! Un
logiciel open source n'est en principe jamais dangereux (le seul danger peut venir de certains composants réutilisés,
mais c'est un risque acceptable).
Si vous êtes dans ce cas, rendez-vous dans les paramètres Windows > Mise à jour et sécurité >
Sécurité de Windows > Protection contre les virus et menaces > Paramètres >

Enlever ou ajouter des exceptions .
La page :
• Explications microsoft [3] explique comment ne pas scanner un dossier spécifique.

Il faut donc indiquer le dossier d'extension de Inkscape comme dossier à ne pas scanner.
Si vous avez des logiciels comme Avast, désinstallez-les. Ce sont des logiciels espions qui ne rapportent rien de plus
par rapport à Windows Defender.

Sous Ubuntu
On conseille d'installer le paquet *.deb
Téléchargez le fichier *.deb depuis https:/ / inkstitch. org/ docs/ install-linux/ et installez-le avec dpkg -i
Par exemple:

sudo dpkg -i inkstitch_2.2.0_amd64.deb

Configuration de InkScape
Tous les réglages InkScape se font dans un seul panneau : "préférences". Donc ouvrez le panneau Édition
-> Préférences et gardez ce panneau ouvert pendant les divers réglages à faire !

Définir des raccourcis
Il est possible de définir des raccourcis spécifiques à InkStitch qui vont vous faire gagner beaucoup de temps.
L'interface va afficher les raccourcis à côté des items de menu. Lire notre article InkStitch - installation/Raccourcis
pour plus de détails....
• Ouvrir le dossier keys en passant par Édition -> Préférences -> Système
• Clic droit sur https:/ / tecfa. unige. ch/ guides/ embroid/ inkstitch/ shortcuts/ inkscape-1-2/ default. xml (inkscape

1.2) ou http:/ / tecfa. unige. ch/ guides/ embroid/ inkstitch/ shortcuts/ default. xml (inkscape 1.1) et enregistrer le
fichier dans ce dossier keys

• Si vous avez mal configuré votre navigateur, il faut chercher le fichier dans le dossier "téléchargements" et le
recopier dans ce dossier keys. Il se peut aussi que votre navigateur refuse d'enregistrer le fichier, car tout ce qui
vient d’Internet est suspect. Forcez le téléchargement dans ce cas. Si vous désirez vérifier que le fichier est bon,
ouvrez-le dans le notepad ou un autre éditeur, vous verrez les raccourcis en format XML.

https://support.microsoft.com/fr-fr/windows/ajouter-une-exclusion-%C3%A0-s%C3%A9curit%C3%A9-windows-811816c0-4dfd-af4a-47e4-c301afe13b26
https://inkstitch.org/docs/install-linux/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=InkStitch_-_installation/Raccourcis
https://tecfa.unige.ch/guides/embroid/inkstitch/shortcuts/inkscape-1-2/default.xml
http://tecfa.unige.ch/guides/embroid/inkstitch/shortcuts/default.xml
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Afficher les directions des chemins
Pour créer des colonnes de satin, il est essentiel de pouvoir voir la direction des lignes de cheminement.

• Dans Edition -> Préférences -> Outils -> Nœuds (Angl. Edit -> Preferences ->
Tools -> node ):

• Cocher Toujours afficher le contour et surtout Afficher le sens des chemins sur le contour (!!)
• En Anglais: Always show outline et Show path direction on outlines

Note: On peut également changer l'affichage des contours dans l'interface, mais cela ne reste pas permanent (icône
qui relie deux contours)

Régler les incréments
En conception de motifs de broderie, on doit souvent souvent agrandir ou diminuer une forme toute conservant son
emplacement. On suggère de régler le comportement de InkScape par rapport à des multiples de la largeur d'un fil
standard, environ 0.2mm.
Menu Edition -> Préférences -> Comportement -> Incréments (Angl. Edit ->

Preferences -> Behavior -> Increments)

On conseille surtout de régler éroder/dilater à 2mm, car ce sont des opérations fréquentes pour ajuster la taille d'un
objet pour atteindre de légères superpositions.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape-1-0-preferences-noeuds.png
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Ajuster les incréments d'érodage

Régler l'affichage de la langue, des règles, grilles et poignées
• Dans Interface :

1. Réglez le "facteur de correction zoom". La distance entre 0 et 100 doit correspondre plus ou moins à 10cm.
Avoir les distances justes permet de mieux visualiser un motif de broderie si vous faites un zoom 1:1 (touche
1)

2.2. Ensuite, si vous avez un écran 4K et/ou une vision faible, il faut augmenter la taille de la poignée.
3.3. Dans le menu déroulant "Langue principale", choisissez votre langue. Mais attention: sous Windows, on peut

pas mettre InkScape en français si le système et la localisation sont réglés pour l'Anglais.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape-adjust-behavior-increments.png
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langue, des règles et poignés

• Dans Grilles, réglez l'espacement à 1mm environ (selon vos goûts).
Il faut ensuite redémarrer InkScape.

Métadonnées par défaut (à option)
Les métadonnées ajoutent du texte dans le fichier SVG qui sert à documenter un motif
• Les métadonnées par défaut se définissent dans l'onglet Métadonnées du panneau Fichier ->
Propriétés du document

•• Une fois remplis les champs qui vous intéressent (par ex. votre nom et les droits), vous pouvez enregistrer le
formulaire comme valeur par défaut.

Ensuite, vous pouvez instruire InkScape pour utiliser ce défaut.
• Onglet Entrée/sortie
• Cochez Ajouter les métadonnées par défaut aux nouveaux documents

Alternativement, you pouvez juste insérer ces méta-donnés dans vos modèles

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape-config-1.png
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Modèles InkScape
Directement ouvrir un dessin entraine souvent tout un train d'adaptations au niveau des unités de mesure, de la taille
du document, etc. On conseille donc de préparer des modèles qui correspondent à la taille de vos cadres.
Exemple pour créer un modèle 50x50mm:
•• Ouvrez un nouveau document blanc
• Fichier -> Propriétés du Document -> Affichage

•• Mettez les mesures en mm
•• L'échelle à 1
• Enregistrez en tant que modèle: Fichier -> Enregistrer un modèle

Définition des propriétés de document pour un modèle

Pour l'utiliser, il suffit de l'ouvrir
• Fichier -> Nouveau à partir d'un modèle ...

Ensuite au lieu d'ouvrir du clipart, vous l'importez. Le dessin importé sera groupé, vous pouvez donc d'abord le
positionner au centre (par exemple) avec les outils Objet -> Aligner et Distribuer ...

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape-define-model-1.png
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Configuration de InkStitch
Ink/Stitch ne nécessite pas beaucoup de configuration initiale à part les raccourcis déjà discutés. Il faut juste installer
les palettes de fils et ajouter une palette réduite que l'on conseille. Plus tard, vous pourrez installer de nouvelles
polices.

Installation d'une palette
(1) Ink/Stitch permet de choisir parmi des palettes de constructeurs, mais il faut les installer lors du premier
usage.

• Menu Extensions -> InkStitch -> Gestion de couleurs de fils -> Installer des

palettes de couleur de Ink/Stitch

(2) Comme ces palettes sont souvent trop larges ou parfois pas à jour, on suggère de prendre la notre qui est basée
sur des numéros de fils Poly40 de Gunold. Vous pouvez ensuite la modifier et adapter avec un éditeur de texte. Si les
palettes de broderie vos intéressent, lisez Palette de fil à broder. Vous allez apprendre que rien n'est standardisé.
Dossier de téléchargement pour nos palettes très réduites:
• https:/ / tecfa. unige. ch/ guides/ embroid/ inkstitch/ palettes/
• https:/ / tecfa. unige. ch/ guides/ embroid/ inkstitch/ palettes/ InkStitch%20Emoji%20Gunold%20No. gpl

(clic-droit et enregistrer)
Pour enregistrer cette palette courte:
• Menu Extensions -> InkStitch -> Gestion de couleurs de fils -> Installer une

palette personnalisée. (choisir le fichier *.gpl que vous venez de télécharger)
•• Dans InkScape, on peut ensuite choisir cette palette "Emoji Gunold" avec la petite flèche en bas à droite à côté de

la palette.

Menu palettes

•• On conseille d'agrandir la taille des tuiles de la palette. Ouvrir la liste des palettes comme ci-dessus. Tout en bas
de la liste on peut ouvrir un panneau de configuration et régler la taille de tuile, etc. Si vous préférez utiliser une
palette complète, vous pouvez instruire InkScape pour afficher 3 voir 3 lignes.

Réglages de la barre des palettes

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Palette_de_fil_%C3%A0_broder
https://tecfa.unige.ch/guides/embroid/inkstitch/palettes/
https://tecfa.unige.ch/guides/embroid/inkstitch/palettes/InkStitch%20Emoji%20Gunold%20No.gpl
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-palettes-1.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-palettes-2.png
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Choisir une palette

Installation de nouvelles polices
Lorsqu’un auteur crée de nouvelles polices, vous pouvez les installer. La communauté la plus active est sur
FaceBook dans le groupe Inkscape/InkStitch
• Pour s'inscrire au groupe: https:/ / www. facebook. com/ groups/ inkstitchfrance

Extensions de InkScape
Pour faire certains types de broderie avancés, on peut utiliser diverses fonctions de InkScape ainsi que les
fonctionnalités de certaines extensions.

Extensions MightyScape
On conseille d'abord d'installer MightyScape [4] , plus que 200 extensions utiles pour le travail en fablab.
Installation avec Git (pour experts)
Si vous avez git installé ou encore WSL (Ubuntu pour windows):
•• Ouvrir le dossier d'extensions et taper soit cmd, soit wsl dans la barre d'adresse. Cela va ouvrir un terminal pour

ce dossier (donc pas à faire "cd")
• git clone -c http.sslverify=false https:/ / gitea. fablabchemnitz. de/ FabLab_Chemnitz/

mightyscape-1. X. git
Installation manuelle (pour intermédiaires)
Si GIT ne vous dit rien, pouvez télécharger le fichier zip et extraire les fichiers au bon endroit, c-a-d dans le dossier
extensions de inkscape comme pour Ink/Stitch. On peut trouver ce dossier avec Edition -> Préférences
-> Système . Ouvrir le dossier extensions utilisateurs. Vous verrez déjà Ink/Stitch qui était installé par l'installeur
à cet endroit.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-palettes-3.png
https://www.facebook.com/groups/inkstitchfrance
https://stadtfabrikanten.org/pages/viewpage.action?pageId=73040380
https://gitea.fablabchemnitz.de/FabLab_Chemnitz/mightyscape-1.X.git
https://gitea.fablabchemnitz.de/FabLab_Chemnitz/mightyscape-1.X.git
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Dossier extensions dans InkScape

Si vous désirez prendre juste 2-3 extensions ciblées et vous connaissez le nom du fichier zip (!), vous pouvez les
chercher dans ce dossier web (voir l'exemple ci-dessous) et les installer dans le dossier d'extensions indiqué juste
ci-dessus.
• https:/ / github. com/ eridur-de/ mightyscape-1. X-zipmirror
Certaines se trouvent aussi dans le dépôt officiel de InkScape, mais toutes. Il faut ensuite extraire les dossiers pour
chaque fichier zip au bon endroit.
Voici un résumé ce qu'il faut faire sous Windows avec le logiciel 7zip [5] (mieux que l'outil Windows).

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape-config-2.png
https://github.com/eridur-de/mightyscape-1.X-zipmirror
http://7zip.org
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Dossier extensions dans InkScape

Réparation de noeuds et segments dupliqués
Voici un exemple d'utilisation des outils MightyScape. J'utilise très souvent l'outil "purge duplicate path nodes" qui
permet d'éliminer certains points super-positionnés et aussi de fermer des chemins qui ont l'air fermés, mais ne le
sont pas, car les points du début et de la fin sont proches. Aussi important, l'outil "purge duplicate path segments"
enlève les autres nœuds dupliqués qui restent. Les développeurs de InkStitch ont fait de gros efforts pour digérer du
mauvais SVG, mais ce type SVG reste difficile à importer dans un autre logiciel de broderie comme Hatch ou
Embroidery Office (enfin pour Embroidery Office on peut passer par Illustrator ou Corel). Finalement, l'outil "close
path" permet de fermer tous les chemins. Les trois fichiers zip portent le nom de l'outil:
• purge_duplicate_path_segments.zip [6]

• purge_duplicate_path_nodes.zip [7]

• close_paths.zip [8]

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape-extensions-1.png
https://github.com/eridur-de/mightyscape-1.X-zipmirror/blob/master/purge_duplicate_path_segments.zip
https://github.com/eridur-de/mightyscape-1.X-zipmirror/blob/master/purge_duplicate_path_nodes.zip
https://github.com/eridur-de/mightyscape-1.X-zipmirror/blob/master/close_paths.zip
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3 outils sur 100 ....

Le problème que je rencontre le plus souvent en broderie emoji sont des points (et donc segments superposés). On
peut les repérer quand la forme de ces points est un peu flou ou encore en bougeant les points, mais cela prend du
temps. L'outil "purge duplicated path segments" fait cela automatiques et presque jamais sans aucune faille. Voici le
dessin steam bowl [9] (police Fluent Flat de Microsoft) qui contient pas mal d'imprécisions qui ne sont pas gênantes
pour l'affichage, mais qui perturbent l'importation dans d'autres logiciels.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape-fablab-chemnitz-1.png
https://icon-sets.iconify.design/fluent-emoji-flat/steaming-bowl/
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Purge duplicate path segments (avant) - fichier à problèmes

Purge duplicate path segments (après) - fichier sans problèmes

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape-fablab-chemnitz-2.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape-fablab-chemnitz-3.png
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Désinstallation d'une très ancienne version de Inkstitch
Si votre installation existante de Ink/Stitch est antérieure à la version 2.1 Ink/Stitch il faut désinstaller
manuellement l'extension. Réinstaller InkScape ne résout pas le problème, il faut manipuler des fichiers !!
Notice: Si vous désirez désinstaller une version plus récente (>2.1) utilisez le désinstalleur de votre OS !!

Désinstallation Windows

Affichez le dossier suivant:

C:\Utilisateurs\votreNomUtilisateur\AppData\Roaming\inkscape\extensions

Tuez tous les fichiers "InkStitch", y compris les dossiers. Si vous n'avez pas installé d'autres extensions pour
InkScape, supprimez simplement tous les fichiers.
Si cela ne fonctionne pas, vérifiez où se trouve le dossier d'extension de Inkscape, dans Inkscape:
Edit->Preferences->System.

Une fois l'extension InkStitch installée, redémarrez Inkscape.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AW_ink_2.png
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Desinstallation Linux

Sous Debian/Ubuntu, les fichiers d'extensions de InkScape se trouvent dans le dossier
~/.config/inkscape/extensions

 cd ~/.config/inkscape/extensions

 rm -r *inkscape*

Desinstallation MacOS

Ouvrez le logiciel Inkscape. Dans "Edition", choisissez "Préférences".

Dans "Système", copiez le chemin inscrit dans "extensions de l'utilisateur".

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInstal_inkstitch2.png
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Rendez vous dans le Finder dans le menu "Aller", puis "Aller dans le dossier".

Collez le chemin de l'extension utilisateur précédemment copié, puis appuyez sur "aller".

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInstal_inkstitch3.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInstal_inkstitch.png


InkStitch - installation 20

Vous vous trouvez maintenant dans le dossier "extensions" de Inkscape. Supprimez tous les fichiers *inkstitch*

Références
[1] https:/ / inkscape. org/ release/
[2] https:/ / inkstitch. org/ fr/ docs/ install/
[3] https:/ / support. microsoft. com/ fr-fr/ windows/

ajouter-une-exclusion-%C3%A0-s%C3%A9curit%C3%A9-windows-811816c0-4dfd-af4a-47e4-c301afe13b26
[4] https:/ / stadtfabrikanten. org/ pages/ viewpage. action?pageId=73040380
[5] http:/ / 7zip. org
[6] https:/ / github. com/ eridur-de/ mightyscape-1. X-zipmirror/ blob/ master/ purge_duplicate_path_segments. zip
[7] https:/ / github. com/ eridur-de/ mightyscape-1. X-zipmirror/ blob/ master/ purge_duplicate_path_nodes. zip
[8] https:/ / github. com/ eridur-de/ mightyscape-1. X-zipmirror/ blob/ master/ close_paths. zip
[9] https:/ / icon-sets. iconify. design/ fluent-emoji-flat/ steaming-bowl/

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInstal_inkstitch6.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInstal_inkstitch5.png
https://inkscape.org/release/
https://inkstitch.org/fr/docs/install/
https://support.microsoft.com/fr-fr/windows/ajouter-une-exclusion-%C3%A0-s%C3%A9curit%C3%A9-windows-811816c0-4dfd-af4a-47e4-c301afe13b26
https://support.microsoft.com/fr-fr/windows/ajouter-une-exclusion-%C3%A0-s%C3%A9curit%C3%A9-windows-811816c0-4dfd-af4a-47e4-c301afe13b26
https://stadtfabrikanten.org/pages/viewpage.action?pageId=73040380
http://7zip.org
https://github.com/eridur-de/mightyscape-1.X-zipmirror/blob/master/purge_duplicate_path_segments.zip
https://github.com/eridur-de/mightyscape-1.X-zipmirror/blob/master/purge_duplicate_path_nodes.zip
https://github.com/eridur-de/mightyscape-1.X-zipmirror/blob/master/close_paths.zip
https://icon-sets.iconify.design/fluent-emoji-flat/steaming-bowl/
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InkStitch - utilisation de base

Guide de tutoriels de broderie machine

Module: InkStitch

◀▬▬▶
⚐ à améliorer ☸ débutant

⚒ 2022/09/27
Prérequis

•• Inkscape

Objectifs

•• Familiarisation avec les "outils" Ink/Stitch
•• Numériser des remplissages avec un point tatami
•• Numériser des lignes avec des points droits
•• Prendre connaissance d'autres variantes de remplissage pour le fonds et les lignes

Voir aussi

•• Cours initiation à la broderie numérique - Bases de InkStitch (FacLab UniGE)
•• InkStitch - broderie ondulée
•• Inkstitch - textures de remplissage

Autres pages du module

•• InkStitch
•• InkStitch - installation
•• InkStitch - utilisation de base
•• InkStitch - broderie ondulée
•• Inkstitch - textures de remplissage
•• InkStitch - lettrage
•• InkStitch - colonnes satin
•• InkStitch - exemples colonnes satin
•• InkStitch - broder un emoji
•• InkStitch - broder une image issue de The Noun Project
•• InkStitch - broder des codes QR
•• InkStitch - broder des patchs et des appliqués
•• InkStitch - astuces et problèmes courants
•• InkStitch - bases SVG
•• Inkscape - édition des chemins
•• InkStitch - broder avec du gros fil
•• InkStitch - broderies à partir de dessins faits à la main
•• InkStitch - points manuels
•• InkStitch - points programmables
Catégorie: InkStitch

[mis à jour pour Ink/Stitch v2.2]

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Guide_de_tutoriels_de_broderie_machine
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cours_initiation_%C3%A0_la_broderie_num%C3%A9rique_-_Bases_de_InkStitch_%28FacLab_UniGE%29
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cat%C3%A9gorie:InkStitch
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Le format et les manipulations de bases
Cette petite introduction montre comment utiliser InkStitch pour créer des remplissages, des traits et des simples
zigzags. La création de colonnes satin est plus compliquée et sera expliquée dans InkStitch - colonnes satin. La
broderie ondulée ainsi que le lettrage sont aussi introduits dans des articles à part.
Il est important de savoir que Ink/Stitch n'accepte que la numérisation de chemins (Angl. "path"), un type
d'élément SVG particulier qui permet de définir n'importe quelle forme avec un langage "path" qui inclut par
exemple des points de contrôle Bézier.
Avant d'expliquer comment utiliser l'extension Ink/Stitch, nous allons introduire quelques notions de base concernant
le format SVG et le logiciel de dessin InkScape. Si n'êtes pas intéressé par des explications techniques, vous lire le
chapitre suivant en diagonal et ensuite suivre de près le suivant qui explique comment numériser un fond
(remplissage) et un contour (trait).

Les objets SVG
Dans InkScape, tout objet graphique est défini par un code SVG, langage inventé dans les années 1990 pour créer
des graphiques. SVG fait partie de HTML5. On peut donc tout à fait ouvrir un fichier Inkscape/Inkstitch dans un
navigateur web et voir le dessin (pas la simulation de broderie). CTRL-U (View Page Source) permet de regarder
rapidement le code SVG. C'est plus simple que d'utiliser l'éditeur XML dans InkScape. Essayez ! Cliquez sur l'image
PNG ci-dessous jusqu'à ce qu'une page SVG s'affiche (accès direct). Ensuite, regardez le code avec CTRL-U.

Cercle jaune avec bordure bleue

Ici, on n'expliquera pas comment utiliser Inkscape. Il existe des nombreux tutoriaux sur le web qui font cela, y
compris dans InkScape: ( Menu Aide -> Didactiels
Ink/Stitch permet (via une interface GUI) d'ajouter des paramètres de broderie à un objet SVG et qui indiquent
comment le broder objet SVG. Cet objet doit un élément SVG de type "path" (en français "chemin", e.f. Formes
arbitraires avec path dans notre tutoriel SVG statique) pour des détails techniques sur la norme SVG. Un engin
traduit ensuite ces objets paramétrés en plan de broderie (que l'on peut visualiser ou non) qui définira tous les points
que la machine devra piquer. Ce plan sera ensuite exporté en format machine de votre choix.
Rappelons la distinction entre:
1. fond (ou remplissage, fill en Anglais) et
2. contour (ou trait, stroke en Anglais).
Un objet de dessin est composé soit d'un fond, soit d'un contour, soit des deux.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=SVG
https://edutechwiki.unige.ch/fmediawiki/index.php?title=HTML5
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Circle-path-yellow.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ACircle-path-yellow.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
https://edutechwiki.unige.ch/fmediawiki/index.php?title=SVG
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Tutoriel_SVG_statique%23Formes_arbitraires_avec_.3Cpath.3E
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Tutoriel_SVG_statique%23Formes_arbitraires_avec_.3Cpath.3E
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Un cercle avec un remplissage jaune et une bordure bleue

Voici un exemple d'un code SVG qui définit ce cercle, un utilisant l'élément SVG circle

<circle

       style="opacity:1; fill:#ffff00; fill-opacity:1; stroke:#0000ff; 

stroke-width:5.92615652; stroke-miterlimit:4; stroke-dasharray:none; 

stroke-opacity:1"

       id="path4147"

       cx="123.99713"

       cy="650.45123"

       r="106.87944" />

Dans InkScape, il est possible d'ouvrir l'éditeur d'arbre XML intégré si l'on souhaite vérifier le code
(CTRL-SHIFT-X). Il est aussi possible d'éditer du code SVG avec un éditeur de programmation, mais ce n'est pas
nécessaire pour faire des dessins. Savoir lire du code, vous aidera simplement à comprendre ce qui se passe.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASVG-jaune-cercle-ligne-remplissage.png
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Fenêtre de l'éditeur XML

La plupart des objets SVG ne peuvent pas être brodés directement, notamment les polices et les objets primitifs
(cercle, carré, etc.), mais on peut facilement les transformer en chemin (Angl. path) comme on explique ci-dessous.

Convertir un objet "primitif" en chemin
A priori il faudrait transformer tous les objets que vous souhaitez broder avec InkStitch en chemin (ceci dit
Ink/Stitch est devenu un peu plus tolérant) :
•• Sélectionner tous les objets avec le raccourci clavier CTRL+A
• Puis, exécutez menu Chemin > Objet en chemin (Angl: Path -> Object to Path)
Un chemin SVG est représenté à l'aide de lettres pour définir des opérations et de chiffres pour les positions,
distances, etc. (mécanisme qui inclut aussi les courbes de Bézier et les Arcs). Vous n'avez pas besoin de comprendre
comment cela fonctionne. Il faut simplement vous assurer que chaque objet que vous aimeriez coudre soit représenté
par un chemin, c.-à-d. l'élément SVG path. Pour vérifier cela, ouvrez l'éditeur XML puis cliquez sur l'objet dans la
scène de travail. Le code XML sera mis en surbrillance.
Voici le même cercle (c.f. ci-dessus) transformé en format "path"

 <path

   style="opacity:1;fill:#ffff00; fill-opacity:1; stroke:#0000ff; 

stroke-width:5.92615652; stroke-miterlimit:4; 

stroke-dasharray:none;stroke-opacity:1"

   d="M 230.87657,650.45123 A 106.87944,106.87944 0 0 1 

123.99713,757.33067 106.87944,106.87944 0 0 1 17.117691,650.45123 

106.87944,106.87944 0 0 1 123.99713,543.57179 106.87944,106.87944 0 0 1

 230.87657,650.45123 Z"

   id="path4147" />

Les objets qui ne sont pas du type path (chemin) sont ignorés par InkStitch ! Si vous voulez savoir plus sur SVG,
lisez Tutoriel SVG statique.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkStitch_XML.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Tutoriel_SVG_statique
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Paramétrer le chemin SVG pour la broderie
Rappelons que Ink/Stitch annote le code des objets que vous voyez sur l'écran avec des instructions qui indiquent
comment générer les points à broder. Sélectionnez au moins un objet puis jouez un peu avec les paramètres
disponibles dans le menu Extensions -> Ink/Stitch -> Paramètres.
Pour commencer, le plus simple sera d'accepter les paramètres par défauts. On reviendra dessus en détail dans la
prochaine section. On apprendra aussi plus tard comment InkStitch ajoute des propriétés aux chemins SVG pour
définir la manière dont les objets à coudre doivent être générés sur la base de chaque dessin. Voici un simple cercle
vert et son paramétrage par défaut:

Paramétrage par défaut d'un fond vert

On discutera un exemple un peu plus sophistiqué dans le prochain chapitre ci-dessous.

Inspecter le plan de broderie dans Inskape
Il est important de savoir à peu
Il est possible de visualiser ce qu'on appelle le plan de broderie. Il sera inclus dans un nouveau calque que vous
pouvez ensuite cacher ou tuer. Le plan permet de visualiser en détail les points de couture. Sinon, il est aussi possible
d'utiliser le simulateur (c.f. ci-dessous) ou encore un visualiseur de broderie à la place.
Extensions -> Ink/Stitch -> Visualiser et exporter -> Préisualiser le plan de

broderie

•• Sélectionnez le calque avec le plan de broderie et cachez les autres (cela devrait être fait automatiquement après
avoir utiliser l'opération Broderie).

• Sélectionnez l'outil Éditer les noeuds...
•• Agrandir la vue
Si l'on regarde le code SVG, on peut voir que nos tracés sont maintenant annotés d'informations propres aux points
de couture. De plus, le nouveau calque Plan Stitch contient deux énormes chemins d'objets - un pour la bordure et un
pour le remplissage - qui définissent tous les points qui seront cousus, sans oublier la couleur du trait pour les deux.
À noter que depuis que le cercle a été séparé en deux objets avec des traits, il n'y plus de remplissage.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-2-param%C3%A8tres_de_broderie.png
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Simulation de la broderie
Menu Extensions -> Ink/Stitch -> Visualiser et exporter -> Simulateur/Aperçu
réaliste (Angl: Visualize and Export-> Simulator/Realistic Preview) affichera une
simulation de point de couture. Cette une situation similaire à celle qu'on voit lorsque l'on paramétrise.
Menu Extensions -> Ink/Stitch -> Export PDF permet de générer une page web imprimable qui
inclut le design et d'importantes informations sur la couture.
•• Si vous cochez la case "Réaliste" au bas du simulateur, une simulation de haute qualité, telle que celle obtenue

avec le logiciel de visualisation et de conversion, s'affichera.
•• Il faut par contre bien comprendre que générer une version imprimée "réaliste" peut prendre un certain temps sur

des PC peu puissants.

Créer le fichier de broderie
Vous pouvez créer un fichier de points pour une sélection d'objets spécifiques, ou pour tous les objets. Pour créer un
fichier de broderie avec l'ensemble du motif :
•• Cliquez dans un espace vide (pour désélectionner)
• Menu Fichier -> Enregistrer une copie (Angl: File->Save a Copy). Veuillez ne jamais

utiliser des caractères accentués ou spéciaux dans vos noms de dossier ou de fichiers, car la plupart des
brodeuses ne les acceptent pas.

•• Sélectionnez le format de votre machine. Si vous n'êtes pas satisfait du résultat, sélectionnez un format répandu
tel que Tajima (DST), puis utilisez un convertisseur gratuit pour transformer votre fichier en format propriétaire.

•• Sélectionnez un nom de dossier dans lequel vous pouvez trouver vos fichiers.
Notez qu'il est également possible de visualiser les points de broderie avec Ink/Stitch -> Visualiser et
exporter -> Prévisualisation du plan de broderie (Angl.: Preview Stitch Plan)

Paramétrage de remplissages
Rappelons que le principe de la broderie machine moderne est de définir des formes et ensuite d'instruire la machine
comment générer des points brodables. InkStitch peut produire plusieurs types de points à partir d'un objet SVG :
points droits divers, broderie ondulée, zig zag simples, colonnes satinées et remplissage tatami, par contour ou ligne
guide.
• Une zone de points remplie avec un tatami, à partir d'un chemin SVG avec un remplissage défini
• Points courants (lignes), à partir d'un trait pointillé (chemin SVG avec un contour en pointillé)
•• Broderie ondulée (remplissage avec des lignes), à partir d'un ou deux traits pointillés
• Zig zag, à partir d'un trait (chemin SVG avec un contour )
•• Deux objets (une zone et un zig zag / ligne) d'un chemin comportant à la fois un remplissage et un contour (à

éviter)
•• Points satin, à partir d'un chemin comportant deux lignes sous forme de sous-chemins. Soit ces deux lignes

doivent avoir le même nombre de points, soit le chemin contient des traverses de direction (aussi appelés "lignes
de direction" ou échelons").

Résumé :
•• Les fonds (remplissages) SVG se traduisent en "tapis": soit des points de remplissage (appelés aussi tatamis), soit

un remplissage tatami guidé, ou soit un remplissage suivant les contours.
•• Les contours (traits) pointillés se traduisent en points droits (simples, répétés et/ou triples). Alternativement on

peut créer un tapissage par points ondulés. Les traits non pointillés sont à éviter.
•• Un chemin avec deux lignes (v.2.2) permet de définir des colonnes satinées. Elles doivent soit avoir le même

nombre de nœuds, soit vous pouvez ajouter des "échelons" (traverses de direction).
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On utilisera un emoji "pomme" de la police Twemoji pour montrer quelques principes.

SVG twemoji original légèrement adapté

(cliquer et enregistrer la page avec CTRL-S [1])

Remplissages de zones (tapis)
Depuis la version 2.2. Ink/Stitch permet de broder différents types de remplissages au sens étroit du terme, que nous
appelons aussi "tapis:
• Tatami Remplissage automatique. C'est le remplissage par défaut comme dans tous les logiciels de

broderie.
•• Remplissage guidé

•• Remplissage selon contour

Broder un remplissage tatami
(De chemin avec remplissages à une surface de broderie)
Les remplissages SVG peuvent être paramétrés pour créer des zones remplies d'un motif type"tatami". Vous pouvez
soit accepter les défauts (conseillé aux novices absolus), soit changer tous les paramètres.
Pour paramétrer un remplissage :
•• Sélectionnez un chemin comportant un remplissage et aucun trait (par exemple, un cercle ou un cercle rouge ou

vert ci-dessous).
• Ouvrez la fenêtre contextuelle des paramètres : Extensions -> Ink/Stitch -> Paramètres
La fenêtre de paramétrage aura trois onglets

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AGreen-apple-twemoji.svg
http://edutechwiki.unige.ch/fmediawiki/images/4/48/Green-apple-twemoji.svg
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• Auto-remplissage : essayez de changer l'angle de remplissage. Vous pouvez également ajouter des coupures s’ils
sont pris en charge par le fichier de points.

• Sous-couche de remplissage automatique : ajoutez une sous-couche, c’est-à-dire des points qui seront cousus sous
le motif. Cela ajoutera de la stabilité et un peu d’effet 3D. Ne le faites pas trop dense.

•• Remplir: une alternative au remplissage automatique (à éviter)
Paramètres (lire aussi le manuel officiel [2] ou sa version anglaise [3] !)
• Auto-remplissage avec des points de broderie: Doit être coché !
• Angle des lignes de points: Par défaut le tatami est brodé horizontalement. On conseille de varier la

direction des chemins.
• Elargir. Ajouter une compensation d'étirement dans la direction des lignes. Pour un tissu tissé, on conseille

d'ajouter 0.3mm
• Longueur maximale du point de remplissage: Il définit en fait la longueur du point de

remplissage. Vous pouvez garder le défaut (0.3mm) ou baisser jusqu'à 2 mm pour un fil de poids 40. Entre cette
valeur et les répétitions, vous pouvez obtenir un effet de texture différent.

• Espacement entre les rangés: Définit la distance entre les lignes et détermine principalement la
densité. Pour un fil de poids w.t. 40 standard, on conseille entre 0.25 (léger) et 0.2 (normal)

• Longueur de point du point droit (parcours entre les sections: On conseille de
laisser le défaut. Sinon entre 2 et 3 pour un fil standard. Cela affecte les lignes brodées pour passer d'un endroit à
l'autre, notamment le chemin du dessous.

• Sauter le dernier point dans chaque rangée: Laisser le défaut (décoché), sauf si vous désirez
alléger la broderie

• Décaler les rangées autant de fois avant de répéter: Définit la répétition d'une rangée (les
points sont distribués à une distance égale, mais ne commencent pas au même endroit au 2è point au début de la
ligne. Permet de varier un peu la texture

• Chemin du dessous En règle générale, il faut absolument cocher, sinon la broderie sera instable et on verra
aussi à travers.

• Autoriser les points d'arrêts Laisser coché pour une broderie "normale".
Voici des copies d'écran de la version Ink/Stitch 2.0, une fois pour l'interface Anglais et l'autre pour l'interface
française.

https://inkstitch.org/fr/docs/params/#sous-couche-de-rempissage-automatique
https://inkstitch.org/docs/params/
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Paramétrage d'une zone de broderie pour remplissage avec un point tatami (English)

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-0-fill-param.png
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Paramétrage d'une zone de broderie pour remplissage avec un point tatami (Français)

Gestion de la sous-couche.
•• On conseille de laisser les paramètres par défaut pour commencer.
Paramètres pour la sous-couche:
• Angle de remplissage Par défaut (champs vide) il sera brodé orthogonalement
• Décalage Par rapport Longueur de point maximalPar défaut, la valeur de l'auto-remplissage
• Espacement entre rangées de points par défaut, pour les tricots, vous pouvez densifier un peu.
• sauter le dernier point dans chaque rangée laisser décoché
• Chemin de dessous comme il va stabiliser le tissu, il faut le laisser en règle générale.
Pour créer une broderie extra-légère:

• cocher sauter le dernier point dans chaque rangéeà la fois pour le remplissage et la
sous-couche

• Décocher Chemin de dessous pour les deux. Les liens vont se faire le long de la bordure.
•• Espacer la distance entre les rangs (0.5 par exemple).

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-0-fill-param-fr.png
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Replissage selon contour (Angl. radial fill)

Le remplissage selon contour

Ce remplissage n'est à notre pas encore très réussi
(version 2.2) il vaut mieux utiliser les contours ondulés
(introduits plus loin dans cet article). Ceci dit, il est
probablement intéressant pour des broderies avec du fil
épais (w.t. 30 et 12) et sans sous-couche ni
sous-chemins. Voici une image d'un paramétrage pour
fil 12 à broder avec une aiguille topstitch 100. Donc
pour un design dense pour fil épais:
•• sans sous-couche,
•• densité diminuée par deux,
•• points allongés et stratégie spirale.
Design à tester encore ....

Remplissage selon contour, pour fil w.t. 12

On conseille de regarder le remplissage par broderie ondulée qui part d'une ligne de contour au lieu d'une surface et
qui offre plus de possibilités de paramétrage.
Fichier:
•• green-apple-twemoji-inkstitch-radial-fill.svg

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AGreen-apple-twemoji-inkstitch-radial-fill.PNG
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-2-remplissage-selon-contour.png
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Remplissage guidé (simulation)

Le remplissage guidé

Le remplissage guidé permet d'ajouter des effets
florentins à un tatami, c'est-à-dire une petite ondulation.
Pour cela il faut suivre les points suivants (aucun ne
doit manquer!)
•• D'abord dessiner une ligne-guide: simple ligne-trait

qui courbe, ondule, etc. selon vos désirs. À notre
avis il faut veiller à ce qu'elle dépasse les bornes de
l'objet à guider.

• Définir ce trait comme ligne de guidage: Extensions
-> Ink/Stitch -> Edition -> Sélection vers
ligne-guide. Vous devriez voir un symbole comme à
gauche de l'image.

•• Mettre la courbe dans un même groupe que les
objets à guide (!)

•• Paramétrer les remplissages en "remplissage guidé".
Voici une copie d'écran qui montre l'objet paramétré (la
pomme) avec sa ligne-guide, le panneau de
paramétrage et la simulation.

Remplissage guidé. En agrandissant l'image, on voit que les ondulations suivent la ligne-guide rouge

Le résultat pour la pomme ne semble pas très réussi selon la simulation, enfin il faudrait encore tester. Nos essais ont
aussi montré qu'il faut éviter des lignes droites dans la ligne-guide (à moins qu'on recherche des effets abrupts).
Notes:
•• Vous pouvez utiliser les paramétrages habituels pour le tatami, entre 4 à 5 lignes par mm (valeurs espacement

entre rangés = 0.25 à 0.2)

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AGreen-apple-twemoji-inkstitch-guided-fill.PNG
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-2-remplissage-avec-ligne-guide.png
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•• Pour un motif plus léger, on conseille de supprimer le chemin de dessous (le fil passera par la bordure) et
éventuellement la sous-couche.

•• On conseille aussi de broder de haut en bas en ajoutant des commandes de départ et d'arrivée (c.f. plus loin).
Fichier:
•• green-apple-twemoji-inkstitch-guided-fill.svg

Numériser des lignes avec des points droits
Pour obtenir une ligne fine en point droit, vous devez dessiner un contour (aussi appelé "trait") et le mettre en
pointillé. Dans InkScape 2.2 (et plus) on peut utiliser les "traits" de deux façons:
1.1. Broder des lignes avec des points droits
2.2. Creér des broderies ondulées

Broder des points droits
Un trait (aussi appelé "contour") est brodé par défaut avec des points zig-zag simples. Ce mode est à éviter, car
moche, mais si cela vous tente, optez pour une largeur de trait de 2 à 4mm. Si vous désirez broder un point droit ou
un point triple, il faut transformer la ligne en pointillés dans le panneau Inkscape Objet -> Fond et
contour -> Tab Style du contour.

•• Mettez l'épaisseur du trait à 0.2mm (environ la largeur d'un fil 40) ou à 3-4 mm si pensez broder un point triple ou
encore répéter la ligne. Cela vous aide mieux à visualiser le résultat, mais n'a aucune incidence sur la
numérisation.

•• Utilisez un pointillé fin ou avec des traits rapprochés.
Paramètres de remplissage

• Points droits le long des chemins (doit être coché!)
• Répéter: Nombre de fois qu'il faut broder le chemin (2 permet de faire un aller-retour, utile pour relier les

branches d'une étoile ou d'un arbre)
• Nombre de répétition du point triple: 1 = avant, arrière avant, une valeur de 2 va quintupler

(attention)
•• Longueur du point droit

• Espacement zig-zag (ignorer, ne sert à rien)
• Autoriser les points d'arrêts: utilisez les défauts, sauf contre-indication.
Attention aux effets de cumul. Un chemin répété avec un point triple fait piquer l'aiguille 4 fois aux mêmes
endroits.
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Paramètres points droits pour Ink/Stitch v 2.0

Gérer les chemins avec remplissage et contours
Les objets qui ont à la fois un remplissage et un contour permettent le réglage de ces deux paramètres, c’est-à-dire
que le paramètre contextuel présentera les onglets combinés des paramètres de surface et de contour. Mais comme le
trait est brodé d'abord, on ne conseille pas d'utiliser cette possibilité. Donc à la place, faites les opérations suivantes.
Utilisez la fonction Chemin -> Contour en chemin.
Alternativement:
•• Copier/coller l'objet en place
•• Supprimer le remplissage de l'un d'entre eux
•• Retirez le trait de l'autre.

Remplissage par broderie ondulée (ripple stitch)
Depuis la version 2.2 (août 2022) permet de créer des broderies ondulées à partir de lignes pointillées. Comme le
manuel officiel [4] explique, «La broderie ondulée tient à la fois du point droit et du remplissage : elle se comporte
comme un point droit (on peut l’exécuter en point triple par exemple), elle est définie à partir d’un trait, mais elle
produit à l’arrivée une broderie qui s’étend sur une surface. Utilisé de manière lâche, le résultat ressemble à des
ondes, d’où son nom.» (consulté le 16 sept. 2022).
Voici un exemple:
Dans la figure ci-dessous on paramètre l'eau, dessiné avec un chemin qui contient deux lignes qui vont dans le même
sens:

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-0-running-stitch-param-fr.png
https://inkstitch.org/fr/docs/stitches/ripple-stitch/
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Ripple stitch (point ondulé) avec deux sous-chemins.

Essai ripple stitch, à améliorer .....

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-2-ripple-stitch-1.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ADesert-island-fluent-ripplestitch-inkstitch.png
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Fichiers dans le dossier http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ travel_places/
place-geographic/
• desert-island-fluent-ripplestitch-inkstitch.svg [5]

Pour plus d'explications et d'exemples, voir InkStitch - broderie ondulée

Opérations diverses
Au delà des principes de paramétrage des fonds et contours introduits ci-dessus, il est utile de connaître et d'utiliser
d'autres fonctions.

Trier les objets
Il faut trier l'ordre des objets à broder avant de s'engager dans des transformations d'objets ou autres ajustements.
1. Ouvrir le panneau objets (Menu Objet -> Calques et Objets) (anciennement Objet -> Objets)
2.2. Les objets en bas de pile sont brodés d'abord. L'utilisation de groupes ou de calques (même objet SVG qu'un

groupe) n'a aucun effet, c.-à-d. lorsque Ink/Stitch tombe sur un groupe, il va d'abord broder l'élément qui est en
bas du groupe. On déconseille donc l'utilisation de calques et de groupes pour des dessins simples.

3.3. On peut les déplacer les objets vers le haut ou vers le bas avec la souris (mouse-drag), ou utiliser les flèches
(préférable)

Pour bien se retrouver dans la pile des objets on conseille nommer les objets les plus importants: Double-clic sur
l'objet et entrer le nouveau nom.

Attacher des commandes spéciales
Inkstitch permet d’attacher des commandes à un objet. Par exemple :
•• En ajoutant un code "couper le fil" (TRIM) à un objet, la machine coupera le fil. Une machine à une seule aiguille

devrait alors également s'arrêter, mais pas une machine à aiguilles multiples. Utile pour les personnes qui n'aiment
pas couper les fils au ciseau.

•• L'ajout d'un code STOP à un objet arrêtera la machine. Attention, cela ne fonctionne pas avec tous les formats de
broderie.

•• On peut définir les positions de départ et de fin. Nécessaire parfois pour réussir le remplissage tatami.
Utilisez Menu Extensions -> Ink/Stitch -> Commandes et explorez surtout Attacher des
commandes à des objets sélectionnés

Les commandes attachées seront visualisées avec des dessins SVG - qui ne seront bien sûr pas cousus.

Ajuster la taille du document
Bien que pas nécessaire pour réussir une broderie, nous conseillons d'ajuster la taille de la page à la broderie ou au
cadre et pour trois raisons:
1.1. Le motif s'affichera correctement dans le navigateur
2.2. Il permet d'utiliser efficacement les raccourcis clavier

• 4 - zoom sur le motif
• 5 - zoom sur la page, donc affiche aussi l'espace vide autour du motif

3.3. La taille du motif sera appropriée
Il existe deux logiques:
1.1. Soit on ajuste la taille du document à votre cadre (conseillé si vous dessinez un motif, mais le zoom avec les

touches 4 et 5 fonctionnera moins bien)

http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/travel_places/place-geographic/
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/travel_places/place-geographic/
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/travel_places/place-geographic/desert-island-fluent-ripplestitch-inkstitch.svg
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2.2. Soit on ajuste la taille du document au dessin (conseillé si vous importez un dessin). Vous pouvez rapidement
ajuster avec les raccourcis CTRL-A, puis CTRL-MAJ-R.

1) Procédure pour ajuster la taille du document à votre cadre

1. Menu Fichier -> Propriétés du document

2. Entrer les valeurs du cadre dans Dimensions personnalisées (Angl. Custom size)
2) Procédure pour ajuster la taille du document à la taille du motif:

1. Tout (ou rien) sélectionner CTRL-A, ensuite Menu Fichier -> Propriétés du document...
(Angl: (File->Document properties...)

2. Ouvrir Redimensionner la page au contenu (Angl. Resize page to content ...)
3.3. Définir une marge (on conseille 1 à 2 mm)
4. Cliquer sur Ajuster la page au dessin (Angl. Resize page to drawing or selection)
5. Vérifier qu'il n'ait pas de Zone de vue (Angl "View port"). X et Y doivent être à 0, et la largeur et la hauteur

doivent correspondre à la taille du document définie ci-dessus.
Raccourci/Shortcut rapide: Ctrl-Maj-R pour ajuster la page à la sélection (Angl. Ctrl-Shift-R)

Hamburger avec texture

Modifier un remplissage avec une texture

Il est possible d'ajouter ou d'enlever des points à un
remplissage, fonction qu'on appelé "texture" dans la
version française. Pour obtenir une texture il faut
d'abord créer un dessin avec un contour ou un
remplissage ou les deux. Les points du contour vont
être ajoutés et les points du remplissage vont enlever
des points à l'objet à texturer.
On peut utiliser des textures avec plusieurs types de
remplissage. On conseille de commencer avec les
remplissages tatami. Voici un exemple qui modifie le
tatami pour le pain d'un emoji hamburger.
•• On dessine d'abord quelques petits ronds avec

contour et remplissage

•• On regroupe ce nouveau chemin (texture) et l'objet à texturer
• Dans Ink/Stitch -> Edition -> Sélection vers texture on définit le chemin avec les ronds

comme texture
On peut aussi regrouper après. La seule contrainte est que la texture doit être le premier élément depuis le haut dans
le groupe.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AHamburger-twemoji-inkstitch.png
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Déclarer un chemin comme texture

Lire InkStitch - textures de remplissage pour plus de détails.

Résumé
Ink/Stitch fournit de bonnes fonctionnalités de base pour créer des fichiers de broderie. Son intégration dans
InkStitch a des avantages:
•• On peut profiter des fonctionnalités d'un outil de dessin gratuit et puissant
•• InkScape est également utilisé pour la découpe et l'art graphique, donc beaucoup personnes connaissent ce

logiciel.
Les fichiers de points de couture, au format Tajima DST ou Brother PES, sont acceptés par notre machine à aiguilles
multiples Brother, comme vous pouvez le voir dans les didacticiels qui suivent ce chapitre.
Dans cet article, nous venons de présenter les fonctionnalités de base. InkStitch permet aussi de créer des colonnes
satinées, de faire des points manuels et du lettrage. Continuez à lire.
Divers fichiers avec la pomme twemoji:
• http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ food_drink/ food-fruit/
Divers fichiers smilies:
• http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ smileys_emotion/ face-affection/

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-2-definir-texture.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=InkStitch_-_textures_de_remplissage
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-fruit/
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/smileys_emotion/face-affection/
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Droits et modification
Le contenu de cette page, y compris les images et les fichiers SVG, est également disponible sous les licences GNU
Free Documentation License et Attribution 4.0 International (CC BY 4.0).
Le projet Inkstitch peut utiliser n’importe quel élément (fragments de texte, fichiers SVG, images) pour la
documentation officielle du projet sans attribution (il suffit de copier et coller).
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[1] http:/ / edutechwiki. unige. ch/ fmediawiki/ images/ 4/ 48/ Green-apple-twemoji. svg
[2] https:/ / inkstitch. org/ fr/ docs/ params/ #sous-couche-de-rempissage-automatique
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[4] https:/ / inkstitch. org/ fr/ docs/ stitches/ ripple-stitch/
[5] http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ travel_places/ place-geographic/ desert-island-fluent-ripplestitch-inkstitch.
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http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/travel_places/place-geographic/desert-island-fluent-ripplestitch-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/travel_places/place-geographic/desert-island-fluent-ripplestitch-inkstitch.svg
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Opérations et utilisation de base

InkStitch - broderie ondulée

Guide de tutoriels de broderie machine

Module: InkStitch

◀▬▬▶
⚐ brouillon ☸ débutant

⚒ 2022/09/27
Prérequis

•• Inkscape
•• InkStitch - utilisation de base

Objectifs

•• Numériser des surfaces avec un point ondulé

Voir aussi

•• Cours initiation à la broderie numérique - Bases de InkStitch (FacLab UniGE)

Autres pages du module

•• InkStitch
•• InkStitch - installation
•• InkStitch - utilisation de base
•• InkStitch - broderie ondulée
•• Inkstitch - textures de remplissage
•• InkStitch - lettrage
•• InkStitch - colonnes satin
•• InkStitch - exemples colonnes satin
•• InkStitch - broder un emoji
•• InkStitch - broder une image issue de The Noun Project
•• InkStitch - broder des codes QR
•• InkStitch - broder des patchs et des appliqués
•• InkStitch - astuces et problèmes courants
•• InkStitch - bases SVG
•• Inkscape - édition des chemins
•• InkStitch - broder avec du gros fil
•• InkStitch - broderies à partir de dessins faits à la main
•• InkStitch - points manuels
•• InkStitch - points programmables
Catégorie: InkStitch

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Guide_de_tutoriels_de_broderie_machine
https://edutechwiki.unige.ch/fmediawiki/index.php?title=InkStitch_-_textures_de_remplissage
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cours_initiation_%C3%A0_la_broderie_num%C3%A9rique_-_Bases_de_InkStitch_%28FacLab_UniGE%29
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cat%C3%A9gorie:InkStitch
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Introduction
La broderie ondulée (Angl "Ripple Stitch") est un remplissage hybride, à situer entre un design composé de lignes
(comme le "redwork") et un remplissage de type tatami. Selon le manuel officiel «Ripple stitch is part running stitch
and part filling: it behaves like a running stitch (it can be done in triple stitch for example), it is defined from a
stroke, but the embroidery result stretches over a surface. Used loosely, the result looks like ripples, hence the
name.»
L'outil Broderie ondulée est assez complexe. Il faut bien comprendre que le résultat dépend (1) du chemin de
départ, (2) des artefacts de guidage ajoutés et (3) des paramètres choisis.
Le dessin de départ est un seul chemin. Celui-ci doit être composé soit:
1. d'une ligne pointillée ouverte, plus à option des artefacts de guidage,
2. d'une ligne pointillée fermée (donc par ex. un polygon), plus à option des artefacts de guidage,
3. de deux lignes pointillées dans un seul chemin qui vont en principe dans le même sens, plus à option des

artefacts de guidage
4. de deux lignes pointillées dans un seul chemin avec des traverses de direction (comme une colonne satin).
Pour les trois premiers, on peut ajouter soit (a) une cible qui définit le point de "gravité" qui va influence la direction
vers laquelle les courbes évoluent, (b) une ligne de guidage ou (c) encore un satin de guidage. Les lignes croisées
sont autorisées et parfois souhaitées.
La combinaison de ces possibles choix de départ avec 17 paramètres qui permettent de choisir le type de point droit
et surtout toutes sortes de distances donne un éventail très large de possibilités.
Le manuel officiel, Broderie ondulée [4] (Angl: Ripple Stitch [1]), fournit pleins de cas d'usage, par exemple un bon
tableau [2] qui présente 9 différents cas pour les ondulations linéaires. On conseille vivement de lire ce manuel
officiel, en français ou dans une autre langue. Les différents choix sont bien expliqués dans l'ordre suivant:
•• Ondulations circulaires, à partir d'un simple contour fermé
•• Ondulations linéaires, à partir de chemins composés de deux lignes
•• Ondulations avec boucles, à partir d'une ligne qui se croise
Ensuite, le manuel explique les principes de guidage optionnel, soit par cible, par chemin ou par satin.
Les paramètres les plus importants sont:
•• Les répétitions: On conseille de mettre soit un point triple, soit répéter 2 fois un point simple, soit combiner les

deux (mais cela devient épais)
•• Le nombre de lignes: Il faut indiquer un nombre (pas d'autre possibilité)
•• Changer de sens, par exemple commencer à l'intérieur pour un remplissage circulaire
•• Style de jointure (s'applique aux ondulations linéaires): Point ou segment (voir une image du speaking head en

bas)
•• L'exposant qui permet d'avoir des écarts qui grandissent ou diminuent.
On va expliciter quelques choix avec des exemples qui comprennent des copies d'écran. Pour débuter, il faut retenir
surtout les points suivants:
1.1. Mettre les contours en pointillé !
2.2. Ces contours sont soit composés d'une ligne ou de deux lignes,
3.3. On peut ensuite ajouter des indications de guidage (cibles, ligne de guidage, satin de guidage)
4.4. Comme pour n'importe quelle numérisation comportant des contours (traits), il faut bien choisir le point de

départ.
5. Pour paramétrer, il suffit de sélectionner l'objet, puis ouvrir le panneau de paramétrage

(Extensions->Ink/Stich->Paramètres), puis sélectionner Méthode = broderie ondulée.
Si vous ne savez enregistrer ou télécharger des fichiers web, lisez InkStitch.

https://inkstitch.org/fr/docs/stitches/ripple-stitch/
https://inkstitch.org/docs/stitches/ripple-stitch/
https://inkstitch.org/assets/images/docs/en/linear-ripple.svg
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Emoji dim button avec remplissage radiaux
Le "dim button" vient de la catégorie emoji des symboles audio-visuels. Il sert à diminuer la luminosité d'un écran.
Ce premier exemple très simple montre comment créer des remplissages radiaux (circulaires). On obtient ce résultat
avec quatre opérations simples
•• On enlève le fond (remplissage) et on définit le contour en pointillé
• Ensuite, on lance le paramétrage: sélectionner un ou plusieurs objets, puis
Extensions->Ink/Stich->Paramètres) puis sélectionner Méthode = broderie ondulée.

•• Les "boutons" en spirale sont paramétrés avec 5 lignes.
•• L'anneau au milieu est un chemin composé de deux lignes. On a brisé les deux lignes au même endroit, en haut.

Le remplissage (par défaut) se fait en lignes parallèles.
•• On définit un point triple (le défaut est un point droit simple)

Dim button - clipart de départ Desert island - fichier SVG de
conception

Dim button - simulation

Voici une copie d'écran du paramétrage d'un des points. Elle montre qu'on a juste modifié 2 paramètres: Le nombre
de lignes à remplir (5 au lieu des 10 par défaut) et le remplissage (point triple).

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ADim-button-fluent.clipart.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ADim-button-fluent-inkstitch.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ADim-button-fluent-inkstitch.png
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Remplissage circulaire d'un rond en spirale de 5 contours

Pour l'anneau on a presque la même configuration, mais on choisi 8 lignes. Cet exemple montre bien que le résultat
est aussi fonction de l'objet du départ. Les petits rond deviennent des spirales parce qu’on part d'un contour de cercle
(une seule ligne). L'anneau, par contre, est défini par deux lignes et donne un remplissage en parallèle.
Un exemple très similaire existe sous forme de serpent, c.f. liens à la fin.
Fichiers:

• Dossier: http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ symbols/ av-button/
• Fichier SVG: dim-button-fluent-ripple-inkstitch.svg [3] (CTRL-S ou menu -> Fichiers -> Enregistrer en tant que)

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-2-ripple-stitch-7.png
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/av-button/
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/av-button/dim-button-fluent-ripple-inkstitch.svg
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Emoji desert island avec remplissages linéaires et radiaux
L'exemple suivant montre un exemple simple avec trois variantes de remplissage ondulé. Le dessin est basé sur
l'emoji "desert island" de la police Fluent (Microsoft). On pourrait très bien numériser cet exemple avec un
remplissage simple en tatami comme le montre l' image suivante.

Desert island - fichier SVG de départ Desert island - simulation pour un
remplissage en tatami

Desert island - simulation en ondulé,
présentée ici

Dans notre nouvelle version:
•• L'eau est ondulée linéairement (défini avec deux lignes dans un seul chemin), plus de détails ci-dessous.
•• Le sable est en ondulée linéaire aussi, mais avec l'ajout d'un point cible.
•• Le tronc est en ondulée linéaire simple.
•• Les feuilles sont en simple ondulé circulaire (défini avec une seule ligne fermée)
•• Les noix de coco en simple trait, donc pas en broderie ondulée.
Voici le SVG. On voit que les feuilles en vert et vert clair sont fermées. La tige, le sable et l'eau sont des chemins
composés de 2 lignes.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ADesert-island-fluent-inkstitch.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ADesert-island-fluent-inkstitch.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ADesert-island-fluent-ripplestitch-inkstitch.png


InkStitch - broderie ondulée 45

Desert island - Fichier SVG De conception

Pour créer l'eau, on modifie le contour du chemin qui définit l'eau: on met le contour en lignes pointillées, on
supprime le remplissage et on coupe les segments à chaque bout à gauche et à droite. Donc on retient juste deux
lignes. On a fait pareil pour le tronc.
Le sable a un remplissage un peu décalé, car en utilise une cible (visualisé par la sorte d'étoile noire). On définit une
cible dans les commandes (c.f. la copie d'écran dans l'exemple suivant): Sélectionner l'objet, puis
Menu->extensions->Ink/Stitch->Commandes->Attacher des commandes à des objets sélectionnés. La position de la
cible n'est pas le point d'attache, mais la position du symbole "étoile", dans notre cas vers la gauche et vers le bas.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ADesert-island-fluent-ripplestitch-inkstitch.svg
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Remplissage linéaire simple avec deux lignes dans un chemin. La copie d'écran montre le paramétrage de l'eau, mais on voit aussi la cible du sable

Fichiers

• Fichier: http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ travel_places/ place-geographic/
desert-island-fluent-ripplestitch-inkstitch. svg

• Dossier (avec clipart, simulation et PES): http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/
travel_places/ place-geographic/

Emoji speaking head avec lignes de direction
Voici un emoji "speaking head" et la simulation la numérisation qu'on va explique ici:

Clipart emoji speaking head de la police twitter Simulation broderie emoji speaking head de la police twitter

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-2-ripple-stitch-5.png
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/travel_places/place-geographic/desert-island-fluent-ripplestitch-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/travel_places/place-geographic/desert-island-fluent-ripplestitch-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/travel_places/place-geographic/
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/travel_places/place-geographic/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASpeaking-head-twemoji.clipart.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASpeaking-head-twemoji-ripple-inkstitch.png
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On va le modéliser la tête en six variantes. La plupart des solutions ne sont pas appropriées pour cette tête. En point
ondulé, seulement la solution 6 (deux lignes avec traverses) est bonne.

Six variantes pour modéliser une tête - SVG

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ARipple-inkstitches-head-1.svg
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Six variantes pour modéliser une tête - Simulation

Voici les techniques de remplissage:
(1) Une simple ligne (point droit) sans broderie ondulée
(2) Chemin circulaire (une seule ligne fermée) sans cible
•• résultat = remplissage circulaire

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ARipple-inkstitches-head-1.png
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Remplissage circulaire

(3) Chemin circulaire (une seule ligne fermée) avec cible et un autre point de départ
•• résultat = remplissage circulaire avec un point "cible" déplacé
•• Notez que la cible était positionnée en dehors de la tête et elle va donc tirer le tout vers le haut à droite.
Pour attacher une cible, il faut utiliser une commande

Poser une cible

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-2-ripple-stitch-2.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-2-ripple-stitch-3.png
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Pour définir le point de départ, il suffit de briser le contour à l'endroit voulu

Briser un contour

(4) Chemin avec une ligne ondulée avec une cible
•• résultat = remplissage linéaire. La cible corrige la position de la fin du remplissage. On l'a positionné à peu près à

la même largeur X du début et de la fin du trait.
(5) Chemin avec deux lignes dans un chemin
•• résultat = remplissage linéaire, superposition un peu moche (dans ce cas)
(6) Chemin avec deux lignes dans un chemin avec traverses (bonne solution pour ce motif)
•• résultat = remplissage linéaire, les traverses assurent une meilleure ondulation
• On a défini une forme qui ressemble beaucoup à une colonne satin. La seule différence est que les lignes sont en

pointillés et que le paramétrage se fait dans le panneau pour les traits. Par contre, cette méthode n'est pas trop mis
en avant dans le manuel officiel alors qu'elle me semble être très importante.

Les lignes ovales qui symbolisent la parole seront modélisées avec de simples ondulations linéaires, mais avec des
bouts en pointe et une diminution des écarts.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-2-ripple-stitch-4.png
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Remplissage linéaire simple avec deux lignes dans un chemin, bouts pointus, indice = 1.2

Fichiers:
• http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ people_body/ person-symbol/
• http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ people_body/ person-symbol/

speaking-head-twemoji-ripple-inkstitch. svg

Autre exemples

Red question mark (fluent)

(il doit en avoir d'autres ....)
Le serpent:
• Dossier: http:/ / tecfa. unige. ch/ guides/ embroid/

emoji/ AAA_EMOJIS/ animals_nature/
animal-reptile/

• Fichier: snake-twemoji-ripple-inkstitch.svg [4]

Point d'interogation:
• Dossier: http:/ / tecfa. unige. ch/ guides/ embroid/

emoji/ AAA_EMOJIS/ symbols/ punctuation/
• Fichier: red-question-mark-fluent-inkstitch.svg [5]

L'étoile du clavier
• Fichier: keycap-asterisk-fluent-inkstitch.svg [6]

• Dossier: http:/ / tecfa. unige. ch/ guides/ embroid/
emoji/ AAA_EMOJIS/ symbols/ keycap/

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-2-ripple-stitch-6.png
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/people_body/person-symbol/
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/people_body/person-symbol/speaking-head-twemoji-ripple-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/people_body/person-symbol/speaking-head-twemoji-ripple-inkstitch.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ARed-question-mark-fluent-inkstitch.png
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/animals_nature/animal-reptile/
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/animals_nature/animal-reptile/
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/animals_nature/animal-reptile/
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/animals_nature/animal-reptile/snake-twemoji-ripple-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/punctuation/
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/punctuation/
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/punctuation/red-question-mark-fluent-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/keycap/keycap-asterisk-fluent-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/keycap/
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/keycap/
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Droits et modification
Le contenu de cette page, y compris les images et les fichiers SVG, est également disponible sous les licences GNU
Free Documentation License et Attribution 4.0 International (CC BY 4.0).
Le projet Inkstitch peut utiliser n’importe quel élément (fragments de texte, fichiers SVG, images) pour la
documentation officielle du projet sans attribution (il suffit de copier et coller).

Liens
• Ripple Stitch [1] (manuel officiel)
• Broderie ondulée [4] (manuel officiel)
• Iris en broderie ondulée [7] (exemple officiel)
• La danse des paramétrages (version 2.2) [8] (Blog de Alyogau.

Références
[1] https:/ / inkstitch. org/ docs/ stitches/ ripple-stitch/
[2] https:/ / inkstitch. org/ assets/ images/ docs/ en/ linear-ripple. svg
[3] http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ symbols/ av-button/ dim-button-fluent-ripple-inkstitch. svg
[4] http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ animals_nature/ animal-reptile/ snake-twemoji-ripple-inkstitch. svg
[5] http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ symbols/ punctuation/ red-question-mark-fluent-inkstitch. svg
[6] http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ symbols/ keycap/ keycap-asterisk-fluent-inkstitch. svg
[7] https:/ / inkstitch. org/ fr/ tutorials/ ripple-iris/
[8] https:/ / lyogau. over-blog. com/ 2022/ 08/ la-danse-des-parametrages-version-2. 2. html
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Guide de tutoriels de broderie machine

Module: InkStitch

◀▬▬▶
⚐ brouillon ☸ débutant

⚒ 2022/09/27
Prérequis

•• Inkscape

Objectifs

•• Créer des textures de remplissage

Autres pages du module

•• InkStitch
•• InkStitch - installation
•• InkStitch - utilisation de base
•• InkStitch - broderie ondulée
•• Inkstitch - textures de remplissage
•• InkStitch - lettrage
•• InkStitch - colonnes satin
•• InkStitch - exemples colonnes satin
•• InkStitch - broder un emoji

https://inkstitch.org/docs/stitches/ripple-stitch/
https://inkstitch.org/fr/docs/stitches/ripple-stitch/
https://inkstitch.org/fr/tutorials/ripple-iris/
https://lyogau.over-blog.com/2022/08/la-danse-des-parametrages-version-2.2.html
https://inkstitch.org/docs/stitches/ripple-stitch/
https://inkstitch.org/assets/images/docs/en/linear-ripple.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/av-button/dim-button-fluent-ripple-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/animals_nature/animal-reptile/snake-twemoji-ripple-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/punctuation/red-question-mark-fluent-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/keycap/keycap-asterisk-fluent-inkstitch.svg
https://inkstitch.org/fr/tutorials/ripple-iris/
https://lyogau.over-blog.com/2022/08/la-danse-des-parametrages-version-2.2.html
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Guide_de_tutoriels_de_broderie_machine
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
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•• InkStitch - broder une image issue de The Noun Project
•• InkStitch - broder des codes QR
•• InkStitch - broder des patchs et des appliqués
•• InkStitch - astuces et problèmes courants
•• InkStitch - bases SVG
•• Inkscape - édition des chemins
•• InkStitch - broder avec du gros fil
•• InkStitch - broderies à partir de dessins faits à la main
•• InkStitch - points manuels
•• InkStitch - points programmables
Catégorie: InkStitch

Introduction
Depuis la version 2.1.2 (janvier 2022), Ink/Stitch permet de créer des textures de remplissage (Angl. stitch patterns).
Le principe est assez simple:
•• Il faut définir un chemin composé soit de traits, soit de remplissages soit des deux.
• Le ce chemin est appliqué à un ou plusieurs objets définissant un remplissage tatami ou un satin, selon les règles

suivantes: Le remplissage enlève des points aux objets, le trait ajoute des points aux objets.

Méthode
Etape 0: Identifier un ou plusieurs objet à texturer avec une texture
Etape 1: Définir la texture
•• Définir un chemin avec des petites formes. On peut utiliser l'outil clonage pour créer un pavé
• Important: Il faut que ce soit un (seul) objet de type chemin. Il peut contenir des traits (contours), des fonds ou les

deux. On conseille de commencer à utiliser uniquement des traits. Le chemin peut être simple ou composé de
plusieurs sous-chemins.

Etape 2: Grouper
•• Grouper le chemin texture avec les objets à texturer. L'objet-texture doit se trouver en haut de la pile

Groupe

Chemin-texture

Objet à texturer

Etape 3: Déclarer la texture
•• Sélectionner la texture
• Menu Extensions -> Ink/Stitch -> Edition -> Sélection vers texture
Si l'opération marche, une marqueur "spirale" va apparaître sur le premier sous-chemin.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cat%C3%A9gorie:InkStitch
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Groupement avec texture et objet texturé

Etape 4:
•• Pour visualiser l'effet texture, il faut soit exporter un fichier machine, soit utiliser la vue "réaliste" dans le

simulateur. La simple simulation ne montre rien (!).
Voici le résultat simulé:

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-1-stitch-pattern.png
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Hamburger avec texture

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AHamburger-twemoji-inkstitch.png
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Mise en garde concernant l'utilisation de textures avec fond
•• Les remplissages (fonds) enlèvent vraiment des points, donc il ne faut pas utiliser des plages larges dans la

direction des points !!

Certaines lignes de la texture sont trop longues ! Il faut réorienter la direction du tatami, sinon couper ces lignes

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALeafy-green-twemoji-inkstitch-bad.png
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Fichier brodé, pas joli !

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-1-stitch-pattern-2.jpg
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Exemples asian food

Exemples

Voici quelques exemples emoji qui montrent plusieurs cas d'utilisation (à
documenter)
Dossier http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/
food_drink/ food-asian/

• http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ food_drink/
food-asian/ cooked-rice-twemoji-inkstitch. svg

• http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ food_drink/
food-asian/ fried-shrimp-noto-inkstitch. svg

• http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ food_drink/
food-asian/ spaghetti-twemoji-inkstitch. svg

•• etc.
Dossier: http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/
food_drink/ food-vegetable/

• http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ food_drink/
food-vegetable/ cucumber-twemoji-inkstitch. svg

• http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ food_drink/
food-vegetable/ leafy-green-twemoji-inkstitch. svg

• http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ food_drink/
food-vegetable/ brocoli-twemoji-inkstitch. svg

• http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ food_drink/
food-vegetable/ potato-twemoji-inkstitch. svg

•• etc.
Voici un emoji non officiel:

Soupe aux arraignés

Dossier: http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ z_variations_combis/
• http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ z_variations_combis/

shallow-pan-of-food-spiders-twemoji-inkstitch. svg
• http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ z_variations_combis/

shallow-pan-of-food-spiders-twemoji-inkstitch-2. svg
• http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ z_variations_combis/

shallow-pan-of-food-spiders-twemoji-inkstitch-3. svg

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-stitch-pattern-3.jpg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-asian/
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-asian/
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-asian/cooked-rice-twemoji-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-asian/cooked-rice-twemoji-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-asian/fried-shrimp-noto-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-asian/fried-shrimp-noto-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-asian/spaghetti-twemoji-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-asian/spaghetti-twemoji-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-vegetable/
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-vegetable/
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-vegetable/cucumber-twemoji-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-vegetable/cucumber-twemoji-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-vegetable/leafy-green-twemoji-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-vegetable/leafy-green-twemoji-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-vegetable/brocoli-twemoji-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-vegetable/brocoli-twemoji-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-vegetable/potato-twemoji-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-vegetable/potato-twemoji-inkstitch.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-spider-soup-stitch-pattern.jpg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/z_variations_combis/
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/z_variations_combis/shallow-pan-of-food-spiders-twemoji-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/z_variations_combis/shallow-pan-of-food-spiders-twemoji-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/z_variations_combis/shallow-pan-of-food-spiders-twemoji-inkstitch-2.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/z_variations_combis/shallow-pan-of-food-spiders-twemoji-inkstitch-2.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/z_variations_combis/shallow-pan-of-food-spiders-twemoji-inkstitch-3.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/z_variations_combis/shallow-pan-of-food-spiders-twemoji-inkstitch-3.svg
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Pour le moment je n'ai pas encore testé les textures sur une colonne satin.

Astuces

Direction des points
Direction des "satins" crées dans les textures: Cette info circule probablement déjà, mais j'ai un joli exemple pour le
principe suivant: Les satins des textures vont dans le sens des points, donc l'angle défini dans les paramètres des
objets à texturer. C'est une évidence puisque la texture enlève juste des points du remplissage tatami.
Concrètement cela veut dire: Lorsque vous avez des éléments textures longs (>6mm) il faut mettre un angle
orthogonal pour le remplissage qui sera modifié (voir l'image). Alternativement, ajouter des lignes pour le tenir.

Direction à régler pour un remplissage tatami: orthogonale par rapport à l'orientation longue des textures

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch2-pattern-fill-direction.png
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Remplissage du adhesive bandage bien orienté Adhesive bandage mal orienté

Fichier pour jouer: http:/ / tecfa. unige. ch/ guides/ embroid/ emoji/ AAA_EMOJIS/ objects/ medical/
adhesive-bandage-twemoji-inkstitch. svg (enregistrer la "page sous" dans le navigateur). Ce motif utilise des textures
qui ont à la fois un contour et un fond.

Enlever une texture
Si l'on désire enlever le marquer de texture (donc pas supprimer le dessin), il faut aller dans Objet -> Fond et
contour -> TAB Style du contour et enlever le marqueur en choisissant le premier élément "-" (rien)
dans le liste des marqueurs.

Détexturer un chemin ... (oui c'est un néologisme)

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AAdhesive-bandage-twemoji.PNG
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AAdhesive-bandage-twemoji-2.PNG
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/objects/medical/adhesive-bandage-twemoji-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/objects/medical/adhesive-bandage-twemoji-inkstitch.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-2-enlever-texture.png
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Droits et modification
Le contenu de cette page, y compris les images et les fichiers SVG, est également disponible sous les licences GNU
Free Documentation License et Attribution 4.0 International (CC BY 4.0).
Le projet Inkstitch peut utiliser n’importe quel élément (fragments de texte, fichiers SVG, images) pour la
documentation officielle du projet sans attribution (il suffit de copier et coller).

Liens
• https:/ / inkstitch. org/ docs/ stitches/ patterns/

InkStitch - lettrage

Guide de tutoriels de broderie machine

Module: InkStitch

▬▶
⚐ brouillon ☸ débutant

⚒ 2022/09/27
Prérequis

•• Inkscape

Autres pages du module

•• InkStitch
•• InkStitch - installation
•• InkStitch - utilisation de base
•• InkStitch - broderie ondulée
•• Inkstitch - textures de remplissage
•• InkStitch - lettrage
•• InkStitch - colonnes satin
•• InkStitch - exemples colonnes satin
•• InkStitch - broder un emoji
•• InkStitch - broder une image issue de The Noun Project
•• InkStitch - broder des codes QR
•• InkStitch - broder des patchs et des appliqués
•• InkStitch - astuces et problèmes courants
•• InkStitch - bases SVG
•• Inkscape - édition des chemins
•• InkStitch - broder avec du gros fil
•• InkStitch - broderies à partir de dessins faits à la main
•• InkStitch - points manuels
•• InkStitch - points programmables
Catégorie: InkStitch

https://inkstitch.org/docs/stitches/patterns/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Guide_de_tutoriels_de_broderie_machine
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cat%C3%A9gorie:InkStitch
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Introduction
Le lettrage est probablement l'activité de couture la plus populaire pour les utilisateurs débutants à domicile. À
compter du printemps 2019, InkStitch inclut une police de caractères numérisée simple disponible en lettres dans le
menu InkStitch.
La plupart des machines à broder incluent des possibilités de lettrage et tous les paquets de broderie sérieux incluent
un module de lettrage.
En outre, InkStitch permet - comme un programme de broderie professionnel - de créer des lettres à partir de polices
SVG.
Inkscape permet également de créer un texte en courbe à partir de texte simple avec des remplissages ou à partir de
polices numérisées.
Cette page reprend les informations des pages InkStitch - Lettering [1] et InkStitch - Embroidery Patch (creating
rounded text paths) [2] présentes sur l'EduTech Wiki anglophone.

Le module de lettrage

Créer des lettres
Pour créer des lettres, il faut ouvrir le menu de lettrage de inkstitch:
Menu Extensions > InkStitch > Lettrage

Module de Lettrage sur InkStitch (Mac)

Dans la fenêtre qui s’ouvre, un espace
permet d’insérer du texte. La
visualisation permet de vérifier la
façon dont le texte sera brodé. Enfin, il
faut appliquer les changements et
quitter cette fenêtre.

Les lettres devraient être un groupe
d’objet. Dans le menu objets (menu
objets > objets), il est possible de
vérifier que chaque lettre est un objet
différent.

Différentes polices

InkStitch (sur InkScape 0.92 version MAC) permet d'utiliser 4 polices différentes.
Pour choisir sa police, il suffit de la sélectionner dans le menu déroulant lors de l'insertion du texte (étape "créer des
lettres").

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
https://edutechwiki.unige.ch/en/InkStitch_-_lettering
https://edutechwiki.unige.ch/en/InkStitch_-_embroidery_patch#Creating_rounded_text_paths
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch_module_lettrage.png
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Les différentes polices sur InkScape 0.92

Ajuster la taille des lettres

Par défaut, les lettres produites une taille de départ que l'on peut
modifier avec le paramètre scale dans le popup (c.f. la figure
ci-dessus).
Il est important de choisir une taille de police adaptée à votre projet.
Les polices sont déjà programmées pour bien "marcher" avec un
certain étendu de taille. Par exemple la petite police contient des lettres
simples adaptés pour des petits bages. En grande taille, cette police
n'est pas belle. A l'inverse les grandes polices définissent des lettres
plus compliquées qu'on peut difficilement réduire.
Lorsque le résultat des fontes digitalisés ne vous satisfait pas, la meilleure solution est de créer vous-même les points
satin manuellement.
Pour réduire une fonte avec l'outil transformation (à vos risques), suivre cette marche à suivre:
• Menu objet > Transformer
•• Dans la fenêtre qui s'ouvre à droite, choisir l'onglet "Dimension"
•• Cocher « Redimensionner proportionnellement »
• Redimensionner jusqu’à 50%
•• Cliquer sur "Apply" / "Appliquer"

Manipuler les Lettres
Il est possible de manipuler les lettres individuellement et les modifier comme on le souhaite comme des objets SVG
standards, et donc de créer un texte en courbe (section 3).

Ajouter du texte en courbe
(Adapté de la page en:InkStitch - embroidery patch de l'Edutech Wiki anglais)
Il existe différentes méthodes pour créer du texte en courbe. La méthode décrite ci-dessous, c’est-à-dire d’utiliser le
module de lettrage d’InkStitch et les effet de chemin de InkScape, est la plus adaptée pour les novices.
Etape 1: Ajouter un ou deux cercles pour guider le positionnement du texte

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch_lettrages_polices.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch_lettrage_transformer.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=InkStitch_-_lettrage%23Ajouter_du_texte_en_courbe
http://edutechwiki.unige.ch/en/InkStitch_-_embroidery_patch
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• Créer un nouveau calque: Menu Calque > Ajouter un calque.
•• Nommer ce nouveau calque « Artwork » ou « Guidelines ».
•• Ajouter un cercle sur ce calque: maintenir la touche CTRL
•• Center le cercle sur le calque
• Enlever le remplissage: par exemple en double-cliquant sur la couleur de fond en bas à gauche, puis en modifiant

les paramètres dans la fenêtre qui s’ouvre dans le menu de droite.
• Ajouter un contour léger, en général 0.5mm (dans l’onglet « contour » et « style de contour »)
Etape 2: Créer le texte
•• Suivre les étapes décrites plus haut, dans la section « créer des lettres ».
•• Utiliser les polices « Small » ou « Médium », et réduire la taille du texte comme vu plus haut (section « Ajuster la

taille des lettres »).
•• Positionner ce texte dans la zone choisie.

Le bouton "Editer sur la zone de travail"

Etape 3: Courber le texte
•• Sélectionner le groupe de lettres créées
• Menu Chemin > Effets de chemin
•• Cliquer sur le bouton +, et sélectionner « Courber » dans la liste,

puis « Ajouter ».
•• Cliquer sur le bouton « Editer sur la zone de travail »
•• Glisser la ligne verte apparue sur le texte vers le haut ou le bas.

Puis, utiliser les poignées de courbes qui apparaissent pour ajuster la
courbe. Bouger les losanges gris pour repositionner, ou cliquer sur
ceux-ci pour faire ré-apparaitre les poignées de courbe.

• Utiliser le cercle créé dans l’étape 2 comme guide.

Etape 4: Vérifier
• Pour vérifier que le texte est toujours brodable, accéder à Extensions > InkStitch > Paramètres
Réparations:
• Si les lettres n’apparaissent pas lors de la simulation, essayer d'abord de réparer les traverses de direction (les

allonger).

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkStitch_Lettrage_effetchemin.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkStitch_Lettrage_courber.png
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• Sinon, essayer de redessiner des traits et ensuite d’ajouter du satin: sélectionner ces traits définissant une lettre.
Ensuite, > Extensions > InkStitch > Outils de Satin > Convertir en lignes de satin. Puis, re-vérifier avec
Extensions > InkStitch > Paramètres. En principe, il faudrait aussi optimiser les satins

Méthode alternative

•• Positionner les lettre comme ci-dessus
•• Créer un deuxième lettre identique, sans le courber.
•• Positionner individuellement chaque lettre avec une rotation appropriée.
Cela donne un résultat nettement plus jolie, mais prend plus de temps.

Ressources
• Le module lettrage sur le site de InkStitch [3]

• Polices d'écriture disponibles pour le lettrage [4]

• Tutoriel vidéo sur la chaîne youtube de InkStitch [5]

• Tutoriel vidéo pour du texte en courbe [6]

Références
[1] https:/ / edutechwiki. unige. ch/ en/ InkStitch_-_lettering
[2] https:/ / edutechwiki. unige. ch/ en/ InkStitch_-_embroidery_patch#Creating_rounded_text_paths
[3] https:/ / inkstitch. org/ docs/ lettering/
[4] https:/ / inkstitch. org/ docs/ fonts/
[5] https:/ / youtu. be/ -Kcc970TJxM
[6] https:/ / www. youtube. com/ watch?v=XFFZXgBtNlg

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkStitch_Lettrage_Parametres.png
https://inkstitch.org/docs/lettering/
https://inkstitch.org/docs/fonts/
https://youtu.be/-Kcc970TJxM
https://www.youtube.com/watch?v=XFFZXgBtNlg
https://edutechwiki.unige.ch/en/InkStitch_-_lettering
https://edutechwiki.unige.ch/en/InkStitch_-_embroidery_patch#Creating_rounded_text_paths
https://inkstitch.org/docs/lettering/
https://inkstitch.org/docs/fonts/
https://youtu.be/-Kcc970TJxM
https://www.youtube.com/watch?v=XFFZXgBtNlg
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InkStitch - colonnes satin

Guide de tutoriels de broderie machine

Module: InkStitch

◀▬▬▶
⚐ à améliorer ☸ intermédiaire

⚒ 2022/09/27
Prérequis

•• Inkscape

Autres pages du module

•• InkStitch
•• InkStitch - installation
•• InkStitch - utilisation de base
•• InkStitch - broderie ondulée
•• Inkstitch - textures de remplissage
•• InkStitch - lettrage
•• InkStitch - colonnes satin
•• InkStitch - exemples colonnes satin
•• InkStitch - broder un emoji
•• InkStitch - broder une image issue de The Noun Project
•• InkStitch - broder des codes QR
•• InkStitch - broder des patchs et des appliqués
•• InkStitch - astuces et problèmes courants
•• InkStitch - bases SVG
•• Inkscape - édition des chemins
•• InkStitch - broder avec du gros fil
•• InkStitch - broderies à partir de dessins faits à la main
•• InkStitch - points manuels
•• InkStitch - points programmables
Catégorie: InkStitch

Créer des colonnes satin
Par defaut, Ink/Stitch traduit les contours (traits) en points zig-zag assez laids. Ce zigzag simple fonctionne assez
bien sur les contours sans remplissage comme des lignes encore des polygones fermés comme les cercles.
Les linges pointillés sont traduits en points avant ou triples (voir InkStitch - utilisation de base).
Les colonnes satin, contrairement aux simples lignes zig-zag peuvent avoir des formes irrégulières, par
exemple: le tronc d'un arbre, la jambe d'un cheval ou un serpent qui a mangé un professeur. La création de colonnes
satin requiert quelques travaux préparatoires que nous allons expliquer. Nous allons d'abord introduire le principe
puis le mettre en œuvre dans deux exemples. Une fois que vous aurez parcouru cet article, vous pouvez également
regarder InkStitch - exemples colonnes satin ou encore un article en Anglais, InkStitch - from satin columns to fills
with satin borders.
Certaines copies d'écran nécessitent une mise à jour - Daniel K. Schneider (discussion) 15 mars 2020 à 13:18 (CET)

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Guide_de_tutoriels_de_broderie_machine
https://edutechwiki.unige.ch/fmediawiki/index.php?title=InkStitch_-_textures_de_remplissage
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cat%C3%A9gorie:InkStitch
http://edutechwiki.unige.ch/en/InkStitch_-_from_satin_columns_to_fills_with_satin_borders
http://edutechwiki.unige.ch/en/InkStitch_-_from_satin_columns_to_fills_with_satin_borders
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Utilisateur:Daniel_K._Schneider
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Discussion_utilisateur:Daniel_K._Schneider
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Contraintes physiques
On conseille de travailler avec des colonnes qui font max. 6mm et au moins 1.5mm. On peut descendre avec un fil
fin et une aiguille fine ou encore au bout d'une colonne. Les machines peuvent broder environ 12mm, mais le résultat
sera fragile.

Anatomie des colonnes satin
Une colonne satin est définie par:
• Un seul chemin SVG, également appelé rail
• Contenant deux sous-chemins qui vont dans la même direction. Je les appelle aussi rails (pardon)
• Les deux sous-chemins doivent avoir soit le même nombre de nœuds soit des traverses de direction (Angl.

"rungs"), que nous appelons aussi traverses ou lignes de direction.

colonne satin avec lignes de direction. Les deux rails vont
dans la même direction (flèches rouges). Méthode

recommandée.

Colonne satin sans ligne de direction (même nombre de
nœuds). Déconseillé dans la plupart des cas.

Il est crucial que les deux rails aillent dans la même direction puisque le logiciel relie les nœuds du premier nœud
d'une ligne au premier nœud de la seconde ligne. Si les deux lignes partent de différentes directions les points auront
l'air d'une étoile écrasée par un camion mais pas d'une colonne satin. Dans l'image ci-dessus vous pouvez voir la
direction des lignes. Voir plus loin [[InkStitch - colonnes satin#Invertir la direction des lignes|Invertir la direction
des lignes].
Si vous voulez modifier des objets constitués de plusieurs chemins combinés, utilisez l'éditeur de chemin (tapez F2
ou cliquer sur l'icône Éditer les noeuds).
Comme nous l'expliquerons ci-dessous, ce type d'objet SVG doit être paramétré pour être traduit en colonnes
satin. Si vous voulez travailler sur un exemple, voici un fichier SVG à télécharger.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-satin-31.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-satin-32.png
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Stitch Plan pour une simple colonne satin (quelques lignes de direction supplémentaires ajoutées).
Double-cliquez et "Enregistrez l'image sous".

Direction des rails satin
Problème: Pour qu'Inkstitch fonctionne correctement il faut que les deux rails sous-chemin aillent dans la même
direction.

Sur cette image, les directions sont différentes (symbolisé par les flèches qui ne
vont pas dans le même sens). Dans ce cas, InkStitch ne fonctionnera pas

correctement et les points satin ne seront pas beau.

• Pour voir les directions des lignes, cochez Afficher le sens des chemins sur le contour dans
Edition -> Préférences -> Outils -> Noeud

•• Puis inverser le sens d'une des deux lignes.
Sélectionner la ligne

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-satin-intro-8.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-bad-path-direction.png
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Menu: Chemin -> Inverser (Angl: Path -> Reverse
Ci-dessous, vous pouvez voir un fichier dont les directions de sous-chemin doivent être corrigées. Si vous voyez
quelque chose comme ça, au lieu d'un joli motif en satin, vous n'avez même pas besoin d'inspecter le dessin. Il suffit
de choisir l’un des deux rails et de l’inverser.

Chemin avec un sous-chemin qui a besoin d'être inversé

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-subpath-direction.png
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Début et fin des lignes
Les lignes doivent commencer et finir assez près les unes des autres.
Vous pourrez peut-être créer une ligne satin à partir de lignes fermées, mais cela ne fonctionnera généralement pas.
Cela s'est produit dans l'exemple ci-dessous. Nous vous recommandons donc de couper des formes fermées, par
exemple cercles.

Point satin créé à partir d'une ligne fermée. Ne fonctionnera généralement pas !

Cependant, nous ne recommandons pas de spéculer que cela fonctionnera. Nous vous recommandons que les formes
arrondies, cercles par exemple, soient coupées une fois - au même endroit - comme dans l’image suivante.

Point satin définissant une bordure pour un patch

Les deux rails de cette bordure ont été définis avec 4 points chacun. En plus, nous avons brisé les deux lignes. Pour 
briser des chemins, il faut utiliser l'outil Editer noeuds (F2) et sélectionner le noeud où vous souhaitez 
briser le chemin. Ensuite, cliquez sur Briser le chemin aux noeuds sélectionnés dans la barre

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-stitch-satin-10.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-stitch-satin-40.png
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d'outil de noeud du haut et déplacez le noeud pour créer le petit espace comme sur l'image ci-dessus. Veillez à ne pas
faire un trop grand espace, sinon cela se verra une fois brodé. Si vous êtes intéressé par la création de patch, vous
pouvez suivre ce tutoriel : InkStitch - broder des patchs.

Transformer une ligne en colonne satin
Il existe différentes stratégies pour créer des colonnes satin à partir de lignes simples. La procédure la plus simple
consiste à tracer des lignes épaisses sans remplissage, uniquement un trait, puis à les transformer en colonne satin
avec une commande. Cette opération est irréversible.
Instructions pas à pas

Tout d'abord, créez un dessin:
•• Tracez une ligne qui a une bonne largeur pour les points satin, par exemple. entre 2 et 6mm. Cette épaisseur sera

visible une fois brodée.
•• Sélectionnez cet objet
• Vérifiez qu'il n'y a qu'une seule ligne et non une forme avec trait et remplissages (Menu Objet -> Fond et
contour)

• Utilisez la commande Extensions->Ink/Stitch->Outils de satin->Convertir ligne en
Satin .

Un trait simple (avant) Une colonne satin simple

Ensuite:
• Paramétrez la colonne satin: Extensions->InkStitch->Paramètres

•• Sélectionner l'onglet Colonne Satin
• Cocher Colonne de satin personalisé (Angl. Custom satin column)

Vous devriez voir la simulation. Si elle convient, cliquez sur Appliquer et Quitter (angl. Apply and
Quit)

https://edutechwiki.unige.ch/fmediawiki/index.php?title=InkStitch_-_broder_des_patchs
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-satin-intro-5.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-satin-intro-5b.svg
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Paramétrer point satin

Astuces:
• Lorsque vous convertissez une ligne en chemin satin avec deux rails et des échelons, l'ancien objet est détruit.

Nous vous suggérons d’en faire une copie et de la placer dans un calque "Création" distinct.
•• Si les instructions de point ne vous conviennent pas, ajoutez des échelons supplémentaires, comme expliqué

ci-dessous. En bref: Outil Édition de chemin, Presser la touche MAJ et dessinez des lignes qui coupent les deux
rails.

•• Si vous modifiez le résultat généré, vous devrez probablement ajouter des lignes de direction (voir ci-dessous)
car, de nouveau, les rails doivent avoir le même nombre de points. Courber une ligne ajoutera des points.

La création de points satin à partir de lignes n’est probablement pas l’utilisation la plus courante. Par conséquent,
poursuivez votre lecture et découvrez comment créer des points satin avec des formes différentes de celles des
lignes.

Création de colonnes satin irrégulières
En broderie, la plupart des colonnes de satin sont irrégulières, c’est-à-dire que les rails ne sont pas parallèles. Pensez
aux polices ou aux pétales de fleurs. Pour les créer, un travail supplémentaire sera nécessaire.

Exemple d'un serpent simple
Créons un serpent simple avec un beau point satin

Tracez deux lignes avec l'outil Bézier

•• Pour les débutants, vous pouvez tracer la figure en cliquant, en utilisant l'outil de dessin de Bézier (Maj+F6)
•• Dessiner les deux lignes avec la même direction.
Nous avons quelque chose comme ça:

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-satin-30.png
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Un serpent en devenir. Deux simples chemins

Pour faire un exercice, vous pouvez télécharger le SVG original (cliquez sur l'image jusqu'à ce que vous obteniez le
SVG, puis enregistrez le.

Un serpent pas encore brodable fait de deux lignes(Fichier SVG)

Lissage

Pour créer une ligne plus lisse, sélectionnez-la, puis appuyez sur CRTL-L. Cela fonctionne aussi bien avec la
sélection d'objet normale qu'en mode Éditer le chemin (F2)
Vous pouvez également passer en mode Editer le chemin (F2), puis sélectionner des nœuds simples et les rendre
"doux" ou "Rendre automatiques les noeuds sélectionnés". Jouez avec les icônes de la barre de menu des nœuds en
haut, comme dans la capture d'écran ci-dessus)

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-satin-intro-2.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-satin-intro-2.svg
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Ajout de traverses de direction

Les échelons, qu'on appelle aussi traverses, traverses de direction ou lignes de direction définissent la direction
des points satin. Ajoutez-en autant que nécessaire!
Sans les traverses, le logiciel utilisera des paires de points pour déterminer les directions des points satin. Cela ne
fonctionne que si les deux rails ont le même nombre de points. S'il y a des traverses il prend la direction des
traverses.
Option (a): Ajout rapide de traverses à un seul chemin avec deux lignes

1.1. Si nécessaire, combinez deux lignes en un seul chemin: sélectionnez-les et appuyez sur CTRL-K
2.2. Assurez-vous que le chemin de la colonne satin existante (avec les deux sous-chemins) est sélectionné avec l'outil

Editeur de noeud.(F2)
3.3. Appuyez sur P ou sélectionnez l'outil Crayon.
4. Maintenir enfoncer le touche Maj.
5.5. Cliquez une fois dans la position ou la ligne de direction va débuter (donc hors des 2 rails)
6.6. Cliquez une seconde fois de l'autre côté. La distance n'a aucune importance tant que la ligne de direction ne croise

que 2 rails et rien d'autre.
Assurez-vous vraiment que chaque échelon s'étend sur les deux sous-chemins, i.e. les deux lignes.
Option (b) Ajouter des échelons en tant que chemins séparés, puis combiner

•• Tracez les lignes de direction d'un chemin donné à l'aide de l'outil de Bézier. (click+click+click-droit) ou l'outil
lignes à main levée (click+click)

• Sélectionnez les deux rails + toutes les lignes de direction. Puis appuyez sur CTRL-K(Menu:
Chemin->Combiner)

• Vérifier dans le gestionnaire d'objets (Menu Objet->Objets), qu'il n'y a qu'un seul chemin pour cet objet de
broderie.

Les deux fichiers suivants (que vous pouvez télécharger) illustrent ce principe. Notez également que cette fois le
serpent a un professeur à l'intérieur.

Serpent brodable avec échelon, i.e. lignes de direction (Fichier SVG)

Si vous regardez le fichier SVG, vous pouvez voir que la ligne supérieure a plus de points. Donc, les barreaux vont
également résoudre ce problème.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-satin-intro-4.svg
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Serpent brodable avec échelon et avec les points affichés (Fichier SVG)

Paramétrage

•• Sélectionnez le serpent.
• Menu: Extensions -> Ink/Stitch -> Paramètres
• Selectionner l'onglet colonne satin et cocher "Custom column"
•• Ajoutez une ou plusieurs sous-couches avec les trois autres onglets (ligne centrée, contour ou zig-zag)

Paramétrer un chemin SVG avec deux sous-chemins pour broder en point satin

La fenêtre de paramétrage peut évoluer selon la version. Ci-dessous on montre une ancienne interface an Anglais.
Les commandes "arrêt" et "coupe" ont été déplacées ailleurs.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-satin-intro-4b.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-param%C3%A8tres-de-broderie.png
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Paramétrer un chemin SVG avec deux sous-chemins pour broder en point satin (Interface obsolète en Anglais)

Vous pouvez sélectionner plusieurs objets à paramétrer. Assurez-vous simplement que tous ces objets sont "des
satins", par exemple. deux rails plus des échelons ou deux rails avec le même nombre de nœuds (voir ci-dessous)

Exemple d'une feuille
L'exemple suivant répète la même procédure que celle décrite dans l'exemple serpent, mais le dessin est un peu
différent et nous expliquerons également comment couper une forme fermée et comment traiter la direction des rails
qui doivent être alignés.

Dessiner la moitié de la feuille

•• J'ai utilisé l'outil de Bézier et fait une première version en cliquant. Assurez-vous que le dernier point est inséré
au-dessus du premier.

Briser le chemin - fichier SVG téléchargeable

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-stitch-satin-20.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALeaf-1.svg
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Lissage

•• Mode édition de noeud (F2)
•• Sélectionnez les nœuds supérieurs (pas la ligne plate en bas))
•• Dans la barre des noeuds: Cliquez sur "Lisser les noeuds sélectionnés"
•• Faites des ajustements mineurs si nécessaire.

Briser le chemin - fichier SVG téléchargeable

Créez deux rails en coupant le chemin aux deux extrémités

•• Sélectionnez un point final ou les deux
•• Nœuds Barre de menu: Briser le chemin aux nœuds sélectionnés

•• Répétez avec l'autre extrémité si nécessaire

Briser le chemin, en utilisant l'icône de Briser le chemin dans la barre de menus des nœuds

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALeaf-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALeaf-3.png
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Vérifiez si le chemin est vraiment brisé

• Désactiver le magnétisme (Touche %)
•• Saisissez chaque point final et déplacez-le un peu
•• L'image suivante montre clairement deux sous-chemins.

Briser le chemin - fichier SVG téléchargeable

Ajouter des échelons (Voir ci-dessus pour plus de détails)

Cela va insérer les échelons dans le chemin. Si cela échoue, sélectionnez d'abord les rails, puis les échelons et
appuyez sur CTRL-K
•• Cliquez dans un espace vide, puis sélectionnez la feuille
•• Tapez F2 (Édition de nœud)
•• Tapez la touche "p"
•• Maintenez la touche MAJ enfoncée (tout le temps !!) pendant que vous insérez des échelons
•• Click-click pour chaque échelon

Demi feuille avec colonne satin - fichier SVG téléchargeable (sous-chemin ligne de direction fixé)

• Vérifiez qu'il s'agit d'un seul chemin (Menu Objet->Objets)

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALeaf-3.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALeaf-4.svg
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Invertir la direction des lignes

•• Les directions de lignes sont le plus souvent incorrectes (voir ci-dessus)
• Sélectionnez la ligne en bas et Menu Chemin->Renverser

Ajuster la taille

•• Notre dessin initial est trop grand. Les points de satin ne devraient généralement pas dépasser 6 mm
• Menu Objet->Transformer
•• Sélectionnez mm et redimensionner proportionnellement
•• Réglez la hauteur à 7 mm ou moins

Paramétrer

• Menu Extensions -> InkStitch -> Paramètres
• Selectionnez l'onglet Colonne Satin et cocher Custom satin column
•• Définissez une sous-couche

Demi feuille avec colonne satin - fichier SVG téléchargeable

Créer l'autre moitié de la feuille

•• Masquer le Stitch plan (si vous en avez déjà un)
•• Copier / coller en place la feuille (Menu Edition)
• Menu Objet -> Retourner verticalement
•• Mettre en place
•• Choisir la couleur des traits si cela n'a pas encore été fait
• Menu Extensions -> Ink/Stitch -> Broder

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALeaf-5.svg
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Fin - Ajouter une tige

•• Dans le menu Objets, masquez le stitch plan
•• Sélectionnez le calque de dessin (par exemple, le calque 1)
•• Tracez une ligne et faites en une colonne satin comme expliqué ci-dessus

Demi feuille avec colonne satin - fichier SVG téléchargeable

et apprécier.

Demi feuille avec colonne satin - simulation

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALeaf-6.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALeaf-6.png
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Créer des colonnes satin sans traverses
Comme on a expliqué au début, il est possible de créer des colonnes satin sans les échelons si les deux chemins ont
le même nombre de points.
Reprenons l'exemple du serpent cité ci-dessus qui commence par deux lignes.
(1) Combinez les deux lignes en un seul chemin

•• Sélectionnez les deux lignes
• Menu Chemin -> Combiner, ou CTRL-K
L'image suivante montre le résultat que nous voulons obtenir (après le paramétrage, expliqué ci-dessous) et sa
structure de chemin SVG.

Serpent constitué de deux lignes

Fichier SVG à télécharger (cliquez sur l'image jusqu'à ce que vous voyiez le fichier .svg, puis "enregistrer sous":

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-satin-intro-3.png
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Un serpent fait de deux lignes combinées dans un seul chemin (fichier SVG)

(2) Compter les nœuds

Si le nombre est inégal, ajoutez ou supprimez des points sur un rail.
Pour ajouter des points:
• Cliquez sur l'outil Editer des noeuds (panneau des outils de dessin au dessous de l'outil de sélection) ou cliquez

sur F2 .
•• Sélectionnez deux nœuds ou cliquez sur un segment, puis cliquez sur "Insérer de nouveaux nœuds dans les

segments sélectionnés" pour ajouter un nouveau nœud.
Pour connaître le nombre exact et la position des nœuds, nous vous suggérons la procédure suivante: Copiez l'objet
et placez-le en dehors de la zone de dessin. Sélectionnez cette copie. Menu Extensions -> Visualisation
de chemin -> Numéroter des nœuds ... . Cela remplacera le dessin par de gros points et des chiffres.
Vous pouvez maintenant réparer le dessin original avec l’outil Édition des nœuds, c’est-à-dire ajouter ou supprimer
des points de manière plus éclairée.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-satin-intro-3.svg
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Numérotez les nœuds pour un chemin. À droite, nous pouvons voir le nœud supplémentaire.
Nous pouvons également voir que nous devrions couper les deux lignes depuis le début de la

ligne extérieure (le point 1 en haut est opposé au point 21 et non au point 11 comme il se
doit).

Alternativement (et plus facile), ajoutez simplement des traverses (échelons ou lignes directrices) comme expliqué
ci-dessus.

Optimisation et dépannage
Optimisation

•• Le panneau objets permet de trier les objets dans l'ordre à broder. Il faut minimiser les sauts et essayer de câcher
les fils. Sinon, on peut ajouter manuellement des coupes (à utiliser avec parcimonie)

• L'outil "Auto-route satin" permet d'arranger le routage pour une séries d'objets satin. Certains colonnes vont être
coupés pour cette optimisation. Lire outils satin [1] pour plus d'informations.

Dépannage/vérification

Lorsqu'un message d'erreur apparaît:
• Assurez-vous que chaque colonne satin est définie comme un seul objet: Ouvrez Menu Objet-> Objets et cliquez

sur les objets.
•• Assurez-vous que les rails ont des échelons et que les échelons coupent les rails et qu'ils ne se croisent pas
•• Assurez-vous que les rails ne se croisent pas
Lire InkStitch - astuces et problèmes courants

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape-number-nodes.png
https://inkstitch.org/fr/docs/satin-tools/


InkStitch - colonnes satin 84

Liens
• InkStitch - exemples colonnes satin (Suite de cet article qui contient quelques exemples supplémentaires)
•• en:InkStitch - satin columns
• Satin Tools [2]

Copyright modification
Contents of this page including pictures and SVG files are also available under the GNU Free Documentation
License [3] and the Attribution 4.0 International (CC BY 4.0) [4] license.
The Inkstitch project [5] can use any element (text fragments, SVG files, pictures) for the project's official docs
without giving attribution (just copy and paste).
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[3] http:/ / en. wikipedia. org/ wiki/ Wikipedia:Text_of_the_GNU_Free_Documentation_License
[4] https:/ / creativecommons. org/ licenses/ by/ 4. 0/
[5] https:/ / github. com/ lexelby/ inkstitch/ i
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Introduction
Cet article contient quelques exemples qui montrent comment créer des colonnes satin. Avant de les regarder il faut
maîtriser les concepts et techniques expliqués dans l'article InkStitch - colonnes satin !

Exemple de la fusée
Comparons une fusée brodée rapidement à une autre qui utilise les points satin appropriés. Nous allons partir d'une
petite fusée [1] de OpenClipArt. Il existe plusieurs autres variantes de cette, e.g. icône de fusée [2]par pitr que nous
avons utilisé ici [3]. Les procédures expliquées ci-dessous ont été conçues pour une première version de Ink / Stitch
et pourraient être simplifiées un peu depuis la version 1.16. C'est à dire qu'on pourrait utiliser le convertisseur en
colonne satin.

Nettoyage du fichier SVG

Source: Rocket Ship as Clip Art
[1] (SVG file), à nettoyer

Source: Fusée en Clip Art [1],
mais néttoyé (SVG file)

Source: Broderie simple
(image)

Le dessin est assez simple. Afin de traiter cela avec Ink/Stich
•• Tout dégrouper
• Créer un nouveau calque, appelé 'Dessin de fusée'
•• Mettez tous les éléments dans ce calque.
•• Ouvrez l'éditeur XML, cliquez sur chaque élément et supprimez environ 6 éléments inutiles situés sous les

fenêtres. Le fichier SVG résultant doit avoir uniquement six objets.
•• Les ailes se chevauchent avec le corps de la fusée, mais gardons cela pour le moment.
C'est maintenant (du moins pour la version 1.7x que nous discutons ici) important de suivre toutes les étapes sur
le SVG avant de configurer les paramètres de broderie. Sinon, vous pouvez avoir des instructions contradictoires
dans vos objets. Si le processus de broderie échoue avec un message d'erreur, essayez de supprimer tous les
paramètres de broderie dans l'éditeur XML. Créez une copie de votre fichier SVG et enregistrez-le. Personnellement,
je fais "enregistrer le fichier sous" avant chaque opération majeure. De cette façon, je peux facilement redémarrer à
partir d’une version précédente.
Vous pouvez maintenant numériser comme indiqué ci-dessus. Cependant, si vous voulez de jolis points de satin,
supprimez tous les remplissages et transformez les traits épais en traits doubles. Séparons d'abord les remplissages et
les traits. Nous allons faire cela de la manière suivante:

https://openclipart.org/detail/261329/rocket-ship-as-clip-art
https://openclipart.org/detail/22539/rocket-icon
https://edutechwiki.unige.ch/en/Stitch_Era_-_creating_embroidery_with_hot_fix_stones
https://openclipart.org/detail/261329/rocket-ship-as-clip-art
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ARocket-ship-Clip-Art.svg
https://openclipart.org/detail/261329/rocket-ship-as-clip-art
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ARocket-ship-Clip-Art2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-stitch-satin-simulation-2.png
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•• Tout sélectionner
• Copier et coller en place. Édition-> Copier puis Menu Édition-Coller en place. Nous avons maintenant 12 objets

au lieu de 6.
• Déplacez tous les nouveaux objets vers un nouveau calque appelé Remplissages de fusée (sélectionnez ces six

dans l'outil Objets (Menu Objet-> Objets), puis utilisez le menu Calques pour les déplacer)
• Verrouillez le calque appelé Remplissages de fusée .
• Supprimer tous les remplissages des objets situés dans le calque 'Dessin de fusée'
•• Verrouillez maintenant ce calque des coups de fusée et supprimez ceux des objets situés dans le calque

"Remplissages de fusée".
La structure d'objet résultante devrait ressembler à ceci:

SVG avec des remplissages purs et des traits purs Fusée avec des calques séparés
à télécharger (fichier SVG)

Ceci peut maintenant être brodé directement comme indiqué dans l'image ci-dessus. Cependant, vous pouvez
remarquer les points de satin plutôt laids.

Création de points satin avec des dessins manuels
Comme on l'a vu dans l'exemple "serpent" ci-dessus, les points de satin sont créés à partir de deux lignes comportant
le même nombre de points. Il existe plusieurs façons d’y parvenir à partir d’un dessin existant. Dans tous les cas,
vous devrez effectuer des adaptations. En outre, le résultat peut échouer. Si vous ne vous sentez pas à l'aise avec
l'utilisation ou l'apprentissage d'édition de chemin plus avancée, vous pouvez simplement faire des dessins à la main.
Nous suggérons la procédure suivante:
•• Verrouiller le calque de remplissage mais le garder visible
•• Créer un nouveau calque
•• Dessinez les lignes comme expliqué dans "l'exemple de serpent ci-dessus". Utilisez (au moins provisoirement)

une couleur différente de celle des dessins.
Le résultat semble correct, mais je n’ai pas pris le temps de faire des ajustements mineurs car j’ai passé trop de temps
à la tentative décrite ci-dessous).

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-stitch-satin-1.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ARocket-ship-Clip-Art3.svg
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Fusée brodable. Double cliquer
pour obtenir le SVG

Fusée brodable. Simulation de broderie

Transformer les traits en deux lignes de sous-chemin pour les points satin
Passons maintenant à la procédure plus complexe consistant à transformer des éléments graphiques existants
(chemin SVG) en chemins pouvant être broder en tant que chemin satin. Rappel:
•• Un chemin doit avoir deux sous-chemins, chacun avec le même nombre de nœuds qui doivent être

approximativement alignés
•• Chaque sous-chemin doit aller dans la même direction (voir les explications plus loin)
•• Les formes fermées doivent être brisées, car InkScape ne permet pas de définir un nœud de départ.
Voir cette vidéo : https:/ / inkstitch. org/ tutorials/ lex-neva-video-tutorial-1/

Avant de commencer

•• Cachez le calque "Remplissage" et verrouillez-le. C'est à dire que vous devriez seulement voir les traits!
•• Déverrouiller le calque "Dessins" s'il était verrouillé

Simplifier le dessin et réduire les chevauchements

Simplifier le dessin

supprimer tous les points supplémentaires qui ne sont pas nécessaires (mais vous pouvez le faire plus tard). InkScape
peut vous aider avec cela (appuyez sur CTRL-L, mais pas trop de fois, sinon utilisez CRTL-Z pour annuler)
Supprimer les chevauchements les plus grands

Dans une prochaine étape, nous devrons couper la partie des ailes qui chevauchent le corps de la fusée. Un moyen
facile de le faire est d'utiliser à nouveau la soustraction.
•• Masquer les zones de remplissage
• Copier / coller en place le corps de la fusée. Le moyen le plus simple consiste à ouvrir le "panneau Objets" (objet

Menu> Objets), à sélectionner le corps, puis à le dupliquer.
•• Sélectionnez l'aile gauche puis le corps (maintenez la touche MAJ enfoncée).
• Menu: Chemin -> Différence
• Répétez cette opération pour l’aile droite, c’est-à-dire que vous dupliquez d’abord le corps, puis vous le

soustrayez.
Transformer le tracé des traits en tracé à deux lignes

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ARocket-ship-Clip-Art9.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-satin-8.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-rocket-result.jpg
https://inkstitch.org/tutorials/lex-neva-video-tutorial-1/
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Pour obtenir deux traits (lignes) au lieu d'un seul trait gras, nous pouvons traduire un chemin en chemin avec des
remplissages et des contours. Une autre alternative serait d'utiliser des décalages(contraction ou étirements). De toute
façon, une procédure générale est la suivante
•• Sélectionnez tous les traits: CTRL-A (les remplissages doivent être masqués)
• Menu Chemin -> Contour en chemin
Maintenant, faites les traits très fins et enlevez le remplissage.
•• Tout sélectionner (CTRL-A)
• Menu Objet -> Remplissage et contour
•• Supprimer les remplissages
•• Réglez les contours sur 1px
Réparer les ailes
• Malheureusement, les ailes ne se chevauchent pas complètement avec le corps et il y a des débris à enlever. Vous

devez vous efforcer d’obtenir deux lignes simples pour chaque aile, comme indiqué dans l’illustration ci-dessous.
•• Faites glisser les deux ailes.
•• Sélectionnez l'outil édition de chemin
•• Supprimez les nœuds superflus
•• Supprimez des segments au bout des deux ailes
•• (Peut-être) transformer les angles vifs en un nœud doux symétrique.

Nettoyer le corps de la fusée

• Maintenant, assurez-vous que vous avez le même nombre de nœuds dans les lignes externe et interne. Pour ce
faire, nous suggérons de supprimer les nœuds plutôt que d’en ajouter de nouveaux. Lorsque vous essayez de
broder un chemin comportant deux sous-chemins de longueur de nœud différente, InkStitch se plaindra et vous
indiquera le nœud à réparer. Rappelez-vous cela pour plus tard.

•• Aligner les nœuds externes et internes (à peu près)
•• Assurez-vous également qu'aucun noeud ne se trouve au-dessus d'un autre. Vous pouvez le savoir en déplaçant

chaque nœud puis - si tout va bien - le remettre en place en appuyant sur CTRL-Z
•• Rendez le haut intérieur un peu moins aigu (faites-en un noeud symétrique)
Si vous essayez de broder maintenant, vous obtiendrez de très mauvais résultats, car les chemins intérieur et
extérieur vont dans une direction opposée.
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Chemins qui ne fonctionneront
pas correctement (cliquez pour

télécharger SVG)

Tentative échouée. InkStitch
associe les mauvaises lignes (le

corps seul est montré).

Corriger les directions de chemin

Problème: pour que InkStitch fonctionne correctement, les deux sous-chemins doivent pointer dans la même
direction. Dans notre cas, ils ne l'étaient pas.

Les directions de chemin sont différentes dans les deux sous-chemins

• Pour voir les directions, définissez Afficher la direction du trajet sur le contour dans
Edition -> Préférences -> Outils -> Nœud

•• Inversez par exemple la ligne suivante:
Menu: Chemin -> Inverser

Dans notre exemple, chaque chemin avait un mauvais sous-chemin, par exemple. la trajectoire interne allait dans le
sens des aiguilles d'une montre et la trajectoire externe dans le sens inverse des aiguilles d'une montre.

Fixer le point de départ

Problème: le zizag du point satin fonctionne maintenant, mais il est mal orienté.
• Les chemins fermés n'ont pas de point de départ et vous ne pouvez pas en définir un. En conséquence, Inkstitch

associera des points "aléatoires", c’est-à-dire commencera à utiliser le premier noeud trouvé dans la définition du
chemin (nous pensons). Pour résoudre ce problème, nous allons briser le chemin fermé de la coque et des trois
fenêtres.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ARocket-ship-Clip-Art6.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-stitch-satin-7.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-bad-path-direction.png
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•• Utilisez l'outil édition de chemin (edit path by node ou F2) pour sélectionner deux nœuds, un pour chaque
sous-chemin, puis briser le chemin (voir la figure ci-dessous).

Impossible de définir un point de
départ dans un chemin fermé

Briser le chemin à un noeud

Paramétrons séparément les calques de trait et de remplissage.
•• Cacher et verrouiller un calque avant de travailler sur l'autre.
• Dans le menu contextuel Inkstitch -> Paramètre, faites en sorte que tous les chemins de la couche de traits

utilisent des points satin, si ce n'est déjà fait. De plus, nous suggérons d’ajouter au moins une sous-couche centrale
car cela stabilisera un peu le tissu.

Le résultat ressemble à ceci::

Fusée brodable (cliquez pour
télécharger SVG)

Simulation de point (comme vu dans le logiciel Stitch
Era)

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-stitch-satin-12.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-break-path.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ARocket-ship-Clip-Art12.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Tutoriels_Stitch_Era
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Tutoriels_Stitch_Era
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-stitch-satin-13.png
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Sommaire
La création de points satin à partir de dessins existants nécessite un effort supplémentaire. Il y a peut-être moyen de
le faire plus rapidement, mais nous n’avons pas réussi à le trouver jusqu’à présent. Ainsi, dans certains cas, nous vous
recommandons de dessiner à la main deux lignes définissant des points satin. En fait, tout dépend de vos
compétences en dessin ou en édition de nœuds respectifs. Personnellement, je suis meilleur en montage qu'en dessin.
Créer des remplissages et des lignes à partir de traits en pointillés fonctionne bien et ne nécessite aucune préparation
particulière.
Les points de coupe ne semblent pas fonctionner dans tous les cas, mais ce n'est pas un problème majeur. Quoi qu'il
en soit, la plupart des personnes utilisant InkStitch ne disposent probablement pas de machines à aiguilles multiples
et préfèrent couper le fil au lieu de le ré-enfiler.

Exemple: Un oiseau avec des lignes directrices (échelons)
Sans surprise, les directions des lignes en zigzag dans l'exemple suivant ne sont pas très belles. Alors réparons-les.

Modèle d'oiseau rond (fichier SVG). Source Liv Iko
[4] (Noun project)

Oiseau rond sans lignes directrices

Oiseau rond sans lignes directrices

Afin d'indiquer à InkStitch comment orienter les points satin, nous ajoutons maintenant des "échelons" (ou lignes
directrices) dans chaque chemin pouvant être cousu, comme expliqué ci-dessus.
Nous avons également fixé le point de départ de la tête et ajouté un œil. Le résultat ci-dessous semble déjà beaucoup
mieux.

https://thenounproject.com/liv_iko/collection/birds/?i=898697
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ARound-bird-1.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkStitch-round-bird-1.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkStitch-round-bird-1b.png
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Oiseau rond avec lignes directrices
Oiseau rond avec lignes directrices, Fichier DST

Tajima

Quelques points supplémentaires à tuer (non nuisibles)

Simulation Brother PES (InkStitch V.1.8.1) Fichier de modèle d'oiseau rond (fichier SVG) à
télécharger

Si vous aimez cet oiseau, vous pouvez le modifier. Cependant, si vous le publiez, merci de mentionner le design
original. (Liv Iko [4]). En outre, vous devez savoir que ce motif est vraiment petit (moins de 3 cm), le broder
correctement peut être un peu difficile.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkStitch-round-bird-2.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkStitch-round-bird-2b.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkStitch-round-bird-2c.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkStitch-round-bird-2e.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ARound-bird-2.svg
https://thenounproject.com/liv_iko/collection/birds/?i=898697


InkStitch - exemples colonnes satin 93

Exemple: AC/DC
(texte en construction, l'exemple marche, mais il faudrait le relire et clarifier 2-3 points)
L'image SVG que l'on retrouve dans Wikipedia Commons a une bonne taille, environ 13 x 5 cm et la qualité du SVG
est bonne.

Logo ACDC, image incluse de Wikipedia

La broder avec un motif de remplissage est simple et créer le fichier de broderie prend moins d'une minute (Il faut
juste tout sélectionner, ensuite paramétrer une sous-couche (underlay):

Logo ACDC, simulation de broderie avec un simple remplissage

Essayons maintenant de créer une broderie un peu plus sophistiquée avec des points satins autour de chaque lettre et
un remplissage rouge.
Premièrement on conseille d'ajouter un peu marge dans le document, car les bordures satin vont agrandir le tout.
• File -> Document Properties -> Resize File to Content et ajouter 5mm pour les 4 bords

par exemple
On va créer deux types de broderies pour cet objet : un remplissage et des bordures en satin. Il faut donc dupliquer le
groupe d'objets, un pour le remplissage et l'autre pour les bordures:
• Ouvrir le panneau Object -> Objects
•• Cliquer sur le chemin regroupant tous les sous-chemins (ex : g12 pour nous qui comprend 5 chemins -path10,

path8, path6, path4, path2- correspondants aux lettres et à l'éclair).
•• CTRL-C
• CTRL-ALT-V (Edit->Paste in Place)
Nous obtenons deux groupes d'objets comme suit :

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALogo_ACDC.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALogo_ACDC.png
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Collage sur place : 2 groupes d'objets sont visibles

Séparer ensuite ces objets dans deux
calques :
•• Ouvrez l'outil "calque" (pour créer

un calque : Shift + CTRL + L)
•• Créer deux calques en appuyant sur

"+" à chaque fois. Nommez ces
calques "remplissage" et "bordures"

• Déplacer ensuite les objets dans
chacun des calques : clic droit >
Move to layer > choisir
"remplissage" ou "bordures".

•• Cacher (fermer l'icône "l'oeil") et
verrouiller (fermer l'icône "cadena")
le groupe "remplissage" (cf. image

ci dessous)

Déplacements dans les calques puis cacher & verrouiller le calque "remplissage"

Créer des objets pour
bordures satin (variante A)

Cette méthode consiste à transformer
les contours en chemins qui définiront
ensuite les colonnes satin.
D'abord on enlève le remplissage pour
toutes les lettres et on définit un
contour:

•• Cliquer sur le groupe "bordures" (i.e le groupe qui n'a pas été cacher / verrouiller).
•• Enlever le fond (fill)
•• Mettre du contour (stroke paint) et le définir à 2mm (stroke style)
• Ensuite (différent de la variante B) on transforme ces bordure en chemin: Path -> Stroke to Path
Cela nous crée déjà les "rails" pour la colonne satin c'est à dire qu'au lieu d'avoir des traits comme bordure on a des
chemins avec deux traits.
Maintenant il faut transformer ces chemins en rails pour broderies.
Commencez par :
•• Dégrouper les objets
•• Définir un contour fin pour mieux voir
Les lettres A et D contiennent des sous-chemins à l'intérieur et il faudrait donc les séparer en plusieurs objets pour
pouvoir créer des lignes satin. A notre connaissance il n'y a pas de méthode simple pour cela. Autrement dit, on ne
sait pas comment sélectionner un sous-chemin et créer un nouveau chemin. On suggère de copier/coller sur place les
lettres et ensuite enlever des noeuds.
•• Sélectionner le D
•• Copier coller à l'endroit ("coller sur place") et renommer le premier objet en D1 et la copie en D2
•• Sur l'un retirer l'intérieur et sur l'autre retirer l'extérieur de la lettre.
Créer le D
•• Cacher D2
•• Sélectionner D1

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AAcdc_2groupes-objets.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AAcdc_calques_verrouiller&cacher.jpg
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•• F2 (edit path by node)
•• Sélectionner l'objet à l'intérieur du D et touche DEL.
Vous avez D1, l'extérieur du D
Maintenant la même chose pour D2
•• Cacher D1
•• Afficher D2
•• F2 (edit path by node)
•• Tuer les points à l'extérieur, cela prend un peu plus de temps.
Vous avez D2, l'intérieur du D
Pour le A: Il faut faire pareil pour le A, mais c'est un peu plus compliqué et on risque de faire des erreurs. Donc on
suggère de faire une copie de sauvegarde du fichier actuel.
•• Sélectionner l'objet A et dupliquer la lettre
•• Ensuite pour chaque "A" (extérieur et deux objets intérieurs) détruire les points comme pour le D.
•• Il faut transformer certains points en points "coin" si le dessin "part" dans tous les sens. En fait, dans ce logo, tous

les points devraient être de type coin, car il n'y a que des droites qui les relient.
•• Il ne faut pas laisser traîner des points dans le vide.
Ensuite, triez les lettres dans l'ordre de brodage (gauche à droite par exemple)

Créer des objets pour bordure satin (variante B)
Au lieu de transformer d'abord les traits en chemins avec deux traits vous pouvez:
•• commencer par créer les objets A1, A2, A3 etc.
•• Ensuite, il faut briser ces contours un endroit donné, écartez les points brisés, sinon Ink/Stitch risque de créer des

coupures à des mauvais endroits ! Vous pourrez toujours ajuster les rails qui résultent de l'opération
• Ensuite, utiliser l'outil Satin tools -> Convert line to satin, pour chaque objet (CTRL-A)
•• Ensuite réparer des choses si nécessaire, notamment des échelons mal placés (dans la lettre A par exemple) et

encore les coupures mal faites.
Le résultat (sans remplissage et sans ajustements):

Logo ACDC, versions "satin tools", fichier SVG téléchargeable

Fichier:Lego-face.svg Cette méthode est un peu plus simple (à condition d'écarter bien les noeuds coupés), mais la
qualité est moins bonne que la solution A avec des échelons ajoutés manuellement.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALogo_ACDC-B3.svg
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Créer des satins
Maintenant on huit objets bordures à créer (3 pour le A, C, la flèche, deux pour le D, et encore un C
Pour chacun de ses objets:
•• Sélectionner
•• Enlever le remplissage
•• Définir un contour fin si c'est pas déjà fait
•• Briser les chemins à un endroit (dans les deux rails)
•• Soit égaliser le nombre de points, soit ajouter des échelons
•• Aligner les directions des rails.
A ce point vous pouvez simuler le résultat et corriger éventuellement les directions, ou briser les rails à un endroit
donné ....

Créer le remplissage
Le remplissage a maintenant un chevauchement avec la bordure, ce qui est très bien (on verra si le résultat de
broderie sera bien)
•• Cacher le groupe "bordures"
•• Option: Choisir une couleur (rouge)
•• Sélectionner "remplissage"
•• Remplir et définir une sous-couche.

Simuler ou broder

Logo ACDC, première version, fichier SVG téléchargeable Logo ACDC, première version (simulation avec Ink/Stitch)

Logo ACDC, première version (simulation avec Ink/Stitch)

Logo ACDC, première version (simulation avec Wings)

A faire:

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALogo_ACDC-3.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALogo_ACDC-4.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALogo_ACDC-4a.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALogo_ACDC-4b.png


InkStitch - exemples colonnes satin 97

•• Diviser la flèche en deux pour mieux gérer le zigzag de la pointe. On voit dans la simulation que le rouge dépasse.
Alternativement on peut diminuer la surface du remplissage, mais cela ne résout pas le problèmes de gros points
utilisées en bas de la flêche.

•• Ajouter des lignes de direction un peu partout.
•• Écarter légèrement les objets, car la bordure a agrandi les lettres, mais avec délicatesse....
•• Broder pour voir le résultat.

Exemple: lego face
Réalisation d'une broderie à partir du design d'une "tête de lego". Le design original a été réalisé par Musket pour le
site Nounproject [5].

Tête de lego, fichier SVG téléchargeable

Inspection du fichier

Menu objet > objets

Lors de l'ouverture du fichier, les premières
constatations sont :
•• Un design très petit : moins d'un

centimètre de côté mais que nous
pourrons redimensionner.

• Un fichier qui doit être nettoyé : le menu
Object > Objects montre que le
design est fait de deux chemins
principaux (ici, g20 et g12) et de
plusieurs sous-chemins dont certains
pourront être retirés (cf.image ci-contre).

Nettoyage du fichier

Cette opération consiste à retirer les
inscriptions (i.e nom de l'auteur) et les chemins inutiles. Pour finir, nous mettrons au même "niveau" les chemins
(pas de "groupe").

https://thenounproject.com/search/?q=lego%20face&i=106256
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALego-face.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALego-face_objets.jpg
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Pour :
• retirer les inscriptions : cliquer sur les inscriptions puis sur la touche SUPPR . Parfois, vous devrez dégrouper

l'image avant de pouvoir les supprimer. Pour cela, cliquer sur l'objet puis Object > Ungroup .
• retirer les chemins inutiles : ouvrir le menu object > Objects . Une fenêtre apparaît comme dans l'image

ci-dessus. Pour avoir une visualisation de tous les chemins, cliquer sur les + pour déplier tous les chemins.
Cliquer ensuite sur chaque sous-chemin (i.e le plus bas niveau de chemins) pour voir si celui-ci est utile ou s'il
peut être supprimé. Si le chemin peut être supprimé, appuyez sur SUPPR.

•• réorganiser les chemins de façon à ce qu'ils soient au même niveau. Pour cela, cliquez glisser jusqu'au niveau
supérieur (les fléchages ont tendance à ne pas fonctionner).

A la fin de ce nettoyage, nous constatons que le chemin nommé path2 comporte le visage et les cheveux. Il faut donc
séparer le chemin en cliquant sur path > break apart (séparer) . A la suite de l'opération, 3 chemins
supplémentaires sont visibles (cf. image ci dessous).

"nettoyage du design"

Ensuite, en théorie, il est possible de faire path (chemin) > exclusion (exclusion) afin de créer un
nouveau chemin composé de plusieurs sous-chemins selon une règle de remplissage pair-impair (voir http:/ /
tavmjong. free. fr/ INKSCAPE/ MANUAL/ html/ Paths-Combining. html). Cependant, pour ce modèle, la technique
la plus simple consiste à repérer les différents chemins et à supprimer les chemins que l'on considère comme inutile
pour la broderie (cf.image ci-dessous).

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALego-face-cleaning.jpg
http://tavmjong.free.fr/INKSCAPE/MANUAL/html/Paths-Combining.html).
http://tavmjong.free.fr/INKSCAPE/MANUAL/html/Paths-Combining.html).
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Suppression de 2 chemins

Ensuite, retirer le remplissage (fill) et mettre des contours (stroke) au visage et aux cheveux pour obtenir ce design:

Pour finir, donnons à cette image une taille raisonnable puisque, pour rappel, elle est actuellement inférieur à 1cm.
Puisque nous avons pour objectif de broder sur des badges de 60 mm, nous prévoyons un design de maximum
50mm. Pour cela, nous sélectionnons l'ensemble du dessin (CTRL + A), fermons le cadenas (cf. image ci dessous)
pour garder les proportions et tapons 50 dans le champ H (High) pour avoir une hauteur de 50 mm. La largeur étant
de 47 mm, l'ensemble est satisfaisant.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALego-face-cleaning2.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AFichier-nettoye.jpg
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Redimensionnement en mm

Ensuite, réajuster la zone au dessin obtenu dans propriétés du document > ajuster la page au
contenu en laissant une marge de 5 mm environ.

Traitement du dessin pour la broderie
Pour ce dessin, nous voulons :
•• Une colonne satin pour le "contour" des cheveux et du visage
•• Un simple remplissage simple pour l'"intérieur" des cheveux, du visage, des yeux et de la bouche.
Cela fait donc deux types de points à générer : points de remplissage et points satin (pour plus de détails sur les
points de broderie, voir en:Embroidery stitch type).
Nous avons choisi de traiter le dessin en 2 parties: points de remplissage et points satin (pour en savoir plus sur
l'utilisation des calques, consultez http:/ / tavmjong. free. fr/ INKSCAPE/ MANUAL_v14/ html_fr/ Layers. html).
Voici une capture d'écran :

création de deux calques

Pour ce dessin, deux types de traitement :
•• les yeux et la bouche feront l'objet d'un traitement
•• les cheveux et le visage d'un autre type de traitement
A ce stade, nous décidons de supprimer la ligne en dessous du visage qui n'apportera pas grand chose à l'exemple.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALego-face_redimensionnement.jpg
http://edutechwiki.unige.ch/en/Embroidery_stitch_type
http://tavmjong.free.fr/INKSCAPE/MANUAL_v14/html_fr/Layers.html).
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALego-face-layers.jpg
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Yeux et bouche

Pour les yeux et la bouche, nous avons choisi un remplissage simple :
• Sélectionner les 3 éléments en appuyant sur la touche MAJ(soit directement dans le dessin soit via le menu
object > objects puis lancer l'application Inkstitch via Extensions > Inkstitch > Params .

•• Le lancement de cette extension à ce stade génère le message d'erreur ci-dessous:

forme non valide

Ce problème est décrit dans la page en:InkStitch - tips and trouble shooting, paragraphe shape is not valid. Pour
résoudre le problème, nous décidons d'adoucir les noeuds (smooth).
Pour cela, suivez la procédure suivante (cf. image ci-dessous)
•• cliquer sur les deux yeux en maintenant la touche CTRL enfoncée
•• cliquer sur l'éditeur de noeud
•• sélectionner ensuite les noeuds
•• cliquer sur adoucir les noeuds
• relancer ensuite la commande extension > Inkstitch > params
•• ajouter un underlay (pas obligatoire) et mettez à 30° les points (pour une question esthétique).

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALego-face-trouble-shooting.jpg
http://edutechwiki.unige.ch/en/InkStitch_-_tips_and_trouble_shooting
http://edutechwiki.unige.ch/en/InkStitch_-_tips_and_trouble_shooting#path815:_erreur_:_Fill:_Shape_is_not_valid._This_can_happen_if_the_border_crosses_over_itself


InkStitch - exemples colonnes satin 102

Adoucir les noeuds

Cheveux et visage

Pour les cheveux et le visage, il s'agit du même traitement. Nous
expliquerons donc ici comment procéder pour les cheveux, il
suffira de reproduire pour le visage. Pour les cheveux, nous
souhaitons réaliser un remplissage ET un contour en satin. Comme
mentionné dans la page en:Inkstitch - basic use, il faut traiter le
remplissage et le contour séparément.

Nous allons commencé par copier-coller la forme de la chevelure
sur place :
•• Sélectionner l'objet avec le sélectionneur d'objet,
• Copier l'objet : CTRL + C pour copier (ou Edition >
copier ),

• Coller sur place (i.e exactement au même emplacement que l'objet actuel) en faisant Edition > coller
sur place ).

Désormais, il y a deux objets identiques l'un sur l'autre. Vous pouvez déplacer un peu l'objet pour le constater (pour
le remettre en place, CTRL + Z). L'un des objets sera utilisé pour le contour et l'autre pour le remplissage.
A cette étape, afin d'y voir plus clair, il peut être utile de transférer l'un des objets dans le calque nommé
remplissage:
•• Créer un calque "remplissage" et un calque "contour".
•• Cliquer sur l'objet
• Clic-droit puis Déplacer vers le calque ...
•• Une fenêtre s'ouvre afin que vous sélectionniez le calque vers lequel l'objet doit être transférer. A cette étape,

l'utilité du nommage des calques prend son importance pour éviter de se disperser.
• Le second objet est à mettre dans le calque nommé contour si cela n'est pas fait. Pour visualiser les choses, ouvrez
Object > Objects et vous pourrez constater où sont vos objets (cf. image ci-dessous). Vous constaterez que
le second objet crée par un coller sur place a un nom presqu'identique au premier objet, ce qui peut être
d'une aide quand il existe de nombreux chemins.

Collage sur place: deux objets présents, chacun dans un calque

Pour le remplissage :
•• Ajouter du remplissage (fill) et

retirer le contour (stroke).
• Extension > Ink/Stitch >

Params . Nous constatons que rien
ne se passe et si l'on referme la
fenêtre, la même erreur que
précédemment est générée (cf. page
en:InkStitch - tips and trouble
shooting, paragraphe shape is not
valid. Finalement, le nombre de
noeuds indique 9 (extension >
visualiser le chemin > nombre de
noeuds) alors que nous en comptons
8. L'utilisation de l'outil

d'adoucisseur de noeuds n'est pas très concluante, nous décidons donc de bouger un petit peu la forme sur les 
côtés et relancer l'extension Ink/Stitch, ce qui fonctionne; le déplacement des noeuds de l'objet a généré une

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALego-face_smooth.jpg
http://edutechwiki.unige.ch/en/Inkstitch_-_basic_use
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALego-face_coller-sur-place.jpg
http://edutechwiki.unige.ch/en/InkStitch_-_tips_and_trouble_shooting
http://edutechwiki.unige.ch/en/InkStitch_-_tips_and_trouble_shooting
http://edutechwiki.unige.ch/en/InkStitch_-_tips_and_trouble_shooting#path815:_erreur_:_Fill:_Shape_is_not_valid._This_can_happen_if_the_border_crosses_over_itself
http://edutechwiki.unige.ch/en/InkStitch_-_tips_and_trouble_shooting#path815:_erreur_:_Fill:_Shape_is_not_valid._This_can_happen_if_the_border_crosses_over_itself
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nouvelle forme donc le 9e noeud peut être lu par Ink/Stitch.
Pour le contour :
•• Reprenez la copie que vous avez déplacer dans le calque contour.
•• Mettre le style de contour à 2 mm (au moins). Il est possible d'aller jusque 6 mm environ.
•• Cliquer ensuite sur l'éditeur de noeud (edit path by node)
• Sélectionner un noeud puis coupez-le en cliquant sur couper le chemin du noeud sélectionné

(voir 1. dans la figure ci-dessous)
•• Séparez ensuite le noeud coupé (cf. 2) afin que Ink/Stitch puisse avoir un point d'entrée et un point de sortie.

couper et séparer le noeud

• Cliquez ensuite sur Extension
> InkStitch > Outil

satin > Convertir ligne

en satin . Vous devriez obtenir
un ligne hachurée (cf. image ci
dessous).

• Lancer ensuite Extension >
InkStitch >paramètres et
ajouter un zigzag underlay.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALego-face_satin.jpg
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Conversion en ligne satin

Pour le visage, procédez de la même
manière, vous devriez avoir à la fin des
opérations ceci :

Lignes satin

NOTE : ceci est une manière de faire pour
les besoins de ce tutoriel mais vous auriez
très bien pu traiter les formes semblables
ensemble (i.e les lignes satin ensemble et les
remplissages ensemble).

Préparation du fichier de broderie

Préparer le fichier pour la broderie signifie :
1.1. Organiser l'ordre de broderie
2.2. Transformer en fichier de broderie

Organiser l'ordre de broderie

Le plus simple est d'ouvrir Object >

Objects et d'organiser les choses à partir
de ce menu. Contrairement a ce que l'on
pourrait penser, l'affichage est dans le sens
inverse pour la broderie. Cela signifie que
les objets seront brodés de bas en haut. Il

faut donc organiser en conséquence c'est à dire :

•• le remplissage doit être broder en premier,
•• les yeux et la bouche en second,
•• les lignes satin à la fin.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALego-face_satin2.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALego-face_satin3.jpg
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Pour être sûr-e de l'ordre de broderie, vous pouvez lancer une simulation avec Extension > Inkstitch >
simulate

Transformer en fichier de broderie

Il faut dans un premier temps vous renseigner sur les fichiers que la machines acceptent. Pour notre Brother
PR1050X, nous pouvons exporter en *.taj et en *.pes. Le plus simple est d'enregistrer sous le format souhaité :
File > save as puis sélectionner le format qui vous intéresse (cf. image ci-dessous)

Broderie

Fichier vectoriel Simulation broderie

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Brother_PR1050X
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Brother_PR1050X
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch_format-broderie.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALego-face-final.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASimulation-lego-face.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALego-face-broderie.JPG
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Trucs et astuces

Retourner des colonnes de satin
Les points de satin commencent sur un rail. Dans certains cas, vous souhaitez changer de "gauche à droite",
c'est-à-dire commencer à broder à partir de l'autre rail.
•• Sélectionnez l'objet
• Utiliser les extensions -> Ink/Stitch -> Outils Satin -> Invertir les rails de satin
Exemple:

Colonnes satin retournées. Fichier avec deux objets identiques. La colonne de gauche
commence en haut "gauche". La colonne de droite commence en haut "droite"

fichier de conception Paramétré et brodé

Simulation

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-flipped-columns.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-flipped-columns-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-flipped-columns-2.png
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Dépannage
• Assurez-vous que chaque colonne satin est définie comme un seul objet: Ouvrez Menu Objet-> Objets et cliquez

sur les objets.
•• Assurez-vous que les rails ont des échelons et que les échelons coupent les rails et qu'ils ne se croisent pas
•• Assurez-vous que les rails ne se croisent pas
Lire InkStitch - astuces et problèmes courants

Liens
•• en:InkStitch - satin columns
• Satin Tools [2]

Copyright modification
Contents of this page including pictures and SVG files are also available under the GNU Free Documentation
License [3] and the Attribution 4.0 International (CC BY 4.0) [4] license.
The Inkstitch project [5] can use any element (text fragments, SVG files, pictures) for the project's official docs
without giving attribution (just copy and paste).

Références
[1] https:/ / openclipart. org/ detail/ 261329/ rocket-ship-as-clip-art
[2] https:/ / openclipart. org/ detail/ 22539/ rocket-icon
[3] https:/ / edutechwiki. unige. ch/ en/ Stitch_Era_-_creating_embroidery_with_hot_fix_stones
[4] https:/ / thenounproject. com/ liv_iko/ collection/ birds/ ?i=898697
[5] https:/ / thenounproject. com/ search/ ?q=lego%20face& i=106256
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https://thenounproject.com/search/?q=lego%20face&i=106256
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InkStitch - broder un emoji

Guide de tutoriels de broderie machine

Module: InkStitch

⚐ brouillon ☸ intermédiaire

⚒ 2022/09/27
Prérequis

•• Inkscape
•• Emoji
•• InkStitch - utilisation de base
•• InkStitch - colonnes satin

Autres pages du module

•• InkStitch
•• InkStitch - installation
•• InkStitch - utilisation de base
•• InkStitch - broderie ondulée
•• Inkstitch - textures de remplissage
•• InkStitch - lettrage
•• InkStitch - colonnes satin
•• InkStitch - exemples colonnes satin
•• InkStitch - broder un emoji
•• InkStitch - broder une image issue de The Noun Project
•• InkStitch - broder des codes QR
•• InkStitch - broder des patchs et des appliqués
•• InkStitch - astuces et problèmes courants
•• InkStitch - bases SVG
•• Inkscape - édition des chemins
•• InkStitch - broder avec du gros fil
•• InkStitch - broderies à partir de dessins faits à la main
•• InkStitch - points manuels
•• InkStitch - points programmables
Catégorie: InkStitch

Emoji Embroidery Project

⚐ ☸ débutant

⚒ 2022/09/27
Objectifs

•• Améliorer la durabilité avec un surcyclage facile et ludique
•• Populariser la formation à la broderie numérique (les emoji sont relativement faciles à numériser)
•• Propager la broderie numérique comme médium pour développer des compétences numériques
•• Introduire la broderie dans les milieux du making et de l'éducation

Autres pages du module

•• Emoji Embroidery Project
•• Emoji

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Guide_de_tutoriels_de_broderie_machine
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cat%C3%A9gorie:InkStitch
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji_Embroidery_Project
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji_Embroidery_Project
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji
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•• Liste des emojis à broder
•• InkStitch - broder un emoji
•• Stitch Era - broder un emoji
•• Atelier upcycling avec des broderies émoji
•• Cours d'initiation à la broderie numérique (FacLab UniGE)

Introduction
Cet article explique comment créer des emoji brodables (aussi écrits émoji ou emojis) avec InkStitch. On vise
notamment les personnes qui désirent récupérer et améliorer (surcycler/upcycler) des vêtements, par exemple des
pulls avec de petits trous de mites.
Voir aussi:
• Stitch Era - broder un emoji (logiciel de broderie semi-professionnel)
• Dossier web [1] qui contient une large collection de fichiers SVG (source et InkStitch), PES, DSG (Stitch Era) et

EMB (Hatch)
•• Emoji
• Liste des emojis à broder indexe qui la large collection de fichiers.
Cette page contient du SVG brodeable. Il suffit d'afficher le SVG en tant que page web (donc, afficher juste le
dessin SVG, rien d'autre), ensuite d’enregistrer cette page *.svg depuis votre navigateur CTRL-S. Vérifiez bien que
c'est du SVG, enregistrer une image matricielle affichée dans cette page ne va pas le faire. Il faut cliquer 2 fois sur
une image affichée sur cette page-ci, d'abord pour afficher la page avec une image + sa documentation (les images
dans un wiki sont des ressources réutilisables qui ont une vie séparée !), ensuite de nouveau cliquer sur l'image pour
arriver au SVG. Les liens "media" affichent directement la page SVG. Il suffit de l'enregistrer. Vous trouverez le
fichier SVG dans vos téléchargements (sauf si vous savez configurer votre navigateur).

Les emoji
Selon Wikipedia, «Émoji (絵 文 字, prononcé [emodʑi]), est un terme issu du japonais pour désigner les
pictogrammes utilisés dans les messages électroniques et les pages web.» Un grand nombre d’émojis sont
standardisés sous forme de caractères Unicode affichables dans de multiples environnements comme les messageries
instantanées, clients e-mail, pages web (HTML) et réseaux sociaux divers comme Facebook et Twitter. En 2020, la
dernière version du jeu émoji est définie dans le document Unicode Technical Standard #51, version 13.1 [2]. Cette
norme définit un émoji comme «colorful pictograph that can be used inline in text. Internally the representation is
either (a) an image, (b) an encoded character, or (c) a sequence of encoded characters.»
Le mot émoji est masculin et son pluriel est soit emoji, soit emojis selon Wiktionary [3]. En résumé (simplifié), les
émoji sont des caractères dans des fontes qui s'affichent soit avec un style "texte" (graphisme simple) soit avec un
graphisme plus complexe et qui inclut des variantes de couleur.
En résumé, un émoji est défini par
•• un dessin
• un code de caractère Unicode (un ou plusieurs caractères combinés, parfois avec un "Zero Width Joiner",

prononcé "zwidge")
•• un nom court à option (non standardisé, utilisé surtout dans les chats)
•• un nom officiel dans le "Common Locale Data Repository" (CLDR)
•• des mots clefs qui facilitent la recherche

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Liste_des_emojis_%C3%A0_broder
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Stitch_Era_-_broder_un_emoji
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Atelier_upcycling_avec_des_broderies_%C3%A9moji
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cours_d%27initiation_%C3%A0_la_broderie_num%C3%A9rique_%28FacLab_UniGE%29
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Stitch_Era_-_broder_un_emoji
http://tecfa.unige.ch/guides/embroid/emoji/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Liste_des_emojis_%C3%A0_broder
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Wp_fr:%C3%89moji
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Wp_fr:Unicode
https://www.unicode.org/reports/tr51/
https://fr.wiktionary.org/wiki/emoji
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Wp_en:Zero-width_joiner
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Télécharger le SVG d'un Emoji
Pour retrouver un emoji et un graphisme qui vous plaît, on conseille de consulter Emojipedia [4] d'abord.
Il existe plusieurs sites qui permettent de télécharger des emoji. Consultez l'article Emoji pour plus d'informations.
Actuellement (juillet 2022), on conseille d'Iconify.design [5] qui met à disposition plusieurs jeux (collections) emoji à
jour (v.14)! Vous pouvez soit d'abord choisir une collection (ci-dessous on liste les plus importantes) et chercher un
emoji dans la collection, soit chercher parmi tous les emoji du site.
Collections Emoji de Iconfiy.design:
• Twemoji [6] (Twitter, conseillé)
• Fluent flat [7] (Microsoft, conseillé)
• Noto Emoji [8] (Google, conseillé)
• OpenMoji [9]

• Emoji One (Colored) [10] (jeu réduit)
• FireFox Emoji [11] (jeu réduit)
Sur Ubuntu on peut aussi copier/coller du code SVG (code affiché par iconify.design). Il faut donc créer un
document vierge dans InkScape, copier le code SVG que l'on obtient on cliquant sur l'icône SVG), puis coller. Selon
votre version InkScape et sa configuration, les emoji de iconify.design sont mal affichés. On conseille de changer
tout-de-suite les propriétés du document (unités = mm, échelle = 1)

Propriétés du document. On commence par choisir les mm, ensuite l'échelle, ensuite la largeur/hauteur

Une alternative est d'utiliser le site Keyboard.cool [12]. On peut chercher des mots en Anglais et le résultat affiché
permet de télécharge du SVG Noto et TweMoji. On peut également parcourir des dossiers:
• Emoji - Smileys & Emotion [13]

• Emoji - People & Body [14]

https://emojipedia.org/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji
https://iconify.design/
https://iconify.design/icon-sets/twemoji/
https://icon-sets.iconify.design/fluent-emoji-flat/
https://iconify.design/icon-sets/noto/
https://iconify.design/icon-sets/openmoji/
https://iconify.design/icon-sets/emojione/
https://iconify.design/icon-sets/fxemoji/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape-1-2-proprietes-document.png
https://Keyboard.cool/db
https://keyboard.cool/db/emoji-smileys-emotion/
https://keyboard.cool/db/emoji-people-body/
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• Emoji - Animals & Nature [15]

• Emoji - Food & Drink [16]

• Emoji - Travel & Places [17]

• Emoji - Activities [18]

• Emoji - Objects [19]

• Emoji - Symbols [20]

• Emoji - Flags [21]

Keyboard.cool est plus facile à utiliser que iconify.design, mais il est moins à jour.
Alternativement utilisez la large table [22] chez wikimedia commons. Elle contient tous les symboles de toutes les
polices "libres" en SVG (Noto, twitter, emojione, firefox, openmoji, ...)

Principes pour broder un emoji
Pour comprendre la suite, il faut être familier avec les principes de base de InkStitch (créer des remplissages et des
satins) et savoir faire des manipulations dans InkScape, par exemple "différence" et "union" d'objets et briser des
nœuds.
Comme les dessins SVG sont faits en plusieurs couches, il faut les simplifier et, en règle générale, veiller à
créer de petits chevauchements. On conseille de ne jamais broder plus que 2 couches larges sinon la broderie
devient trop rigide.
Sachez que dans un logiciel de broderie (semi) professionnel comme Stitch Era, digitaliser un emoji est moins
compliqué, car la procédure de digitalisation comprend une option pour éliminer les superpositions (overlap) et il est
est très facile d'ajouter des bordures à des objets de broderie. Si vous possédez CorelDraw, il existe une fonction
simple qui permet d’aplatir une dessin ou des objets choisis: Object -> Shaping -> Simplify.
Les dessins ne sont pas forcément réalisés de la même façon. Certains émojis sont nettement plus faciles à broder
que d'autres et il existe des grandes différences entre polices. ....

Opérations InkScape importantes
1. Pour commencer, il faut choisir son emoji. Certains sont très simples à broder, d'autres un peu moins et

quelques-uns sont plus difficiles. Globalement on conseille aux débutants de partir des SVG faite par Twitter,
donc un caractère de la police Twemoji [6] ou Fluent flat [7]. La plupart des emojis ont des chemins sans traits
avec un simple remplissage.

2.2. Il faut adapter la taille. Nous avons décidé de les standardiser autour d'une longueur ou hauteur de 45mm. Ainsi
on peut les broder avec un petit cadre typique de 5x5cm. Les objets importés ont des tailles variées, car en SVG la
taille affichée, par exemple dans une page web ou dans une fonte, s'adapte sans problèmes.

3.3. Il faut remplacer toutes les couleurs avec gradient par une couleur simple.
4.4. Il faut supprimer les objets qui compliquent, surtout lorsqu'on est débutant. Typiquement: tous les objets

minuscules (moins que 3mm), toutes sortes d'ombres, certains contours.
5. Un dessin à destination de l'écran se fait souvent avec pleines de couches superposées. Il n'y a,à notre

connaissance, pas de méthode pour simplifier/aplatir une telle structure de façon rapide. Donc il faut
manuellement soustraire les grands objets posés sur un autre grand objet. On commence en bas la pile: on fait
d'abord une copie de l'élément à soustraire, on la réduit un peu (CTRL_( pour qu'il y ait une superposition, et
ensuite sélection l'objet qui doit avoir un trou et l'objet dupliqué et on fait la soustraction CTRL_- .

6. Il est intéressant de broder certaines bordures avec un point triple ou un satin. Dans cas on peut dupliquer l'objet
(chemin) qui aura une bordure. L’objet dupliqué sera vidé du remplissage et aura soit un trait pointillé pour créer
un point simple ou triple, soit un trait épais que l'on peut transformer en satin avec les outils satin.

https://keyboard.cool/db/emoji-animals-nature/
https://keyboard.cool/db/emoji-food-drink/
https://keyboard.cool/db/emoji-travel-places/
https://keyboard.cool/db/emoji-activities/
https://keyboard.cool/db/emoji-objects/
https://keyboard.cool/db/emoji-symbols/
https://keyboard.cool/db/emoji-flags/
https://commons.wikimedia.org/wiki/Emoji/Table
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Stitch_Era_-_logiciel_de_broderie_machine_et_de_hotfix
https://iconify.design/icon-sets/twemoji/
https://icon-sets.iconify.design/fluent-emoji-flat/
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7.7. Les colonnes ("serpents" de 1 à 4mm) devraient être brodées avec un point satin. Je conseille de les agrandir à
1.5mm au moins. Une largeur idéale pour une petite broderie tourne autour de 2.5 mm. Ensuite, pour faire du
satin il faut savoir briser des points, faire des ponts, unir des points, renverser la direction, ajouter des traverses de
direction, etc.

8.8. En fonction de l'usage, il faut choisir le taux de remplissage. Pour boucher des trous de mites, on resserre un peu
les points (2.25 pour un remplissage) et on définit une sous-couche assez dense (ou on laisse simplement 2
couches de dessin superposés).

9.9. Des remplissages superposés et juxtaposés doivent être orientés dans des directions différentes (à régler dans les
paramètres)

10. Pour broder des formes plutôt larges (4cm) il faut penser à une compensation d'étirement si vous pensez faire un
contour avec un trait. Sinon, il faut simplement chevaucher tous les chemins. Donc, utiliser la fonction
outset/inset CTRL_) et CTRL_(.

11.11. À la fin, il faut trier les objets dans le panneau "objets". Le premier à broder en bas. On conseille aussi d'attacher
des coupes (si votre machine les gère) et de déplacer les points d'entrée et de sortie(voir l'exemple du "microbe").
Si vous possédez une machine multiaiguille, on peut faire un minimum.

὇� Exemple de digitalisation avec une princesse de la collection noto (google)

Batch d'une princesse emoji, version simple sans
satins

Pour suivre cet exemple, on conseille de télécharger le SVG du emoji
"princess" de Iconify.design: noto:princess.svg [23].

Étape 1: Préparation de base:

•• Ouvrir le fichier SVG
•• Afficher le panneau "objets"
•• Tuer le rectangle noir posé par-dessus (est-ce un bug du

téléchargement ?)
•• Renommer les éléments importants (dans le menu objets: double

clic sur un chemin)
•• Tuer les éléments superposés qui n'apportent rien à la broderie

(certains dégradés)
• Régler la taille: sélectionner tous les objets dans tous les calques

(CTRL-ALT-A). Ensuite, définir la taille. Pour boucher un trou, on
conseille entre 40 et 50mm.

Étape 2: Éliminer les superpositions

Éliminer les superpositions est la partie la plus pénible et généralement
on conseille la méthode suivante: traitez les objets de bas en haut
(position arrière->avant) dans le panneau d'objets et faites surtout des soustractions (opérateur "différence"
CTRL_-).

Pour la princesse, il faut par exemple
•• soustraire le pull de l'ovale pour les cheveux.
•• soustraire le cou du pull
•• soustraire les cheveux du haut du rond de visage
• unifier les cheveux du haut avec l'ovale pour les cheveux SHIFT-select, puis CTRL-K
•• Soustraire le visage jaune des cheveux
•• soustraire la couronne des cheveux
Exemple: Pour soustraire un objet "pull" d'un objet "oval", il faut
1. Dupliquer le pull: CTRL_D (ou menu contextuel->Duplicate)

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APatch-princess-lydie.jpg
https://api.iconify.design/noto:princess.svg?download=true&box=true&inline=false&height=auto
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2.2. Sélectionner l'ovale
3. Ajouter le pull dupliqué à la sélection CTRL_Click
4. Menu Path -> Difference CTRL_-
5.5. Réparez la couleur si nécessaire.
Note: Une alternative pour mettre à plat un dessin plus rapidement serait d'exporter le dessin comme PNG, puis
tracer l'image avec des couleurs (explications à faire)
Étape 3: Ajouter des légères superpositions

Ensuite il faut agrandir certains objets pour qu'il ait de petites superpositions, ceci pour éviter à ce qu'il reste des
espaces entre les objets brodés dus au "pull effect". On conseille d'utiliser la fonction Path->Outset , CTRL_) ou
Path->Inset , CTRL_(. Avant d'utiliser cette fonction, on conseille de régler le montant du "outset" à 1px.
Preferences -> -> Behaviour -> Steps -> Inset/Outset by.
Vous pouvez laisser max. deux couches de superposition pour les petits objets (yeux, bouche, collier, etc.)
Ensuite, si vous avez une machine avec une seule aiguille, unifiez les couleurs similaires et triez les couleurs dans
l'ordre, autant que possible
Étape 4: Améliorations facultatives

•• Remplacer des remplissages par des satins
•• Ajouter des contours (satins ou points triples ou points simples)
•• Optimiser les sauts
Fichiers à télécharger:

• Original (sans le rectangle noir): media:princess.svg [24]

• Fichier sans superpositions media:princess-1.svg [25]

• Fichier prêt pour la paramétrisation media:princess-2.svg [26]

• Patch brodable media:patch-princess-lydie.svg [27]

• Fichier brodeable: media:princess-3.svg [28] (modèle avec satins et points triples)

Original Sans superpositions Avec de petites superpositions
(2px)

http://edutechwiki.unige.ch/fmediawiki/images/d/d9/Princess.svg
http://edutechwiki.unige.ch/fmediawiki/images/0/0e/Princess-1.svg
http://edutechwiki.unige.ch/fmediawiki/images/7/7d/Princess-2.svg
http://edutechwiki.unige.ch/fmediawiki/images/4/46/Patch-princess-lydie.svg
http://edutechwiki.unige.ch/fmediawiki/images/5/56/Princess-3.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APrincess.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APrincess-1.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APrincess-2.svg
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Patch brodeable avec satins et points
triples

Simulation Broderie de la version avec satins

À faire:
•• Alléger le collier (par ex. enlever les points d'arrêt)

Exemples commentés
À faire: mieux trier les exemples selon difficulté et détails explicatifs....

ὒ� Wrench - au travail ....
Ce outil ὒ� [29] "Wrench" (Spanner) sera très simple à digitaliser et à broder, car il consiste en un seul chemin simple.
On prend la version twemoji [30] car un peu plus large et on va ajouter un contour en ligne droite.
Opération de préparation

•• Tuer le rectangle noir
•• Adapter la taille
• Le dupliquer avec CTRL-D
•• Enlever le remplissage du doublon, définir un trait et le mettre en pointillés
Paramétrage

•• Le remplissage: selon vos besoins, densifier le remplissage et la sous-couche (par exemple 0.225 pour le
remplissage)

•• Changez l'angle du remplissage (par exemple 45 deg)
•• Définissez un "bean stitch" pour le contour (triple point)

Original Fichier brodeable
media:wrench-twemoji-2.svg

Simulation

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APrincess-3.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APrincess-3.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APrincess-3b.jpg
https://emojipedia.org/wrench/
https://iconify.design/icon-sets/twemoji/wrench.html
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWrench-twemoji.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Wrench-twemoji-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWrench-twemoji-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWrench-twemoji-2.jpg
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ὠ� Face with tears of joy de Twitter
Cet emoji (le plus populaire qui existe) est assez facile à digitaliser, toutefois il faut veiller à l'effet pull et des
distorsions de tissu.
•• On conseille de soustraire les larmes du visage.
•• De rendre les yeux et sourcils avec des points satin
Version brodeable à télécharger: media:face-with-tears-of-joy-3.svg [31]

Original Version brodeable, paramétré. Fichier brodé

ὣ� Astonished Face
Un autre emoji facile à digitaliser. On prend également la version twitter [32]

• On conseille de soustraire la bouche (réduite) du visage: CTRL-D, puis CTRL-(), puis soustraire avec CTRL_-
•• Ensuite pareil pour les deux yeux (il faut faire pour le gauche et le droit)
•• Briser les sourcils: CTRL-SHIFT-K
• Mettre les yeux et la bouche en chemin (Angl. path) CTRL-SHIFT-C
•• Créer un satin pour les sourcils.
• Transformer les yeux en segments droits Extensions->Flatten Béziers, avec 0.1. Ceci va régler le

problème des points superposés que Inkstitch (dec 2020) ne sait pas encore régler.
•• Paramétrer yeux (défauts, mais changer l'angler de 90)
•• Paramétrer le visage (selon l'usage il faut alléger ou alourdir). Pour boucher un trou de mites, je conseille une

sous-couche moyenne.
•• Paramétrer le reste (bouche, bouche intérieure) avec des angles différents.
•• option: Ajouter un triple point (bean stitch) autour: Créer un cercle (r=22.5), centrer, transformer en chemin,

CTRL-L, définir un trait et tuer le remplissage. Enfin, il risque d'être mal positionné à cause de l'effet
resserrement/étirement.

À faire: compensation d'étirement pour le visage.

http://edutechwiki.unige.ch/fmediawiki/images/7/7a/Face-with-tears-of-joy-3.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AFace-with-tears-of-joy.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AFace-with-tears-of-joy-3.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AFace-with-tears-of-joy.jpg
https://iconify.design/icon-sets/twemoji/astonished-face.html
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Original Version brodeable, paramétrée.

Ὂ�La bombe de noto
Parmi les emoji facilement trouvables, celle Google nous semble être la plus joli à broder.
•• Il faut tuer trois objets inutiles, ensuite les petites boules de l'explosion difficiles à broder
•• Enlever les dégradés de tous les objets
•• Agrandir un peu les flammes et la boule de feu
•• Transformer le fil en satin (enlever le remplissage, mettre en contour, briser au 2 bouts et ajouter des traverses de

direction)
• Mettre un satin autour du corps de bombe (dupliquer l'objet avec CTRL-D, enlever le remplissage, mettre un trait

de 2.5mm, briser le chemin, outils satin -> convertir une ligne en satin.
Version brodable à télécharger: media:bomb-noto-2.svg [33]

Original Version brodable, paramétré. Fichier brodé

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AAstonished-face-twemoji.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AAstonished-face-twemoji-2.svg
http://edutechwiki.unige.ch/fmediawiki/images/d/dd/Bomb-noto-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ABomb-noto.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ABomb-noto-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ABomb-noto.jpg
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ὠ� Smiling face with heart eyes de Twitter
Cet emoji visage souriant avec des yeux de coeur, deuxième le plus populaire, vient du jeu Twitter est il est facile à
digitaliser, car le fichier d'origine ne contient que trois objets.
•• Briser les yeux
• Dupliquer les 3 yeux et la bouche et diminuer un peu les doubles avec CTRL-( (inset)
• Soustraire du visage les 3 copies dupliquées et diminuées CTRL_-, ensuite vérifier la forme du visage (cacher les

autres objets) et réparer si nécessaire
•• Changer la taille du tout (par exemple à 40mm)
•• À option: ajouter des bordures satin.
•• Paramétrage des remplissages: Changer les angles des remplissages, densifier le underlay si c'est pour boucher

des trous.
Version brodable à télécharger: media:smiling-face-with-heart-eyes-3.svg [34]

Original Version brodeable, paramétrée. Version brodeable avec bordures,
paramétrée.

Fichier brodé

ᾓ� Person fencing de Twitter
Ce dessin est relativement facile à numériser. Etapes principales:
•• CTRL-L sur tous les objets et reconstituer la couleur.
•• Séparer les objets qui sont dans un même chemin, mais devraient être séparés: CTRL-SHIFT-K
•• Séparer les jambes est un peu plus compliqué. Il faut briser le nœud en haut au milieu, détruire le segment du haut

et ensuite relier les deux hauts de jambes
•• Ajuster certains dessins au niveau de la superposition. Il faut surtout raccourcir les objets en bas de la pile, sinon

on risque plus de distorsion.
•• Tuer le visage blanc et agrandir le visage noir
•• Soustraire le visage noir du reste de la tête
•• transformer l'épée en contour et mettre en points triples
•• Ajuster la densité et la direction des tatami.

http://edutechwiki.unige.ch/fmediawiki/images/f/f8/Smiling-face-with-heart-eyes-3.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASmiling-face-with-heart-eyes.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASmiling-face-with-heart-eyes-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASmiling-face-with-heart-eyes-3.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASmiling-face-with-heart-eyes-3.jpg
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Original SVG brodable (accès direct) Simulation

ᾝ�♀️ La vampire de Twitter
Les dessins de Twitter sont différents de ceux de Google et les techniques de dessin diffèrent aussi un peu. Pour le
vampire, on a utilisé aussi l'opérateur "union". Sinon les manipulations les plus importantes sont tout à fait standards
:
•• Tuer les objets inutiles (2-3, notamment les contours beiges des dents, il vaut mieux mettre un trait noir autour des

dents blanches puis casse l'objet)
•• Nommer les éléments
•• Faire des différences depuis le bas de la pile, il faudrait notamment réduire la cape et une partie de l'ovale visage
•• Union du "oval visage", cou, oreilles
•• Briser les objets non contigus (ici les 2 yeux)
Fichiers à télécharger:
• media:woman-vampire-light-skin-tone.svg [35]

• media:patch-woman-vampire-light-skin-tone-1.svg [36] (version très dense à 3 couches)
• media:woman-vampire-light-skin-tone-5.svg [37] (version trou de mites)

Original Patch brodable (3 couches) Version trou de mites (visage
avec sous-couche dense)

Version trou de mites (visage
avec sous-couche dense)

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APerson-fencing-twemoji.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Person-fencing-twemoji-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APerson-fencing-twemoji-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APerson-fencing-twemoji.jpg
http://edutechwiki.unige.ch/fmediawiki/images/3/3e/Woman-vampire-light-skin-tone.svg
http://edutechwiki.unige.ch/fmediawiki/images/1/14/Patch-woman-vampire-light-skin-tone-1.svg
http://edutechwiki.unige.ch/fmediawiki/images/a/a1/Woman-vampire-light-skin-tone-5.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWoman-vampire-light-skin-tone.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APatch-woman-vampire-light-skin-tone-1.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWoman-vampire-light-skin-tone-5.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWoman-vampire-light-skin-tone-5.jpg
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ᾒ� Grinning Face with One Large and One Small Eye
Le ᾒ� est aussi connu sous les noms Zany Face, Crazy Eyes, Excited, Wild, ou Goofy Face. On va broder la version
twemoji [38], simple.
Opération InkScape:
•• Tuer le rectangle noir
•• Ajuster la taille: W = 45mm
•• Nommer les objets
•• Soustraire tous les objets importants du visage:
•• répéter: CTRL-D, ensuite CTRL-/
•• Union de ces copies, puis soustraire du visage.
•• Transformer le trait rouge sur la langue en satin: enlever le segment du haut, briser le nœud en base, renverser une

ligne, écarter les 2 côtés.
•• Transformer d'autres objets en satin (option).
•• Ajouter un contour en satin: Créer un cercle, le transformer en chemin, épaissir de 2.7mm, briser un point, et

transformer en satin

Original Fichier prêt à broder (download) Simulation

A tester.

Ὀ� Kiss mark
La marque de baiser Ὀ� (kiss mark, kissing lips). On va broder la version noto [39]. A priori c'est un des emoji les plus
simples à broder, car il est composé de 2 formes seulement. On va quand-même ajouter un contour satin de 2.5mm et
ensuite comment faire un tout satin en plus miniature.
Opérations InkScape:

•• Tuer le rectangle noir
•• Ajuster la taille: W = 45mm
•• Nommer les objets
• Dupliquer les deux objets: CTRL-D
•• Enlever le remplissage et ajouter un trait de 2.5mm à ces deux objets
•• Tout sélectionner (les 2 lèvres et leurs contours), puis diminuer jusqu'à ce que les lèvres ne touchent plus:

CTRL_(
Paramétrage et transformations

• Transformer les deux contours en satin avec l'outil convertir ligne en satin (pas besoin de briser un
noeud avant, car il semble déjà avoir des coupures qq. part.)

•• Sélectionner les éléments satin (plusieurs) et paramétrer avec une sous-couche (j'ai mis un zigzag)

https://iconify.design/icon-sets/twemoji/zany-face.html
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AZany-face-twemoji.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Zany-face-twemoji-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AZany-face-twemoji-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AZani-face-twemoji-2.png
https://iconify.design/icon-sets/noto/kiss-mark.html
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•• À option: Peaufiner le satin, notamment les coins de la bouche
•• Paramétrer les lèvres avec une sous-couche.
•• Vérifier les couleurs, on suggère une autre couleur pour le satin pour avoir plus de flexibilité.

Original Simulation

À tester.
Version petite en satin

On peut broder une lèvre entière comme colonne satin à condition de diminuer la taille du dessin.
•• CTRL-A, régler H=15mm. Cela nous laisse des points à 4.5mm mm, larges, mais raisonnables.
• Couper les chemins aux bouts et paramétrer un satin avec une sous-couche. Il va falloir réparer la géométrie (unir

des points superposés que l'on peut trouver avec le module de détection d'erreurs ou en numérotant les noeuds).
On conseiller de les unir (SHIFTJ_J)

•• à option: Ajouter des coupes de fils.
Version petite en satin irrégulier

Comme 3e variante on va rendre le satin irrégulier.
• Désélectionner tout. Visualiser et exporter -> prévisualiser le le plan de
broderie

•• Tuer le dessin d'origine (ou le mettre dans un calque à ne pas broder)
•• Renommer le calque avec le plan de broderie en "broderie"
•• Bouger les points au milieu du document
•• Avec l'éditeur de points bouger les points, ensuite faire des retouches manuelles.

Fichier prêt à
broder (download)

Simulation Fichier prêt à
broder (download)

Kiss mark régulier vs. irrégulier
(env. 2 cm de long)

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AKiss-mark-noto.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AKiss-mark-noto.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Kiss-mark-noto-satin.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AKiss-mark-noto-satin.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AKiss-mark-satin.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Kiss-mark-noto-irregulier-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AKiss-mark-noto-irregulier-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AKiss-mark-noto-satins.jpg
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Ὂ� Pile of poo de noto
Cet emoji "pile de caca" (en Anglais aussi "poop", "similing poop", "dog dirt", "pile of poop") est aussi assez facile à
digitaliser. Le plus difficile est de bien broder les pupilles noires, car petites. Parmi les variantes disponibles sur
Iconify [40] on a choisi la dernière variante de Google Noto [41] (qu'on retrouve dans Android 11).
•• tuer le rectangle noir
• Dégrouper les yeux (sélectionner puis CTRL-SHIFT-G
•• Nommer les éléments
• Dupliquer les 2 yeux blancs (CTRL-D)
• Réduire la taille des doublons de 1px (avec un Inset CTRL-(
• Soustraire les doublons du corps CTRL_-
•• Faire la même chose pour la bouche (dupliquer, réduire et soustraire)
•• Réparer la couleur du corps.
•• Redimensionner à 45mm (à vous de savoir): CTRL-A et changer la taille dans la barre du haut, ensuite ajuster la

taille du document.
• Transformer les yeux et les pupilles en chemin, sélectionner puis CTRL-SHIFT-C
• Réparer la forme des pupilles: 2 X CTRL-L
•• Paramétrer ou continuer. Si le poop sert à boucher un trou de mites, il faut renforcer le underlay.
•• À option: Transformer en satin les yeux, et les lèvres, ajouter un satin autour du corps.
•• À option: Varier les couleurs pour pouvoir broder divers éléments (yeux vs lèvre supérieure) avec des couleurs

différentes
Versions brodables à télécharger:
• media:pile-of-poo-noto-2.svg [42]

• media:pile-of-poo-noto-3.svg [43] avec satins

Original (sans
carré noir)

Version
brodable
simple,

paramétrée.

Version
brodeable avec

satins.

Fichiers brodés (à gauche: avec
satin)

ᾒ�♀️ Woman facepalming de openmoji et noto
Cet emoji Woman facepalming [44] ᾒ�♀️ a été conçu pour la version Emoji 4.0 en 2016 et il est probablement
populaire dans les milieux universitaires....
Nous allons comparer une solution openmoji [45] et noto (google) [46]. Il faut veiller à bien faire sortir la main.
OpenMoji

•• Enlever le rectangle noir
•• Ajuster la taille (CTRL-A), puis dans la barre du haut: H=45. Ensuite, ajuster la taille du document (1mm de

marge)
•• Nommer les objets dans le panneau objets
• Unifier visage et main jaune (sauf si vous pensez border avec des fils différents): Path -> Union
•• Soustraire cet objet visage+main des cheveux: Sélectionner visage+main, CTRL-D, diminuer 1px avec CTRL-(,

sélectionner cheveux et visage+main et CTRL_-. Il faut ensuite briser le résultat (car on obtient deux objets
disjoints).

https://iconify.design/icon-sets/?query=poh
https://iconify.design/icon-sets/noto/pile-of-poo.html
http://edutechwiki.unige.ch/fmediawiki/images/5/5b/Pile-of-poo-noto-2.svg
http://edutechwiki.unige.ch/fmediawiki/images/d/d5/Pile-of-poo-noto-3.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APile-of-poo-noto.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APile-of-poo-noto-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APile-of-poo-noto-3.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APile-of-poo-noto.jpg
https://emojipedia.org/woman-facepalming/
https://iconify.design/icon-sets/openmoji/woman-facepalming.html
https://iconify.design/icon-sets/noto/woman-facepalming.html
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•• Soustraire visage+main du torse (pareil que ci-dessus).
•• Enlever les snapping
• Les traits noirs sont (heureusement) déjà des lignes, donc on pourra facile les traduire en satins . Donc

sélectionner tous les 8 traits (sauf l’œil) et régler la largeur à 2.25mm
•• Avec l'outil "édition de nœuds", ajuster les mains, visage et cheveux pour que les traits noirs soient bien

chevauchés. Selon la direction du remplissage, il faut prévoir un effet "pull", donc plutôt faire trop grand dans la
direction des points.

•• Arranger l'ordre
• Créer les satins pour tous les traits noirs: Les sélectionner, puis Extensions -> Inkstitch -> Outils
satin -> convertir en satin

•• Paramétrer l'oeil (underlay = 0.3mm)
•• Paramétrer deux objets torse, deux objets cheveux et main+visage. On suggère de changer la direction du

remplissage pour chaque groupe d'objets. Si l'emoji sert à boucher un trou, densifiez la sous-couche (0.3mm).
Version Noto

Cette version demande plus de travail, car l'objet est composé de plusieurs couches qu'il faut soustraire. Comme
d'habitude on fera cela du bas de la pile vers le haut.
•• Enlever le carré noir
•• Redimensionner et ajuster la taille du document.
•• Enlever les objets inutiles (path840, nez-path861, path878, path885, ...)
•• Soustraire visage+bras+main+cou+pull de l'ovale cheveux. Pour cela on copie d'abord les objets à soustraire et on

les unifie (CTRL-+).
•• Unifier ces cheveux avec les cheveux du haut
•• Soustraire ces cheveux de l'ovale visage (faire une copie des cheveux d'abord)
•• Unifier cou + visage (CTRL-+)
•• Unifier pull + bras
•• Soustraire visage du pull
•• Tuer la partie cachée de la bouche.
•• Arranger l'ordre: Depuis le bas: visage, éléments du visage, cheveux main, pull
• Simplifier les objets (CTRL-L) et ensuite ajuster les dimensions pour obtenir des chevauchements (notamment le

visage: CTRL_))
•• Ajouter un bean stitch à la main: La dupliquer, enlever remplissage, mettre le trait en pointillé
•• À option: Ajouter des contours satin, ou bean stitch, ou encore transformer les éléments du visage en satin
•• Régler les couleurs à peu près. Pour machine à aiguille unique, on conseille réduire les couleurs à 3-4
•• Paramétrer le bean stitch de la main: 2 x et sérré (1.2mm)
•• Paramétrer le remplissage de la main (soit ajouter une compensation d'étirement, soit mettre le trait de haut en

bas)
•• À améliorer: alléger la région de la main (bean stitch simple ou encore réduire les objets dessous)
Versions brodeables à télécharger:
• media:woman-facepalming-openmoji-2.svg [47]

• media:woman-facepalming-noto-2.svg [48]

http://edutechwiki.unige.ch/fmediawiki/images/1/1a/Woman-facepalming-openmoji-2.svg
http://edutechwiki.unige.ch/fmediawiki/images/5/56/Woman-facepalming-noto-2.svg
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Original Openmoji (sans carré
noir)

Version brodeable Original Openmoji (sans carré
noir)

Version brodeable sans
contours satins, région main

trop dense

2 versions brodées: OpenMoji à
gauche, Noto (Google) à droite

ᾚ� Microbe de twitter
Le microbe ᾚ� (aussi appelé cell, coronavirus, germ, virus, covid-19) a été introduit en 2018 et il est devenu populaire
en 2020.
Nous allons broder la version Twitter Emoji [49]

•• Régler la taille: CTRL-A, ensuite régler dans la barre du haut à 40mm de hauteur. Ajuster ensuite la taille du
document.

•• Créer un calque pour les tentacules
•• Déplacer tous les tentacules dans ce calque
•• Briser les trois objets qui contiennent des tentacules multiples
•• Ensuite il y a 2 corps: intérieur (vert clair) et extérieur (vert foncé). On va utiliser l'extérieur pour faire un bord

satin.
•• Sélectionner extérieur et le renommer "bord". Enlever le fill et mettre un bord de 3mm. Ensuite diminuer avec des

Inset (CTRL_) de 3px, donc 3 fois si vous avez bien réglé vos préférences.
•• Convertir ce bord en satin, si vous le faites sans briser un lien, cela créera 2 objets que l'on peut appeler bord 1 et

bord 2
•• Enlever le snap et repositionner tous les tentacules. Il ne faut pas qu'ils chevauchent avec le corps. Il suffit de les

couvrir avec la moitié du bord satin.
• Convertir les cercles en chemin et appuyer 3-4 fois sur CTRL-L (pour tenter d’éliminer les points superposés).

Paramétrer (on utilise le défaut).
•• Paramétrer le corps. Densifier éventuellement les sous-couches et changer la direction des points.
•• Trier les tentacules dans l'ordre pour éviter de grands sauts si vous avez une machine à une aiguille qui ne sait pas

couper sans redémarrer. Sinon, ajouter des coupes (pour une machine multiaiguille). Lisez aussi la suite qui
montre comment cacher les sauts des contours.

•• On pourrait broder les tentacules en satin, mais c'est du travail. Donc, on va juste mettre une ligne autour. Créer
un nouveau calque "bordures". Copier les tentacules et "paste in place" dans ce nouveau calque.

•• Dans le calque "bordures": Sélectionner tous les objets, enlever le remplissage, créer une bordure et mettre en
pointillé.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWoman-facepalming-openmoji.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWoman-facepalming-openmoji-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWoman-facepalming-noto.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWoman-facepalming-noto-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWoman-facepalming-openmoji-noto.jpg
https://iconify.design/icon-sets/twemoji/microbe.html
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• Pour cacher les sauts entre traits, il faut maintenant couper le trait de chaque bordure de tentacules à l'intérieur
(vers le corps). Ceci va faire démarrer et terminer la couture à un endroit où le satin va cacher les joints. Avec
l'outil "édition de noeuds" sélectionner un point proche et brisez la ligne avec SHIFT-B.

•• Ensuite il faudrait faire l'équivalent pour le remplissage, mais à notre connaissance il n'existe pas de solution aussi
facile. Sélectionnez tous les tentacules et ajoutez à chacun une commande départ et d'arrivé. En déplaçant les
cercles près du bord extérieur de la forme, vous pouvez déplacer les entrées/sorties. Pour mieux voir ce que faites,
il faut diminuer la taille de ces deux objets commandes. On conseille environ 2mm pour ce microbe. Voir des
détails dans le fichier SVG.

•• Arranger le tout dans l'ordre: Corps en bas (en premier). Ensuite tentacules, bords de tentacules, cercles. Pour
finir, en haut, le satin.

•• Paramétrer les tentacules et les cercles (remplissage normal).
•• Ajuster de nouveau la taille du document
À faire: voir si une version DST coupe mieux les fils.
À télécharger
• media:microbe-twemoji-3.svg [50]

Original Twemoji (sans carré
noir)

Version brodable avec sauts
cachés

objet brodé (à refaire, car
certaines coupes de fils ne sont

pas faites, remplacé par la
stratégie "cacher", c.f.

explications)

simulation (pour une bonne
solution qui cache les sauts)

Version 2 brodée sur une
chaussette (avec un petit

resserrement)

http://edutechwiki.unige.ch/fmediawiki/images/e/ed/Microbe-twemoji-3.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AMicrobe-twemoji.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AMicrobe-twemoji-3.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AMicrobe-twemoji.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AMicrobe-twemoji-3.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AMicrobe-twemoji-3b.jpg
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Ἴ� Le snowboarder
Pour le Snowboarder [51] (Emojipedia) Ἴ�, on a un bon choix entre la version Noto [52] et la version twemoji [53].
Comme souvent, la version twemoji est plus simple. Notez par ailleurs que les versions les plus sophistiquées de
Apple, Facebook etc ne sont pas disponibles comme ressource ouverte.
Le snowboarder de Noto / Google avec une technique brutale

Étant donné que cet objet est assez complexe, il faudrait passer un certain temps pour bien éliminer les
superpositions. Ici on propose une alternative aux opérations de soustraction, moins bonne, mais qu'il faut connaître
pour digitaliser des images en PNG (autrement dit, il ne faut pas faire comme cela pour ce type de situation... mais
pour broder des dessins en format non-vectorisé elle est utile)

Original Original, sans dégradés, moins de
couleurs

PNG exporté en mauvaise qualité
(défaut de 92 DPI)

PNG exporté en bonne qualité.

InkStitch

•• Enlever le rectangle noir
•• Enlever le dégradé des lunettes, pull, neige et snowboard (SHIFT-CTRL-ALT-CLic) pour sélectionner un objet,

si nécessaire.
• Enregistrer comme PNG en bonne qualité (dans le panneau exportation: choisir 300 DPI!): CTRL-SHIFT-E
•• Réduire les bleus clairs à une seule couleur (mauvais choix à ne pas faire, mais je l'ai fait ...)
Tracer dans InkStitch

• On va tracer l'image PNG pour éviter de devoir travailler avec les superpositions. Voir aussi InkStitch - broderies
à partir de dessins faits à la main

•• Mettre le dessin dans un calque "dessin" et vérouiller / cacher. Cela nous permet éventuellement de récupérer un
objet ou de comparer.

•• Importer le PNG avec les options par défaut
•• Tracer le PNG: cliquez sur l'image, ensuite avec les options suivants (traduction française à ajouter un jour):

•• Color quantification,
•• Multiple scans,
•• Smooth (lisse)
•• Remove Background (ôter arrière-plan)
•• Smooth corners = 1
•• Optimize = 1

Ajustements dans InkStitch

•• Nommer les objets
• Briser les objets qui ne sont pas contigus (pratiquement tous)
• Briser des objets comme la neige crée beaucoup d'objets (trop) et il faut donc détruire les petits objets avec

Inkstitch -> Troubleshoot -> Cleanup document. Utilisez des paramètres agressifs (30 et 20 par exemple).
•• Dans le calque dessin récupérer les objets détruits (pieds et flocons de neige dans mon cas)

https://emojipedia.org/snowboarder/
https://iconify.design/icon-sets/noto/snowboarder.html
https://iconify.design/icon-sets/twemoji/snowboarder.html
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASnowboarder-noto.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASnowboarder-noto-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASnowboarder-noto-2.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASnowboarder-noto-2b.png
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•• Lissez les objets neige (et tuer les tentacules avec l'outil édition de noeuds)
• Ensuite, utiliser Troubleshoot -> Troubleshoot Objects pour détecter d'autres objets à problème (par exemple

oublis de briser des objets non contigus)
•• Finalement, agrandir certains objets et vérifier l'ordre.
En résumé, cette méthode n'est pas très convaincante.
À télécharger:
• media:Snowboarder-noto-3.svg [54]

Solution brodable (il faudrait la peaufiner un peu) Simulation (voir aussi media:Snowboarder-noto-2b.jpg)

὇� Alien
Alien (ou ET ou Extraterrestrial Alien) est un objet simple à digitaliser si l'on part des icônes de Google ou de
Twitter. On prend la version noto [55] (google), un peu mieux proportionnée à notre avis. Le tout (y.c. cette
documentation) prend 20 minutes.

SVG original Version SVG pour broder (download Simulation

Procédure:
•• Union des 2 objets pour la tête (elle est irrégulière en haut à sa droite)
•• Faire une copie des yeux et de la bouche
• Sélectionner chaque copie et diminuer avec CTRL-(

http://edutechwiki.unige.ch/fmediawiki/images/4/4f/Snowboarder-noto-3.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASnowboarder-noto-3.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Snowboarder-noto-2b.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASnowboarder-noto-3.jpg
https://iconify.design/icon-sets/noto/alien.html
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AAlien-noto.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Alien-noto-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AAlien-noto-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AAlien-noto-2.jpg
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•• Mettre les trois objets dans le même chemin (CTRL-K), dégrouper
• Sélectionner la tête et cet objet à soustraire, puis CTRL_- (Chemin -> Différence)
•• Paramétrer (léger ou épais, changements de direction selon vos goûts). Il va falloir réparer la partie droite du

visage (je suggère tuer des noeuds et/ou CTRL-L)
•• Ajouter une coupure de fil à un œil.
Note: J'ai mis des couleurs différentes pour la bouche et les yeux, cela permet de varier les objets brodés.

὇� Ghost
Le fantôme ὇� (Disappear, Ghoul, Halloween) est à notre avis pas super réussi chez nos sources habituelles. On prend
donc la version chez emojione [56].
•• On transforme les contours du corps et des mains (qui sont des chemins-surface en satin): pour les mains:

CTRL-L, puis briser un point ou tuer un segment au bout (ALT-DEL), ajouter des traverses et paramétrer en satin
dense avec sous-couche.

•• CTRL-L, puis briser le contour du corps (deux points qui sont à face-à-face) et ajouter des traverses
•• Transformer les deux ellipses en chemin, dégrouper tout
•• Soustraire les yeux blancs et la bouche rouge du visage, pour chaque objet: CTRL-D (copier), CTRL-SHIF-(

(réduire la taille), ensuite sélectionner visage plus la copie et CTRL_-
•• Paramétrer les surfaces (remplissage). On conseille de changer la direction des yeux, bouche et pupilles.
•• À option: Ajouter des contours en ligne à certains objets (fait pour la bouche avec la même couleur)
•• Vérifier l'ordre
•• À option: Couper les fils

SVG original Version SVG pour broder
(download)

Simulation Brodé avec des couleurs qui ne
font pas peur...

À peaufiner: couper le contour derrière les pattes. Là on brode simplement par-dessus.

Ὀ� Skull
Le Ὀ� Skull [57] (similaire au Skull and Crossbones [58] doit être populaire parmi une certaine population. On prend la
version de Noto [59].
Opération de géométrie

•• On va broder cet objet avec un contour triple points.
• Dupliquer les yeux et le nez CTRL-D
• Diminuer ces 3 objets: CTRL_(
•• Union des trois objets
•• Soustraire cet objet yeux-nez de la tête
•• Faire pareil pour les espaces bleus entre les dents.
•• Dupliquer la tête, enlever le remplissage et définir un trait en pointillé
•• Changer la couleur de la tête de gradient en solide

https://iconify.design/icon-sets/emojione/ghost.html
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AGhost-emojione.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Ghost-emojione-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AGhost-emojione-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AGhost-emojione-2.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AGhost-emojione-2b.jpg
https://emojipedia.org/skull/
https://emojipedia.org/skull-and-crossbones/
https://iconify.design/icon-sets/noto/skull.html
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•• Bouger les "entre dents" en bas de la pile (à broder d'abord)
•• Vérifier les objets !
Paramétrage

•• Selon vos besoin, paramétrer la tête: distance=0.225

Original Fichier brodable
download

Simulation Brodé sur une chaussette
(largeur=32mm)

ὂ�Bird
Le ὂ� bird est un animal sympa qui va bien sur des chaussettes. Nous allons broder les versions iconify/noto [60] et
twemoji [61], assez similaires.
Twemoji

•• Briser l'objet qui contient les deux pattes et le bec (CTRL-SHIFT-K), les renommer
• Identifier l’œil et l'aile rouge et les nommer.
•• Union de tout le reste (CTRL-+).
•• Paramétrer

SVG twemoji original de
twemoji [61]

Version SVG pour broder
(download)

Simulation En train d'être brodé

Noto, assez similaire
•• Mettre les pattes et l'aile en satin
•• Paramétrer (tourner la direction de l'oeil)

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASkull-noto.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Skull-noto.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASkull-noto-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASkull-noto-2.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASkull-noto-2b.jpg
https://iconify.design/icon-sets/noto/bird.html
https://iconify.design/icon-sets/twemoji/bird.html
https://iconify.design/icon-sets/twemoji/bird.html
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ABird-twemoji.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Bird-twemoji-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ABird-twemoji-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ABird-twemoji-2.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ABird-twemoji-2-stitching.jpg
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SVG twemoji original de iconify/noto [60] Version SVG pour broder (download) Simulation

Notice: Sur une version réduite (3cm) et un tissu léger, les pattes et le bec peuvent faire des nœuds un peu durs.

Ὂ� Light bulb
L'ampoule (Angl. light bulb, Idea, electric light bulb) sert parfois à exprimer une idée, par exemple "tiens on pourrait
broder des emoji").
On prend le modèle de Twitter [62].
Procédure:
•• L'objet est presque prêt pour le paramétrage, il faut juste réduire un peu le bas du bulbe
•• Paramétrer bulbe, joint et bout pour un remplissage. On a densifié un peu les paramètres par défaut.
•• Faire un contour du joint: Dupliquer, tuer le remplissage, mettre un trait pointillé.
•• À option: faire un contour. Pour cela copier bulbe, joint et bout, ensuite union, tuer le remplissage et mettre un

trait pointillé
•• Mettre le fil en satin: amputer une branche en sectionnant 2 nœuds. Ensuite, rejoindre deux noeuds dans la grande

branche par un segment (pas besoin de réparer le petit), et briser à part. Maintenant on a deux objets "fil" à broder.
Il suffit d'ajouter un point aux bouts et le briser ensuite, puis d'enlever le segment en bas de la grande branche.

•• Briser à part la visse et faire deux satins.

SVG original Version SVG pour
broder (download)

Simulation Brodé

À vérifier si le point triple passe bien en réalité.

https://iconify.design/icon-sets/noto/bird.html
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ABird-noto.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Bird-noto-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ABird-noto-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ABird-noto-2.jpg
https://iconify.design/icon-sets/twemoji/light-bulb.html
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALight-bulb-twemoji.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Light-bulb-twemoji-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALight-bulb-twemoji-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALight-bulb-twemoji-2.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALight-bulb-twemoji-2b.jpg
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ὄ� Waving hand
La waving hand de Twitter [63] ὄ� sera brodée très simplement (cela fatigue les satins).
Procédure
•• Tout dégrouper et réordonner un peu dans le panneau objets
•• Tuer l'ombre orange de la main
•• Resserrer l'écart dans la paume
• Dupliquer objet par objet (CTRL-D). Chaque objet dupliqué sera transformé un bean stitch (point triple).

SVG original Version SVG pour broder (download) Simulation

ὄ� Clapping hands
Une fois que vous saurez créer votre propre numérisation d'un emoji vous pourrez broder le "clapping hands" (
Applause, Clap, Clapping, Golf Clap, Round Of Applause)
Nous allons montrer deux types de solutions avec deux graphismes différents
Le twemoji

La version twemoji peut être numérisée de façon simple:
•• Enlever le rectangle noir et agrandir dans Inkstitch à 45mm
•• Soustraire la main gauche de l'orange (derrière) de la : Dupliquer la main gauche (CTRL-D), la diminuer un peu

(CTRL-(, ensuite la soustraire de la main orange (sélectionner main orange, puis le duplicata, puis CTRL_-)
•• Briser la main derrière: CTRL-SHIFT-K
•• Briser les éclats (break apart): CTRL-SHIFT-K
•• Paramétrer les deux mains avec un remplissage
•• (À option: créer des satins pour les éclats): Soit les remplacer par des lignes grasses et ensuite transformer en

satin, soit faire la chirurgie de noeuds sur un objet, puis dupliquer 5 fois (notre solution)
Le noto

Cette version contient des dégradés qu'on conseille de remplacer déjà dans InkScape (car Stitch Era n'en veut pas).
•• Dans Inkstitch, tuer les deux "ombres" et remplacer les dégradés dans les mains, ensuite enregistrer
(à suivre)

https://iconify.design/icon-sets/twemoji/waving-hand.html
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWaving-hand-twemoji.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Waving-hand-twemoji-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWaving-hand-twemoji-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWaving-hand-twemoji-2.jpg
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ὤ� Folded Hands
Folded Hands ὤ� (Namaste, Please, Prayer, Thank You, Person with Folded Hands, ...) est utile pour remercier
quelqu'un ou pour demander quelque chose.
On va broder la version OpenMoji [64], simple, car
Procédure:
•• Nommer les objets
•• Paramétrer les surfaces mains jaunes et manches bleues: Densifier un peu (0,225mm de distance entre les fils,

cela fait 4.5 fils/mm). Il faut réparer la main gauche (CTRL-L).
•• Pareil pour les manches
•• Créer un point triple pour les contours. Mettre les lignes en pointillé, ensuite paramétrer.
•• alternativement, on aurait pu traduire les mains en satin de 1.5mm au moins. Dans cas il aurait fallu écarter un peu

les mains.

Fichier SVG brodeabale (download direct) Simulation

ᾗ� Lab Coat
(à finir)
Le lab coat [65] ᾗ� n'est peut-être pas un emoji très populaire, mais broder cela sur une chaussette fait sérieux.
On va comparer deux solution, celle de twitter [66], relax, et celle de openmoji [67] plus "rigide".
OpenMoji

•• La version openmoji sera très facile à digitaliser, puisque les traits sont des vrais traits.
•• Examiner et nommer les trait (il y en un qui ne sert à rien: le tuer)
•• Examiner et nommer les remplissage (il y en a 2 en blanc qu'il faut éliminer)
•• Soustraire les revers du labcoat, pour chaque côté: dupliquer (CTRL-D), diminuer les copies CTRL_(, puis

différence (CTRL-). Attention: il faut soit laisser un trou soit une seule forme, pas deux.
•• Mettre les traits à 1.8 mm et convertir en satins. Le résultat n'est pas super convainquant: il faut réparer certains

satins et ajuster d'autres ....
•• Trier dans l'order pour éviter trop de sauts
•• A option: ajouter des trim

https://iconify.design/icon-sets/openmoji/folded-hands.html
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Folded-hands-openmoji-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AFolded-hands-openmoji-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AFolded-hands-openmoji.jpg
https://emojipedia.org/lab-coat/
https://iconify.design/icon-sets/twemoji/lab-coat.html
https://iconify.design/icon-sets/openmoji/lab-coat.html
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Original Fichier brodable
media:lab-coat-openmoji-2.svg

Simulation (version 2)

ᾞ� DNA Double Helix
Le DNA Double Helix [68] (ou DNA) est emoji introduit en 2018 dans Unicode 11.0. Ici, nous allons broder la
version de Twitter. Celle de Google est composée de points et pas très appropriée pour broder.
Cet emoji demande pas mal de travail manuel, car il faudrait transformer en principe toutes les surfaces en satin.
• Réduire les surfaces bleues et violettes en trois chemins: Sélectionner les trois chemins violets et union CTRL-+,

pareil pour juste deux des bleues (pour pouvoir modéliser une hélice, il faut l'un passe sur l'autre et on a donc
deux bleues et un violet (voir le svg du fichier)

•• Briser les tiges rouges (CTRL-SHIFT-K)
• Transformer les longs chemins (bleus et violets) en satin: tuer les remplissages et définir des bordures. Si

nécessaire insérer un point aux bouts (par exemple le bas du bleu), briser les points aux bouts SHIFT-B, les
écarter un peu, inverser la direction d'un des deux chemins (CTRL-R), et ajouter des traverses

•• Paramétrer ces trois satins assez densement (0.38 d'écart) et une souscouche de zigzag
•• Pour le reste (les tiges), on suggère de mettre un seul en satin et ensuite les recopier, au lieu de créer 14 satins.

Faites attention à dessiner plus large, car un satin étroit se brode difficilement. Pour finir, changer les couleurs
selon le dessin original.

• Pour mettre en satin un rectangle: Tuer les segments au bout ALT-DEL, vérifier qu'il n'a que 4 points et
paramétrer en satin (sinon il faut ajouter des traverses). Duplifier et tirer le duplicata sur le rectangle adjacent en
laissant un peu chevauchement. Grouper (CTRL-G). Cela fait une tige bicolorée.

•• Maintenant faire 6 copies de cette tige bicolore, dégroupez, et fixez les couleurs. Pour finir, ajuster un peu les
longueurs.

•• Vérifier l'ordre (mettre les longs chemins en haut), optimiser les chemins pour une machine à une seule aiguille
(pas fait ici)

•• Simuler et broder ....
•• À option: Ajouter des sauts.

Original Fichier brodable
media:dna-twemoji-2.svg

Simulation (version 2) Broderie (version 1, branches
un peu étroites)

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALab-coat-openmoji.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Lab-coat-openmoji-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALab-coat-openmoji-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALab-coat-openmoji-2.jpg
https://emojipedia.org/dna/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ADna-twemoji.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Dna-twemoji-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ADna-twemoji-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ADna-twemoji-2.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ADna-twemoji-2b.jpg
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Après le premier test (broderie sur une chaussette) on a agrandi un peu la largeur des branches.

Ὦ�️ Shield
Le Ὦ�️ Shield sert à se protéger. On prend la version de Noto [69] car, il nous semble que sa forme sera plus jolie en
broderie que celui de Twitter par exemple.
•• On va broder cet objet avec un contour satin. Ce contour existe déjà et on peut juste couper ou alors créer un

nouveau contour que l'on transformer en satin. On prend cette deuxième option.
•• Tuer le contour gris transparent.
• Dupliquer le fond (objet en bas de la pile): CTRL-D
•• Enlever le remplissage du dupliqué, définir un trait de 2mm (ou 2.5), briser en bas, transformer en satin
•• Soustraire le beige du fond (CTRL-D, CTRL-( et CTRL_-)
•• Soustraire la partie orange du beige (CTRL-), CTRL-D et CTRL--)
•• Agrandir un petit peu les deux demi-écussons
•• Vérifier les objets !

Original Fichier brodable download Simulation

ὣ� Face screaming in fear
Le face screaming in fear ὣ� (aussi appelé Home Alone, Scream, Screaming Face, Screaming Face in Fear) est un
autre emoji populaire (rang 4 avec une trentaine d'autres). La forme Google noto a des dégradés et on va montrer
comment créer un dégradé du visage avec une édition de code XML et une manipulation de points du plan de
broderie. On va broder la variante Noto [70].
Préparation initiale dans Inkscape

•• Tuer 2-3 objets avec dégradés/transparence posés sur le visage
•• Tuer la plupart ombres oranges du visage et des mains
•• Enlever le dégradé du visage
•• Mettre un trait autour de la main (dupliquer l'objet, puis mettre en pointillé le trait)
•• Option: Mettre un trait autour du visage ou un satin
• Agrandir les yeux CTL_)
•• Tout mettre à plat et réorganiser l'ordre: visage - bouche - yeux - mains - contour des mains.
Créer un dégradé

Créer un dégradé en InkStitch n'est pas encore une fonctionnalité bien développée et testée, donc elle est cachée et il
va falloir travailler avec du code. Faire un bon dégradé en broderie est assez compliqué, mais pour créer quelque
chose de potable, on utilisera la méthode simple suivante:
•• Créer un léger fond avec un fil jaune

https://iconify.design/icon-sets/noto/shield.html
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AShield-noto.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Shield-noto.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AShield-noto-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AShield-noto-2.jpg
https://iconify.design/icon-sets/noto/face-screaming-in-fear.html
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•• Créer un remplissage dégradé en bleu de haut en bas, donc un écartement de lignes qui va de 4fils/mm (0.25mm
d'écartement) à moins que 1/mm (5mm d'écartement)

•• Ensuite on fera l'inverse avec du rouge. Dense en bas et très écarté en haut.
Donc:
• Dupliquer le visage 2 fois et nommer chaque version en visage bleu / visage rouge, les mettre en bas de la pile
•• Paramétrage de base pour les 3 visages, mais légère pour le jaune: 0.33 mm distance (peu de remplissage), points

de 2mm
• Paramétrage normal pour le bleu et le rouge, mais attention:

• décocher le underlay (sous-couche), car sinon on a 8 couches à broder (2x jaune, 2x bleu, 2x rouge, 2x
yeux/mains)

• décocher underpath (chemin de dessous), car sinon il sera visible
• Ouvrir l’éditeur XML et ajouter un attribut

•• Sélectionner le visage bleu
• Cliquer sur le petit + (en vert) et créer un nouvel attribut embroider_end_row_spacing_mm
• Name=embroider_end_row_spacing_mm Value=5

Ajouter un dégradé (espacement de fils)

•• Répéter cela pour le visage rouge.
Inverser le dégradé rouge

•• On a un problème: le dégradé du rouge commence aussi en haut (et déplacer le point de départ en bas ne sert à
rien). Il y a deux solutions, soit on joue sur les valeurs de densité (faible au départ et dense à la fin), soit on
copie/colle les points générés. Juste pour le fun, on adapte la 2e solution.

•• On va donc générer les points de broderie pour cet objet, ensuite copier / coller cet objet, puis retourner.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-degrade-1.png
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• Sélectionner le cercle rouge, puis Visualisation et exporter -> Prévisualisation du plan
de broderie

• Ensuite, renverser l'objet de broderie à droite dans l'image ci-dessous:(Path -> Flip vertical)
•• Ensuite, mettre les points manuels générés à la place du visage rouge, donc pile sur le cercle bleu: Pour cela il faut

le bouger dans le calque broderie et les positionner (utilisez le menu Layer / calques pour cela). Pour finir il tuer
ou déplacer l'ancien visage rouge dans un calque non brodé.

Cercle rouge en points de broderie, déjà retourné

Version modifiée (brodable) Version avec du dégradé
(brodable) (download [71])

Simulation, version 1 (points
triples à refaire par exemple)

Broderie, Version 1 Broderie, Version 2

A faire/essayer

•• Agrandir un petit peu le contour.
• On peut envisager de densifier non linéairement les dégradés, mais c'est du travail manuel et je n'ai pas envie, car

c'est facile à faire avec StitchEra comme on a montré dans Stitch Era - broder un emoji.
•• Refaire les traits
•• Densifier éventuellement le bleu et le rouge. Ou encore une solution à 2 couleurs

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-degrade-2.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AFace-screaming-in-fear-noto-3.svg
http://edutechwiki.unige.ch/fmediawiki/images/a/ad/Face-screaming-in-fear-noto-4.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AFace-screaming-in-fear-noto-4.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AFace-screaming-in-fear-noto-4.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AFace-screaming-in-fear-noto-4.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AFace-screaming-in-fear-noto-4b.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Stitch_Era_-_broder_un_emoji%23.F0.9F.98.B1_Face_screaming_in_fear
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•• Broder avec un cercle lourd et deux couches de stabiliseur (au lieu du magnétique plus pratique)

὆�Ἲ� La femme artiste de Twitter
Voici un autre exemple d'un personnage. Même principe que pour les autres personnages
•• Il faut éliminer par soustraction les grandes superpositions, mais de sorte à ce que les surfaces soient légèrement

superposés. Enfin, alternativement, on pourrait aussi jouer sur les compensations.
•• Les éléments du visage sont faits par des satins, définis par des points et non pas par des traverses.

Original légèrement modifié. Original modifié. Modèle brodable Incorporé dans un patch.
Bordure avec Decora 12 et

écriture avec Poly 60.

ἶ� Soft Ice Cream
Le soft ice cream a été numérisé à partir de la soft ice cream [72] de la police Twemoji.
Opérations:
•• Faire des soustractions jusqu'à ce qu'il ne reste plus d'objets superposés.
•• Séparer les couches de glace en deux fois trois objets
•• Ajuster les formes et superpositions.
•• Ajuster les lignes de direction

Fichier original légèrement modifié Fichier broadable
(non testé)

Simulation.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWoman-artist-twemoji-1.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWoman-artist-twemoji-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWoman-artist-twemoji-3.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APatch-woman-artist-twemoji.jpg
https://iconify.design/icon-sets/twemoji/soft-ice-cream.html
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASoft-ice-cream-twemoji.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASoft-ice-cream-twemoji-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASoft-ice-cream-twemoji-2.png
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Ἰ� SantaClaus
Twitter emoji Sauta Claus récupéré de https:/ / icon-sets. iconify. design/ twemoji/
santa-claus-medium-light-skin-tone/
Opérations :
• Union du visage et des 2 oreilles pour faire un seul objet (path > union),
•• Tailler les pèces se superposant pour ne pas faire de multiples couche (pompom/bonnet, visage/barbe etc.) Une

méthode est de copier-coller le pompom sur place pour de soustraire le pompom au bonnet et ensuite de déplacer
le pompom légèrement vers le haut pour faire un overlapping.

•• Ajouter des trims

Original Fichier brodable (non testé) Simulation

Emoji 6cm pour fils de taille 12
Idéalement il ne faut pas faire des emoji audelà de 5cm car on ne peut plus facilement les broder sur des manches ou
des chaussettes. Enfin pour la Brother, on peut utilise le clamp frame ou le sleave frame. Nous avons utilisé le clamp
frame.
Ces modèles doivent être brodés avec (environ) les réglages suivantes (testez d'abord)
•• 0.4 de distance
•• 1 de distance pour la sous-couche pour boucher un trou, sinon aucune sous-couche je pense.

ᾝ�♀️ La vampire de Twitter
C.f. les explications ci-dessus pour le vampire pour fil 40

Original Version trou au coude 6cm avec du fil 12 !
(media:woman-vampire-light-skin-tone-WT12-1.svg)

Simulation Photo (test)

https://icon-sets.iconify.design/twemoji/santa-claus-medium-light-skin-tone/
https://icon-sets.iconify.design/twemoji/santa-claus-medium-light-skin-tone/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASantaclaus.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASantaclaus_broderie.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASantaclaus_simulation.PNG
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWoman-vampire-light-skin-tone.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Woman-vampire-light-skin-tone-WT12-1.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWoman-vampire-light-skin-tone-WT12-1.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWoman-vampire-light-skin-tone-WT12-1.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWoman-vampire-light-skin-tone-WT12-1.jpg
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Photo (trou cou d'un pull réparé)

Fichiers de broderie à télécharger

Emoji Embroidery Project

⚐ ☸ débutant

⚒ 2022/09/27
Objectifs

•• Améliorer la durabilité avec un surcyclage facile et ludique
•• Populariser la formation à la broderie numérique (les emoji sont relativement faciles à numériser)
•• Propager la broderie numérique comme médium pour développer des compétences numériques
•• Introduire la broderie dans les milieux du making et de l'éducation
•• Créer du matériel pédagogique pour la formation en broderie numérique

Autres pages du module

•• Emoji Embroidery Project
•• Emoji
•• Liste des emojis à broder
•• Emoji embroidery project copyrights
•• InkStitch - broder un emoji
•• Stitch Era - broder un emoji
•• Atelier upcycling avec des broderies émoji
•• Cours d'initiation à la broderie numérique (FacLab UniGE)

἞�἟� ἞�἞� ἞�἞�

Le tableau suivant fait partie du projet Emoji
Embroidery Project. Les colonnes à droite
listent les emojis numérisés, selon le
logiciel de conception utilisé. Le dossier
référencé contient des graphismes source en
SVG (de Google/Noto [73] ou
Twitter/Twemoji [74] légèrement modifiés),
les fichiers design ( InkStitch, Stitch
Era/Embroidery Office ou Hatch), des
fichiers machine PES et/ou DST ainsi que
des images. Respectez, SVP, le copyright et
sa licence.

The following table is part of the Emoji
Embroidery Project. It displays the the
official subcategories of emojis. The
columns on the right list the digitized
emojis, according to the design software
used. The referenced folder contains slightly
changed SVG source files (from
Google/Noto [73] or Twitter/Twemoji [74]),
design files ( InkStitch, Stitch
Era/Embroidery Office or Hatch), PES and/or
DST machine files, and pictures. Please
respect the copyright et its licence.

Die folgende Tabelle ist Teil des Emoji Embroidery
Projects. Sie zeigt links die offiziellen
Unterkategorien der Emojis. Die Spalte rechts listet
die gepunchten Emojis je nach verwendeter
Software auf. Der referenzierte Ordner enthält leicht
veränderte SVG-Quelldateien (von Google/Noto [73]

oder Twitter/Twemoji [74]), Designdateien
(InkStitch, Stitch Era/Embroidery Office oder
Hatch), PES- und/oder DST-Maschinendateien, und
Bilder. Bitte Copyright und Lizenz beachten.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AWoman-vampire-light-skin-tone-WT12-1b.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji_Embroidery_Project
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji_Embroidery_Project
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Liste_des_emojis_%C3%A0_broder
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji_embroidery_project_copyrights
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Stitch_Era_-_broder_un_emoji
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Atelier_upcycling_avec_des_broderies_%C3%A9moji
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cours_d%27initiation_%C3%A0_la_broderie_num%C3%A9rique_%28FacLab_UniGE%29
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji_Embroidery_Project
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji_Embroidery_Project
https://github.com/googlefonts/noto-emoji
https://twemoji.twitter.com/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Stitch_Era
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Stitch_Era
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Hatch_Embroidery_3
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji_embroidery_project_copyrights
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji_embroidery_project_copyrights
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji_Embroidery_Project
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji_Embroidery_Project
https://github.com/googlefonts/noto-emoji
https://twemoji.twitter.com/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Stitch_Era
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Stitch_Era
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Hatch_Embroidery_3
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji_embroidery_project_copyrights
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji_Embroidery_Project
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji_Embroidery_Project
https://github.com/googlefonts/noto-emoji
https://twemoji.twitter.com/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Stitch_Era
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Hatch_Embroidery_3
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji_embroidery_project_copyrights
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Les motifs mesurent 4.5cm max. par défaut
et sont destinés à être brodés sur des
vêtements, notamment des pulls. On peut
également les insérer dans des patchs ou
appliqués (dossier [75]). Un petit mot
d'emploi est dans Emoji Embroidery Project

The designs measure 4.5cm max. by default
and are intended to be embroidered on
clothing, including sweaters. They can also
be inserted in patches or appliqués (folder
[75]).

Die Motive sind standardmäßig max. 4,5 cm groß
und sollen auf Kleidungsstücke, insbesondere
Pullover, gestickt werden. Man kann sie auch in
Patches oder Applikationen (Ordner [75]) einfügen.
Eine kleine Anweisung auf Deutsch ist in Emoji
Embroidery Projekt [76]

A présent (déc 2021), la plupart des emoji
n'a pas été testé. Modifiez-vous même le
design ou faites-nous signe [77] en cas de
problème.

Most designs have not been tested so far.
You can either change them yourself or tell
us [77].

Die meisten Motive sind noch nicht getestet. Sie
können die Dateien selber verbessern oder uns
anfragen [77].

La norme UniCode (liens vers le site
unicode)

Emoji numérisés / digitized emoji Liens vers les
dossiers / fichiers à droite, certains emoji récent ne s'affichent pas encore
(sauf sur mobile récent, FB, etc.)

Dossiers avec
télé-chargements / download.
Licence: CC BY-SA [78]

catégories
pricipales

sous-categories
(official names)

Numérisé
pour Stitch

Era

Numérisé pour InkStitch Numérisé
pour Hatch

Smileys & Emotion [79]
⬇️ download [80]

face-smiling [81] ὠ� ὠ� ὠ� ᾒ� ὠ� ᾮ� [82] ⬇

face-affection [83] ὠ� ᾗ� ὠ� ᾒ� ὡ� ὡ� ☺️ ὡ� ὡ� ᾗ� ὠ� [84]

face-tongue [85] ὠ�ὡ� ᾒ� ὡ� [86]

face-hand [87] ᾑ� ᾒ�ᾒ� ᾑ� ᾒ� [88]

face-neutral-skeptical
[89]

ᾑ�ὣ�ἲ�️ ὤ�ὣ�ἲ�️ ὣ�ἲ�️ [90]

face-sleepy [91] ὣ�ὢ� ᾒ� ὣ�ὢ� [92]

face-unwell [93] ὣ� ᾗ� ὣ� ᾒ� ᾒ� ᾒ� [94]

face-hat [95] ᾗ�ᾒ� ᾗ� ᾒ� [96]

face-glasses [97] ὠ�ᾑ� ὠ� ᾝ� ᾑ� [98]

face-concerned [99] ὢ� ὣ� ὢ� ὢ� ὣ� ὣ� ᾗ� ὢ� ὢ� ὢ� [100]

face-negative [101] ὇�ὢ� Ὀ� ὢ� ὢ� [102]

face-costume [103] ᾒ�὇�὇�὇� ὇� ᾑ� Ὂ�὇� ᾒ�὇�὇� [104]

cat-face [105] ὣ� ὣ� ὣ� ὣ� ὣ� ὣ� ὣ� ὣ� ὤ� (ὣ� ὣ�) ὣ� [106]

monkey-face [107] ὤ�ὤ� ὤ� ὤ� [108]

emotion [109] Ὂ�❤️ὒ�Ὂ� Ὂ� ❤️ Ὀ� Ὁ� Ὂ� Ὂ� Ὂ� ❤️ᾧ� Ὀ� ❤️ ❤️ᾧ� [110]

People & Body [111]
⬇️ download [112]

hand-fingers-open [113] ᾯ� ᾯ� ὄ�Ὑ� Ὑ� [114]

hand-fingers-partial
[115]

ᾯ� ✌️ ὄ� ᾑ� ᾑ� [116]

http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/AA_PATCH_APPLIQUE/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji_Embroidery_Project
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/AA_PATCH_APPLIQUE/
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/AA_PATCH_APPLIQUE/
https://w.arbores.tech/wiki/Emoji_Embroidery_Projet
mailto:daniel.schneider@unige.ch
mailto:daniel.schneider@unige.ch
mailto:daniel.schneider@unige.ch
https://creativecommons.org/licenses/by-sa/4.0/deed.fr
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Stitch_Era_-_logiciel_de_broderie_machine_et_de_hotfix
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Stitch_Era_-_logiciel_de_broderie_machine_et_de_hotfix
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Hatch_Embroidery_2
https://unicode.org/emoji/charts/full-emoji-list.html#smileys_&amp;_emotion
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/smileys_emotion/
https://unicode.org/emoji/charts/full-emoji-list.html#face-smiling
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/smileys_emotion/face-smiling
https://unicode.org/emoji/charts/full-emoji-list.html#face-affection
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/smileys_emotion/face-affection
https://unicode.org/emoji/charts/full-emoji-list.html#face-tongue
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/smileys_emotion/face-tongue
https://unicode.org/emoji/charts/full-emoji-list.html#face-hand
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/smileys_emotion/face-hand
https://unicode.org/emoji/charts/full-emoji-list.html#face-neutral-skeptical
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/smileys_emotion/face-neutral-skeptical
https://unicode.org/emoji/charts/full-emoji-list.html#face-sleepy
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/smileys_emotion/face-sleepy
https://unicode.org/emoji/charts/full-emoji-list.html#face-unwell
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/smileys_emotion/face-unwell
https://unicode.org/emoji/charts/full-emoji-list.html#face-hat
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/smileys_emotion/face-hat
https://unicode.org/emoji/charts/full-emoji-list.html#face-glasses
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/smileys_emotion/face-glasses
https://unicode.org/emoji/charts/full-emoji-list.html#face-concerned
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/smileys_emotion/face-concerned
https://unicode.org/emoji/charts/full-emoji-list.html#face-negative
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/smileys_emotion/face-negative
https://unicode.org/emoji/charts/full-emoji-list.html#face-costume
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/smileys_emotion/face-costume
https://unicode.org/emoji/charts/full-emoji-list.html#cat-face
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/smileys_emotion/cat-face
https://unicode.org/emoji/charts/full-emoji-list.html#monkey-face
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/smileys_emotion/monkey-face
https://unicode.org/emoji/charts/full-emoji-list.html#emotion
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/smileys_emotion/emotion
https://unicode.org/emoji/charts/full-emoji-list.html#people_&amp;_body
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/people_body/
https://unicode.org/emoji/charts/full-emoji-list.html#hand-fingers-open
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/people_body/hand-fingers-open
https://unicode.org/emoji/charts/full-emoji-list.html#hand-fingers-partial
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/people_body/hand-fingers-partial
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hand-single-finger
[117]

Ὑ� ὄ� ὄ� Ὑ� ᾯ� [118]

hand-fingers-closed
[119]

✊ ὄ� ᾑ�Ἷ� ᾑ�ὄ� ὄ� [120]

hands [121] ὄ� ᾯ� ὄ� ᾯ� ὤ� [122]

hand-prop [123] ✍️ ✍️ ᾓ� Ὀ� [124]

body-parts [125] ᾞ�ᾛ� ᾛ�ὄ�ὄ�ὄ� ὄ� ᾛ� ὄ� [126]

person [127] ὇�ᾝ� ᾝ� ὆� [128]

person-gesture [129] ὤ� ᾒ�♀️ ὤ�Ὀ�Ἷ�♀️ [130]

person-role [131] ᾝ�Ὡ� ᾝ�⚕️ ὆�Ἲ� ὆�Ἲ�
὆�ἳ� ὆�ἷ�

὇� ὆�Ἲ� ὆�Ἷ�Ἶ� ὆�Ὃ� ᾝ�Ἷ�ὒ� ὆�Ὃ� ὆�ἷ� ὇�♂️ ὇�♀️ ᾝ�Ἷ�Ἶ�
὆�⚖️ ὆�Ὡ� ὆�ἳ� ὆�Ὃ� ὆�✈️ ὆�Ὠ� ὆�♀️ ὗ�️♀️ Ὀ�♀️

ᾬ� [132]

person-fantasy [133] ᾛ�♂️ ᾛ� ᾝ�♀️ ᾝ�
ᾛ�♀️ ᾛ�♀️ ᾝ�♀️

὇� ᾝ� ᾝ�♀️ ᾝ�Ἷ�♀️ ᾝ�♀️ ᾝ�♀️ ᾝ� ᾝ�♀️ ᾝ�♀️ ᾝ� ᾝ�♀️ ᾜ� [134]

person-activity [135] Ὀ�Ἷ� Ὣ�Ἷ� Ὀ�Ἷ� Ὀ� ᾝ�Ἷ�♀️ Ὀ�♀️ [136]

person-sport [137] Ἴ� Ἴ�Ἷ�♀️ᾓ� Ὣ� Ἴ� ᾓ�Ἷ� Ὣ�♂️ [138]

person-resting [139] ᾝ� Ὤ� Ὤ� Ὤ� ᾝ�♀️ᾝ�Ἷ�♀️ [140]

family [141] ὆�὆�὆� Ὁ� Ὁ� [142]

person-symbol [143] ᾬ� ᾬ� ὆� [144]

Component [145]
Component

hair-style [146] hair-style

Animals & Nature [147] (140)
⬇️ download [148]

animal-mammal [149]

(64)
ὀ�⬛ ὃ�️ ὁ� ὁ� ᾘ�
ᾘ� ὀ� ὀ� ὃ� ὀ� ᾙ� ὃ�
ὀ�

ὃ� ὁ� ᾘ� ᾚ� ὃ� ὁ� ᾚ� ὁ�ᾛ� ὂ� ὃ� ᾘ� ᾙ� ὃ� ὀ� ὀ�⬛ ᾘ� ὂ�
ὀ� ὃ� ὀ� ᾘ� ᾙ� ᾘ� ᾚ� ὂ� ὀ� ὀ� ὀ� ὃ� ὁ� ὁ� ὃ� ὁ� ὂ� ὂ�
ᾙ� ὁ� ᾚ� ᾘ� ᾙ� ὂ� ὀ� ὀ� ὃ� ὃ� ᾚ� ᾙ� ᾘ� ὃ� ὃ�❄️ ὂ� ὃ�
ᾚ� ᾚ� ᾚ� ᾙ� ᾚ� ὃ�

ὀ�⬛ὀ�ὃ�️ὃ� [150]

animal-bird [151] (18) ὂ� ᾘ� ᾘ� ὂ� ᾘ� ᾙ� ᾙ� ᾘ� ὁ� ὁ� ὂ� ὂ� ὂ� ὂ� ὂ� ὔ�️ ᾘ� ᾘ� ᾚ� ᾘ� ᾚ� ᾫ� ᾚ� ᾙ� ᾙ� ὔ�️ᾙ�ὂ�⬛ᾫ� [152]

animal-amphibian [153]

(1)
ὃ� ὃ� ὃ� [154]

animal-reptile [155] (8) ὀ� ὂ� ᾘ� ὀ� ὃ� ὀ� ᾙ�
ᾙ�

ὀ� ὂ� ᾘ� ὀ� ὃ� ὀ� ᾙ� ᾙ� ὃ� [156]

animal-marine [157]

(10)
ὃ� ὀ� ὂ� ᾘ� ὃ� ὀ� ὂ� ᾚ� ὁ� ὂ� ὂ� ᾘ� ὁ� ὁ� ὂ�ὀ� [158]

animal-bug [159] (16) ὁ� ᾚ� ᾘ� ὀ� ᾘ� ὁ� ὁ� ὁ� ᾫ� ὁ� ᾙ� ᾫ� ὗ� ὗ� ᾘ� ᾙ� ᾫ� ᾫ� ᾚ� ᾚ�ὁ� [160]

plant-flower [161] (10) ἳ� ἳ� Ὁ� ἳ� Ὂ� Ἷ�️ ἳ� ᾔ� ἳ� ἳ� ἳ� ἳ� ᾫ� [162]

plant-other [163] (13) ἳ� ἳ� ἳ� ἴ� ἳ� ἳ� ᾫ� ἳ� ἳ� ἳ� ἳ� ἳ� ἳ� ☘️ ἴ� ἴ� ἴ� ἴ� ἴ� ἳ� ᾫ� [164]

Food & Drink [165] (130)
⬇️ download [166]

https://unicode.org/emoji/charts/full-emoji-list.html#hand-single-finger
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/people_body/hand-single-finger
https://unicode.org/emoji/charts/full-emoji-list.html#hand-fingers-closed
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/people_body/hand-fingers-closed
https://unicode.org/emoji/charts/full-emoji-list.html#hands
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/people_body/hands
https://unicode.org/emoji/charts/full-emoji-list.html#hand-prop
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/people_body/hand-prop
https://unicode.org/emoji/charts/full-emoji-list.html#body-parts
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/people_body/body-parts
https://unicode.org/emoji/charts/full-emoji-list.html#person
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/people_body/person
https://unicode.org/emoji/charts/full-emoji-list.html#person-gesture
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/people_body/person-gesture
https://unicode.org/emoji/charts/full-emoji-list.html#person-role
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/people_body/person-role
https://unicode.org/emoji/charts/full-emoji-list.html#person-fantasy
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/people_body/person-fantasy
https://unicode.org/emoji/charts/full-emoji-list.html#person-activity
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/people_body/person-activity
https://unicode.org/emoji/charts/full-emoji-list.html#person-sport
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/people_body/person-sport
https://unicode.org/emoji/charts/full-emoji-list.html#person-resting
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/people_body/person-resting
https://unicode.org/emoji/charts/full-emoji-list.html#family
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/people_body/family
https://unicode.org/emoji/charts/full-emoji-list.html#person-symbol
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/people_body/person-symbol
https://unicode.org/emoji/charts/full-emoji-list.html#component
https://unicode.org/emoji/charts/full-emoji-list.html#hair-style
https://unicode.org/emoji/charts/full-emoji-list.html#animals_&amp;_nature
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/animals_nature/
https://unicode.org/emoji/charts/full-emoji-list.html#animal-mammal
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/animals_nature/animal-mammal
https://unicode.org/emoji/charts/full-emoji-list.html#animal-bird
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/animals_nature/animal-bird
https://unicode.org/emoji/charts/full-emoji-list.html#animal-amphibian
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/animals_nature/animal-amphibian
https://unicode.org/emoji/charts/full-emoji-list.html#animal-reptile
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/animals_nature/animal-reptile
https://unicode.org/emoji/charts/full-emoji-list.html#animal-marine
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/animals_nature/animal-marine
https://unicode.org/emoji/charts/full-emoji-list.html#animal-bug
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/animals_nature/animal-bug
https://unicode.org/emoji/charts/full-emoji-list.html#plant-flower
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/animals_nature/plant-flower
https://unicode.org/emoji/charts/full-emoji-list.html#plant-other
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/animals_nature/plant-other
https://unicode.org/emoji/charts/full-emoji-list.html#food_&amp;_drink
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/
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food-fruit [167] (19) ἴ� ἵ� ἴ� ἴ� ἴ� ἴ� ἴ� ἴ� ἴ� ᾖ� ἴ� ἴ� ἵ� ἵ� ἵ� ἵ� ᾭ� ᾕ� ἴ� ᾭ�
ᾖ�

ἵ� [168]

food-vegetable [169]

(15)
ἴ� ᾕ� ἴ� ᾕ� ᾕ� ἳ� ἳ�️ ᾭ� ᾕ� ᾖ� ᾖ� ᾜ� ᾜ� ᾕ� ἴ� ἳ� ᾭ� ᾕ� ᾭ� [170]

food-prepared [171]

(34)
ἷ� ἵ� ἵ� ᾕ� ᾕ� ᾭ� ᾖ� ᾖ� ᾕ� ᾜ� ᾜ� ἵ� ἵ� ᾖ� ᾕ� ἵ� ἵ� ἵ� ἲ� ᾖ�

ἲ� ἲ� ᾭ� ᾕ� ᾜ� ᾕ� ἷ� ᾕ� ἷ� ᾭ� ᾖ� ᾕ� ἷ� ᾜ� ᾜ� ᾖ�
[172]

food-asian [173] (17) ἵ� ἷ� ἵ� ἵ� ἵ� ἵ� ἵ� ἵ� ἶ� ἶ� ἶ� ἶ� ἶ� ᾖ� ἶ� ᾕ� ᾖ� ᾖ� [174]

food-marine [175] (5) ᾘ� ᾘ� ᾙ� ᾙ� ᾙ� ᾚ� [176]

food-sweet [177] (14) ἶ� Ἰ� ἶ� ἶ� ἶ� ἶ� ἶ� Ἰ� ἷ� ᾜ� ᾖ� ἶ� ἶ� ἶ� ἶ� ἶ� [178]

drink [179] (19) ἷ� ☕ ἷ� ᾕ� ᾭ� ☕ ἷ� ἷ� ἷ� ἷ� ἷ� ἷ� ἷ� ἷ� ᾔ� ᾔ� ᾖ� ᾜ� ᾜ� ᾜ� ᾜ� ᾭ� [180]

dishware [181] (7) ἷ�️ ᾖ� ἷ�️ ἷ� ᾔ� ὒ� ᾭ� Ἷ� [182]

Travel & Places [183]
⬇️ download [184]

place-map [185] Ὗ� ἱ� [186]

place-geographic [187]

(9)
Ἵ�️ Ἵ�️ ⛰️ ἰ� Ὗ� Ἵ�️ Ἵ�️ Ἵ�️ Ἵ�️ Ἵ�️ Ἵ�️ [188]

place-building [189] Ἷ� Ἵ�️ ᾟ�Ἵ�️ Ἶ� Ἶ� [190]

place-religious [191] ὔ� ⛩️ ⛪ [192]

place-other [193] ἰ� ἰ� ⛲ ⛺ ἰ� ἰ� Ἵ� ἰ� ἰ� ἰ� ἰ� ἰ� ♨️ Ἲ� Ὥ� Ἲ� Ἲ� Ὀ� Ἲ� [194]

transport-ground [195] Ὡ� Ὡ� Ὡ� Ἴ�️ Ὡ� Ὡ�
Ἴ�️ Ὡ�Ὢ�

Ὡ� Ὡ� Ἴ�️ Ὡ� Ὧ� Ὧ� Ὦ� Ὡ� Ὧ� Ὢ� Ὡ� Ἴ�️ Ὥ� Ὣ� Ὡ�
Ὡ� Ὡ� Ὧ� Ὧ�

[196]

transport-water [197] Ὢ� ⛵ Ὧ� Ὢ� ⛵ Ὧ� Ὢ� [198]

transport-air [199] ᾨ� Ὠ� Ὠ� Ὧ� ᾨ� Ὠ� Ὧ�️ ✈ Ὦ� ✈ Ὦ� [200]

hotel [201] Ὤ�️ ᾟ� [202]

time [203] ⌚ ὕ� ⏳ [204]

sky & weather [205] ❄️ ὒ�⚡ ἰ� ἰ�⚡ ☔ ἲ�️ ☀️ ἰ� ᾩ� ☄️ ἱ� ἲ� ἲ� ⚡ [206]

Activities [207]
⬇️ download [208]

event [209] Ἰ� Ἰ� Ἰ� Ἰ� ✨ ᾞ� Ἱ�️ ✨ [210]

award-medal [211] Ἱ� Ἴ� Ἱ� [212]

sport [213] Ἴ� Ἳ� ⚽ ⚽ Ἴ� Ἵ� ᾔ� Ἳ� ᾔ� ⛳ Ἳ� ᾔ� Ἳ� [214]

game [215] Ἲ� Ἳ� ᾟ� ὗ�️ Ἲ� Ἳ� Ἲ� ᾞ� ᾪ� [216]

arts & crafts [217] ᾟ� Ἲ� Ὓ�️ Ἲ� ᾟ� ᾪ� ᾟ� ᾪ� [218]

Objects [219]
⬇️ download [220]

clothing [221] ᾗ� ὅ� ὗ� ᾗ� ᾗ� ᾛ� ὅ� ὅ� ὅ� ᾞ� ᾞ� ᾞ� ᾞ� ὅ� ὅ� ᾗ� ᾧ� ᾧ� ᾧ�
ὅ� ὅ� ὅ� ὅ� ὅ� Ὤ�️ Ἱ� ᾧ� ὅ� ὅ� ᾗ� ᾗ� ὆� ὆� ᾧ� ὆� ὅ� ὅ�
Ἲ� Ἱ� ᾞ� ᾩ� ⛑️ ὏� Ὀ� Ὀ�Ὀ�

[222]

https://unicode.org/emoji/charts/full-emoji-list.html#food-fruit
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-fruit
https://unicode.org/emoji/charts/full-emoji-list.html#food-vegetable
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-vegetable
https://unicode.org/emoji/charts/full-emoji-list.html#food-prepared
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-prepared
https://unicode.org/emoji/charts/full-emoji-list.html#food-asian
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-asian
https://unicode.org/emoji/charts/full-emoji-list.html#food-marine
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-marine
https://unicode.org/emoji/charts/full-emoji-list.html#food-sweet
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/food-sweet
https://unicode.org/emoji/charts/full-emoji-list.html#drink
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/drink
https://unicode.org/emoji/charts/full-emoji-list.html#dishware
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/food_drink/dishware
https://unicode.org/emoji/charts/full-emoji-list.html#travel_&amp;_places
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/travel_places/
https://unicode.org/emoji/charts/full-emoji-list.html#place-map
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/travel_places/place-map
https://unicode.org/emoji/charts/full-emoji-list.html#place-geographic
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/travel_places/place-geographic
https://unicode.org/emoji/charts/full-emoji-list.html#place-building
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/travel_places/place-building
https://unicode.org/emoji/charts/full-emoji-list.html#place-religious
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/travel_places/place-religious
https://unicode.org/emoji/charts/full-emoji-list.html#place-other
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/travel_places/place-other
https://unicode.org/emoji/charts/full-emoji-list.html#transport-ground
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/travel_places/transport-ground
https://unicode.org/emoji/charts/full-emoji-list.html#transport-water
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/travel_places/transport-water
https://unicode.org/emoji/charts/full-emoji-list.html#transport-air
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/travel_places/transport-air
https://unicode.org/emoji/charts/full-emoji-list.html#hotel
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/travel_places/hotel
https://unicode.org/emoji/charts/full-emoji-list.html#time
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/travel_places/time
https://unicode.org/emoji/charts/full-emoji-list.html#sky_&amp;_weather
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/travel_places/sky-weather
https://unicode.org/emoji/charts/full-emoji-list.html#activities
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/activities/
https://unicode.org/emoji/charts/full-emoji-list.html#event
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/activities/event
https://unicode.org/emoji/charts/full-emoji-list.html#award-medal
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/activities/award-medal
https://unicode.org/emoji/charts/full-emoji-list.html#sport
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/activities/sport
https://unicode.org/emoji/charts/full-emoji-list.html#game
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/activities/game
https://unicode.org/emoji/charts/full-emoji-list.html#arts_&amp;_crafts
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/activities/arts-crafts
https://unicode.org/emoji/charts/full-emoji-list.html#objects
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/objects/
https://unicode.org/emoji/charts/full-emoji-list.html#clothing
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/objects/clothing
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sound [223] ὐ� [224]

music [225] Ἳ� Ἳ�Ἳ� Ἳ� Ἱ�️ Ἱ�️ Ἱ�️ Ἲ� Ἲ� ὏� [226]

musical-instrument
[227]

Ἳ� Ἳ� Ἳ�Ἳ� Ἳ� [228]

phone [229] ὏� Ὅ� ὏� [230]

computer [231] ᾞ� ὐ�Ὃ� ᾞ� [232]

light & video [233] ὏� Ὂ� ὏� [234]

book-paper [235] Ἷ�️Ὅ� Ὅ� Ἷ�️ Ὅ� [236]

money [237] ᾩ� Ὃ� ᾩ� [238]

mail [239] ὎� ✉ ὎� [240]

writing [241] ὘�️ ✏️ ✒️ ὘�️ ὘�️ ὘�️ ὘�️ Ὅ� ὘�️ [242]

office [243] Ὄ� Ὄ�Ὄ� Ὄ� [244]

lock [245] Ὕ� ὑ�Ὕ� Ὕ� [246]

tool [247] ᾩ� ὒ� ὒ� ὑ� ὒ� ᾩ� ⛏ ⚒️ Ὦ�️ ὞�️ ⚔️ ὒ� ᾨ� Ἷ� Ὦ�️ ᾩ� ὒ� ᾩ� ὒ�
⚙️ Ὕ�️ ᾚ� ὑ� ⛓️ ᾩ� ᾟ� ᾟ� ᾩ�

[248]

science [249] ᾞ� ᾞ� ⚗️ ᾞ� ᾞ� ὒ� ὒ� ᾞ� [250]

medical [251] ᾧ� ᾧ� Ὀ� Ὀ� ᾧ� ᾧ� ᾧ�ᾧ� ᾧ� [252]

household [253] Ὥ� ᾩ� Ὤ�️ Ὤ� ᾟ� ᾟ� Ὣ� ᾟ� ᾟ� ᾪ� Ὥ� ᾮ� Ὥ� [254]

other-object [255] ᾪ� Ὢ� ⚰️ ᾪ� ⚱️ Ὗ� ᾪ� ᾪ� [256]

Symbols [257]
⬇️ download [258]

transport-sign [259] Ὣ� Ὣ� [260]

warning [261] ☢️ ☣️ Ὢ� ☢️ ὑ� [262]

arrow [263] ὐ� ὐ� ὐ� [264]

religion [265] ☯ ☮️ ☯ [266]

zodiac [267] ♎ ♊ ♋ ♎ [268]

av-symbol [269] ὐ� ὐ� ὐ� [270]

gender [271] ⚧️ ⚧️ [272]

math [273] ✖ ♾️ ✖ ✖ [274]

punctuation [275] ❓ ‼️❓ ❓ [276]

currency [277] Ὃ� Ὃ� Ὃ� [278]

other-symbol [279] ὓ� ♻️ ⚕️ὓ� ὓ� [280]

keycap [281] *️⃣ #️⃣*️⃣ *️⃣ [282]

alphanum [283] Ἑ� ἥ�㊗️Ἑ� Ἑ� [284]

https://unicode.org/emoji/charts/full-emoji-list.html#sound
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/objects/sound
https://unicode.org/emoji/charts/full-emoji-list.html#music
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/objects/music
https://unicode.org/emoji/charts/full-emoji-list.html#musical-instrument
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/objects/musical-instrument
https://unicode.org/emoji/charts/full-emoji-list.html#phone
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/objects/phone
https://unicode.org/emoji/charts/full-emoji-list.html#computer
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/objects/computer
https://unicode.org/emoji/charts/full-emoji-list.html#light_&amp;_video
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/objects/light-video
https://unicode.org/emoji/charts/full-emoji-list.html#book-paper
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/objects/book-paper
https://unicode.org/emoji/charts/full-emoji-list.html#money
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/objects/money
https://unicode.org/emoji/charts/full-emoji-list.html#mail
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/objects/mail
https://unicode.org/emoji/charts/full-emoji-list.html#writing
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/objects/writing
https://unicode.org/emoji/charts/full-emoji-list.html#office
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/objects/office
https://unicode.org/emoji/charts/full-emoji-list.html#lock
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/objects/lock
https://unicode.org/emoji/charts/full-emoji-list.html#tool
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/objects/tool
https://unicode.org/emoji/charts/full-emoji-list.html#science
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/objects/science
https://unicode.org/emoji/charts/full-emoji-list.html#medical
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/objects/medical
https://unicode.org/emoji/charts/full-emoji-list.html#household
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/objects/household
https://unicode.org/emoji/charts/full-emoji-list.html#other-object
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/objects/other-object
https://unicode.org/emoji/charts/full-emoji-list.html#symbols
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/
https://unicode.org/emoji/charts/full-emoji-list.html#transport-sign
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/transport-sign
https://unicode.org/emoji/charts/full-emoji-list.html#warning
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/warning
https://unicode.org/emoji/charts/full-emoji-list.html#arrow
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/arrow
https://unicode.org/emoji/charts/full-emoji-list.html#religion
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/religion
https://unicode.org/emoji/charts/full-emoji-list.html#zodiac
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/zodiac
https://unicode.org/emoji/charts/full-emoji-list.html#av-symbol
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/av-symbol
https://unicode.org/emoji/charts/full-emoji-list.html#gender
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/gender
https://unicode.org/emoji/charts/full-emoji-list.html#math
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/math
https://unicode.org/emoji/charts/full-emoji-list.html#punctuation
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/punctuation
https://unicode.org/emoji/charts/full-emoji-list.html#currency
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/currency
https://unicode.org/emoji/charts/full-emoji-list.html#other-symbol
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/other-symbol
https://unicode.org/emoji/charts/full-emoji-list.html#keycap
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/keycap
https://unicode.org/emoji/charts/full-emoji-list.html#alphanum
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/alphanum
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geometric [285] ὓ� [286]

Flags [287]
⬇️ download [288]

flag [289] Ἷ�️ἰ� [288]

country-flag [290] ἟�἟� ἞�἞� ἞�἞� ἞�἟�
἞�἞�

἞�἞� ⬇️ [291]

subdivision-flag [292] Ἷ������� [293]

Other elements (our creations)
Fichiers/Files/Dateien de/of/für Patchs & Appliqués ⬇️ download [75]

Various hacks, extra elements, modifications ⬇️ download [294]

Autres informations
Unicode® Emoji Charts v14.0 a été publié en sept. 2021 et fin octobre 2021 les nouveaux symboles étaient encore
peu implémentés. Embroidery designs (both design and machine files) created within the emoji embroidery project
© 2021 by Daniel K. Schneider (Faclab [295], University of Geneva / Arbores TECH SARL & Lydie Boufflers
(TECFA [296], University of Geneva). Les motifs sont mise à disposition avec une licence: Attribution-ShareAlike
4.0 International [78]. Consultez Emoji embroidery project copyrights pour plus de détails SVP.
Voir aussi: Emoji, InkStitch - broder un emoji, Stitch Era - broder un emoji, Atelier upcycling avec des broderies
émoji, et la Emoji table v.13 [22] (Wikimedia commons)

Liens

Fichiers emoji
• Twemoji [74] de Twitter (requires technical skills, i.e. pulling a GitHub archive): format SVG et PNG
• OpenMoji.org [297] (as of Nov 2020, supports version 13): format SVG et PNG
• Noto Emoji [73] fonts de Google (requires technical skills, pulling a GitHub archive): format SVG et PNG

Catalogues emoji
• Unicode® Emoji Charts v13.1 [298] Listes officielles pour la version 13.1.

• Liste de base avec le nom des emoji [299]

• Liste avec images de différents vendeurs [300]

• OpenMoji.org [297] permets de chercher des emoji avec leur nom (en Anglais) et de télécharger des images
• decodeunicode.org [301]

• Emojipedia [4]

https://unicode.org/emoji/charts/full-emoji-list.html#geometric
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/symbols/geometric
https://unicode.org/emoji/charts/full-emoji-list.html#flags
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/flags/flag
https://unicode.org/emoji/charts/full-emoji-list.html#flag
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/flags/flag
https://unicode.org/emoji/charts/full-emoji-list.html#country-flag
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/flags/country-flag
https://unicode.org/emoji/charts/full-emoji-list.html#subdivision-flag
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/flags/subdivision-flag
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/AA_PATCH_APPLIQUE/
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/z_variations_combis
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji_Embroidery_Project
http://faclab.ch/
http://tecfa.unige.ch/
https://creativecommons.org/licenses/by-sa/4.0/deed.fr
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji_embroidery_project_copyrights
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Emoji
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Stitch_Era_-_broder_un_emoji
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Atelier_upcycling_avec_des_broderies_%C3%A9moji
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Atelier_upcycling_avec_des_broderies_%C3%A9moji
https://commons.wikimedia.org/wiki/Emoji/Table
https://twemoji.twitter.com/
https://openmoji.org/
https://github.com/googlefonts/noto-emoji
https://www.unicode.org/emoji/charts-13.1/index.html
https://www.unicode.org/emoji/charts-13.1/emoji-list.html
https://www.unicode.org/emoji/charts-13.1/full-emoji-list.html
https://openmoji.org/
https://decodeunicode.org/en/search/search
https://emojipedia.org/


InkStitch - broder un emoji 144

Modification de copyright
• Pour les emoji noto ("noto" dans le nom de fichier): Apache 2.0 [302]

Autorisé: Utilisation commerciale, modifications, distribution. Pas de trademark.
Obligations: garder ce copyright

• Pour les emoji twitter ("twemoji" dans le nom de fichier): Attribution 4.0 International (CC BY 4.0) [4]]
Autorisé: Copier, distribuer et communiquer le matériel par tous moyens et sous tous format
Obligations: Garder ce copyright, attribuer l'oeuvre à twemoji [303] dans une "Readme", about, etc.

• Pour les openmoji ("openmoji" dans le nom de fichier"): Attribution 4.0 International (CC BY 4.0) [4]]
Autorisé: Copier, distribuer et communiquer le matériel par tous moyens et sous tous format
Obligations: Garder ce copyright, attribuer l'oeuvre à openmoji [304]
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http://faclab.ch/
http://tecfa.unige.ch/
https://openmoji.org/
https://www.unicode.org/emoji/charts-13.1/index.html
https://www.unicode.org/emoji/charts-13.1/emoji-list.html
https://www.unicode.org/emoji/charts-13.1/full-emoji-list.html
https://decodeunicode.org/en/search/search
https://github.com/googlefonts/noto-emoji/blob/master/LICENSE
https://github.com/twitter/twemoji
https://github.com/hfg-gmuend/openmoji
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Guide_de_tutoriels_de_broderie_machine
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
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•• InkStitch - broder des patchs et des appliqués
•• InkStitch - astuces et problèmes courants
•• InkStitch - bases SVG
•• Inkscape - édition des chemins
•• InkStitch - broder avec du gros fil
•• InkStitch - broderies à partir de dessins faits à la main
•• InkStitch - points manuels
•• InkStitch - points programmables
Catégorie: InkStitch

Utiliser une image issue de The Noun Project
Dans cet article, nous apprendrons à créer une broderie à partir de dessins SVG simples, comme on peut en trouver
sur le site The noun project [1]. Sur ce site, on peut trouver une énormément de dessins qui peuvent être combinés,
pour créer une broderie originale. Pour cet exemple, nous avons choisi quatre dessins différents issus du site.
Ci-dessous se trouvent les étapes détaillées pour la création de cette broderie.
Une page en anglais existe pour la même démarche.
Téléchargement de images

• Prendre quatre oiseaux issus du site The Noun Project (s'inscrire sur le site pour télécharger les images libres de
droits.) Pour l'exemple, des oiseaux [4], créés par Liv Iko, ont été téléchargés.

•• Choisir quatre oiseaux différents.
•• Télécharger les images en .SVG
• Ouvrir les images dans Inkscape (Fichier -> importer -> sélectionner les quatre fichiers des oiseaux)
•• Enlever le texte comportant le nom de l'auteur. Si les broderies sont publiées, il est impératif de citer le nom de

l'auteur dans la publication. Pour enlever l'écriture, il faut sélectionner l'image, puis aller dans le menu déroulant
Objet et cliquer sur Dégrouper. Chaque élément est sélectionné individuellement. Enlever la sélection des oiseaux
et effacer celles des textes.

•• Enregistrer le fichier en l'appelant p.ex. oiseaux.svg
Pour éviter cette étape, il est possible de télécharger directement les exemples ci-dessous. Attention à télécharger le
fichier .svg et à l'ouvrir dans Inkscape. N'oubliez pas de créditer Liv Iko pour toute publication des dessins.

Quatre oiseau de Liv Iko

Fichier avec 4 oiseaux sur InkStitch [2]

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cat%C3%A9gorie:InkStitch
https://thenounproject.com
http://edutechwiki.unige.ch/en/InkStitch_-_stitch_files_from_Noun_Project_icons#Simplify
https://thenounproject.com/liv_iko/collection/birds/?i=898697
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AQuatre_oiseaux_InkStitch.png
https://edutechwiki.unige.ch/en/File:Inkstitch-birds-0.svg
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Broder des surfaces en couleur - exemple des oiseaux
Après avoir téléchargé les images depuis le site The Noun Project ou avoir récupéré le fichier ci-dessus, faire les
étapes suivantes :

Position et taille
•• Disposer les images, p.ex sur la ligne du bas et ajuster aussi la taille de chaque oiseau afin que l'ensemble tienne

dans l'espace à disposition pour broder (p.ex un cercle).
•• Sauvegarder le fichier
•• Chaque oiseau est composé d'un simple chemin SVG. Il faudra changer ces chemins pour créer une jolie broderie

colorée.

Un chemin par oiseau

Découper les chemins
• Pour découper les chemins, sélectionner tous les oiseaux (Édition -> Sélectionner tout). Puis dans le menu

Chemin -> Séparer.
•• Les oiseaux sont maintenant transformés en formes noires.
•• Enregistrer

Oiseaux avec les chemins séparés

Il est possible de télécharger directement ce fichier ici [3].

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AUn_chemin_par_oiseau.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AOiseaux_avec_les_chemins_s%C3%A9par%C3%A9s.png
https://edutechwiki.unige.ch/mediawiki/images/5/5c/Inkstitch-birds-2.svg
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Mise en couleur
Les oiseaux ont été transformés en d'objets qu'il faut passer en couleur. Parfois il y a plusieurs couches superposées.
Pour chaque objet, y compris les fond noirs, il faut :
•• Ajouter un fond de couleur
•• Enlever la couleur des contours
La façon la plus simple de procéder consiste à :
•• Ouvrir le menu Fond et contour qui se trouve à droite de la fenêtre principale
•• Ouvrir le menu Objets sur la même fenêtre
•• Sélectionner individuellement chaque "path" (chemin) dans le menu Objet
•• Définir la couleur du "path" dans le menu Fond et supprimer le contour s'il y en a un.

Passer chaque élément en couleur

Simplifier
Actuellement, il y a jusqu'à trois couches de noir. Cela est trop épais pour être brodé. Pour y remédier, il va falloir
suivre les étapes suivantes :
•• Sélectionner les différentes parties en couleur en cliquant dessus.
• Les dupliquer (Édition -> Dupliquer).
•• Déplacer les parties en couleur dupliquées.
•• Sélectionner à nouveau les parties en couleur ainsi que le contour noir sur l'oiseau.
• Dans le menu Chemin -> Différence. Les parties en couleur ont disparu.
•• Positionner les parties en couleur qui ont été dupliquée sur l'oiseau.
•• Les agrandir légèrement pour qu'elles débordent sur le noir.
•• Dans la fenêtre sur la droite de l'écran, ouvrir le menu Objet cliquer sur la flèche verte "Descendre à l'arrière-plan"

afin qu'au moment de broder, le fond soit brodé avant le pourtour. Cela permet d'obtenir de belles finitions.
• Cliquer sur le menu Fichier -> Nettoyer le document

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APasser_chaque_%C3%A9l%C3%A9ment_en_couleur.png
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Créer deux calques
Cela n'est pas obligatoire, mais il est important d'avoir le réflexe de créer différents calques pour y mettre les
différents groupes d'éléments du dessin.
•• Créer un nouveau calque et le nommer "Fonds"
•• Sélectionner tous les fonds et les déplacer dans ce calque
•• Renommer le calque avec les lignes noires "Contours"

Paramétrer
Dans un dessin .SVG il n'y a que des surfaces remplies. Le plugin de broderie va les transformer en surfaces
remplies avec des lignes, qui représentent les points de broderie. Il est aussi possible de changer l'angle des points et
leur longueur.
•• Cacher le calque nommé "Contours"
• Ouvrir Extension -> Ink/Stitch -> Paramètres. Cela permettra de paramétrer les points de broderie
•• Ajouter Arrêt et Couper si la machine à broder est équipée de plusieurs aiguilles
•• Augmenter la densité des points (minimum 0,2mm par ligne / 5 lignes par mm)
•• Changer les autres valeurs ou juste cliquer sur Appliquer et quitter (il n'est pas nécessaire de changer autre chose

pour ce modèle).
•• Refaire ces différents points avec le calque "Contours". Pour cela le faire apparaître et cacher le calque "Contour"

Créer la broderie
•• Pour commencer vérifier que la broderie ne contient pas trop de couleurs (faire attention que tous les oranges

soient les mêmes, par exemple).
•• Mettre les calques des mêmes couleurs les unes à côtes des autres si la machine ne possède qu'une aiguille

(utiliser l'outil Objet pour le faire).
•• Broder les éléments les plus imposants en premier. Pour cela mettre les "paths" leur correspondant en bas de la

liste des calques.
•• Mettre les "paths" des contours en haut de la liste des calques. En général, les contours sont brodés en dernier.
•• Montrer tous les calques qui seront brodés. Pour cet exemple, il y en a deux : "Contours" et "Fonds"
• Choisir Extension -> Ink/Stitch -> Broder...
•• Enregistrer le fichier sous un format .pes ou .dst (vérifier quel format de fichier correspond à la machine utilisée).

Oiseau avec 2 couches pour le remplissage. Télécharger le fichier SVG [4]. Auteur du fichier: Daniel K. Schneider

http://edutechwiki.unige.ch/mediawiki/images/8/84/Inkstitch-birds-4.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AOiseaux_avec_deux_couches_de_broderie.png
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Fichier .SVG [5] avec deux couches, sous-couches et chevauchements. Auteur du fichier: Daniel K. Schneider

Lors de la simulation, le résultat apparaît comme ici (.dst donne les mauvaises couleurs, mais cela n'est pas grave, car
il arrive rarement que l'on brode avec une machine à 16 aiguilles).
Comme on peut le voir, il y a aussi quelques fils supplémentaires dus au passage de l'aiguille d'un oiseau à un autre.
Ces fils pourront être coupés à l'aide de ciseaux.

Simulation des broderies .dst. Auteur du fichier: Daniel K. Schneider

Simulation de broderie .pes. Auteur du fichier: Daniel K. Schneider

Réalisation
La broderie finie n'est pas optimale pour deux raisons:
•• Les bords noirs sont brodés comme des lignes pleines à la place d'être brodés en points satin. Il aurait aussi fallu

broder une sous-couche.
•• Le remplissage couleur ne passe pas sous les contours et cela laisse un espace non brodé.
•• Les contours noirs ne sont pas nets. Cela peut être dû à la tension du fil, au contour mal défini ou à l'aiguille qui

doit être remplacée.

http://edutechwiki.unige.ch/mediawiki/images/2/2c/Inkstitch-birds-6.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AOiseaux_avec_deux_couches_de_broderie.png
http://edutechwiki.unige.ch/en/File:Inkstitch-imported-birds-4.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASimulation_des_broderies_.dst.png
http://edutechwiki.unige.ch/en/File:Inkstitch-imported-birds-5.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASimulation_de_broderie_.pes.png
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Broderie des oiseaux en cours. Auteur du fichier: Daniel K. Schneider

La deuxième version en .pes utilise une sous-couche pour les parties remplies en couleur.

Broderie des oiseaux. Première ligne en .dst, deuxième ligne en .pes. Auteur de la broderie: Daniel K. Schneider

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ABroderie_des_oiseaux_en_cours.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ABroderie_des_oiseaux.png


InkStitch - broder une image issue de The Noun Project 156

Broder les contours en points satin
Pour obtenir des points satins, il faut remplace les bords noirs par deux traits fins. Pour cela, suivre l'explication
ci-dessous ou aller directement sur la page en anglais InkStitch - satin columns [6].
•• Retourner à une version ultérieur de l'image SVG (après avoir rompu les chemins (point 2.2))
•• Sélectionne l'objet sur lequel seront brodés les points satin
•• Faire deux copies
• Créer un "inset" et un "outset": menu Chemin -> Inset et menu Chemin -> Outset
•• Réduire le trait
•• Enlever le remplissage
•• Vérifier que les deux traits aient le même nombre de points et supprimer ceux qui sont superflus.
•• Si besoin, corriger les lignes de direction pour qu'elles aient toutes dans le même sens.
•• etc.
Pour un exemple plus détaillé des oiseaux, allez sur la page en anglais Adding direction lines [7].
Pour terminer, si vous souhaitez remplir l'intérieur des oiseaux et les contours avec des points satins, allez sur la page
InkStitch - from satin columns to fills with satin borders [8]

Remplir avec le point satin - exemple avec le dessin "Love" de Louis Prado
Avant d'essayer cet exemple, assurez-vous d'avoir compris la procédure expliquée dans InkStitsch - satin columns
[6]. Vous devriez savoir:
•• ajouter, enlever des noeuds
•• briser un chemin
•• ajouter des rails

Télécharger et disposer l'image
Pour cet exemple, nous allons utiliser l'illustration love [9] par Louis Prado
•• Télécharger le fichier SVG. Il ne faut pas oublier de nommer l'auteur et de copier la licence si vous n'êtes pas un

membre du the Nounproject.com
•• Ouvrir l'image dans Inkscape et dégrouper les objets
•• Ajuster la taille
•• Changer les couleurs de remplissage
•• Ajouter des bords
•• Créer un layer appelé "love"
•• Insérer tous les objets

https://edutechwiki.unige.ch/en/InkStitch_-_satin_columns
https://edutechwiki.unige.ch/en/InkStitch_-_satin_columns#Adding_direction_lines_.28rungs.29
https://edutechwiki.unige.ch/en/InkStitch_-_from_satin_columns_to_fills_with_satin_borders
https://edutechwiki.unige.ch/en/InkStitch_-_satin_columns
https://thenounproject.com/search/?q=love&i=15070#
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Love légèrement modifié. Source Love [9].
Auteur du fichier: Daniel K. Schneider

Ce fichier peut être brodés tel quel. Les bords seront réalisés en zigzags.

Ajouter les contours en points satin
Pour pouvoir créer les contours en points satin, il faut enlever le remplissage et transformer les contours en chemins
(Chemin -> Objet en chemin)
Copier et déplacer tous les objets dans un nouveau layer

•• Créer un nouveau layer et le nommer "Contours"
•• Sélectionner tous les objets et les copier
• Sélectionner les objets copiés et coller sur place (Edition -> Coller sur place ou Ctrl+Alt+V)
Créer les contours pour le point satin

•• Cacher le layer nommé Love
•• Sélectionner tous les objets
•• Enlever le remplissage des personnages
•• Changer la taille des contours, p.ex. 3mm (facultatif)
• Menu Chemin -> Objets en chemin. Cela crée de nouveaux objets en chemin
•• Enlever le remplissage des contours
•• Changer la taille du contour (0,1mm)
Pour ajouter des rails

•• Sélectionner p.ex. la tête de la femme
•• Cliquer sur l'outil d'édition des noeuds
•• Cliquer sur Majuscule et garder la touche enfoncée
•• Cliquer sur l'outil pour tracer les courbes de Bézier
•• Dessiner les rails
Maintenant qu'il y a des rails pour la colonne de satin, si le message d'erreur error: satin column: object path5452-3
has two paths with an unequal number of points (34 and 29) apparaît, il faut enlever ou ajouter des rails pour qu'ils
soient égaux en nombre.
Ajuster la direction des rails

• S'assurer que la direction des rails soit visible (Edition -> Préférences -> Noeuds -> Afficher la direction des
chemins sur le contour)

•• Sur le dessin, cliquer sur le contour
• Chemin -> Inverser

https://thenounproject.com/search/?q=love&i=15070#
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALove_l%C3%A9g%C3%A8rement_modifi%C3%A9._Source_Love._Auteur_du_fichier-_Daniel_K._Schneider.png
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Couper

•• Sélectionner deux noeuds qui se font face, en maintenant enfoncée la touche majuscule
• Chemin-> Séparer
Tester la broderie

•• Sélectionner tous les paths
• Menu Extension -> Ink/Stitch -> Paramètres
•• Ouvrir l'onglet de Colonne Satin et cliquer dans la case Colonne satin personnalisée
•• Il est possible d'ajouter une sous-couche (facultatif)

Améliorer les points de broderie
•• Pour que la broderie soit plus harmonieuse, sélectionner l'onglet Auto-remplissage et changer l'angle de 0 à 30°

ou changer les autres paramètres.

Résultat

SVG version 4 (8cm) SVG Version 5 (5cm) Simulation de la broderie

Le résultat de la broderie est correct pour la version de 8cm. La première version à 5cm, en bleu, a trop de
remplissage et il dépasse un peu du contour (en haut à droit sur la photo ci-dessous). Une version corrigée (en bas à
droite, en rouge) a permis de réduire le remplissage.

Brodeuse en action Résultat des broderies. 1x8cm et 2x5cm.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APrado-love-4.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APrado-love-5.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ALove-inkstitch_preview.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APrado-love-inkstitch-1.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APrado-love-inkstitch-2.jpg
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Copyright et modifications
Le contenu de cette page, y compris les images et fichiers .svg sont utilisable sous la licence GNU et l'attribution
internationale 4.0 de Crative Commons (CC BY 4.0) [4].
The Inkstitch project peut utiliser librement tous les éléments de cette page, pour la documentation officielle, sans
avoir besoin de citer la source.
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InkStitch - broder des codes QR

Guide de tutoriels de broderie machine

Module: InkStitch
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Prérequis
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•• Inkstitch - textures de remplissage
•• InkStitch - lettrage
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•• InkStitch - exemples colonnes satin
•• InkStitch - broder un emoji
•• InkStitch - broder une image issue de The Noun Project
•• InkStitch - broder des codes QR
•• InkStitch - broder des patchs et des appliqués
•• InkStitch - astuces et problèmes courants
•• InkStitch - bases SVG
•• Inkscape - édition des chemins
•• InkStitch - broder avec du gros fil
•• InkStitch - broderies à partir de dessins faits à la main
•• InkStitch - points manuels
•• InkStitch - points programmables
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Catégorie: InkStitch

Introduction

Qu'est-ce qu'un QR Code ?

Exemple de QR Code

Le QR code un type de code-barre, mais sous forme de carré contenant une multitude de zones noires.

Quelques précautions avant de créer le QR code
Pour réaliser une broderie d'un QR code, il faut garder à l'esprit qu'une imprimante broderie à ses limites concernant
la finition des coutures. Ainsi, il est nécessaire que le QR code à réaliser ne soit pas trop complexe, ne contienne pas
de trop nombreuses petites parties noires, ni de logo. Une broderie demandant trop de finesse risque de ne pas bien
sortir et le QR code sera donc inutilisable.

Créer un QR code simple pour InkStitch

Créer le QR code
Il existe de nombreux outils en ligne pour générer des codes QR et pouvoir les personnaliser.
ici, nous allons utiliser l'outil gratuit qrcode-monkey [1] qui permet les actions essentielles comme:
•• Générer un code QR pour différentes résolutions
•• Ajouter une image
•• Exporter au format SVG (InkStitch n'accepte que ce format d'image !)
Sur les captures d'écran, vous pouvez voir les 4 étapes à suivre pour créer un code QR avec le style par défaut.
1. Entrez le contenu du code QR. ATTENTION, il est grandement recommandé de taper l'URL en majuscule (pas

comme dans l'image) puisque cela permettra de générer un code QR plus simple et donc plus facilement brodable.
2.2. Choisissez la résolution sachant que 400px est plus ou moins égal à 8cm.
3.3. Cliquer sur "Create QR Code"
4.4. Cliquer sur SVG pour exporter le code.
Code QR avec URL en minuscule (non-recommandé car QR code trop complexe pour la machine à broder)

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cat%C3%A9gorie:InkStitch
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AQR_code_broderie.png
https://www.qrcode-monkey.com/
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Code QR avec URL en majuscule (recommandé ! On voit bien que cela simplifie grandement la broderie)

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ACode_QR_basse_r%C3%A9solution_avec_url_en_minuscule.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ACode_QR_basse_r%C3%A9solution_avec_URL_en_majuscule.png


InkStitch - broder des codes QR 162

Créer la broderie en SVG
Le code produit par QR Code Monkey possède la structure suivante:
•• Un unique groupe parent.
•• Plusieurs groupes imbriqués composés principalement de rectangle SVG. Seulement les 3 grands rectangles sont

en fait des "Path Object".

Il est maintenant nécessaire d'effectuer quelques modifications à notre fichier SVG. Pour cela, suivez les étapes
suivantes:
(1) Optimisation de l'image SVG

• Tout d'abord, enregistrez le fichier au format SVG optimisé (Menu Fichier -> Enregistrer sous; sélectionnez
"SVG optimisé").

•• Fermez et réouvrez le fichier.
(2) Tout dégrouper

•• Tout sélectionner
• Dégroupez (CTRL-SHIFT-G) au moins trois fois car les figures noires sont assez complexes par endroit (surtout

si vous avez entré un URL en minuscule).
• Créer un calque (Menu Calque -> Ajouter Calque)
• Déplacer tous les objets dans ce calque (Tout sélectionner, Menu Calque->Déplacer la sélection dans calque)
(3) Transformer tous les objets en "Path SVG" ("Chemin SVG")

• Sélectionnez tous les objets et transformez-les en "Path" (Menu Path -> Object to Path) (fr: Menu Chemin ->
Objets en chemin). ATTENTION, Cela peut prendre un certain temps en cas de dessin complexe.

(3) Remplir les objets avec de la couleur

•• Tout sélectionner
•• Effacez les bordures

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AQR_Code_Monkey_-_SVG_Structure.png
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•• Définir une couleur de remplissage (La couleur choisie n'est pas importante. Vous choisirez la couleur finale du
fil sur la machine de broderie)

(3) Effacer 3 rectangles en trop

•• Les trois grands rectangles sont composés de trois rectangles, et l'un de ces trois rectangle est un espace blanc.
Vous pouvez effacer ces espaces blancs car le fond blanc de base suffit.

Résultat
Dans InkScape

Ce code QR créé jusqu'ici est plutôt grand (10,5 cm). Il est possible de le réduire de 50% afin d'être contenu sur un
patch. Ci-dessous, nous avons créé une version 9 cm. Vous pouvez directement coudre le code QR sur un tissu ou
créer un badge. Pour créer un badge, il existe un patch à intégrer à votre travail dans InkScape. Dans le cas où vous
utiliseriez ce patch [2], il faudra adapter la taille de votre code QR afin qu'il entre dans le grand cercle vert (vous
pourrez supprimer les deux cercles verts par la suite). N'oubliez pas de transformer en chemin les divers cercle en
bordure.
Dans les deux cas, vous devrez exporter votre travail au format DST.
Sur la machine à broder

Si vous imprimez directement le code QR sur un tissu, choisissez un tissu de préférence blanc (ou de couleur très
claire) et les fils de couleurs selon votre goût, mais d'une seule et même couleur. Il est recommandé que votre QR
code soit blanc et noir, mais des fils de couleur très foncée (bleu marine, bordeaux ou vert foncé) feront l'affaire lors
de la lecture du code QR par un lecteur.
Si vous souhaitez créer un badge avec le patch, il faudra mettre un "STOP" sur votre machine à aiguilles multiples.
Le STOP doit être programmé juste après le premier cercle de positionnement afin que vous puissiez placer le badge
dans le cercle créé. Comme pour l'option avec un tissu, choisissez un badge de couleur blanc ou de couleur claire et
des fils de couleur foncée ou noire pour le code QR. La bordure brodée du badge peut être de n'importe quelle
couleur.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AQR_Code_Monkey_-_Rectangle_Blanc_%C3%A0_effacer.png
https://edutechwiki.unige.ch/mediawiki/images/e/e1/Inkstitch-path-effect-62mm.svg|
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QR Code avec image
Voici un autre exemple:

QR Code avec une image

Copyright modification
Contents of this page including pictures and SVG files are also available under the GNU Free Documentation
License [3] and the Attribution 4.0 International (CC BY 4.0) [4] license.
The Inkstitch project [5] can use any element (text fragments, SVG files, pictures) for the project's official docs
without giving attribution (just copy and paste).

Références
[1] https:/ / www. qrcode-monkey. com/
[2] https:/ / edutechwiki. unige. ch/ mediawiki/ images/ e/ e1/ Inkstitch-path-effect-62mm. svg|

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInk-Stitch_QR_Code.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInk-Stitch_Simulation_QR_Code.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInk-Stich_SVG_avec_Trim.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASimulation_avec_Trim.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInk-Stitch_QR_Code-inkstitch.jpg
http://en.wikipedia.org/wiki/Wikipedia:Text_of_the_GNU_Free_Documentation_License
https://creativecommons.org/licenses/by/4.0/
https://github.com/lexelby/inkstitch/i
https://www.qrcode-monkey.com/
https://edutechwiki.unige.ch/mediawiki/images/e/e1/Inkstitch-path-effect-62mm.svg|
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InkStitch - broder des patchs et des appliqués

Guide de tutoriels de broderie machine

Module: InkStitch

⚐ brouillon ☸ intermédiaire

⚒ 2022/09/27
Prérequis

•• Inkscape

Voir aussi

•• Stitch Era - créer des patchs pour vêtements

Autres pages du module

•• InkStitch
•• InkStitch - installation
•• InkStitch - utilisation de base
•• InkStitch - broderie ondulée
•• Inkstitch - textures de remplissage
•• InkStitch - lettrage
•• InkStitch - colonnes satin
•• InkStitch - exemples colonnes satin
•• InkStitch - broder un emoji
•• InkStitch - broder une image issue de The Noun Project
•• InkStitch - broder des codes QR
•• InkStitch - broder des patchs et des appliqués
•• InkStitch - astuces et problèmes courants
•• InkStitch - bases SVG
•• Inkscape - édition des chemins
•• InkStitch - broder avec du gros fil
•• InkStitch - broderies à partir de dessins faits à la main
•• InkStitch - points manuels
•• InkStitch - points programmables
Catégorie: InkStitch

Introduction
Ce petit tutoriel explique comment broder des patchs avec le logiciel OpenSource InkStitch. Cette méthode marche
aussi pour les appliqués. Il faut simplement substituer le stabilisateur solvable ou le filmoplast à l'envers par un tissu.
Créer un patch bien fait nécessite un peu de travail de précision. Créer un appliqué est un peu plus simple puisque la
bordure peu largement dépasser le bord du tissu d'application.
La création de patchs est expliquée en termes généraux, en anglais, dans l’article Embroidery patch [1]. Ici, nous
résumons simplement la méthode que nous préférons.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Guide_de_tutoriels_de_broderie_machine
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Stitch_Era_-_cr%C3%A9er_des_patchs_pour_v%C3%AAtements
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cat%C3%A9gorie:InkStitch
https://edutechwiki.unige.ch/en/Embroidery_patch
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Préparation du tissu
Découpez un tissu stable approprié de la taille du badge. Vous pouvez imprimer une version papier du dessin et
l'utiliser comme modèle.
Idéalement, vous pouvez couper les patchs avec une découpeuse laser. Nous utilisons notre Trotec_Speedy_100R 50
MW avec les réglages suivants: puissance = 23, vitesse = 1,9 et Hz = 1000. Étant donné que le tissu peut se
déformer, envisagez d’alourdir les bords, par ex. avec des morceaux de plomb. Couper aux ciseaux fait aussi l'affaire,
mais essayez d'être aussi précis que possible.

Découpage de tissu pour fabriquer des patchs

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Trotec_Speedy_100R
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3A1200px-Laser-cutting-textured-fabric-for-embroidery-patches.jpg
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Encerclement
•• Encerclez un stabilisateur auto-adhésif détachable, côté collant vers le haut.
•• Pensez à utiliser deux couches pour ajouter une stabilité supplémentaire.

Utilisez un stabilisateur collant, côté collant vers le haut, sinon utiliser de la colle

N'attachez pas le stabilisateur au tissu (votre patch pré-coupé), attendez!
Pour obtenir de meilleurs résultats, vous pouvez également utiliser un stabilisant lourd soluble dans l’eau ou dans la
chaleur. Mais il vous faudrait alors recommencer le cerclage après chaque patch ...

Placer le tissu
•• Cousez un point de placement (ligne de coupe) de la taille du patch.
•• Retirez le cercle
• Collez le tissu prédécoupé à l’intérieur / au-dessus de la ligne de coupe. (Si vous n'avez pas de stabilisant collant,

collez le tissu)
•• Remettez le cercle (dans la même direction)

Réalisation du bord
•• Cousez une ligne de fixation
(donc une ligne qui attache le patch au stabilisateur. La sous-couche du zig-zag peut aussi faire l'affaire pour attacher
le patch.
•• La bordure en zigzag aura à peu près le même diamètre extérieur que le patch. Pour un patch de 62mm, on utilise

62.1mm.
•• Attention: S'il y a du fil blanc qui remonte dans les bordures, il faut pousser un petit peu le satin vers l'extérieur.

Cela diminue la tension du fil supérieur (ma théorie).

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3A1200px-Hooping-for-patch.jpg
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Coudre une bordure en satin

Coudre le reste de la broderie
Ensuite, cousez le reste de la broderie.

Réutilisation du stabilisateur dans le cercle
Retirez délicatement le patch. Il devrait "se détacher" très facilement, car la bordure de protection aura perforé le
stabilisateur.
Vous pouvez maintenant coller un nouveau morceau de stabilisateur au-dessus du trou rond (côté collant vers le
haut!) Et recommencer sans encercler à nouveau.
Si c'est bien fait, vous pourrez l'utiliser pour au moins 10 patchs.
Il est préférable de ne pas coudre une couleur d’arrière-plan. Sinon, vous devrez gérer un effet Pull / Push et
également vous assurer que le chevauchement entre la bordure et l'arrière-plan est correct. Le point zigzag doit venir
en premier afin de s’assurer qu’il est correctement placé le long des bordures. Au lieu de cela, utilisez des tissus
spécialisés pour les patchs en question, le rendu sera meilleur. Par exemple vous pourrez en trouver chez Twilly ou
Step [2] de Gunold.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3A1200px-Brother-patch-8mm.jpg
https://www.gunold.de/en/products/effect-fabrics/step-fabrics-in-embroidery/
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Coller le patch sur un tissu

Deux versions collées sur une chemise

Avec notre expérience très limitée, le moyen le plus simple de
coller un patch sur un tissu est d’utiliser un film thermique fait
avec de la colle. Encore une fois, Gunold [3] a plusieurs produits.
Nous avons HeatnBond Lite [4].

(1) Coupez un morceau de thermofilm, un peu plus grand que la
taille du patch
(2) Infusez le patch avec de la colle
•• Chauffez la presse à chaud (à 200 degrés) ou votre fer à

repasser (chaleur moyenne).
• Mettez le patch à l'envers dans la presse à chaud ou sur une

table. Placez le thermofilm sur le dessus et le papier de
cuisson sur le dessus. S'il n'a pas son propre papier de cuisson,
ajoutez le vôtre.

•• Chauffer avec la presse à chaud (ou le fer à repasser pendant
environ 2-3 secondes (pas plus !)

•• Retirez le papier de cuisson
Le patch a maintenant de la colle sur le côté inférieur.
(3) Appliquez le patch sur le tissu
•• Placez le patch sur le tissu, côté collant en bas
•• Encore une fois, mettez du papier de cuisson sur le dessus
•• Chauffez pendant 10 secondes environ
(4) Cousez les bordures. Sinon, le patch pourrait se détacher
pendant le lavage.

Méthode alternative "trim in place"
Si vous créez une forme unique et que vous n'avez pas l'équipement ou les ciseaux pour le découper vous pouvez
utiliser une méthode "couper à l'endroit".
Votre design doit inclure:
•• Une ligne de fixation qui attache le tissu écusson (ou autre tissu d'application). A environ 1mm du bord. Cette

ligne ajoutera aussi un peu de relief à la bordure.
•• Une ligne de découpe qui aide à découper le tissu écusson en place
•• Une bordure en satin qui couvre les bords. Elle doit suivre la ligne de découpe + 0.5mm (!!)
•• Cerclez un stabilisateur lourd soluble dans l'eau ou un filmoplast à l'envers. Pour un appliqué, cerclez le tissu avec

un stabilisateur approprié.
•• Collez un tissu écussons sur le dessus avec une coller temporaire (épingler va aussi)
•• Brodez une ligne de fixation qui attache bien le tissu écusson. Ne brodez pas de ligne de fixation si votre bord

n'est pas en satin.
•• Brodez une ligne de découpe, environ 0.5mm à l'intérieur. Cette ligne peut aussi faire affaire de ligne de fixation

si elle est bien faite. Vous pouvez tenir des effets d'étirement aussi. Si votre broderie est horizontale, dessinez la
ligne tout près des bords.

•• Retirez le cercle, une fois brodé la ligne de découpe.
•• Découpez le tissu le long de la ligne de découpe.
•• Remettez le cerceau en place

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-logo-patch-glued.jpg
https://www.gunold.de/en/products/foilsgauze/bsn-permanent-heat-seal-film/
https://www.thermowebonline.com/c/our-brands_heatnbond
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•• Brodez le reste. On conseille de broder d'abord les bords.
Évidemment, si vous utilisez un autre de bordure, il faut s'adapter.

Broder des appliqués
Le principe pour broder des appliqués est très similaire:
1.1. Cercler un tissu sur lequel on va poser l'appliqué (donc pas un filmoplast inversé ou stabiliseur soluble)
2.2. Broder une ligne de positionnement sur ce tissu
3.3. Arrêter la machine et coller le patch découpé
4.4. Broder le satin qui peut dépasser
5.5. Broder le reste
Voici un design pour un appliqué:

Appliqué: ligne rouge = positionnement; bordure satin qui dépasse le contour du patch que l'on va
poser

Si vous créez un design unique, voir la méthode "trim in place" décrite ci-dessus. En résumé, on peut:
1.1. Cercler un tissu
2.2. Coller un carré de tissu patch par dessus avec une colle temporaire. Alternativement, le fixer avec des épingles
3.3. Broder une ligne de fixation / découpe (donc une ligne de positionnement bien décalé de 1mm au moins vers

l'intérieur)
4.4. Arrêter la machine et découper le tissu le long de la couture
5.5. Broder le satin, puis le reste.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APaintbrush-twemoji-inkstitch-applique.svg
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Modèles à télécharger
Vous trouverez ci-dessous nos modèle standard que nous avons conçu pour nos cours et nos activités de
sensibilisation. Il consistent en un positionnement, une ligne d'amure, un zig-zag lourd et une ligne à l'intérieur du
zig-zag. Vous voudrez peut-être réduire le rayon de la ligne de positionnement un tout petit peu (par exemple de 0,2
mm) si vous ne pouvez pas placer exactement le badge au milieu.
Il faut cliquer jusqu'à ce que le SVG s'affiche, ensuite enregistrer la page SVG depuis votre navigateur (CTRL-S)
Sinon, regardez les liens à la fin de la page qui pointent vers des dossiers de téléchargement directs.

Patch rond 62mm
(Exemples faits par divers auteurs/autrices)

Modèle patch - réutilisables

Modèle SVG pour créer des patchs de 62 mm

SVG

Ce patch est idéal pour des activités "outreach", puisqu'il est brodé relativement
rapidement. Enfin, la bordure prend quand-même quelques minutes. Les lignes
vertes permettent de positionner du texte (ou un groupe d'autres objets) utilisant
la méthode Chemin -> Effets de chemin -> Courber (voir
ci-dessous)

Modèle tiré du the noun project [5].

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-path-effect-62mm.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Inkstitch-path-effect-62mm.svg
https://thenounproject.com/korawan_m/collection/hand-solid-style/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-path-effect-62mm-fuck-1.svg
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Exemple horloge Premier essai Horloge brodée (travail étudiant)

Virus crée par Simon Mong [6] avec TurtleStitch [7] Virus brodé

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AMontre2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AHorloge-broderie.png
https://www.turtlestitch.org/users/SimonMong/projects/Corona%20Virus
http://turtlestitch.org
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ACorona-patch.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ACorona-patch.jpg
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Patch carré 62 mm

Modèle patch - réutilisable

Modèle SVG pour créer des patchs carrés de 62 mm

SVG

Patch carré 62 mm. Vous devez tuer l'objet de lettrage dans le gestionnaire
d'objets puisque nous avons supprimé l'espace de noms SVG. La couronne a été
prise du site Noun projet [8]. Ne reproduisez pas sans citer.

Patch rectangulaire 82x62mm

Modèle patch - réutilisable

SVG Ce modèle est utile pour créer des lettrages simples (donc pas arrondis) avec
la petite fonte de InkStitch.

Propagande pour bon comportement en pandémie

(SVG)

Patch brodé

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-patch-62mm-square.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Inkstitch-patch-62mm-square.svg
https://thenounproject.com/term/crown/36069/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Inkstitch-patch-82x62mm.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ACovid-do-not-C-82x62.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Covid-do-not-C-82x62.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ACovid-do-not-C-82x62.jpg
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La famille des corona

(SVG)
Patch brodé

Covid party with invited friends

(SVG)
Patch brodé

La famille des corona

(SVG)

Patchs brodés. A droite, 2ème version avec des points allégés

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ACorona-family-82x62.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Corona-family-82x62.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ACorona-family-2-82x62.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ACorona-party-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Corona-party-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ACorona-party-2.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-mj-hiblen-fuck-covid-patch-4.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Inkstitch-mj-hiblen-fuck-covid-patch-4.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-mj-hiblen-fuck-covid-patch-4.jpg


InkStitch - broder des patchs et des appliqués 175

Patch rond 10cm

Modèle patch - réutilisable

Modèle SVG pour créer des patchs ronds de 100 mm

(Page SVG à enregistrer "sous")

Ce modèle est idéal pour fabriquer des patchs qui contiennent un lettrage plus des
dessins. Ce modèle (Feb 2020) nécessite peut-être encore quelques ajustements.
Par contre, il est difficile de placer les lettres avec Ink/Stitch.

Exemple SVG (lourd)

(SVG)

Exemple simulation

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-path-effect-100mm.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Inkstitch-path-effect-100mm.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-100mm-covid-19-maison-1.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Inkstitch-100mm-covid-19-maison-1.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-100mm-covid-19-maison-1.jpg
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Exemple SVG

(SVG)

Exemple simulation

Exemple brodé Exemple (V2) brodé

Exemple SVG (relativement lourd)

(SVG)

Exemple brodé

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-100mm-covid-19-maison-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Inkstitch-100mm-covid-19-maison-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-100mm-covid-19-maison-2.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-100mm-covid-19-maison-2b.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-100mm-covid-19-maison-2c.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-100mm-covid-19-maison-1-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Inkstitch-100mm-covid-19-maison-1-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-100mm-covid-19-maison-1-2.jpg
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Exemple SVG

(SVG)

Exemple brodé

Patch rond 46mm

Patch rond 46 mm

. Même type de design que le 62mm et le 100mm

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ACovid-hello-friend-B-100mm.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Covid-hello-friend-B-100mm.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ACovid-hello-friend-B-100mm.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APatch-46mm-inkstitch.svg
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Appliqué 46/48mm
Idéal pour broder des emoji dans un cadre 50x50. La bordure fait 48mm
Le modèle suivant est un prototype. La bordure de 3mm est très large par rapport à la taille du patch (46mm).
Nécessaire à notre avis pour être sûr qu'il soit bien brodé sur un tissu qui peut bouger comme un pull

Modèle appliqué avec une ligne de position, une ligne de fixation et un satin qui
déborde

Exemple SVG:

Emoji smiling face with smiling eyes

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-patch-46-48mm-appliqu%C3%A9-v1.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASmiling-face-with-smiling-eyes-twemoji-applique.svg
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Modèles de découpe laser
Si vous voulez couper des patchs textiles avec une découpeusepaintbrush-twemoji-inkstitch-applique.svg laser ou un
cutter en vinyle, vous pouvez saisir des modèles de la page Embroidery patch [9].

Patch du projet Ink/Stitch
La conception suivante est disponible sur le site Web Ink / Stitch [10]. Il s'inscrit presque dans le patch assez large de
80 mm. Nous l'avons juste réduit un peu. Nous avons dû modifier le design de la version 6.15 plus petite, c'est-à-dire
remplacer les points de satin dans les aiguilles par des lignes droites et éliminer une certaine densité. Notez
également que cette conception a été effectuée avant que Ink / Stitch n'ait un module de lettrage, c'est-à-dire qu'une
version plus récente devrait être plus jolie.

6.15cm Version 1
Ce design n'est pas encore très attractif. On pourrait probablement rendre le cadre bleu un peu plus petit et utiliser
moins de densité. Il peut être nécessaire d'améliorer la bordure (moins de sous-couche) et d'agrandir un peu le point
de placement. Le cerclage n'était probablement pas parfait. Nous aurions dû utiliser deux couches de stabilisateur.

Modèle SVG InkStitch Logo patch Simulation Premier test

https://edutechwiki.unige.ch/en/Embroidery_patch#Patch_templates_for_cutting
https://inkstitch.org/tutorials/resources/inkstitch-logo/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-patch-61-5mm-logo-V1.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-logo-patch-v1.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-patch-61-5mm-logo-V1_%25281%2529.jpg


InkStitch - broder des patchs et des appliqués 180

6.15cm Version 2

Modèle SVG InkStitch Logo patch Second test

8cm Version 1

Modèle SVG InkStitch 80mm Logo patch

Premier test avec la version de 8cm

Bien entendu, vous n'êtes pas vraiment obligé d'utiliser les couleurs officielles.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-patch-61-5mm-logo-V3.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-patch-61-5mm-logo-V3-jpg.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-patch-80mm-logo-v1.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-logo-path-80mm-v1.jpg


InkStitch - broder des patchs et des appliqués 181

Deuxième test avec différentes couleurs pour les en-dessous de 20 et
au-dessus de 60 ans.

Créer des chemins de texte arrondi
Il existe plusieurs autres méthodes pour créer un texte arrondi. Pour commencer, nous vous recommandons d'utiliser
la première méthode décrite ci-dessous, c'est-à-dire d'utiliser le module de lettrage d'Ink/Stitch et la méthode d'effet
de chemin d'InkScape .
En plus d'utiliser la police de lettrage InkStitch, vous pouvez soit créer votre propre police, soit copier / coller des
objets de lettre à partir d'un fichier de police, puis vous adapter à vos besoins. Voir InkStitch - lettrage et copier par
ex. celles de InkStitch - Geneva-simple typefaces [11] ou de Small embroidery font. [12]

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-logo-path-80mm-v1b.jpg
https://edutechwiki.unige.ch/en/InkStitch_-_Geneva-simple_typefaces
https://github.com/inkstitch/embroidery-fonts/tree/master/small-font
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Chemin arrondi avec le Lettrage d’Ink/Stitch

Modèle SVG pour des patchs de 62 mm

Pour courber le lettrage d'Ink/Stitch dans une position, il faut d'abord dessiner
une référence. Prenez le type de modèle écusson qui contient deux cercles.
Vous n'aurez pas besoin de ces cercles mais ils aident au positionnement.
Etape 1: Ajouter un ou deux cercles pour guider la position du texte
(alternativement prenez un modèle de patch, ci-dessous)

• Créez un nouveau calque Menu Calque -> Ajouter un calque.
Appelez-le quelque chose comme "Artwork" ou "Guidelines".

•• Ajoutez le cercle (maintenez la touche CTRL enfoncée) à ce calque
•• Centrez le cercle avec l'outil d'alignement
•• Retirez le remplissage et réglez le trait sur quelque chose de petit, par ex.

0,5 mm

Etape 2: Créer le texte

• Lire InkStitch - lettrage si nécessaire
• Sélectionnez une police approprié pour du petit lettrage, par exemple Geneva Sans
•• Réduisez le texte à créer à la bonne taille. Notez que les polices intégrées ont des restrictions sur le

redimensionnement.
•• Positionnez le texte à un endroit qui nécessite peu de manipulations (donc par exemple au milieu x/y et vers le

bas)
Etape 3: Courber

•• Sélectionnez le groupe de lettres dans un groupe de lettrage Ink/Stitch (vous pouvez supprimer le groupe
extérieur)

• Menu Chemin -> Effets de chemin
• Cliquez sur le + pour ajouter un effet de chemin.
• Sélectionnez l'effet de chemin Courber (Angl. bend
• En bas du panneau, cliquez sur le bouton Modifier sur la zone de travail (ressemble à l'icône

Modifier le chemin)
•• Poussez la ligne verte au milieu du texte vers le haut ou vers le bas. Utilisez ensuite les deux poignées de contrôle

des courbes qui apparaîtront pour ajuster les courbes. Déplacez les petits losanges gris pour les repositionner
(cliquez également dessus pour faire réapparaître les commandes de courbe)

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-path-effect-62mm.svg
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Outil "Effet de chemin" d'Inkscape

•• Notez que l'affichage peut être perturbé si vous utilisez des finitions. A éviter, si pas nécessaire.
Etape 4: Vérifier

• Les lettres ont en principe la bonne paramétrisation (vérifier dans les extensions de menu> Params
•• Cependant, en raison de la flexion ou du positionnement, quelque chose peut mal tourner. Par exemple à partir de

juin 2019, j'ai eu des problèmes avec les "1" et "0" et les ai remplacés par "I" et "O". Vous pouvez également
annuler l'effet de chemin et ajouter des lignes directrices aux lettres. Cela s'impose si le paramétrage ou la
simulation ne marche pas à cause d'un rail qui a une traverse défaillante ou encore des points inégaux.
Alternativement, vous pouvez directement réparer (je fais cela), mais les points à éditer sont décalés et nécessitent
une certaine souplesse mentale. Voici aussi ci-dessus.

Etape 5: Coudre

•• Vérifiez que les lignes vertes soit tuées ou cachées
• Fichier -> Enregistrer un copie sous
Dépannage

Si, après l'avoir plié, une lettre n'est pas paramétrable:
•• Notez la lettre et le sous-objet en question dans le message d'erreur. Essayez d'abord de réparer le rail en question

avec l'éditeur de noeuds (attention les points sont affichés ailleurs sur l'écran)
•• Si vous n'arrivez pas: Dans le gestionnaire d'objets, sélectionnez l'objet de lettrage, puis dans le panneau Effets de

chemin, supprimez la courbe.
•• Maintenant, corrigez la lettre incriminée avec des barreaux supplémentaires et/ou allongés (voir le tutoriel satin)
•• Refaire la courbe à nouveau (comme expliqué ci-dessus)

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape-path-effect-bend-1.png
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Modèle à télécharger

Template for download

Modèle Badge à télécharger (SVG) Fichier d'example - simulation

Télécharger le fichier d'exemple:
• File:Inkstitch-path-effect-62mm-massages-4.svg [13]

On voit bien la distorsion sur le grand lettre, tirez-en vos conclusions.
Exemple supplémentaire (en anglais)
• Machine embroidery in education workshop (EdMedia2019) [14]

Texte arrondi avec un motif de remplissage simple
Voici une méthode simple à utiliser pour du texte très large. Le résultat sera moche sur un écusson 10x10 et extra
moche sur un plus petit. Par contre, vous pouvez utiliser le résultat comme repère pour coller des lettres numérisées.
Inkscape permet de positionner un texte SVG le long d'un chemin comme expliqué dans plusieurs tutoriels que vous
pouvez trouver sur Internet. Par exemple, le tutoriel semi-officiel (en anglais) "Text on Path [15]" ou les badges de
mission NASA avec Inkscape [16], un tutoriel plus détaillé de Nicu (en anglais). Notez que Inkstitch possède un
module de lettrage qui produit des groupes de chemins SVG qui sont rendus avec un point satin. Ces lettres
numérisées ne sont pas du texte SVG, c'est-à-dire que la méthode décrite ci-dessous ne peut pas fonctionner.
Ci-dessous, nous expliquons brièvement comment créer un patch de broderie à l'aide des polices Inkscape.
Cependant, comme nous ne fournissons que des instructions minimales, veuillez lire les badges de mission NASA
avec Inkscape [16] en premier ou simultanément! Utilisez ce qui suit comme liste de contrôle.
Etape 1: Ajouter un cercle pour guider la direction du texte pour le texte de la moitié supérieure
•• Ajoutez le cercle (maintenez la touche CTRL enfoncée)
•• Centrez le cercle avec l'outil d'alignement
•• Retirez le remplissage et réglez le trait sur quelque chose de petit, par ex. 0,5 mm
Etape 2: Ajouter le texte
Pour utiliser une police avec un motif de remplissage de tatami simple:
•• Utilisez une taille de police en gras qui n'est ni trop grande (elle doit tenir dans le patch) ni trop petite. Par

exemple, pour un patch 8x8cm, vous pouvez commencer avec une taille = 27 (environ 7,2 mm)
•• Copiez / collez le texte (en tant que sauvegarde)

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-path-effect-62mm.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-path-effect-62mm-massages-4.png
https://edutechwiki.unige.ch/en/File:Inkstitch-path-effect-62mm-massages-4.svg
https://edutechwiki.unige.ch/en/Machine_embroidery_in_education_workshop_(EdMedia2019)
http://tavmjong.free.fr/INKSCAPE/MANUAL/html/Text-Path.html
http://howto.nicubunu.ro/NASA-badge-inkscape/
http://howto.nicubunu.ro/NASA-badge-inkscape/
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Etape 3: Aligner le texte
•• Sélectionnez le texte et le chemin du cercle
• Texte du menu -> Mettre sur le chemin
•• Vous pouvez ajuster l'espacement entre les lettres ou les mots (mais ce n'est pas strictement nécessaire)
•• Cliquez deux fois sur le cercle, puis faites pivoter en utilisant les commandes dans les coins.
Etape 4: Convertir le texte en chemin
•• Si vous êtes satisfait du résultat ..
• Traduire la police en chemin: sélectionnez le texte, puis Chemin du menu -> Objet vers le chemin
•• Supprimez le trait et définissez une couleur de remplissage.
Etape 5: Ajouter un second cercle pour le texte du bas
•• Il doit être aussi grand que le cercle précédent (ci-dessus) plus le texte
•• Insérez un texte
•• Ajouter au chemin en utilisant ce deuxième cercle
•• Faire pivoter le texte en haut
•• Retourner verticalement
•• Espacer un peu les lettres: double-cliquez pour sélectionner toutes les lettres, puis ajoutez un espacement entre les

lettres, par ex. 5px
•• Réajuster la rotation: sélectionnez le cercle (cliquez deux fois) et faites pivoter.
•• Traduire en chemin et définir la couleur de remplissage.
Etape 6:

•• Supprimer les cercles
• Ajoutez d'autres contenus, par exemple nous avons utilisé fist roots [17] de Noun project créé par corpus delicti [18]

Résultat:

Simulation

La police ne sera pas belle et devrait être remplacée manuellement, lettre par lettre par une police cousue satin, si
possible.
Résultat

https://thenounproject.com/search/?q=revolution&i=659670
https://thenounproject.com/corpusdelicti/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-path-lettering-1-photo.png
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Modèle à télécharger

Le modèle suivant pour un patch de 8 cm comprend les deux cercles et du texte SVG factice que vous pouvez
remplacer par le vôtre. Avant de vous lancer là-dedans, rappelez-vous que les lettres numérisées tous comme les
zones semblent plutôt laides ...
•• Cliquez deux fois sur l'image pour obtenir le SVG, puis "epaintbrush-twemoji-inkstitch-applique.svgnregistrer la

page sous" dans la fenêtre de votre navigateur
•• Changer le texte en haut et en bas
•• Tourner. Cliquez sur les cercles (et non sur le texte) pour le faire. Pour faire pivoter un objet dans InkScape,

cliquez deux fois dessus. Après la deuxième fois, des poignées de rotation apparaîtront dans les coins.
•• Enfin, traduisez le texte en chemins pour la broderie, comme décrit ci-dessus.

Modèle à télécharger, format de lettre 23 pt (8,1 mm)

Modèle de badge à télécharger (SVG). Le texte est
modifiable (visible uniquement dans le SVG)

Exemple (SVG). Le texte n'est pas modifiable

Texte arrondi avec des objets police de broderie
Cette méthode un peu compliquée fonctionne pour les polices où chaque lettre est un seul chemin, c'est-à-dire qu'elle
ne fonctionnera pas facilement avec le module de lettrage InkStitch. Si vous souhaitez utiliser les polices numérisées
intégrées, consultez la méthode d'effet de chemin décrite ci-dessus et qui fonctionne relativement bien avec les
petites lettres. Bien sûr, vous pouvez saisir ces polices, puis combiner chaque lettre en un seul objet.
Nous utiliserons l'extension InkScape qui permet d'étaler un ou plusieurs objets le long des chemins. Lire Générer à
partir du chemin [19] (manuel semi-officiel, en anglais)
Etape 1: Créer le texte à partir de différents objets
•• Copiez / collez des lettres pour créer une phrase, par ex. à partir de la police simple Geneva.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-path-lettering-0.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-path-lettering-0b.svg
http://tavmjong.free.fr/INKSCAPE/MANUAL/html/Extensions-GenerateFromPath.html
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Police simple Geneva

•• Utilisez l'outil aligner et distribuer (aligner en bas pour les majuscules et
rendre les espaces égaux) pour fixer le positionnement

•• Ajustez la taille, par ex. h = 7 mm
•• Groupez chaque phrase qui sera alignée avec un cercle, par ex.

"EMBROIDERY" et "FOR CHANGE"
•• Copiez / collez le résultat à des fins de sauvegarde
[ Alternativement, il serait possible d'utiliser des polices Ink/Stitch numérisées,
à condition de transformer chaque groupe définissant une lettre en un seul
objet. Une deuxième méthode consisterait à créer des objets de broderie et
utiliser ces derniers.]
Etape 2: Motif le long du chemin (texte en haut)
L'extension nécessite que l'utilisateur sélectionne deux objets: d'abord un objet
simple ou un groupe. Deuxièmement, un chemin.
• Créez deux cercles, un plus petit pour le texte en haut et un plus grand pour le texte en bas (comme expliqué

ci-dessus). Transformez les cercles en chemin (!). Assurez-vous ensuite que le cercle extérieur va dans le sens des
aiguilles d'une montre (Chemin-> Chemin inverse, si nécessaire) et le cercle intérieur dans le sens inverse des
aiguilles d'une montre.

•• Sélectionnez le groupe de lettres à placer en haut, plus le cercle extérieur (qui doit être un objet de chemin dans le
sens des aiguilles d'une montre). Vous avez donc deux et seulement deux objets sélectionnés.

• Extensions -> Générer à partir du chemin -> Motif le long du chemin
•• Cochez le type de déformation Serpent
•• Cochez Aperçu en direct
•• Si nécessaire, ajustez le décalage (par exemple, pour nos lettres de 7 mm, nous avons choisi 3,5). Il peut

également s'agir d'un nombre négatif
•• Le décalage tangentiel tournera.
•• Appliquez si vous êtes satisfait.
•• Vous pouvez toujours faire pivoter et placer le texte (contrairement au texte le long du chemin, vous ne pouvez

pas faire pivoter le chemin lui-même), mais il est préférable de le générer correctement.
Etape 3: Texte en bas
Pour que le deuxième objet soit placé en bas, il est crucial de changer la direction du cercle - Pour voir les directions
du chemin, définissez Afficher la direction du chemin, direction sur le contour dans
Édition -> Préférences -> Outils - > Nœud, puis sélectionnez le cercle et appuyez sur F2 pour vérifier.
•• Sélectionnez le cercle
• Menu: Chemin -> Inverser
•• Vérifiez dans l'outil Modifier le chemin (F2) que les flèches vont dans le sens inverse des aiguilles d'une montre.
À la fin, supprimez les deux cercles.
Exemple:

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ATypeface_geneva-simple-sans.svg
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Exemple de patch réalisé avec une police de broderie

Fichier SVG à télécharger Simulation

Téléchargements
Les modèles sont aussi disponibles via un serveur web classique:
• Patchs utilisés [75] dans le projet Emoji Embroidery Project
• Dossier patch [20] dans les ressources Ink/Stitch (il y a aussi notre palette préférée)

Modification des droits d'auteur
Le contenu de cette page, y compris les images et les fichiers SVG, est également disponible sous la licence de
documentation gratuite GNU [21] et la licence Attribution 4.0 International (CC BY 4.0 [4]).
Le projet Inkstitch [22] peut utiliser n'importe quel élément (fragments de texte, fichiers SVG, images) pour les
documents officiels du projet sans donner d'attribution (il suffit de copier-coller).

Références
[1] https:/ / edutechwiki. unige. ch/ en/ Embroidery_patch
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Astuces et opérations avancés avec InkStitch
et InkScape

InkStitch - astuces et problèmes courants

Guide de tutoriels de broderie machine

Module: InkStitch

Page d'entrée du module
InkStitch

⚐ à améliorer ☸ intermédiaire

⚒ 2022/09/27
Prérequis

•• Inkscape

Autres pages du module

•• InkStitch
•• InkStitch - installation
•• InkStitch - utilisation de base
•• InkStitch - broderie ondulée
•• Inkstitch - textures de remplissage
•• InkStitch - lettrage
•• InkStitch - colonnes satin
•• InkStitch - exemples colonnes satin
•• InkStitch - broder un emoji
•• InkStitch - broder une image issue de The Noun Project
•• InkStitch - broder des codes QR
•• InkStitch - broder des patchs et des appliqués
•• InkStitch - astuces et problèmes courants
•• InkStitch - bases SVG
•• Inkscape - édition des chemins
•• InkStitch - broder avec du gros fil
•• InkStitch - broderies à partir de dessins faits à la main
•• InkStitch - points manuels
•• InkStitch - points programmables
Catégorie: InkStitch

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Guide_de_tutoriels_de_broderie_machine
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cat%C3%A9gorie:InkStitch
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Astuces

Télécharger des documents SVG de ce wiki
La plupart des designs utilisés dans ce tutoriel sont disponibles en fichiers SVG. La meilleure façon de les obtenir est
sauvegarder les fichiers depuis le MediaWiki d’EduTechWiki. Un MediaWiki affiche les fichiers SVG en PNG
réduits.
Évitez de sélectionner « enregistrer l’image sous » pour obtenir l’image. Pour télécharger le SVG :
•• Cliquez sur l'image
•• Cliquez à nouveau sur l'image lorsque vous voyez File:XXX.svg dans le titre. Ensuite, le dessin devrait être

affiché dans votre navigateur.
•• Maintenant, utilisez le menu Fichier du navigateur : Sélectionnez « enregistrer la page sous » ou appuyez sur

CTRL-S dans votre navigateur

Version Inkscape et gestion des objets
L'auteur de InkStitch recommande d’installer la version 1.2 ou supérieure. Un des apports des nouvelles version de
InkStitch est le panneau "calques et objets" qu'on retrouve dans Objects -> Calques et Objets. Ce
panneau a comme fonction de lister tous vos objets de broderie (plus éventuellement d'autres objets comme du
clipart) et de les trier.
Vous pouvez grouper vos objets et/ou les mettre dans des calques (une calque est juste un groupe d'un point de vue
technique). Nous, on utilise très peu les calques pour le travail avec des objets peu complexes.
Pour faciliter la sélection des objets se trouvant dans différentes couches vous pouvez ouvrir Edition ->
Préférences -> Comportement (Angl. Edit -> Preferences -> Behavior -> Selecting). Cochez ensuite
l’option « sélectionner dans tous les calques » et assurez-vous que les objets cachés et verrouillés soient ignorés.
Cette option se trouve dans toutes les options.

Ajout de formes non standardisées
Avec Inkscape vous pouvez ajouter des formes intégrées tel que des rectangles, des ellipses, des étoiles et des
spirales. Ces formes peuvent être paramétrées, vous pouvez par exemple créer un rectangle avec des bords arrondis
ou une étoile avec 7 pointes. Ensuite vous pouvez les combiner avec des opérations de géométrie soustractive que
l'on retrouve dans le menu chemin
Avec l’outil « Bezier » vous pouvez créer les formes de votre choix. Mais souvent il est plus facile de partir de
formes intégrées et de les modifier par la suite que d'utiliser l’outil « Bezier ».
En installant des extensions, vous pouvez obtenir des fonctionnalités supplémentaires. Nous allons les aborder dans
les sous-chapitres suivants.

Extension des formes
L’extension des formes pour la dernière version officielle « Inkscape 0.92.3 » peut être téléchargée depuis la page
officielle d'Inkscape [1] et est datée d’août 2017. Les nouvelles versions sont annoncées sur arakne.es [2]. Pour utiliser
cette extension il suffit de :
•• télécharger la version 2017-08-10 (inkscape_arakne_shapes_2017_08_10)
• Dézipper le contenu du fichier dans le répertoire d’extension d'Inkscape.
•• Redémarrer Inkscape
• L’extension est maintenant disponible. Vous pouvez l’accéder en allant sur le menu : Extensions ->
Generate from paths -> Shapes .

Dessinez tout d'abord un objet (n'importe) et selectionnez-le. Ceci défini le secteur de modification.

https://inkscape.org/en/~PacoGarcia/%E2%98%85shapes-creator
http://www.arakne.es/en/inkscape-extension-shapes-new-version-2/
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Extension shape

Le prochain fichier a été créée avec le TAB "From corners", selectionnez le losange (rombus) et ajoutez l'espace à
20mm. Si vous souhaitez savoir plus sur les lignes satins vous pouvez lire l'article lignes satins.
•• Dessinez d'abord un rectangle pour indiquer les délimations
•• Créez le losange
•• Copiez / coller en place cet objet pour en avoir deux
•• Enlever le trait du 1er objet (à remplir avec un motif de tatami ou une hachure).
•• Supprimer le remplissage du 2e (objet de bordure)
•• Régler l'épaisseur du trait à 2,5 mm
• Menu Path -> Stroke to Path (Fr: Chemin -> Objet en chemin)
•• Inversion un des deux sous-chemins si nécessaire
•• Egaliser le nombre de points ou ajouter des échelons

Forme InkScape non-standarde, à télécharger

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkStitch_-_troubleshooting.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape-shapes-extension-2.svg
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Puzzle
L'extension Jigsaw permet de créer des pièces de puzzle. Pour utiliser cette extension téléchargez-là sous github.com
[3] Copiez ensuite les fichiers dans le dossier « extension Inksape ». Pour accéder à l’extension allez sur :
Extension > Render > Lasercut Jigsaw .
Cette extension permet de créer trois types de trajectoires : les « vagues » de bordure, horizontales et verticales.
L'image suivante montre un exemple de Lasercut Jigsaw qui utilise les points zigzag par défaut. T

Extension jigsaw

Tous les traits zig-zag devraient être remplacés par des rails de satin pour rendre cette broderie plus jolie (une future
version de Ink/Stitch pourrait créer automatiquement de meilleurs points de satin).

Définir les chevauchements
Dans la plupart des dessins, les chemins différents sont adjacents, alors qu'on broderie on fait souvent de sorte à ce
que les objets de broderie soient légèrement superposés afin d'éviter des espaces non brodés.
Depuis la version 1.8.2, vous pouvez définir un paramètre "expansion/élargir" pour les remplissages. Le paramètre
de remplissage peut être défini avec un nombre positif ou négatif. Le nombre positif rend l'objet à broder plus grand
que le dessin et un nombre négatif plus petit.
Vous pouvez également utiliser Inkscape pour agrandir ou diminuer la taille d'un objet
L'utilisation du paramètre d'expansion ou la modification d'un dessin est une question conceptuelle. Par exemple, si
vous souhaitez simplement créer un chevauchement afin de créer une broderie ayant aucun espace utilisez
l'élargissement (en Anglais: expand)

https://github.com/Neon22/inkscape-jigsaw
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape-shapes-extension-3a.svg
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Travailler avec les calques et l'ordre des points
Les objets sont cousus selon l'ordre du premier plan/arrière-plan. Le dernier objet se trouvant sur la liste de l’« object
panel » sera cousu en premier parce que il se trouve à l'arrière. Cet ordre peut être modifié. Il existe plusieurs façons
de le faire :
• Avec la version 0.92 et celles supérieures d’Inkscape vous pouvez utiliser le panneau des calques et objets » et

déplacer les objets menu Objet -> Calques et objets (Angl. menu object -> layers and objects)
• Vous pouvez également utiliser les touches « page up » et « page down » et vérifier l'ordre avec l’ « object panel ».
•• Vous pouvez changer la position avec le XML Editor
• Vous pouvez utiliser des calques. Un calque est une variante du groupe SVG (g). Ainsi, si vous placez un objet

dans un calque, sa position sera influencée par la position du calque.
Si vous importez un dessin, par exemple TheNounProject, vous commencez par :
• Créer un nouveau calque (Menu: Layer -> Add Layer) ou ouvrir le « layer panel » (Menu : Layer -> Layers)
•• Sélectionner le calque
•• Copier/coller l'image depuis la page SVG (ou importer le fichier SVG)
•• Dégrouper tous les objets
•• Éventuellement disposer les objets dans différentes calques en fonction du type et de l'ordre des points.
• Adapter l’ordre (les traits et les petites surfaces doivent généralement être au-dessus, donc vers le haut de panneau

"objets")

Créer un patch
La création de patches est expliquée dans l'article InkStitch - broder des patchs et des appliqués. Ci-dessous vous
trouveriez un exemple à utiliser de préférence avec la méthode "precut". Si souhaité, vous pouvez augmenter le
rayon de la ligne de coupe.

Patch pour Inkstitch

Effacez les lignes vertes avant de commencer à broder.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-path-effect-62mm.svg
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Créer des lignes de point
Par défaut, InkStitch traduit les traits pleins en lignes en zigzag.
Si vous avez besoin d'une ligne simple, mettez-la en pointillé. Il se traduira par une simple ligne de points. Vous
pouvez ensuite paramétrer un point triple (bean stitch), c-a-d des aller-retours.

Ligne simple avec InkStitch

Créer un dégradé linéaire
Voir l'exemple emoji ὣ�

Créer un dégradé radial
Pour le moment (dec. 2020) ce n'est pas possible. Par contre, on peut importer des fichiers de broderie ou du SVG
généré ailleurs.
On propose d'utiliser Turtlestich [4], un environnement de programmation de broderie en ligne gratuit, créer pour
enseigner l'informatique et on montre comment créer le dégradé dans Turtlestitch à partir de Gradients V3 [5]. Une
variante [6] montre une solution linéaire, plus simple
Dans Turtlestitch:
•• Ouvrir le projet
•• Cliquer sur le drapeau vert (en haut à droite)
•• Éventuellement jouer avec les paramètres au départ
•• Cliquer sur le drapeau vert (en haut à droite)
•• etc.
•• Ensuite exporter (sous le dessin il y a les options)
Vous avez le choix entre deux stratégies:
Option SVG / ajuster

•• Exporter en SVG
•• Importer dans InkScape

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-trouble1.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=InkStitch_-_broder_un_emoji%23%F0%9F%98%B1_Face_screaming_in_fear
https://www.turtlestitch.org/
https://www.turtlestitch.org/users/dks/projects/gradients%20V3
https://www.turtlestitch.org/users/dks/projects/gradients%20V3%20linear
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•• CTRL-A, puis mettre le remplissage à "aucun" (il ne faut pas laisser "non défini", car cela peut s'afficher en noir.
• Ajuster la taille des cercles avec CTRL-( et CTRL-)
•• Mettre les cercles en pointillés et paramétrer selon vos soushaits.
•• Tuer le tatami si vous en avez créer un et remplacer par un fait par InkStitch
Option paresse

•• Exporter en DST
•• Importer dans InkScape et utilise "tel quel" sans paramétrer (ce sont des points manuels déjà définis)

Créer un dégradé radial avec TurtleStitch

Prochaine version: Créer les cercles avec la mécanique tortue (demande des compétences en trigo) et varier un peu
les points.

Points satins
•• Pour définir les points en ligne de satin, vous devez définir un chemin qui inclut au moins deux sous-chemins

ayant soit le même nombre de noeuds, soit des échelons de direction.
•• Les deux chemins qui définissent le contour du satin doivent être plus long que les échélons.

Bordures en satin

•• Les rails doivent aller dans le même sens et ils doivent commencer à peu près au même endroit !

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ATurtlestitch-gradient-1.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-trouble3.png
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• Pensez à utiliser les outils d'optimisation et hésitez pas a scinder une colonne satin. On les trouve dans les
Outils:satin

Dans une autre version de ce texte, on ajoutera un exemple.

Optimisation
Par optimisation on entend la plupart du temps la minimisation de sauts. On peut faire pas mal d'optimisation en
arrangeant les objets dans le bon ordre et de placer les entrées sorties de façons à ce que le saut passe sous des objets
qui vont être brodé par dessus. Pour éviter à ce que l'aiguille se coince, on peut même broder des lignes invisibles
(c'est d'ailleurs ce qui se passe dans les sous-chemins des tatami).
Voici un exemple simple: Une fourmi sans nœuds. En règle générale je mets relativement peu de coupes de fil car
cela crée des nœuds et rend la broderie désagréable à porter (en plus, trop de nœuds vont tirer le tissu). Du coup je
coupe les fils avec des ciseaux (pour assurer les sauts, la machine fait des nœuds plus minces). Alternativement, on
peut faire un effort pour enchaîner les éléments de façon à ce que la plupart des connexions soient cachés sous des
objets.
Voici un exemple simple pour novices, l'emoji ant-twemoji-inkstitch.svg [7] que vous pouvez télécharger.
•• Cette araignée a 6 pattes et 2 antennes en satin "lourd" (sous-couches centrale, zigzag et contour).
•• On pointe la direction du satin vers l'intérieur, donc la couture va finir un peu dans le corps de la fourmi.
•• Les pattes sont brodés de bas à gauche vers bas à droite vers 2è à gauche etc.
•• Pour éviter des sauts visibles qu'il faut couper, on insère entre chaque patte des lignes qui débutent à la fin de

chaque satin et vont jusqu'à un endroit qui rend le saut invisible
•• On aurait aussi pu arranger l'ordre des pattes autrement, mais j'aime bien basculer de gauche à droite car je pense

que cela équilibre mieux la tension.

Motif "ant twemoji" optimisé

http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/animals_nature/animal-bug/ant-twemoji-inkstitch.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-optimisation-1.jpg
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Voici une simulation:

Simulation

Il vaut mieux jouer avec le fichier et lancer la simulation pour voir.
Ensuite, il existe des outils pour réarranger les colonnes satin et les traits.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-optimisation-2.jpg
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Outils satin
Les outils satin [1]

Outils satin

Ink/Stitch permet de minimiser les sauts d'un ensemble de colonnes satin. Cette opération peut scinder des satins,
donc on conseille de faire une sauvegarde avant.
• Outils:Satin -> Agencement automatique de colonnes satin

Les autres opérations servent à faire des réparations et ajustements manuels:
• Convertir le satin en trait permet de refaire un dessin qu'on peut ensuite remettre en satin avec la

commande Convertir ligne en satin
• Intervertir les rails du satin a comme fonction d'intervertir le côté de l'arrivée et du départ. Pour

invertir le début et la fin au sens propre du terme, il faut intervertir les lignes de direction avec le manu InkScape
Chemin -> Intervertir

• Scinder colonne satin permet de couper une colonne satin. Très utile lorsqu'il s'agit de gérer des virages
serrés par exemple.

Lisez les explications du manuel officiel [1] !

Outils lignes
Agencement automatique de traits est un outil très puissant pour arranger du line art. Cela concerne
notamment les dessins importés ou vectorisés.

Autres outils
• La fonction "réempliage" permet de trier facilement les objets. On les sélectionne d'abord dans l'ordre, puis on

choisit Ink/Stitch -> Edition -> Réempiler les objets dans l'ordre de leur
sélection

https://inkstitch.org/fr/docs/satin-tools/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-2-outils-satin.png
https://inkstitch.org/fr/docs/satin-tools/


InkStitch - astuces et problèmes courants 200

• Dans visualiser et exporter on trouve une commande qui montre des densités. Ceci dit, dans la version 2.2 on
n'arrive pas voir les couleurs, il faut sélectionner le calque "Densité" et mettre les contours à zéro. Voici un
exemple qui montre une densité assez élevé le long de colonnes satin et dans des textures sur la tête du
Hear-no-evil-monkey-twemoji-inkstitch.svg [8].

Carte de densités

Ce type de carte permet d'identifier les endroits où on peut alléger le motif. Ici on pourrait soit juxtaposer le satin,
soit le l'agrandir un peu.

Problèmes

Détection de problèmes
Il existe deux types d'erreurs. Le premier type d’erreur est de moins en moins fréquent. Ce sont des erreurs dans le
code Python qui peuvent faire arrêter l'exécution d'une procédure ou même faire planter le programme entier. Un
deuxième type de messages d'erreur concerne les erreurs de conception, par exemple les objets qui ne peuvent pas
être brodés. Ci-dessous, nous n'énumérons que quelques messages d'erreur. Consultez la liste officielle des messages
d’erreurs pour en apprendre plus.
InkStitch permet de détecter certains problèmes. En règle générale il trouve des objets non paramétrables (formes
primitives et fontes de SVG ou encore des objets qui ont une topologie trop compliqué, c-a-d des chemins qui se
croisent)

http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/smileys_emotion/monkey-face/Hear-no-evil-monkey-twemoji-inkstitch.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-optimisation-densites.png
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Détection de problèmes

Problèmes détecté

Une fois réparé les erreurs, vous pouvez simplement supprimer le calque "Résolution de problèmes"

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-2-problem-detection.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-2-problem-detection-2.png
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Le reparamétrage d'un objet ne marche pas
A priori ce problème n'apparaît plus dans les versions plus récentes de Ink/Stitch, mais ne sait-on jamais. La solution
la plus simple est de supprimer tous les instructions de broderie. Résolution de problèmes ->

Supprimer tous les paramètres de broderie

Si vous désirez faire un peu d'informatique, utilisez l'éditeur XML de InkScape (CTRL-SHIFT-X) ou n'importe quel
éditeur de programmation pour supprimer les attributs "inkstitch".
Attention: L'éditeur XML de InkScape est un éditeur d'arbres. Il faut sélectionner l'objet, puis dans le panneau des
propriétés, vous pouvez sélectionner une propriété et ensuite la tuer avec un petit bouton en haut.

Tuer un attribut (presque fait ...) avec le petit bouton. Appuyer sur DEL tue l'objet en entier.

Si vous ouvrez le fichier dans un éditeur de programmation ou encore dans votre navigateur (view source), il est
encore plus facile de tuer tous les attributs "inkstitch:*"...
Voici le code source complet du nez:

<path

     fill="#fe6011"

     d="M 13.4528 6.14188 C 13.4528 6.14188 13.4565 4.74498 13.3854 

4.14578 C 13.303 3.43422 13.157 3.24697 12.8761 3.12713 C 12.5353 

2.98108 11.7338 3.12713 11.3781 4.00721 C 11.1197 4.63638 10.6103 

5.56889 10.6103 5.56889 C 10.3632 5.85351 9.78643 6.04451 8.95129 

6.25423 C 7.95137 6.50514 7.4046 6.60626 7.08627 6.85718 C 6.66308 

7.18674 6.41217 7.88331 6.56197 8.35893 C 6.65934 8.66602 7.34842 

8.74467 8.2697 8.87949 C 9.24715 9.0218 12.3443 9.62475 12.6514 9.56857

 C 12.9585 9.5124 14.0595 8.89822 14.1419 8.09303 C 14.2093 7.49383 

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape-XML-editor-delete-prop.png
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13.4715 6.48267 13.4528 6.14188 Z"

     id="path739"

     style="stroke-width:0.374503;fill:#ff7200"

     inkstitch:row_spacing_mm="0.21"

     inkstitch:staggers="3" />

path815: erreur : Fill: Shape is not valid. This can happen if the border crosses over itself
Ce message d’erreur signifie que vous avez deux points qui se chevauchent quelque part et que vous ne pouvez pas
les voir en mode d'édition de noeud (F2).
Méthode 1

Pour trouver l’endroit visualisez les nœuds. ATTENTION cela modifie le dessin original, il faudra donc ensuite
annuler les modifications pour arriver à votre dessin initial. Pour cela :
•• Enregistrez le fichier
• Extensions -> Visualize Path -> Number Nodes

Méthode 2

Une autre méthode consiste à lisser l'objet: CTRL-L Cette procédure garantie aucun succès et peut causer des pertes
de détails.
Méthode 3

Vous pouvez remplacer une courbe Bézier par des petits traits droits. Extensions -> Modifier Chemin
-> Aplatir Beziers (Anglais: "Flatten Beziers"). Choisissez une petite valeur, par exemple 0.1 ou 0.2 On
utiliser également cette méthode pour créer des points manuel à partir de traits. Lire InkStitch - points manuels.
Méthode 4

Installer des extensions pour nettoyer les chemins. On peut régler 95% des problèmes si on exécute "close path",
"purge_duplicate_path_nodes" et "purge_duplicate_path_segments". Lisez nos conseils d'installation.

No embroiderable paths found in document.
Vous avez converti des objets en chemin et cela ne fonctionne toujours pas.
C'est peut-être une couleur manquante. Par défaut, les traits SVG s'affichent en noir lorsqu'aucune couleur n'est
définie. Sélectionnez donc les objets et ouvrez "Stroke and Fill". Changez le remplissage et/ou la bordure en couleur,
par exemple le noir.

error: satin column: object pathXXXX has a fill (but should not)
Cela signifie probablement qu'il vous reste quelques propriétés " restantes " dans l'objet que vous devriez supprimer.
•• Ouvrez l'éditeur XML
•• Supprimez toutes les propriétés du InkStitch (en particulier celle du satin). Cliquez sur le bouton "supprimer les

propriétés" en haut de la page.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=InkStitch_-_installation%23R%C3%A9paration_de_noeuds_et_segments_dupliqu%C3%A9s
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propriétés à supprimer dans l'éditeur XML

error: satin column: object path3XXX has two paths with an unequal number of points (x
and y)
Cela signifie que vous avez des noeuds supplémentaires dans un sous-chemin définissant une ligne de point satin. Il
existe deux solutions :
(1) Utiliser des barreaux (plus facile)
(2) Rendre les points égaux (prend plus de temps)
•• Identifiez quelle ligne a un point supplémentaire, puis supprimez-le.
•• Cliquez sur l'icône Modifier le chemin par nœuds ou appuyez sur F2.
•• Sélectionnez le(s) nœud(s) que vous voulez supprimer.
Effacez-les. Cela peut nécessiter d'ajuster les commandes de Bézier des points adjacents.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-trouble4.png
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Effacer un noeud

Remarque: Les points peuvent se cacher sous un autre. Pour les trouver, il y a deux options :
•• Déplacez chaque nœud et, si OK, remettez-le en place avec CTRL-Z.
Ou
• Utilisez l'outil de comptage de notes. Copier/coller l'objet en dehors de la zone de dessin (ou travailler avec une

copie de fichier). Sélectionnez le menu Extensions -> Visualiser le chemin -> Nœuds de
nombres... - Ceci remplacera le dessin avec des points et des chiffres (utilisez des petits points et des petites
polices. Cochez la case "Prévisualisation" pour afficher les nœuds. Annulez la prévisualisation une fois que vous
avez trouvé votre noeud. Vous pouvez maintenant réparer le dessin original avec l'outil « Edit Paths (F2) ».
Utilisez TAB ou SHIFT-TAB pour passer au nœud suivant ou précédent une fois que vous êtes en mode Edition.
Cependant, cela fonctionne seulement quand les nœuds ne sont précisément superposés.

Lisez InkStitch – colonnes en satin [6] pour plus de détails.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-trouble2.png
https://edutechwiki.unige.ch/en/InkStitch_-_satin_columns
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error: One or more rails crosses itself, and this is not allowed. Please split into multiple
satin columns.
Ce message peut avoir trois significations
•• Cela signifie que les rails se croisent de manière très visible, par exemple un huit. Dans ce cas vous devez couper

le dessin en deux.
•• Après avoir cassé la ligne et réduit la taille de l'ensemble du chemin (ou dessin), le début et la fin d'un

sous-chemin se chevauchent. Dans ce cas, déplacez juste un peu le nœud final.
•• qu'un échelon appartenant à un rail s'étend sur un autre rail (à vérifier)
Astuce : Désactivez tout accrochage lors de la manipulation des nœuds.

error: satin column: One or more of the rungs doesn't intersect both rails.
Chaque rail doit croiser les deux échelons une fois.
Cela signifie que vos dessins au point de satin ne sont pas seulement constitués de deux sous-chemins (lignes) et/ou
que les lignes de direction (barreaux) sont mal placées.

La gestion des couleurs
Assurez-vous que les couleurs qui se ressemblent sont les mêmes avant de broder. Sinon, vous obtiendrez de
nombreuses couleurs de fil différentes. Il existe deux situations où les couleurs doivent être regroupées. Vous avez
une machine à coudre avec une seule aiguille ou le nombre d'objets est élevé (quelques centaines d’objets). Le seul
moyen existant est de vous assurer que le code SVG source est trié par couleur en suivant les étapes de
regroupement.
Le regroupement
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Regroupement de couleur sur inkscape

Suivez ces instructions pour regrouper les objets de la même couleur :
•• Sélectionnez un objet avec la couleur de votre choix (remplissage, bordure ou les deux)
• Menu Edition->Select Same -> Fill Color (ou variante)
•• Appuyez sur Ctrl-G pour placer ces objets dans un même groupe.
Si vous cousez des objets l'un sur l'autre, vous devrez peut-être définir deux groupes d'une même couleur. Vous
devrez peut-être aussi réorganiser les objets si vous voulez optimiser les sauts.

Simulation
1) Lorsque vous paramétrez un objet, vous verrez une simulation des points. Touches de raccourci :
↑ accélérer
↓ ralentir
r redémarrer l'animation
q quitter (et fermer la fenêtre)
(2) Simulation de plusieurs objets différents ou de tous les objets
Vous pouvez également sélectionner les objets que vous souhaitez voir dans un aperçu simulé qui montre le
processus d'assemblage. Pour tout voir, sélectionnez tous les objets ou rien.
Utilisez ensuite Menu Ink/Stitch -> Visualiser et Exporter -> Simulateur / Apperçu
réaliste

(3) Pour la prévisualisation du résultat pensez à utiliser l'aperçu avant impression
• Menu Ink/Stitch -> -> Visualiser et Exporter -> Export PDF

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape-regroupment-color.png


InkStitch - astuces et problèmes courants 208

Vous pouvez également générer un fichier de points et le charger dans un autre programme de visualisation [9].
Plusieurs d'entre eux sont gratuits.

Signaler des bugs ou autres problèmes
Si vous tombez sur un bug, nous vous suggérons de faire ce qui suit :
•• Vérifiez s'il y a une nouvelle mise à jour
•• Vérifiez les rapports de bugs déposés et peut-être ajouter quelques informations utiles.
•• Si votre bug n'a pas encore été signalé, enregistrez-en un nouveau.
Voir aussi la documentation officielle sous la rubrique dépannage [10]

Documenter un dessin ou modèle

Documentation interne
Comme aucun élément autre que les chemins sont inclus dans la broderie, vous pouvez simplement utiliser du texte
SVG.
Alternativement, utilisez les balises meta de SVG
• Menu Fichier-> Propriétés du document, ONGLETS Métadonnés et License.

• Angl.Menu document -> Document Properties, MetaData and License TABS.

Impression d'un dessin ou modèle
Il y a plusieurs options :
•• Créez un fichier de broderie, ouvrez avec un afficheur de fichier de points gratuit ou commercial, puis

imprimez-le.
• Inclure le SVG dans une page HMTL et un document en html. Voir Utilisation de SVG avec le tutoriel HTML5

[11]

• Utiliser le menu : Extensions -> Ink/Stitch -> Imprimer . Cette fonctionnalité fournit des
informations sur l'ensemble de points, par exemple le nombre de points, la couleur et les points de trim/stop etc.

Liens
• Ink/Stitch [12] (page d'accueil)
• Répertoire Ink/Stitch [13] Github
• Vidéo d'introduction Inkstich [14] (Youtube anglais).
• Des motifs de broderie gratuits [15] sur Silver Seams.

Droits et modification
Le contenu de cette page, y compris les images et les fichiers SVG, est également disponible sous les licences GNU
Free Documentation License et Attribution 4.0 International (CC BY 4.0).
Le projet Inkstitch peut utiliser n’importe quel élément (fragments de texte, fichiers SVG, images) pour la
documentation officielle du projet sans attribution (il suffit de copier et coller).

http://edutechwiki.unige.ch/en/Embroidery_software#Free_converter_tools_and_other_utilities
https://inkstitch.org/docs/error-messages/
https://edutechwiki.unige.ch/en/Using_SVG_with_HTML5_tutorial
https://inkstitch.org/fr/
https://github.com/inkstitch/inkstitch
https://www.youtube.com/watch?v=FsbD8mnSAO4
https://silverseams.com/free-patterns/embroidery-patterns/
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https://inkscape.org/en/~PacoGarcia/%E2%98%85shapes-creator
http://www.arakne.es/en/inkscape-extension-shapes-new-version-2/
https://github.com/Neon22/inkscape-jigsaw
https://www.turtlestitch.org/
https://www.turtlestitch.org/users/dks/projects/gradients%20V3
https://www.turtlestitch.org/users/dks/projects/gradients%20V3%20linear
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/animals_nature/animal-bug/ant-twemoji-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/smileys_emotion/monkey-face/Hear-no-evil-monkey-twemoji-inkstitch.svg
http://tecfa.unige.ch/guides/embroid/emoji/AAA_EMOJIS/smileys_emotion/monkey-face/Hear-no-evil-monkey-twemoji-inkstitch.svg
http://edutechwiki.unige.ch/en/Embroidery_software#Free_converter_tools_and_other_utilities
https://inkstitch.org/docs/error-messages/
https://edutechwiki.unige.ch/en/Using_SVG_with_HTML5_tutorial
https://inkstitch.org/fr/
https://github.com/inkstitch/inkstitch
https://www.youtube.com/watch?v=FsbD8mnSAO4
https://silverseams.com/free-patterns/embroidery-patterns/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Guide_de_tutoriels_de_broderie_machine
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cat%C3%A9gorie:InkStitch
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Introduction

Cet article contient du matériel pour présenter le langage SVG aux utilisateurs de Ink/Stitch
dans une formation en présentielle ou en ligne.

Les points suivants sont abordés :
•• Différences entre images matricielles et vectorielles,
•• SVG : origine, utilisation, langage SVG, formalisme XML utilisé par SVG,
• SVG utilisé par le logiciel de dessin Inkscape et son extension InkStitch.

Lors de la séance, des démonstrations seront réalisées avec un simple éditeur de code en ligne et on vous montrera
aussi comment éditer du code avec Inkscape.
Prérequis:

•• Avoir réussi une broderie avec Ink/Stitch ou avoir des connaissances en technologies Web.
Matériel:

• Navigateur Web, Inkscape et son extension broderie InkStitch installé.
• https:/ / edutechwiki. unige. ch/ fr/ InkStitch_-_bases_SVG

Image vectorielle VS matricielle
Une image matricielle [1] (formats *.JPG, *.PNG, *.GIF etc.) est définie par une matrice de points colorés. Elle perd
en qualité si on agrandit ou diminue sa taille. Une image vectorielle [2] est composée d'objets que l'on peut modifier.
Les images vectorielles peuvent être agrandies ou réduites à l’infini.
Vectoriel vs Matriciel:

Différence conceptuelle entre les images matricielles (bitmap) et vectorielles. Notez la différence entre les "S" agrandis

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASvg-logo.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=SVG
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
https://edutechwiki.unige.ch/fr/InkStitch_-_bases_SVG
https://fr.wikipedia.org/wiki/Image_matricielle
https://fr.wikipedia.org/wiki/Image_vectorielle
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ABitmap_VS_SVG_Fr.svg
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Origine et utilisation de SVG
SVG signifie Scalable Vector Graphics est un format de fichier libre et normalisé pour le dessin vectoriel. Scalable,
en français adaptable ou extensible veut dire qu'il existe un mécanisme pour ajouter des fonctionnalités comme on
verra plus loin. Le format SVG est basé sur le XML (langage de balisages normalisé) que le format SVG utilise pour
représenter des données visuelles ('dessin') sur le Web. SVG s’intègre fait partie intégrante du standard HTML5
utilisé pour créer des pages web mais peut aussi être utilisé dans d'autres contextes.
Histoire

•• 1999: date de création du format SVG,
•• 2001, publication de la "Scalable Vector Graphics (SVG) 1.0 Specification, W3C Recommendation". Le W3C

(World Wide Web Consortium) est la principale organisation internationale qui définit des normes pour le Web,
•• 2003, le standard évolue vers la recommandation en version 1.1 avec une seconde édition en août 2011, qui est la

version actuelle,
•• 2014, intégration à HTML5, le langage pour créer des pages web.
Intérêt
Les images SVG et les images vectorielles en général permettent une plus grande souplesse de manipulation que les
images matricielles et ils sont plus précis. On peut modifier facilement le code.
Usages typiques

• Partage de dessins (par ex sur OpenClipArt [3])
• Visualisation de contenus économiques, processus, cartes, etc. (exemple [4])
•• Interfaces utilisateurs (icônes, etc.)
• Dessins statiques, animés ou interactifs (exemple: sortes de café [5])
Caractéristiques du langage

•• Dimensions, structure et coordonnées d'objets sous forme numérique, éditable
•• Possibilité d'utiliser le langage CSS pour définir des styles
•• Formes géométriques de base: lignes, rectangles, ellipses, etc.
• Chemins (courbes de Bézier et permettent d’obtenir presque n’importe quelle forme).
•• Fontes pour écrire du texte (à transformer en chemins pour la broderie)
•• Inclusion d'images matricielles (à vectoriser pour la broderie)
Echange:

SVG étant un format ouvert (libre de droits) et populaire, il existe des sites de partage dont voici les
principaux:

• OpenClipArt [6] (alive again)
• TheNounProject [7] (enregistrement demandé)
• FreeSVG [8]

• SVG SilH [9] (attention aux pubs au début)
• Pixabay [10] (contient également du matriciel)
• FreePik [11]

• Public domain vectors [12] (pensez juste à cliquer sur SVG dans le choix du format)
Publier vos designs:

• Puisque SVG est un format web on peut soit directement mettre les fichiers sur le web (c.f. les exemples
ci-dessous, soit les inclure dans une page HTML). Attention: la plupart des portails censurent HTML5 et SVG.
Voir Tutoriel SVG avec HTML5.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=SVG
http://openclipart.org
https://frappe.io/charts
http://snapsvg.io/demos/#coffee
https://openclipart.org/
https://thenounproject.com/
https://freesvg.org/
https://svgsilh.com/fr/
https://pixabay.com/vectors/search/
https://www.freepik.com/
https://publicdomainvectors.org/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Tutoriel_SVG_avec_HTML5
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Anatomie d'un fichier SVG avec un objet simple

Structure d'un fichier SVG

SVG circle - en pixels

<?xml version="1.0"?>

<svg xmlns="http://www.w3.org/2000/svg" width="200" height="140">

    <circle cx="100" cy="100" r="50"  fill="aqua" />

</svg>

•• ligne 1: Déclaration XML obligatoire au début du fichier
•• ligne 2: Début du code svg, avec (option) les dimensions du canevas de dessin
•• ligne 3: Code pour un cercle
•• ligne 4: Fin du XML (et donc aussi fin du fichier)
Tout objet SVG est défini par une balise (aussi appelé "tag"). Ci-dessus il s'agit de <circle ...../>, plus loin
on verra aussi les <path ...../>. Chacun de ces objets est paramétré avec des attributs, par exemple
cx="100"> définit la position x du centre du circle et "r=50" définit le radius.

Unités de mesure
Par défaut SVG travaille en pixels, mais on peut utiliser d'autres unités de mesure. Nous préférons les "mm".
Attention: InkScape convertit en pixels, mais peut afficher en mm.
La même chose en utilisant des "mm" à la place de pixels

SVG circle - en mm

<?xml version="1.0"?>

<svg xmlns="http://www.w3.org/2000/svg" width="4cm" height="2.4cm">

    <circle cx="20mm" cy="20mm" r="10mm"  fill="aqua" />

</svg>

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ACircle-svg1.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ACircle-svg1mm.svg
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Notion de chemin
Traduction du même dessin en chemin (avec un défaut / bug de InkScape).
Il est difficile de comprendre le sous-langage "path" de SVG qui permet de définir des chemins.

SVG circle chemin - en mm

<?xml version="1.0"?>

<svg xmlns="http://www.w3.org/2000/svg" width="4cm" height="2.4cm">

    <path

     style="fill:#00ffff"

     d="M 113.38583,45.354332

        A 37.795277,37.795277 0 0 1 75.590553,83.149609 

          37.795277,37.795277 0 0 1 37.795277,45.354332 

          37.795277,37.795277 0 0 1 75.590553,7.5590553 

          37.795277,37.795277 0 0 1 113.38583,45.354332 Z"

     id="circle1473" />  

</svg>

• M = positionner aux coordonnées X/Y (Move to)
•• A = définit un "arc" avec les paramètres suivants: rx ry x-axis-rotation large-arc-flag sweep-flag x y
•• Z = Fermer le tout.
Vous pouvez tuer la première et la dernière ligne dans l'exemple ci-dessus et le cercle est toujours là, sans points en
trop.
• SVG corrigé à télécharger si vous le désirez.

  <path

     style="fill:#00ffff"

     d="M 113.38583,45.354332 

        A 37.795277,37.795277 0 0 1 37.795277,45.354332 

        37.795277,37.795277 0 0 1 113.38583,45.354332 Z"

     id="circle1473" />

Pour en savoir plus: Tutoriel SVG statique

Identificateurs
Chaque objet de dessin au autre peut avoir un identificateur qui doit être unique id="...". Si vous duplifiez du
code il faut en tenir compte (enfin InkScape répare peut-être). Cet identificateur permet de repérer des objets qui
posent problème.
Inkscape ajouter un deuxième identificateur qui ne doit pas être unique, c-a-d un nom que vous pouvez changer dans
l'interface. Dans le code c'est inkscape:label="....".

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ACircle-path-svg1mm.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Circle-path-svg1mm.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Tutoriel_SVG_statique
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Outils d'édition
Inkscape contient un éditeur d'arbre, pratique pour faire des petites modifications, mais difficile à utiliser pour des
"grands travaux". Pour tout travail sérieux, on conseille d'installer un éditeur de programmation, par exemple
Visualstudio Code [13] (gratuit, Win/Mac/Linux).

Explorer le code SVG en ligne
Pour jouer avec du code SVG, nous conseillons d'utiliser un simple éditeur SVG en ligne:
• https:/ / framavectoriel. org/ svg-editor. html
• Démo (https:/ / svg-edit. github. io/ svgedit/ editor/ svg-editor. html)

Utiliser un outil d'édition de code
(option: à télécharger)
Installation de VisualStudio code (éditeur recommandé, mais il en existe pleins d'autres)
• Téléchargement: https:/ / code. visualstudio. com/
• Ajoutez l'extension SVG: Fichier->Préférences->Extensions , puis entrer "SVG" et sélectionner

l'extension SVG. Juste SVG, pas les autres.

Copie d'écran Visual Studio code

https://code.visualstudio.com/
https://framavectoriel.org/svg-editor.html
https://svg-edit.github.io/svgedit/editor/svg-editor.html)
https://code.visualstudio.com/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AVisualStudioCode-svg-example.png
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Utiliser l'éditeur de Inkscape
L'éditeur de InkScape peut être lancé avec CTRL-MAJ-X (ou Edit->Editeur XML). (démo à faire)

Copie d'écran de l'éditeur de structure XML de InkScape 1.0

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkScape-1-0-xml-editor.png
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Challenge
Avec un éditeur de votre choix (on suggère d'utiliser l'éditeur en ligne svg-editor [14]), créez un simple torse (tronc,
tête et 2 bras) avec les contraintes suivantes:
•• La tête doit être faite avec un cercle parfait avec un radius de 1cm (diamètre de 2cm)
•• Le tronc doit être un carré 2x4cm.

une solution possible

Vous allez travailler en groupes de 4-5 et vous avez 15-20 minutes pour finir la tâche. Un participant peut partager
l'écran.
•• Si vous utilisez svg-editor, commencez par dessiner les formes.
•• Ensuite, utilisez l'éditeur de code pour préciser les dimensions
Faites attention à la syntaxe, tous les attributs doivent être mis entre guillemets, par exemple r="14mm"

Formalisme XML
On présente brièvement le formalisme XML utilisé par SVG, car il est important de respecter la syntaxe, notamment
l'imbrication et la fermeture des balises !
XML (Angl. eXtended Markup Language) est un langage de balisage et sert à encoder/structurer des données (textes,
formats vectoriels, messages entre machines, feuilles de style,...). Il existe des centaines de langages XML (par
exemple les documents Office comme docx sont des fichiers zip avec du XML dedans) et SVG est un langage XML.
Pour qu'un document soit bien formé, il doit respecter les règles suivantes.
(1) Le document commence par une déclaration XML (l’attribut version est obligatoire):

<?xml version="1.0"?>

(2) Structure hiérarchique:
• begin-tags (balises d’ouverture) et end-tags (balises de fermeture) doivent correspondre
• pas de croisements de types de balises (<g>...<rect>...</g> .... </rect> : FAUX)
(3) Case sensitive:

https://svg-edit.github.io/svgedit/editor/svg-editor.html
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ATronc-svg-demo.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=XML
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• Respecter impérativement la casse (majuscule, minuscule) et l'orthographe exacte d'une même balise. Exemple de
non-respect de la casse : <Courses> n'est pas égal à </courses>

(4) Toutes les balises doivent être fermées Les balises de type "EMPTY" (balises sans balises de fermeture ...)
nécessitent une syntaxe spéciale:
• Ces balises sans contenu utilisent la syntaxe XML "auto-fermante" (par ex.. <br/>)
• Les valeurs d’attributs sont entre guillemets (quoted), par ex:

<rect x="150" y="100" width="100" height="50" style="fill:red;stroke:blue;stroke-width:1"/>

(5) Un seul élément racine (root):
• L’élément racine se trouve au début et à la fin du fichier. Dans notre cas <svg> ....</svg>
(6) Caractères spéciaux: (qu'on ne peut pas utiliser)

<   &  >  "  '

• Il faut substituer les caractères spéciaux ci-dessus par &lt; &amp; &gt; &aquot; &apos; à la place de: <, &, >,", ’
En plus, un langage XML
•• définit le jeux de balises utilisables ainsi que leurs attributs,
•• spécifie leur possible imbrication (relation).
Conclusion: Il faut faire attention à la syntaxe et respecter les règles "sémantiques".

Espaces de noms et les extensions XML de InkScape
XML est extensible. On a le droit d'ajouter des éléments d'un autre langage au langage SVG. Par contre, il faut les
déclarer au début du fichier et définir des espaces de noms. Un espace de nom est défini avec un préfixe associé à
une adresse web. Exemple: xmlns:cc="http:/ / creativecommons. org/ ns# dit que tout élément préfixé par cc
appartient au langage creative commons qui permet de définir un copyright.
Exemple d'un simple fichier SVG crée par InkScape:
• Lignes 3-9 déclaration d'espaces de nommage (angl. Namespace) xmlns:xxx avec le nom du langage ajouté.
•• Lignes 18-26: description du contenu (Métadonnées bibliothécaires)
•• Lignes 30-49: configuration de l'écran Inkscape

<?xml version="1.0" encoding="UTF-8" standalone="no"?>

<svg

   xmlns:dc="http://purl.org/dc/elements/1.1/"

   xmlns:cc="http://creativecommons.org/ns#"

   xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"

   xmlns:svg="http://www.w3.org/2000/svg"

   xmlns="http://www.w3.org/2000/svg"

   xmlns:sodipodi="http://sodipodi.sourceforge.net/DTD/sodipodi-0.dtd"

   xmlns:inkscape="http://www.inkscape.org/namespaces/inkscape"

   width="4cm"

   height="2.4cm"

   version="1.1"

   id="svg1475"

   sodipodi:docname="circle-chemin-svg1mm.svg"

   inkscape:version="0.92.4 (5da689c313, 2019-01-14)">

  <metadata

     id="metadata1481">

http://creativecommons.org/ns#
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    <rdf:RDF>

      <cc:Work

         rdf:about="">

        <dc:format>image/svg+xml</dc:format>

        <dc:type

           rdf:resource="http://purl.org/dc/dcmitype/StillImage" />

        <dc:title></dc:title>

      </cc:Work>

    </rdf:RDF>

  </metadata>

  <defs

     id="defs1479" />

  <sodipodi:namedview

     pagecolor="#ffffff"

     bordercolor="#666666"

     borderopacity="1"

     objecttolerance="10"

     gridtolerance="10"

     guidetolerance="10"

     inkscape:pageopacity="0"

     inkscape:pageshadow="2"

     inkscape:window-width="950"

     inkscape:window-height="528"

     id="namedview1477"

     showgrid="false"

     inkscape:zoom="1.8454687"

     inkscape:cx="75.590551"

     inkscape:cy="41.574804"

     inkscape:window-x="231"

     inkscape:window-y="146"

     inkscape:window-maximized="0"

     inkscape:current-layer="svg1475" />

  <path

     style="fill:#00ffff"

     d="M 113.38583,45.354332 A 

     37.795277,37.795277 0 0 1 37.795277,45.354332

     37.795277,37.795277 0 0 1 113.38583,45.354332 Z"

     id="circle1473" />

</svg>

Voici un fragment de code qui inclut plus de métadonnées. Dans InkScape, on peut les ajouter dans
Menu->Fichier->Propriétés du Document->Metadonnées. On conseille à celles et ceux qui veulent
partager leur créations sous certaines conditions d'utiliser cette fonctionnalité.

  <metadata

     id="metadata1481">

    <rdf:RDF>

      <cc:Work



InkStitch - bases SVG 219

         rdf:about="">

        <dc:format>image/svg+xml</dc:format>

        <dc:type

           rdf:resource="http://purl.org/dc/dcmitype/StillImage" />

        <dc:title>Fichier exemple broderie Ink/Stitch</dc:title>

        <cc:license

           

rdf:resource="http://creativecommons.org/licenses/by-nc-sa/4.0/" />

        <dc:creator>

          <cc:Agent>

            <dc:title>Daniel K. Schneider</dc:title>

          </cc:Agent>

        </dc:creator>

        <dc:language>fr</dc:language>

        <dc:subject>

          <rdf:Bag>

            <rdf:li>broderie machine</rdf:li>

            <rdf:li>SVG</rdf:li>

            <rdf:li>Ink/Stitch</rdf:li>

          </rdf:Bag>

        </dc:subject>

        <dc:date>Mai 2020</dc:date>

        <dc:description>Ce fichier contient trois objets de broderie, un circle avec un

 contour plus un petit graffiti. </dc:description>

        <dc:contributor>

          <cc:Agent>

            <dc:title>Lydie Boufflers</dc:title>

          </cc:Agent>

        </dc:contributor>

      </cc:Work>

      <cc:License

         rdf:about="http://creativecommons.org/licenses/by-nc-sa/4.0/">

        <cc:permits

           rdf:resource="http://creativecommons.org/ns#Reproduction" />

        <cc:permits

           rdf:resource="http://creativecommons.org/ns#Distribution" />

        <cc:requires

           rdf:resource="http://creativecommons.org/ns#Notice" />

        <cc:requires

           rdf:resource="http://creativecommons.org/ns#Attribution" />

        <cc:prohibits

           rdf:resource="http://creativecommons.org/ns#CommercialUse" />

        <cc:permits

           rdf:resource="http://creativecommons.org/ns#DerivativeWorks"

 />

        <cc:requires

           rdf:resource="http://creativecommons.org/ns#ShareAlike" />
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      </cc:License>

    </rdf:RDF>

  </metadata>

Annotations InkStitch

Circle vert avec bordure satin rouge et un
grafiti manuel (SVG)

InkStitch ajoute des attributs aux balises SVG qui disent comment il faut
broder chaque objet. Depuis la version 1.28 (Mai 2020), ces annotations sont
conformes avec la norme XML.
•• SVG à télécharger
La balise g sert à grouper des objets. La notion de calque n'existe pas en
SVG, c'est juste une extension InkScape pour faciliter le dessin. Sur le plan de
la broderie groupe "normal" ou groupe "calque" ne change rien. Le fragment
de code suivant montre le groupe "plan de broderie" caché (display:none).

<g

     inkscape:label="Plan de broderie"

     inkscape:groupmode="layer"

     id="__inkstitch_stitch_plan__"

     style="display:none">

 .....

</g>

Voici le code source du fichier (sans les métadonnées et paramètres Inkscape):
•• ligne 3: Espace de nom de Ink/Stitch
•• lignes 27-28: remplissage avec sous-couche et angle de 30 deg. (sinon réglages standards)
•• lignes 36-39: satin avec sous-couche (réglages standards)
•• lignes 46-48: répétition de points (point manuel mis hors service)
•• ligne 56: points manuels du plan de broderie. Pas affiché (ligne 59)
Le plan de broderie utilise une instruction path très simple d="x,y x2,y2,...." qui définit simplement un
chemin a parcourir. La même information est montrée lors de simulations. Vos objets de broderie paramétrés sont
simplement traduits en séries de lignes connectés où chaque noeud est un point à broder ...
<?xml version="1.0" encoding="UTF-8" standalone="no"?>

<svg

   xmlns:inkstitch="http://inkstitch.org/namespace"

   xmlns:dc="http://purl.org/dc/elements/1.1/"

   xmlns:cc="http://creativecommons.org/ns#"

   xmlns:rdf="http://www.w3.org/1999/02/22-rdf-syntax-ns#"

   xmlns:svg="http://www.w3.org/2000/svg"

   xmlns="http://www.w3.org/2000/svg"

   xmlns:sodipodi="http://sodipodi.sourceforge.net/DTD/sodipodi-0.dtd"

   xmlns:inkscape="http://www.inkscape.org/namespaces/inkscape"

   width="27.347523mm"

https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Circle-bordure-satin.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ACircle-bordure-satin.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=M%C3%A9dia:Circle-bordure-satin.svg
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   height="27.683676mm"

   version="1.1"

   id="svg1475"

   sodipodi:docname="circle-bordure-satin.svg"

   inkscape:version="0.92.4 (5da689c313, 2019-01-14)">

  <title

     id="title2281">Fichier exemple broderie Ink/Stitch</title>

  

  <g

     inkscape:groupmode="layer"

     id="layer1"

     inkscape:label="Broderie"

     style="display:inline">

    <path

       inkstitch:angle="30"

       inkstitch:fill_underlay="True"

       inkscape:label="circle vert"

       inkscape:connector-curvature="0"

       id="circle1473-8"

       d="m 90.116617,52.315576 a 37.795277,37.795277 0 0 1 

-75.590553,0 37.795277,37.795277 0 0 1 75.590553,0 z"

       

style="display:inline;fill:#00ff3d;fill-opacity:1;stroke:none;stroke-opacity:1"

 />

    <path

       inkstitch:fill_underlay="False"

       inkstitch:zigzag_underlay="True"

       inkstitch:satin_column="True"

       inkscape:label="contour rouge"

       

sodipodi:nodetypes="cccccccsssccccccccccccccccccccccccccccccccccccccccccc"

       inkscape:connector-curvature="0"

       id="path1"

       d="m 85.377107,52.638589 c -0.0638,1.507821 -0.23701,4.09634 

-0.52469,5.584986 C 82.703207,70.599784 72.905357,81.245565 

60.69404,84.264512 48.843041,87.518035 35.38247,83.386637 

27.419521,74.016833 22.166513,68.087953 19.291287,60.220801 

19.25655,52.315607 19.20144,40.829572 25.588219,29.583884 

35.558647,23.855016 c 11.23026,-6.827979 26.543377,-5.908388 

36.857269,2.249955 2.427773,1.816871 4.562781,3.988397 

6.363711,6.409776 1.80093,2.421378 3.26778,5.09261 4.35924,7.908895 

1.09146,2.816284 1.80753,5.777622 2.10689,8.779211 0.14968,1.500794 

0.19519,1.250582 0.13135,2.758402 m 9.45791,0.864286 c 0.006,14.470747 

-8.59249,28.987384 -21.081248,36.169545 C 61.418507,96.372709 

45.297017,96.711024 32.614651,89.972435 20.394699,83.654087 
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11.671485,71.096918 10.1309,57.412322 8.5470741,44.844196 

12.975194,31.71223 21.862737,22.679994 30.607848,13.595807 

43.524481,8.8172702 56.077025,9.9856757 69.752758,11.100095 

82.558927,19.346717 89.264757,31.313363 c 3.61493,6.293305 

5.48208,13.515725 5.57018,20.763242 m -12.80661,7.862611 c 

4.57542,1.177121 9.15083,2.354241 13.72625,3.531361 m -18.56325,6.79001

 c 3.78328,2.829643 7.56655,5.659286 11.34983,8.488929 M 

70.268424,77.182409 78.755507,88.533614 M 59.946266,82.017727 

63.475395,95.744549 M 50.307831,82.907432 49.593131,97.062629 M 

39.32092,80.092902 33.17044,92.862083 M 30.043688,73.391868 

19.555972,82.925399 M 24.540013,65.314398 11.771832,71.466956 M 

21.723695,54.327946 7.5686151,55.044948 M 22.614314,44.691997 

8.8880651,41.160636 M 27.45131,34.370626 16.101486,25.881697 M 

34.374257,27.448805 25.887175,16.0976 M 44.696415,22.613487 

41.167286,8.8866647 M 54.33485,21.723782 55.04955,7.5685845 m 

10.272211,16.9697275 6.15048,-12.769181 m 3.126752,19.470215 c 

3.495904,-3.177844 6.991814,-6.355687 10.487714,-9.533531 m 

-4.98404,17.611001 12.76818,-6.152558"

       

style="fill:none;stroke:#ff0000;stroke-width:0.37795275;stroke-miterlimit:4;stroke-dasharray:none"

 />

    <path

       inkstitch:fill_underlay="False"

       inkstitch:repeats="2"

       inkstitch:manual_stitch="False"

       inkscape:label="graffiti noir"

       inkscape:connector-curvature="0"

       id="path2227"

       d="M 31.292863,60.468996 42.265685,56.269521 34.002201,67.106876

 50.800102,59.927129 41.58835,71.712752 58.792651,60.468996 

51.74837,74.557558"

       

style="fill:none;stroke:#000000;stroke-width:0.75590551;stroke-linecap:butt;stroke-linejoin:miter;stroke-miterlimit:4;stroke-dasharray:0.75590551,

 0.75590551;stroke-dashoffset:0;stroke-opacity:1" />

  </g>

  <g

     inkscape:label="Plan de broderie"

     inkscape:groupmode="layer"

     id="__inkstitch_stitch_plan__"

     style="display:none">

    <g

       inkscape:label="color block 1"

       id="__color_block_0__">

      <path

         id="path2261"

         style="fill:none;stroke:#00ff3d;stroke-width:0.40000001"

         embroider_manual_stitch="true"
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         d=" __contenu supprimé, consultez le fichier svg__ "

         inkscape:connector-curvature="0" />

    </g>

    <g

       inkscape:label="color block 2"

       id="__color_block_1__">

      <path

         id="path2264"

         style="fill:none;stroke:#ff0000;stroke-width:0.40000001"

         embroider_manual_stitch="true"

         d=" __contenu supprimé, consultez le fichier svg__ m"

         inkscape:connector-curvature="0" />

    </g>

    <g

       inkscape:label="color block 3"

       id="__color_block_2__">

      <path

         id="path2267"

         style="fill:none;stroke:#000000;stroke-width:0.40000001"

         embroider_manual_stitch="true"

         d="m 31.292863,60.468996 2.647385,-1.013197 2.647385,-1.013197

 -2.647385,1.013197 -2.647385,1.013197 5.29477,-2.026394 

5.294771,-2.026393 0.383281,-0.146688 -3.437533,4.50824 

-3.437534,4.50824 -1.388417,1.820875 5.213073,-2.228168 

5.213073,-2.228168 5.213073,-2.228168 1.158682,-0.495243 

-3.491262,4.466761 -3.491262,4.466761 -2.229228,2.852101 

4.745683,-3.101509 4.745682,-3.10151 4.745683,-3.101509 

2.967253,-1.939228 -2.535384,5.070768 -2.535384,5.070769 

-1.973513,3.947025 2.535384,-5.070768 2.535384,-5.070769 

1.973513,-3.947025 -4.745683,3.101509 -4.745682,3.10151 

-4.745683,3.101509 -2.967253,1.939228 3.491262,-4.466761 

3.491262,-4.466761 2.229228,-2.852101 -5.213073,2.228168 

-5.213073,2.228168 -5.213073,2.228168 -1.158682,0.495243 

3.437533,-4.50824 3.437534,-4.50824 1.388417,-1.820875 

-5.29477,2.026394 -5.294771,2.026393 -0.383281,0.146688 

0.383281,-0.146688 -0.383281,0.146688 0.383281,-0.146688 

-0.383281,0.146688"

         inkscape:connector-curvature="0" />

    </g>

  </g>

</svg>
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Conclusion générale
•• Passer par le code SVG permet de régler (ou au moins comprendre) certains problèmes.
• SVG est un format web et tous les navigateurs affichent un fichier SVG. A condition d'avoir accès à un serveur

web, on peut assez facilement publier un dessin sur Internet. Pour inclure des images SVG dans un portail
(wordpress par exemple), il faut installer un plugin, car SVG présente des légers risques de sécurité. SVG est
intégré à HTML (lire Tutoriel SVG avec HTML5) et on peut donc créer des pages web "manuelles" qui contiennt
des images de broderie.

•• Il existe d'autres outils d'édition que InkScape. Certains (comme Illustrator ou InkScape) ajoutent des extensions
XML. On conseille d'échanger du SVG "pur", donc toujours enregistrer/exporter en tant que "SVG simple".
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Inkscape - édition des chemins

Introduction
Cette contribution décrit comment modifier un tracé dans le logiciel de dessin Inkscape, et explique les différentes
possibilités disponibles dans le menu Chemin (Path) du logiciel.

Exemple d'un dessin à main levée avec le logiciel
Inkscape

Au contraire des formes dessinées par les outils de création de forme
du logiciel, l'outil Stylo et l'outil Crayon créent ce qu'on appelle des
chemins.

Un chemin est une séquence comprenant des segments de lignes
droites ou de courbes de Bézier qui, comme tout autre objet sur
Inkscape, peut avoir des propriétés de remplissage et de contour par
exemple. Cependant, contrairement à une forme, un chemin peut être
modifié en faisant glisser librement l'un de ses noeuds ou en faisant
glisser directement un segment du chemin.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Tutoriel_SVG_avec_HTML5
https://fr.wikipedia.org/wiki/Image_matricielle
https://fr.wikipedia.org/wiki/Image_vectorielle
http://openclipart.org
https://frappe.io/charts
http://snapsvg.io/demos/#coffee
https://openclipart.org/
https://thenounproject.com/
https://freesvg.org/
https://svgsilh.com/fr/
https://pixabay.com/vectors/search/
https://www.freepik.com/
https://publicdomainvectors.org/
https://code.visualstudio.com/
https://svg-edit.github.io/svgedit/editor/svg-editor.html
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ADessin_main_lev%C3%A9e.png
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Dessiner à main levée et créer des chemins

Exemple d'un dessin avec l'outil Bézier dans le
logiciel Inkscape.

La façon la plus simple de créer une forme arbitraire est de dessiner en
utilisant l’outil « Dessin à main levée » (Touche F6). Vous pouvez
lisser votre dessin en le sélectionnant et ensuite en appuyant sur
CTRL-L une ou plusieurs fois.

Si vous souhaitez des formes plus régulières, utilisez l’outil « Stylo »
(ou « Bézier ») (Touches Maj + F6). Avec l’outil Stylo, chaque clic va
créer un nœud que l’on pourrait qualifier de « pointu » car il n’y aura
pas de poignées pour modifier les courbures du trait. Ainsi, une série
de clics va produire une séquence de segments de lignes droites. Si
vous cliquez et déplacez (« Drag & Drop »), vous allez créer un nœud
de Bézier plus adoucis, qui comprendra deux poignées opposées pour modifier la courbure du trait.

Appuyer sur la touche Maj tout en déplaçant une poignée avec la souris va vous permettre d’effectuer une rotation
sur une seule des poignées et de maintenir fixe les autres.
Appuyer sur la touche Ctrl va limiter la direction du segment de ligne droite ou de la poignée de l’outil Bézier de
seulement 15 degrés.
La touche Entrée va quant à elle terminer la ligne dessinée et la touche Esc va l’annuler. Si vous ne voulez
qu’annuler le dernier segment d’une ligne non terminée, appuyez sur la touche Retour en arrière

(backspace).
Dans les outils Dessin à main levée et Outil Bézier, le chemin qui est sélectionné affiche de petites ancres carrées aux
deux extrémités. Ces ancres vous permettent de continuer ce chemin (en cliquant puis tirant l'une des ancres) ou de le
fermer (en dessinant d'une ancre à une autre) au lieu d'en créer une nouvelle.

Convertir un objet en chemin
N'importe quelle forme ou objet de type texte peut être converti en chemin (Maj + Ctrl + C) en passant par le
menu Chemin > Objet en chemin (Path > Object to path).
Cette opération ne modifie pas l'apparence de l'objet mais supprime toutes les capacités spécifiques à son type (par
exemple, vous ne pourrez plus arrondir les coins d'un rectangle ou modifier le texte initial). À la place, vous pouvez
par contre maintenant modifier les nœuds.
Comme action supplémentaire, vous pouvez convertir votre contour d'objet en chemin (Alt + Ctrl + C). Cela
permet notamment de modifier un objet n'ayant pas de remplissage d'origine mais que des traits, en un objet n'ayant
que du remplissage mais pas de traits.
Attention ! Un objet peut toujours se convertir en chemin, mais un chemin ne pourra jamais être converti en
objet.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ADessin_outil_b%C3%A9zier.png
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Opérations sur les chemins
Il existe plusieurs façons de modifier un tracé dans le logiciel Inkscape. Selon la nature du tracé, les possibilités
varient.
Si le tracé est d'abord un rectangle, une ellipse, une étoile ou une spirale, c'est-à-dire une forme géométrique tracée à
partir des outils de formes, le résultat est un objet et non un chemin. Les modifications de ces formes sont accessibles
uniquement en glissant les poignées blanches.
Par contre, pour modifier un chemin, il faut utiliser les outils liés aux chemins, ou alors convertir les objets en
chemins (voir la section précédente)
Les opérations sur les chemins agissent sur les chemins ou convertissent le résultat en chemin. Il existe plusieurs
types d'opérations [1] que l'on peut retrouver dans le menu "chemin" (path) d'Inskcape[2], et dont des exemples sont
disponibles sur le site de Freenambule [3]:

Menu Chemin : Opérations sur les chemins

https://www.freenambule.com/2010/10/08/inkscape-05-operation-sur-les-chemins/
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AOutils_chemin_inkscape.png
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Opération Racccourcis
clavier

Description

Union Ctrl + + Relie les formes sélectionnées en une seule forme

Différence Ctrl + - Soustrait une forme à une autre

Intersection Ctrl + * Ne conserve que l'intersection des deux formes

Exclusion Ctrl + ^ Exclut l'intersection des deux formes

Division Ctrl + / Le premier chemin est découpé par le deuxième

Découper les chemins
(Cut Paths)

Ctrl + Alt

+ /

Permet de créer autant de chemin que d'intersections

Combiner Ctrl + K Assemble les deux chemins en une seule forme

Séparer Maj + Ctrl

+ *

Si un chemin est composé de deux formes distinctes, cela crée deux chemins différents

Contracter (Inset) Ctrl + ( Permet de contracter une forme en mettant à l'échelle, mais également en décalant le chemin d'un objet,
c'est-à-dire en le déplaçant perpendiculairement au chemin en chaque point

Dilater (Offset) Ctrl + ) Permet d'étendre (dilater) une forme en mettant à l'échelle, mais également en décalant le chemin d'un
objet, c'est-à-dire en le déplaçant perpendiculairement au chemin en chaque point

Offset dynamique Ctrl + J Crée un objet avec une poignée déplaçable (similaire à la poignée d'une forme) contrôlant la distance
de décalage

Offset lié Similaire à l'offset dynamique, l'offset lié crée un objet connecté à un autre chemin qui reste
modifiable. Il est possible d'avoir plusieurs offset liés à un même chemin source

Simplifier Ctrl + L Réduire le nombre de nœuds sur un chemin tout en préservant au mieux sa forme

Inverser Inverser le sens du chemin

Illustration des opérations sur des chemins

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape_chemins_operations.jpg
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Sous-chemins et combinaisons
Un chemin peut contenir plusieurs sous-chemins. Un sous-chemin est alors une séquence de plusieurs nœuds
connectés les uns aux autres. Par conséquent, si un chemin a plus d'un sous-chemin, tous ses nœuds ne sont pas
forcément connectés.
Inkscape peut "combiner" des chemins en un chemin composé de sous-chemins (Ctrl + K) et séparer ce chemin
composé en des chemins séparés (Maj + Ctrl + K). Puisqu'un objet ne peut avoir qu'un seul remplissage et trait,
un nouveau tracé composé garde alors le style du premier objet à combiner.
Lorsque vous combinez des chemins qui se chevauchent avec un remplissage, le remplissage disparaît généralement
dans toutes les zones où les chemins se chevauchent. C'est par exemple le moyen le plus simple de créer des objets
avec des trous.

Les nœuds
Les chemins contiennent tous au minimum un nœud, qui est représenté par un carré, un losange ou un rond. Il est
possible d'utiliser l'outil nœud F2 dans la barre de menu de gauche pour visualiser et sélectionner les nœuds.

Les types de nœuds
Inkscape permet de créer des types de nœuds différents, qui se comportent chacun d'une manière spécifique: [4] [5]

• Les nœuds durs ou Cusp nodes : Utilisé pour créer des coins ou pour pouvoir modifier librement la courbure du
tracé. Les poignées peuvent être déplacées indépendamment. Ce type de nœud est représenté par un losange.

• Les nœuds doux ou Smooth nodes : Utilisé pour dessiner de belles courbes fluides. Les deux poignées et le nœud
sont alignés sur une ligne droite. Ce type de nœud est représenté par un carré.

• Les nœuds symétriques ou Symmetric nodes: Utilisé pour dessiner des courbes douces. Les poignées ne sont pas
seulement sur la même ligne, mais également les deux à la même distance du nœud. Les nœuds symétriques sont
également représentés par des carrées, mais leurs poignées se déplacent toujours ensemble.

• Les nœuds automatiques ou Auto-smooth nodes: Utilisé pour dessiner de jolies courbes, sans se soucier des
poignées ou des formes de segment. Les poignées reposent sur une ligne droite et leur distance par rapport au
nœud s'adapte automatiquement lorsque vous déplacez le nœud, de sorte qu'une courbe lisse est dessinée. Ce type
de nœud est représenté par un rond.

Illustration des différents types de noeuds

Il est possible de changer de type de nœud grâce à l'outil nœud (voir la partie suivante). Lorsque vous changez de
type de nœud, vous pouvez aussi conserver la position de l'une des deux poignées en passant votre souris dessus, de
sorte à ce que seule l'autre poignée soit tournée ou mise à l'échelle.
De plus, vous pouvez complètement rétracter la poignée d'un nœud en maintenant la touche Ctrl + clic dessus. Si 
deux nœuds adjacents ont leurs poignées rétractées, le segment de chemin présent entre eux est alors une ligne
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droite. Pour retirer le nœud rétracté, appuyez sur Maj + glisser le curseur hors du nœud.

Sélectionner un nœud

Icône du bouton permettant de masquer / afficher
les poignées des noeuds sélectionnés

Les nœuds doivent être sélectionnés avant de pouvoir être modifiés (à
une exception près, cliquer-faire glisser un chemin déplacera le chemin
en ajustant les poignées sur les nœuds les plus proches). Les nœuds
sélectionnés sont indiqués par un changement de couleur ainsi qu'un
léger agrandissement de taille. [6]

Par défaut, les poignées des nœuds sélectionnés sont affichées, tout
comme les poignées des nœuds adjacents. Si les poignées gênent la
sélection des nœuds, elles peuvent être désactivées en cliquant sur
l'icône Masquer les poignées dans les contrôles d'outils. Cliquez une
deuxième fois sur l'icône pour réactiver les poignées.

Pour modifier les noeuds, il est possible de les sélectionner de
différentes manières.
•• Cliquer avec le bouton gauche de la souris sur un nœud pour

sélectionner ce nœud. Un nœud devient rouge lorsque le pointeur le
survole et il peut être sélectionné (ou désélectionné). Notez qu'un nœud peut être sélectionné et déplacé en une
seule étape en cliquant-glissant sur le nœud.

•• Cliquer avec le bouton gauche de la souris sur le chemin pour sélectionner le nœud le plus proche de chaque côté
de l'endroit où vous avez cliqué. Le symbole de la main est ajouté au pointeur lors du survol d'un chemin
cliquable. Notez que le chemin peut être ajusté en cliquant-glissant sur le chemin. Dans ce cas, les nœuds les plus
proches ne sont pas sélectionnés.

• Le glissement gauche de la souris sélectionnera tous les nœuds dans la zone élastique. Le glissement ne doit pas
commencer sur un chemin à moins que la touche Maj soit utilisée, permettant au glissement de commencer sur
un chemin sauf sur un nœud (interrompu dans la v0.48).

Les nœuds peuvent être ajoutés (ou supprimés) de la sélection en maintenant la touche Maj enfoncée tout en
utilisant l'une des méthodes précédentes.

Modifier des nœuds
La souris peut être utilisée pour déplacer les nœuds et les poignées en les faisant glisser, et peut également être
utilisée pour modifier la forme d'un chemin entre deux nœuds en faisant glisser le chemin. Les nœuds peuvent être
insérés n'importe où le long d'un chemin en double-cliquant sur le chemin ou en cliquant sur le chemin tout en
maintenant les touches Ctrl + Alt enfoncées. [7]

Pour effectuer cette action de modification de chemins, sélectionnez donc un chemin et passez à l'outil « Noeud »
(Touche F2). Vous observerez un certain nombre de noeuds (petits carrés gris) créés sur le chemin . Ces noeuds
peuvent alors être sélectionnés en cliquant dessus ou en appuyant sur la touche Maj + clic gauche, ou en
faisant "glisser" un segment comme avec les objets que vous sélectionnez avec l'outil Sélecteur par exemple. Vous
pouvez également cliquer sur un segment de chemin pour sélectionner automatiquement les nœuds adjacents. Les
nœuds sélectionnés sont alors mis en surbrillance et affichent leurs poignées de nœuds (un ou deux petits cercles
connectés à chaque nœud sélectionné par des lignes droites). La touche ! inverse la sélection de nœuds dans le ou
les sous-chemins actuels (c'est-à-dire les sous-chemins avec au moins un nœud sélectionné); Les touches Alt + !
inversent tout le chemin sélectionné.
Les chemins sont donc modifiables en faisant glisser leurs nœuds, leurs poignées de nœud ou en faisant glisser 
directement un segment de chemin. Pour vous exercer, essayez de faire glisser certains nœuds, poignées et segments
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de chemins et observez ce qui se passe. Pour annuler vos actions, n'hésitez pas à utiliser les actions habituelles
"Annuler" ou "Rétablir" (Ctrl + Z).

Touches clavier utiles pour les modifications

Comme autre touches clavier utilisables avec les chemins, nous avons également la touche Ctrl qui fonctionne
comme d'habitude pour restreindre le mouvement et la rotation. Les touches fléchées, Tab, [], < > fonctionnent
aussi toutes avec les chemins mais s'appliquent aux alors aux nœuds au-lieu des objets. Sachez également que vous
pouvez ajouter des nœuds n'importe où sur un chemin en double-cliquant ou en appuyant sur Ctrl + Alt +
clic gauche à l'emplacement souhaité.

Utiliser l'outil nœud et les contrôles

Lorsque l'outil nœud est activé, plusieurs contrôles apparaissent en haut de l'écran, permettant d'effectuer différentes
opérations sur les nœuds sélectionnés. [8]

Opérations sur les noeuds - Menu de l'outil noeud

Des exemples des différentes opérations sur les noeuds sont disponibles sur le manuel FlossManuals [9].

Opération Racccourcis clavier Description

Insérer Insérer Insérer de nouveaux nœuds dans les segments sélectionnés

Supprimer Retour arrière, Supprimer / delete ou
Ctrl + Alt + Click gauche

Supprimer le nœud sélectionné

Joindre (join) Maj + J Joindre (fusionner) les nœuds finaux sélectionnés

Casser (break) Maj + B Rompre le chemin aux nœuds sélectionnés. Chaque nœud
sélectionné est converti en deux nœuds finaux.

Joindre les nœuds
finaux

Joindre les nœuds finaux sélectionnés avec un nouveau
segment

Supprimer le segment Supprimer le segment entre deux nœuds non-finaux

Modifier en nœud dur Maj + C Modifier le nœud en nœud dur

Modifier en nœud
doux

Maj + S Modifier le nœud en nœud doux

Modifier en nœud
symétrique

Maj + Y Modifier le nœud en nœud symétrique

Modifier en nœud
automatique

Maj + A Modifier le nœud en nœud automatique

Modifier en ligne
droite

Maj + L Modifier le segment en ligne droite

Modifier en courbe Maj + U Modifier le segment en courbe

Convertir en chemins Maj + Ctrl + C Convertir les objets sélectionnés en chemins

Convertir le contour
en chemins

Ctrl + Alt + C Convertir le contour de l'objet sélectionné en chemins

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AOutils_noeud_inkscape.png
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Illustration des opérations sur les noeuds

Aligner et distribuer les noeuds

Lorsque l'outil de sélection des noeuds est activé, le menu Aligner et Distribuer (Maj + Ctrl + A ou Menu >
Objet > Aligner et distribuer) affiche des commandes spéciales qui permettent d'aligner ou distribuer les nœuds
sélectionnés, et qui peuvent être utiles pour placer uniformément des marqueurs sur une ligne droite.

Icônes des commandes pour aligner / distribuer
les noeuds

Les commandes disponibles sont:
•• Aligner les nœuds sélectionnés le long d'une ligne horizontale.
•• Aligner les nœuds sélectionnés le long d'une ligne verticale.
•• Distribuer les nœuds sélectionnés horizontalement.

•• Distribuer les nœuds sélectionnés verticalement.

Aligner et distribuer les noeuds : exemples

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape_noeud_illustration.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape_-_aligner_et_distribuer_les_noeuds.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape_-_Aligner_et_distribuer_les_noeuds.png
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Effacer / Supprimer un nœud

Vous pouvez supprimer des nœuds avec Suppr ou Ctrl + Alt + clic. Lors de la suppression de nœuds, le
logiciel essaiera de conserver la forme du chemin. Si vous souhaitez que les poignées des nœuds adjacents soient
rétractées (sans conserver la forme), vous pouvez supprimer avec Ctrl + Suppr. De plus, vous pouvez dupliquer
(Maj + D) les nœuds sélectionnés. Le chemin peut être rompu (Maj + B) au niveau des nœuds sélectionnés, ou si
vous sélectionnez deux nœuds finaux sur un seul chemin, vous pouvez les joindre (Maj + J).

Sources
[1] Flossmanuals : Initiation à inkscape, les opérations sur les chemins (https:/ / fr. flossmanuals. net/ initiation-inkscape/

les-operations-sur-les-chemins/ )
[2] Tutoriel Inkscape : tutoriel avancé (https:/ / inkscape. org/ doc/ tutorials/ advanced/ tutorial-advanced. html)
[3] https:/ / www. freenambule. com/ 2010/ 10/ 08/ inkscape-05-operation-sur-les-chemins/
[4] Readthedocs.io - Inkscape manual, node type (https:/ / inkscape-manuals. readthedocs. io/ en/ latest/ node-types. html)
[5] Flossmanuals : Initition à Inkscape, les différents types de noeuds (https:/ / fr. flossmanuals. net/ initiation-inkscape/

les-differents-types-de-noeuds/ )
[6] Inkscape manual : Path editing (http:/ / tavmjong. free. fr/ INKSCAPE/ MANUAL/ html/ Paths-Editing. html)
[7] Inkscape manual : Path editing (http:/ / tavmjong. free. fr/ INKSCAPE/ MANUAL/ html/ Paths-Editing. html)
[8] Inkscape manual : Path editing (http:/ / tavmjong. free. fr/ INKSCAPE/ MANUAL/ html/ Paths-Editing. html)
[9] https:/ / fr. flossmanuals. net/ initiation-inkscape/ loutil-noeud/

InkStitch - broder avec du gros fil

Guide de tutoriels de broderie machine

Module: InkStitch

⚐ brouillon ☸ débutant

⚒ 2022/09/27
Prérequis

•• Inkscape

Objectifs

•• Créer des broderies avec du fil lourd

Autres pages du module

•• InkStitch
•• InkStitch - installation
•• InkStitch - utilisation de base
•• InkStitch - broderie ondulée
•• Inkstitch - textures de remplissage
•• InkStitch - lettrage
•• InkStitch - colonnes satin
•• InkStitch - exemples colonnes satin
•• InkStitch - broder un emoji
•• InkStitch - broder une image issue de The Noun Project
•• InkStitch - broder des codes QR
•• InkStitch - broder des patchs et des appliqués
•• InkStitch - astuces et problèmes courants
•• InkStitch - bases SVG
•• Inkscape - édition des chemins
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•• InkStitch - broder avec du gros fil
•• InkStitch - broderies à partir de dessins faits à la main
•• InkStitch - points manuels
•• InkStitch - points programmables
Catégorie: InkStitch

Broder avec du gros fil est comme passer, en peinture, de aquarelle à l'acrylique ou a l'huile. Il faut repenser le
design du motif de la broderie et il faut utiliser un paramétrage très différent, notamment au niveau de la densité, de
la sous-couche et de la densité des points.
Cet article est une ébauche qui discute quelques essais.

Les gros fil
Rappelons d'abord quelques principes détaillés dans les article Fil à broder et Aiguille pour machines à broder et à
coudre. Comme un gros fil est plus large, il fait des nœuds beaucoup plus volumineux. Ainsi, des problèmes comme
rupture de fil, aiguille cassée, constitution de nids arrivent nettement plus rapidement. Une règle simple: Pas deux ou
plusieurs nœuds au même endroit. Évitez aussi à piquer au même endroit.
Tailles de "gros fils"

Il existe deux tailles: wt 30 (mi-gros) et wt 12 (gros). La taille d'un fil n'est pas mesuré en diamètre mais en poids.
"12" veut dire qu'on peut dérouler un kg de fil 12 pendant 12 km, un fil "30" pendant 30 kilomètres, le fil standard
"40" pendant 40km et le fil mince "60" pendant 60km. "wt" est une abréviation de weight, poids en français. Le fil
standard en broderie de poids 40 et a environ 0.2mm de diamètre, alors que le fil 12 fait environ le double. Diamètres
et poids peuvent varier selon le constructeur et le type de fil, c.f. l'article fil à broder pour plus de détails sur les
mesures. Il varie aussi selon la tension, le type de tissu, etc.
Pratiquement, cela veut dire qu'un fil 12 est plus que 3 fois plus volumineux. Pour illustrer ce principe, on peut
montrer qu'on peut facilement broder un design fait pour un fil de poids 12 avec trois fils de poids 40 enfilés
simultanément.

Motif brodé avec un
fil coton 12 wt.

Même motif brodé avec trois fils 40 wt
simultanés qui ont le même volume qu'un seul

fil 12

Types de fil

Dans le commerce on trouve trois grandes catégories de gros fils
• Rayon /Viscose, notamment le Decora 12 [1] de Madeira.
• Cotton, notamment le Cotty [2] de Gunold, en tailles 30 et 12
• Aspect laine, notamment la Filaine [3] de Gunold (100% acrylique) et le Lana [4] / Burmilana de Madeira (50%

laine / 50% acrylique)
Ces trois types de fils ont des propriétés différentes:
•• Le rayon est surtout utilisé pour couvrir des plages larges, des bordures épaisses en satin ou encore pour faire des

points décoratifs. C'est le fil le plus facile à broder puisqu'il glisse bien.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cat%C3%A9gorie:InkStitch
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fil_%C3%A0_broder
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https://edutechwiki.unige.ch/fmediawiki/index.php?title=Aiguille_pour_machines_%C3%A0_broder_et_%C3%A0_coudre
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fil_%C3%A0_broder
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AEmbroidery-heart-cotty-12.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AEmbroidery-heart-3-threads.jpg
https://garne.madeira.de/3/maison/produits/filsabroderetpourquilting/decora/decora-12/
https://www.gunold.de/fr/produits/fil-de-dessus/cotty-cotty-bio-fil-de-coton/
https://www.gunold.de/fr/produits/fil-de-dessus/filaine-fil-de-laine/
https://garne.madeira.de/3/maison/produits/filsabroderetpourquilting/lana/lana-12/
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•• La coton est le plus proche de la broderie main, puisqu'on utilise en règle générale ce type de fil. On peut aussi
l'utiliser comme le rayon, par exemple pour créer les bordures d'écusson.

•• La laine (acrylique ou mélange) est le plus difficile à broder car il a le plus de "poils". Il donne un aspect "poils"
et se prête donc bien pour broder des motifs d'animaux.

Le coton et la laine peuvent être brossés avec une brosse en métal pour obtenir un aspect doux et feutré à la broderie.
Règles générales d'utilisation

Les règles pour broder avec ces fils sont plus ou moins les mêmes, sauf qu'on conseille de diminuer la vitesse, cela
concerne particulièrement les fils poilus comme a Filaine de Gunold ou la Burmilana de Madeira..
Aiguille: Pour le fil de taille 12, il faut une aiguille Topstitch 100. Une 110 universelle ou une 90 topstitch vont
aussi, mais le fil risque de casser plus et de coincer dans les enfileurs. Il ne faut surtout pas utiliser une aiguille de
broderie (type H-E) plus petite que 110 !
Densités: Il faut diviser les densités des tatami par 2 environ, donc environ 2 à 2.5 fils/mm. On peut densifier le satin
par contre.
Remplissage: Cherchez à éviter le tatami, sinon il faut vérifier que les points soient allongés. Il n'y a pas besoin de
sous-couche en principe si on brode plutôt densément (2.5 linges/mm). A la place, on peut obtenir des effets joli en
juxtaposant des lignes (comme en broderie main, c.f. l'exemple carotte ci-dessous)
Longueur des points: Il faut allonger les points de 50% au moins, donc broder avec des points de 4 à 5mm d'écart.
Design: Évitez les broderies qui ont trop de détails (petites surfaces, changement de fils, etc.) Un nœud à huit fois le
volume d'un noeud pour un fil 40!! Donc si vous prenez par exemple un motif fait pour du 40, il ne faut pas juste
l'agrandir mais aussi écarter les points d'arrêt. C'est exactement le contraire du fil 60 qui permet de broder des choses
super serrées....
Dans les sections suivantes on discutera quelques cas pratiques.

Remplissage d'une carotte avec le cotty 12
Cet exemple simple montre comment un peu obtenir un effet brodé main avec une forme simple. Les images
suivantes montrent qu'un remplissage tatami n'est pas intéressant et pour deux raisons: D'abord il y a des
imperfections (on les lignes des bordures) et ensuite cela ne donne pas vraiment un effet "broderie main". On obtient
un meilleur résultat avec un remplissage hachée (des lignes en parallèle.

Remplissage
"normal" tatami

Remplissage en lignes parallèles Remplissage en lignes parallèles

Meilleur design (à notre avis)
•• Lignes crées avec un hatch fill (fr: remplissage hachuré). Pour cela il faut installer l'extension. Alternativement on

aurait aussi pu utiliser le remplissage de InkStitch pour créer le tapis (pas mettre de sous-couche), ensuite générer
la plant de broderie et et copier/coller le résultat. Finalement depuis la version 2.2. il existe des modes de
remplissage, notamment le remplissage selon contour et surtout la broderie ondulée qu'il faudrait tester !

•• Distance entre les lignes = 1mm
•• Paramétrage: points quintuples pour la partie rouge, points triples pour le vert (donne un peu moins de volume).
Ci-dessous on explique comment y arriver.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AEmbroidery-carrot-12wt-c.jpg
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Choix et installation du hatch fill

Le hatch fill peut se faire soit avec une extension de InkScape, soit un détournant le remplissage Tatami. Le "hatch
fill" original fait partie de l'extension Eggbot disponible chez Evil Mad Scientist [5]. Les explications pour
l'installation sont sur la page Installing software [6]. Toutefois, nous conseillons à la place d'installer la version de
hatch fill de Mightyspace, une super large collection d'extension utile dans un contexte de fabrication.
Dossier de téléchargement de l'extension (Février 2022, le dossier peut changer)
• mightyscape-1.X-zipmirror [7] (attention il faut d'abord cliquer sur le fichier voulu, puis utiliser le bouton

download, comme ci-dessous).
• download [8] (il faut cliquer sur le bouton download)
Il faut dézipper le fichier hatch_fill.zip dans le dossier extensions de InkScape.
L'installation complète de toutes les fonctionnalités de ce paquet demande quelques compétences, mais le "hatch"
fonctionnera aussi avec une installation moitié complétée. Si cela vous intéresse, voici la page officielle. Vous devez
aussi consulter cette page si le lien ci-dessus ne fonctionne plus.
• MightyScape 1.X - Introduction and Installation [4]

Le hatch fill se trouvera dans Extensions->FabLab Chemnitz->Shape/Patterns from existing Path
Paramétrage dans Hatch fill

•• Sélectionnez un remplissage à remplir avec des lignes hachurées
•• Lancez l'extension
•• Hatch spacing = 1
•• Crosshatch = décoché
Le résultat va se trouver un groupe: d'abord le "hatch fill", ensuite l'original que vous pouvez utiliser pour créer une
bordure (enlever le fond, définir un contour, élargir un peu et mettre aussi en pointillés).

https://wiki.evilmadscientist.com/Hatch_fill
https://wiki.evilmadscientist.com/Installing_software
https://github.com/eridur-de/mightyscape-1.X-zipmirror
https://github.com/eridur-de/mightyscape-1.X-zipmirror/blob/master/hatch_fill.zip
https://stadtfabrikanten.org/pages/viewpage.action?pageId=73040380
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Hatch fill de InkScape: remplissage en lignes

Paramétrage dans InkStitch

Si ce n'est pas déjà fait, il faut mettre la ligne de remplissage en pointillés de votre choix, une convention Ink/Stitch
pour définir un point droit (répété ou non).
Comme on le dit dans l'introduction, il est important de respecter les contraintes physiques de ce fil.
On conseille de visualiser la largeur approximative du fil lorsqu'on définit les pointillés des lignes (contours).
Puisqu'un point quintuple, donc un double point triple prendra pas mal de largeur on a choisi 08.mm un compromis
qui nous permet de toujours voir les lignes.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape-green-carrot-hatch-fill.png
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Visualisation du remplissage en lignes

Ensuite on utilise les paramètres suivants pour des lignes qui ont 1mm de distance
•• 2 répétitions pour le point triple
•• Longueur des points = 4mm (peut être augmentée)

Paramétrage du remplissage en lignes

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-hatch-fill-visualization.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-hatch-fill-visualization-b.png
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Remplissage radial
(à faire)

Réutilisation de motifs faits pour taille 40
Il existe deux situations:
1.1. Adapter un fichier design
2.2. Adapter un fichier machine

Adapter un fichier design
Selon les principes évoqués au début, il faut dans la plupart des cas:
•• simplifier le dessin, éliminer les petits objets pas nécessaires
•• écarter si possible les points d'arrêt (inkstitch ne s'adapte pas à la taille du fil)
•• penser à remplacer certains remplissages ou alternativement supprimer les sous-couches
•• Changer la densité de tous les objets et allonger la longueur des points.

Adapter un fichier machine
Il est possible broder certains designs commerciaux. Il faut qu'ils ne contiennent ni trop de détails ni beaucoup
changements de fils (noeuds d'arrêt rapprochés) ni multiples superpositions/sous-couches.
Pour un motif réutilisable pour un fil 12 on conseille les opérations suivantes
•• Il faut agrandir le design de 200% environ (sans faire recalculer les points). Donc, ouvrez le fichier machine (par

exemple *.PES) dans InkScape / InkStitch, verrouiller les dimensions dans la barre de menu et doubler la largeur.
Ensuite de nouveau enregistrer en tant que fichier machine.

•• Ouvrez le panneau objets. Supprimez toutes (ou presque) toutes les coupes de fils. Il restera quand-même les
points de verrou au début et à la fin d'une section, mais les noeuds seront moins larges.

•• Vérifiez qu'il n'ait pas trop de couches superposés, sinon essayez de les éliminer.
Un exemple "envol" était discuté dans l'article Fil à broder. Ci dessous on montre des photos de nœuds qui sont crée
lors de points d'arrêt et de coupe. On comprend pourquoi il faut faire très attention à leur concentration !

Quelques noeuds de la
broderie du paysage avec le
cadre large 36.0 x 20.0cm

Points d'arrêts du fil noir, on voit que cela prend vite du volume

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fil_%C3%A0_broder
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ABroder-envol-noeuds.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ABroder-envol-noeuds-2.jpg
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Références
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[2] https:/ / www. gunold. de/ fr/ produits/ fil-de-dessus/ cotty-cotty-bio-fil-de-coton/
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https://garne.madeira.de/3/maison/produits/filsabroderetpourquilting/decora/decora-12/
https://www.gunold.de/fr/produits/fil-de-dessus/cotty-cotty-bio-fil-de-coton/
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https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cat%C3%A9gorie:InkStitch
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Fichier de Broderies à partir de dessins faits main
Créer des fichiers de broderies à partir de photos, de peintures ou de dessins complexes à la main peut s'avérer
difficile. Nous apprendrons à travers cette page à créer des designs de broderie à partir de dessins simples. Pour
d'autres cas, lisez le survol dans InkStitch - broder des images.
Notre méthode simple a été testée avec des centaines de patches en utilisant le logiciel commercial Stitch Era,
comme par exemple au Salon du livre 2018. Elle marche aussi bien avec InkStitch, mais prend un peu plus de temps.
Après avoir réduit les couleurs (avec le logiciel gratuit GIMP), tracer des vecteurs avec Inkscape marche bien si le
dessin original est simple. Il faut notamment éviter de dessiner des éléments qui se superposent et sont de même
couleur.

Dessin à la main souhaité
Afin de créer un fichier SVG manipulable à partir d'un dessin à la main, nous suggérons de respecter les différentes
règles ci-dessous:
•• utiliser des feutres larges
•• utiliser peu de couleurs
•• utiliser des couleurs avec contraste (i.e. rouge, bleu, vert, noir)
•• Ne pas faire de remplissage sur de zones large (difficiles à broder)
A droite, un exemple acceptable d'un dessin fait à la main (sans parler de la qualité du dessin).
Il est relativement facile d'utiliser des dessins d'enfants plus complexes, comme nous l'expliquons sur la page créer
une broderie à partir d'un dessin d'enfant, à l'aide du logiciel Stitch Era. Par contre, créer une broderie à partir d'une
peinture ou d'une photographie peut prendre énormément de temps et pour cette raison nous le déconseillons.

Scanner, couper et réduire les couleurs
Avant de vectoriser (et de tracer) un dessin scanné, on suggère de réduire les couleurs.
Beaucoup de logiciels permettent de réduire les couleurs. Nous utilisons Gimp [1], un logiciel puissant et gratuit de
manipulations d'images. Même si c'est un outil complexe qui demande du temps afin de comprendre son
fonctionnement, les manipulations énoncées ci-dessous ne sont pas trop difficiles à effectuer.

Étape 1 - Scanner
Scannez l'image au format .jpg. Photographier l'image avec un portable va aussi, mais essayer d'éviter des ombres
!
N'importe quelle résolution fonctionnera puisque la broderie peut fonctionner généralement à une résolution très
basse.

Etape 2 - Rogner
Recadrer la photo. Vous n'avez pas besoin de faire très attention à la taille des marges. Cependant, vous devez
décider si vous voulez une image complète ou une partie de celle-ci. Ci-dessous, nous avons décidé de découper une
partie du dessin pour le rendre plus rectangulaire.
•• Ouvrez la photo dans Gimp.
•• Faites glisser la souris pour sélectionner un rectangle. Par défaut, l'outil de sélection de rectangle est déjà

sélectionné. Vous pouvez tirer / pousser les bordures du rectangle (déplacez le curseur tout près) avant de cliquer
sur "Crop to Selection".

•• Sauvegardez le fichier.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=InkStitch_-_broder_des_images
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Stitch_Era_-_logiciel_de_broderie_machine_et_de_hotfix
https://edutechwiki.unige.ch/fmediawiki/index.php?title=GIMP
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Stitch_Era_-_cr%C3%A9er_une_broderie_%C3%A0_partir_d%27un_dessin_d%27enfant
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Stitch_Era_-_cr%C3%A9er_une_broderie_%C3%A0_partir_d%27un_dessin_d%27enfant
https://www.gimp.org/downloads/
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Couper une image avec Gimp 2.10

Etape 3 - Réduire les couleurs
Comme expliqué dans le manuel en ligne de Gimp [2], la réduction des couleurs est très simple (sauf si vous avez
besoin de transitions douces entre les couleurs, ce que la broderie ne requière pas).
Ouvrez l'outil de réduction des couleurs et réduisez les couleurs avec les paramètres de conversion suivants:
• Définissez le nombre maximal de couleurssur le nombre de couleurs que vous pouvez compter sur votre

dessin, plus une pour l'arrière plan.
•• Ne touchez pas à l'option "Dithering".
• Cliquez sur Convertir et vérifiez le résultat (voir la figure ci-dessous).

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AGimp-crop-picture.png
https://docs.gimp.org/fr/gimp-image-convert-indexed.html
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Image: Réduction de couleur avec Gimp 2.10

Couleurs indexées

Sélectionnez le nombre approprié de couleurs

Si vous pouvez voir les éléments importants du dessin dans des couleurs approximativement correctes, continuez,
sinon:
•• Annulez (appuyez sur Ctrl-Z).
•• Ajoutez une couleur supplémentaire.
•• Répétez cette opération jusqu'à ce que tous vos éléments de dessins sont d'une couleur différente.

Avant et après la réduction de couleur

Dessin à la main scanné fait pour la broderie Dessin à la main scanné, fait pour la broderie, avec
couleurs réduites

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AGimp-indexed-colors.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AGimp-indexed-colors-2.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AVacation-1.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AVacation-2.jpg
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Etape 4 - Ajuster les couleurs (optionnel)
Ouvrez l'outil de palette de couleurs:
• Windows -> Dockable dialogs -> Colormap

Réduction de couleurs avec Gimp 2.10

Vous pouvez maintenant modifier les couleurs ou fusionner deux couleurs, par exemple en attribuant le même code
de couleur à deux couleurs indexées ou plus. Vous devez également rendre le fond entièrement blanc (#ffffff), sauf si
vous souhaitez le broder.

Réduction de couleurs avec Gimp 2.10

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AGimp-indexed-colors-3.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AGimp-indexed-colors-4.png
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Etape 5 - Enlever le fond (optionnel)
Vous pouvez rendre la couleur d'arrière-plan transparente (à moins que certains dessins utilisent la même couleur).
•• À l'étape 4 précédente, assurez-vous que l'arrière-plan est blanc (#ffffff).
• Ajoutez un canal pour la couche alpha: Layer -> Transparency -> Add Alpha Channel
• colors -> Colors to Alpha ...

Rendre le fond transparent

Sauvegardez le fichier.

Etape 6 - Exporter
Pour pouvoir tracer le fichier "raster", nous avons besoin d’un format lisible par Inkscape et qui conserve
l’arrière-plan transparent.
• Exportez le fichier au format .png

Tracer le fichier matriciel avec InkScape
Vous devez maintenant convertir le fichier matriciel (bitmap/raster) à couleurs réduites en images vectorielles SVG.
Si votre dessin est simple, ce n'est pas trop compliqué. Sinon, cela peut prendre du temps.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AGimp-indexed-colors-5.png
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Tracer avec Inkscape 1.x (en Anglais)

1. Ouvrez l’image dans InkScape, c’est-à-dire importez l’image couleur .png réduite que vous avez créée avec
GIMP (Fichier -> Ouvrir).

2.2. Sélectionnez la photo (cliquez dessus).
3. Ouvrez l'outil de traçage Chemin -> Vectoriser un objet matriciel (Angl. Path -> Trace

Bitmap).
4. Cochez couleurs sous Plusieurs passes (Quantification de couleurs sous une seule
passe crée un seul chemin)

5.5. Définissez les options de lissage (dans notre cas, cela ne faisait aucune différence, mais dans d'autres cas, cela
peut l'être). Le lissage et l'optimisation sert à rendre les traits plus nets. Enlever les mouchetures si l'on a utilisé un
feutre un peu abîmé par exemple est également utile.
• Moucheture (Angl. Speckles). Élimine des objets plus petits que N pixel
• Adoucier les coins (Angl. Smooth corners). Lissage de coins (plus = plus de lissage)
• Optimisé (Angl. Optimize). Diminution du nombre de noeuds (plus = moins de noeuds)

6. Sélectionnez le nombre de couleurs que vous souhaitez (normalement N est le nombre de couleurs que vous avez
obtenu dans l'étape de réduction des couleurs plus la couleur de l'arrière plan). Cliquez sur Mettre à jour.
Cela vous donne une prévisualisation.

7. Cliquez sur Appliquer / OK pour tracer. Le résultat sera placé dans un groupe SVG. Cela signifie que vous
pouvez tracer plusieurs fois. Chaque fois, un nouveau groupe est créé.

Après avoir tracé, la photo est toujours là. Plus tard, il faut la masquer ou supprimer
•• Masquez l'image (ou son calque)
• Ouvrez le panneau des objets (Objet -> Objets).
•• Attribuez un nom explicite à chaque chemin, par exemple: la couleur.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape-tracing-5.png
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Préparation pour la broderie
Si ce n'est pas déjà fait, ajustez la taille de votre broderie et du document SVG
Ajustement de la taille de la broderie

•• Définissez les mesures dans la barre de menus principale, de px à mm.
•• Verrouillez les dimensions dans la barre de menus.
•• CTRL-A (Tout sélectionner).
•• Entrer la nouvelle dimension pour la largeur "W".

Ajuster la taille du dessin

Ajustement des dimensions du document

Après le redimensionnement, ajustez la taille du document (Menu Fichier -> Propriétés du document)
•• Sélectionnez TOUT (CTRL-A).
• Dans Fichier -> propriétés du document (Angl. File -> document properties)

sélectionnez Ajuster la taille de la page au contenu ou donner les dimensions de votre cadre
(pour nous ce sera 50x50mm).

•• Ajoutez une petite marge (dans la version actuelle en sept 2022 ce n'est plus possible)

Ajuster la taille du document, InkScape 0.9 en Anglais

Mise en calque (facultatif !)

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape-set-path-sizes.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape-document-properties.png
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•• Créez un nouveau calque.
• Déplacez tous les objets que vous voulez y broder (en utilisant le menu: Calques -> Déplacer la sélection dans un

calque).
Transformer les polygones multi-formes en polygones simples

•• Comme InkStitch souhaite avoir un chemin connecté, vous devrez peut-être séparer les chemins qui contiennent
des formes séparées multiples, par exemple le bleu dans notre cas.

• Menu Path -> Break Apart (CTRL-SHIFT-K)

Résultat

Broderie avec remplissage facile

Structure du fichier svg résultant

Création de satins

Dans notre cas, la plupart de ces motifs devraient être brodés avec des points de satin, enfin, ce n'est pas une
obligation. Il y a trois façons de le faire:
• Modifiez le chemin comme décrit dans d'autres d'articles, comme InkStitch - exemples colonnes satin ou

InkStitch - broder un emoji.
•• Ajoutez des numérisations supplémentaires au traçage (par exemple 8 au lieu de 4). En triant le chemin produit,

vous trouverez des contours
•• Retracez l'image avec une strategie "centerline", ce qui vous donne des lignes à la place de fonds. Ensuite vous

pouvez choisir ce qui vous convient le mieu.
Dans les trois cas, il y aura du travail.
• Utilisez des lignes de direction (échelons) pour orienter les chemins. La procédure pour créer des échelons est

disponible sur cette page [3]

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AVacation-2b.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkscape-tracing-4.png
https://edutechwiki.unige.ch/fr/InkStitch_-_colonnes_satin#Ajouter_des_.C3.A9chelons_.28Voir_ci-dessus_pour_plus_de_d.C3.A9tails.29
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Modification et Droit d'auteur
Le contenu de cette page, y compris les images et les fichiers SVG, est également disponible sous les licences GNU
Free Documentation License [3] et la license Attribution 4.0 International (CC BY 4.0) [4] .
Le project Inkstitch [5] peut utiliser n’importe quel élément (fragments de texte, fichiers SVG, images) pour la
documentation officielle du projet sans attribution (il suffit de copier et coller).

Références
[1] https:/ / www. gimp. org/ downloads/
[2] https:/ / docs. gimp. org/ fr/ gimp-image-convert-indexed. html
[3] https:/ / edutechwiki. unige. ch/ fr/ InkStitch_-_colonnes_satin#Ajouter_des_. C3. A9chelons_. 28Voir_ci-dessus_pour_plus_de_d. C3.

A9tails. 29
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https://edutechwiki.unige.ch/fmediawiki/index.php?title=Guide_de_tutoriels_de_broderie_machine
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
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Catégorie: InkStitch

Introduction
La plupart des broderies professionnelles nécessitent à un moment donné une utilisation de points manuels, soit la
création d'objets de broderie ("ensembles de points") crées à la main sans passer par un dessin paramétrisé, soit des
modifications manuelles apportées aux "ensembles de points" générés que l'on peut voir dans le calque plan de
broderie (en: Stitch plan) lorsqu'on utilise Ink/Stitch -> Visualiser et exporter ->

Prévisualisation du plan de broderie pour créer les fichiers de broderie machine (Angl.
Ink/Stitch -> Visualise and Export -> Stitch Plan Preview ... )
Les points générés à partir de vos dessins (lignes, fonds et rails satin) ont la même forme technique que les "points
manuels". La différence est que les formes générées incluent des points de verrouillage, c'est-à-dire 2-3 allers-retours
au début et à la fin d'un paquet. Dans les explications ci-dessous, nous montrerons d’abord (a) comment créer
directement des points manuels, (b) comment réutiliser et modifier les points générés dans la couche de plan de
broderie, (c) comment faire des retouches dans un plan de broderie (sans le régénérer), et (d) comment importer et
utiliser des fichiers machine que l'on trouve dans le commerce.

Le plan de broderie
Commençons d'abord avec une petite explication comment InkStitch fonctionne. Le format de fichier utilisé par
InkScape (le logiciel de dessin) est le SVG, le format Internet pour faire des dessins vectoriels précis. Ce format peut
être édité avec n'importe quel outil d'édition. L'extension Ink/Stitch ajoute des annotations à chaque objet dessiné que
vous paramétrez pour broder. Par exemple, l'expression embroider_running_stitch_length_mm="2" dit
que les points doivent être espacés de 2mm. Lorsque vous créez le fichier de broderie ou une simulation, Ink/Stitch
va créer des objets de broderie dans un plan de broderie, qui depuis la version 2 n'est plus affichée. Ces objets sont
des simples segments connectés, définissant le chemin que la brodeuse va faire point par point.
Dans les techniques introduites dans cette page, on part de l'idée que Ink/Stitch, à partir de vos objets de broderie
(calques et objets visibles), créera un plan de broderie qui contient des objets brodables. Ce plan de broderie
contient une série de chemins définissant tous les points de broderie selon une organisation simple. D'abord ils
apparaissent dans l'ordre que vous spécifiez dans votre design (voir Object -> Objects. Ensuite les objets de
même couleur et qui se suivent sans coupe sont agglutinés dans un seul objet brodable directement. La machine va
juste suivre les points du début à la fin.
Voici un dessin: à gauche l'objet de broderie, c-à-d. un simple rond de 15mm sans trait, à droite le paquet de
broderie généré dans le plan de broderie.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cat%C3%A9gorie:InkStitch
https://edutechwiki.unige.ch/fmediawiki/index.php?title=SVG
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À gauche un dessin paramétrisé (simple tatami, espacement = 0.33mm, sans sous-couche. A droit l'objet de broderie généré.

Encore quelques explications:
•• Les objets non paramétrés ne devraient pas être brodés et on suggère de les mettre dans un calque à part. En fait,

lorsqu'ils sont visibles au moment de créer le fichier de broderie, Ink/Stitch peut se plaindre.
• Les calques visibles, c’est-à-dire les objets paramétrés, seront convertis en objets brodables pouvant être

assemblés dans un calque plan de broderie. À partir de ce plan, Ink/Stitch peut créer des fichiers code machine
propriétaires (DST, PES, JEF, EXP, VP3, etc.). Edutechwiki anglais contient une description très technique de ces
formats, fait par un des rares experts du domaine.

•• Les objets du plan de broderies peuvent être édités et également copiés vers un autre calque. Assurez-vous de ne
jamais afficher le plan de broderie plus un autre calque avant de créer le fichier de broderie. C'est l'un ou l'autre.

Les exemples utilisés ci-dessous incluent également du code pour une bordure, mis dans un calque à part, que vous
pouvez ignorer. Certains fichiers SVG sont joints à la fin si vous avez envie de jouer avec les exemples.

Le code SVG
Cette petite section s'adresse aux personnes qui ont un certain bagage technique et qui connaissent HTML5 (SVG en
fait partie). Il n'y a pas besoin de comprendre ce langage pour aller plus loin dans cet article, mais si vous êtes
curieux vous pouvez jeter un coup d'oeil au Tutoriel SVG statique ou un autre tutoriel mieux fait sur Internet ! On va
juste brièvement discuter le code SVG pour les deux chemins discutés dans l'introduction. Cela peut encourager
certain-e-s d'éditer manuellement le code lorsqu'il y a un problème.
Chaque chemin est défini par une balise SVG de type path:

<path

......

/>

Les coordonnées des points sont définies dans l'attribut d avec un langage trop compliqué à expliquer ici et qui
définit des points et les connexions entre ces points.
Le code pour le dessin rose ("Pink sun") est nettement plus court que l'objet de broderie généré ("copy path1004"), 
car sa forme est définie que par 4 points. Dans le code, vous voyez aussi les ajouts Ink/Stitch au code SVG, c.-à-d.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APink-sun.png
http://edutechwiki.unige.ch/en/Embroidery_format
http://edutechwiki.unige.ch/en/Embroidery_format
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Tutoriel_SVG_statique
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les attributs embroider qui disent comment traiter la forme (lignes 3, 8 et 9) selon votre paramétrage. Finalement
dans le code qui définit l'objet de broderie vous voyez un attribut embroider_manual_stitch="true", donc
la preuve qu'un objet généré est la même chose qu'on objet crée avec placement manuel de points (cf ci-dessous).
<path

       inkscape:label="Pink sun"

       embroider_fill_underlay="False"

       inkscape:connector-curvature="0"

       id="path815"

       d="m 23.195707,270.36104 c 0.184634,4.86353 -5.127906,8.77256 

-9.714393,7.16478 -4.6969665,-1.26178 -6.8691498,-7.49073 

-3.972794,-11.39945 2.593332,-4.1167 9.184486,-4.35015 

12.062475,-0.42724 1.046583,1.31216 1.628887,2.98362 1.624712,4.66191 

z"

       

style="opacity:1;vector-effect:none;fill:#9c00a5;fill-opacity:1;stroke:none;stroke-width:0.13598354;stroke-linecap:butt;stroke-linejoin:miter;stroke-miterlimit:4;stroke-dasharray:none;stroke-dashoffset:0;stroke-opacity:1"

       embroider_row_spacing_mm="0.33"

       embroider_running_stitch_length_mm="2"

/>

<path

       inkscape:label="copy path1004"

       id="path985"

       style="fill:none;stroke:#9b00a5;stroke-width:0.1058332"

       embroider_manual_stitch="true"

       d="m 45.894006,276.61793 -0.46259,-0.59035 -0.462591,-0.59034 

0.462591,0.59034 0.46259,0.59035 -1.16342,-1.48473 -1.414212,-1.41421 

-1.414211,-1.41421 -0.920242,-1.61882 v -2 -2 -1.99999 l 

1.19952,-1.38072 0.758327,0.1127 h -2.150235 -1.006367 l 

-1.199213,0.32999 h 2.955579 2.537203 l 0.753075,0.33 h -2.540279 

-2.999996 -1.458967 l -0.574864,0.33 h 2.78383 2.999996 2.375943 l 

0.482629,0.33 h -2.108573 -2.999996 -2.999996 -1.017884 l 

-0.416071,0.33 h 2.183954 2.999996 2.999996 1.741564 l 0.360634,0.33 h 

-1.352199 -2.999996 -2.999996 -2.999996 -0.26972 l -0.318942,0.33 h 

1.338661 2.999996 2.999996 2.999996 0.881443 l 0.279243,0.33 h 

-0.410687 -2.999996 -2.999996 -2.999996 -2.337553 l -0.241359,0.33 h 

0.328914 2.999997 2.999996 2.999996 2.90137 l 0.221924,0.33 h -2.373295

 -2.999996 -2.999996 -2.999996 -1.298791 l -0.210757,0.33 h 2.259547 

2.999996 2.999996 2.999996 1.823043 l 0.169811,0.33 h -1.242855 

-2.999996 -2.999996 -2.999996 -2.999996 -0.196532 l -0.151924,0.33 h 

1.098454 2.999997 2.999996 2.999996 2.999996 0.652438 l 0.13059,0.33 H 

45.289527 42.289531 39.289535 36.289539 34.28916 l -0.103223,0.33 h 

2.853601 2.999996 2.999996 2.999996 2.402881 l 0.09985,0.33 h -1.752732

 -2.999996 -2.999996 -2.999996 -2.999996 -0.705518 l -0.08237,0.33 h 

1.537886 2.999997 2.999996 2.999996 2.999996 1.087154 l 0.07052,0.33 h 

-0.407675 -2.999996 -2.999996 -2.999996 -2.999996 -2.345721 l 

-0.05784,0.33 h 0.153559 2.999997 2.999996 2.999996 2.999996 2.709228 l

 0.04193,0.33 h -2.001159 -2.999996 -2.999996 -2.999996 -2.999996 
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-0.927395 l -0.01761,0.33 h 1.695004 2.999996 2.999996 2.999996 

2.999996 1.271089 l 0.01349,0.33 h -0.53458 -2.999996 -2.999996 

-2.999996 -2.999996 -2.454566 l 0.0204,0.33 h 0.184169 2.999996 

2.999996 2.999996 2.999996 2.777314 l -0.01037,0.33 h -2.016945 

-2.999996 -2.999996 -2.999996 -2.999996 -0.913769 l 0.0418,0.32999 h 

1.621964 2.999996 2.999997 2.999996 2.999995 1.250004 l -0.0561,0.33 h 

-0.443905 -2.999996 -2.999996 -2.999996 -2.999996 -2.314347 l 

0.05762,0.33 h 3.006729 2.999997 2.999996 2.999996 2.637794 l 

-0.07942,0.33 h -1.808375 -2.999996 -2.999996 -2.999996 -2.999996 

-0.662519 l 0.09543,0.33 h 1.317087 2.999996 2.999996 2.999996 2.999996

 0.956148 l -0.102228,0.33 H 48.289518 45.289522 42.289526 39.28953 

36.289534 34.334747 l 0.135385,0.33 h 2.569401 2.999996 2.999996 

2.999996 2.205109 l -0.149968,0.33 H 46.78952 43.789524 40.789528 

37.789532 34.789536 34.605517 l 0.17811,0.33 h 0.755907 2.999997 

2.999996 2.999996 2.999996 0.375922 l -0.200887,0.33 h -2.425027 

-2.999996 -2.999996 -2.999996 -1.326501 l 0.212167,0.33 h 1.864333 

2.999996 2.999996 2.999996 1.456025 l -0.257152,0.33 h -0.448874 

-2.999996 -2.999996 -2.999996 -2.384154 l 0.259683,0.33 h 2.87447 

2.999996 2.999996 2.42624 l -0.321997,0.33 h -1.354244 -2.999996 

-2.999996 -2.999996 -0.332652 l 0.331807,0.33 h 0.750844 2.999996 

2.999996 2.999996 0.255137 l -1.046572,0.77699 -0.730641,-0.73064 

-0.707106,0.7071 -0.707106,-0.7071 -0.707105,0.7071 -0.707106,-0.7071 

-1.414212,1.41421 -0.358197,0.3582 -0.614936,-0.16876 h 1.487851 

2.557473 l 0.901707,-0.33 H 43.03953 40.039534 38.305161 l 

-0.66588,-0.33 h 1.650254 2.999996 2.604874 l 0.330151,-0.23655 

0.201638,-0.0935 h -0.886666 -2.999996 -2.999996 -1.425284 l 

-0.454254,-0.33 h 1.129539 2.999996 2.999996 2.104477 -0.749999 

-0.749999 0.749999 0.749999"

       inkscape:connector-curvature="0"

/>

Tuyau: Lorsque vous n'arrivez plus à paramétrer un dessin parce que Ink/Stitch bloque, vous pouvez en règle
générale simplement tuer ces paramètres "embroider" au lieu de tout recommencer. Voir InkStitch - astuces et
problèmes courants. Vous pouvez soit utiliser l'éditeur d'arbre XML de Inkscape (CTRL-MAJ-X), soit n'importe
quel éditeur de code (aussi appelé éditeurs de texte ou éditeurs de programmation). Il en existe des dizaines, par
exemple Brackets.

Création de points manuels
La création de points manuels est facile, mais nécessite l'ajout de points de verrouillage (des allers-retours au début
et à la fin de chaque chemin).
Comme expliqué dans la page officielle Manual Stitch [1], la procédure initiale est simple:
1.1. Créez un chemin de type contour (une ligne). Le style de trait ou la largeur ne sont pas pertinents.
2. Ouvrir Extensions> Ink/Stitch> Params.
3. Activer le Manual stitch placement (fr: placement manuel de points). Les autres réglages n'auront

aucun effet en mode de couture manuelle.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Brackets
https://inkstitch.org/docs/stitches/manual-stitch/
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Création de points manuels, en InkStitch v. 2.0

Voici un autre exemple d'un petit bon homme de 2cm de haut. Les points sont à peu près à 2mm de distance, donc à
broder plutôt avec un fil fin et une aiguille fine. Cet exemple montre qu'il faut faire très attention à la distance entre
les points: ni trop peu (1mm), ni trop (>1cm).

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AManual-points-fr-inkstitch2.png
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Les points à broder sont simplement définis par les nœuds qui définissent une ligne. Si votre dessin comporte
des contrôles de courbe, ceux-ci n'auront aucun effet.
Si vos nœuds sont trop éloignés ou trop proches, vous obtiendrez des points trop éloignés ou trop proches. Un bon
moyen de visualiser les distances est d'utiliser la grille
• Edit -> Preferences -> Grids . (fr: Modifier -> Préférences -> Grilles ? ) Unités de grille = mm,

distances définies à 1 x 1 mm par exemple
• Activer la grille avec View -> Page Grid (Menu Affichage -> Grille de page ?)
Conseil: pour transformer une forme lisse, par exemple la spirale d’Inkscape en une série de petites lignes
connectées, procédez comme suit:
• convertir la forme en chemin si nécessaire (Path -> Object to Path)
• Extensions -> Modify path -> Flatten Beziers . Par exemple, sélectionnez une distance de 2.

Nous avons utilisé ce paramètre pour convertir la spirale dans la figure ci-dessous.
Vous devrez peut-être supprimer, ajouter ou déplacer des points à l'aide de l'éditeur de nœuds (F2).
En Anglais, on utilise "Manual Stitch Placement".

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-2-2-points-manuels.png
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Paramétrer une ligne pour la couture manuelle, InkStitch 1.x en Anglais.

Conseil important: Les exemples présentés ici ne comportent aucun point de verrouillage. Vous devrez les ajouter
si vous ne voulez pas que votre broderie se désagrège rapidement. L'association d'une commande à l'objet
sélectionné ne semble pas fonctionner (à l'exception du Trim) au moment de la rédaction. Par conséquent, créez des
verrous manuels en effectuant un simple mouvement de va-et-vient 2-3 fois au début et à la fin.
Ci-dessous, nous allons montrer à la fois une vue de conception et les objets pouvant être assemblés dans le plan de
broderies. En haut à gauche, la spirale inkscape originale, qui sera rendue dans un vilain zig-zag. Au milieu, la
spirale aplatie, également rendue par défaut en zig-zag. En bas à droite, l'objet aplati paramétré comme
placement manuel de points (comme expliqué ci-dessus).

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-manual-stitches.png
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Mode Création (calque de plan de couture = masqué)

plan de broderies (autres couches = masqué)

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-manual-stitches-2a.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-manual-stitches-2b.png
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Utilisation des points générés en tant qu'élément de conception
Une stratégie plus souvent utilisée consiste à générer un plan de broderie définissant tous les points de votre
broderie. En principe, InkStitch créera pour les objets de dessin un objet pouvant être cousu. Ces objets sont
agglutinés par blocs de couleur dans l'ordre de vos objets. Appelons ces objets objets brodables . Ces objets peuvent
être édités, car ils ne sont composés que d'une longue ligne définie par des nœuds. Jusqu'à présent, nous pensons que
la meilleure méthode pour ce faire est la suivante:
Étape 1: Générez un objet pouvant être cousu

•• Créer un design dans InkScape
•• Par exemple, créez une spirale InkScape, faites-la en pointillé ("Spirale en pointillé" dans la figure ci-dessous,

2e ligne)
•• Définissez une couleur pour le trait ou le fond (selon la forme). On suggéré d'utiliser une couleur différente du

modèle précédent et suivant dans la liste des objets (l'objet généré sera à part et pas agglutiné)
•• Paramétrer la broderie avec Ink/Stitch

• Dans cet exemple, nous paramétrons la spirale comme une simple ligne (nous n’avons pas le choix ...)
• Sélectionnez uniquement cet objet, puis générez le plan de broderie en utilisant Extensions ->
Ink/Stitch -> ....

Le résultat, un seul chemin, sera placé dans le calque Stitch Plan (fr: Plan de broderie), à l'intérieur d'un groupe de
blocs de couleur.
Étape 2: Copiez et éditez l'objet pouvant être assemblé

•• L'objet généré dans le plan de broderie, par exemple path1523 est un chemin défini manuellement (comme
ci-dessus), sauf qu'il contient également des points de verrouillage au début et à la fin.

• Déplacez cet objet vers votre calque de broderie ("Generated spiral" dans la figure ci-dessous).
•• Maintenant, éditez l'objet, C.-à-d.. appuyez sur F2 et déplacez, supprimez, ajoutez des nœuds. Dans le cas

présenté dans la figure ci-dessous, nous venons de déplacer des nœuds à la fin et au début. Assurez-vous que
lorsque vous déplacez des points de verrouillage (plusieurs allers-retours superposés) ensemble, c'est un peu
délicat ....
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Positionnement manuel (en haut) par rapport à la réparation des packs de points générés (en bas)

Pour finir, sachez que vous pouvez importer des fichiers broderie machine (par exemple DST ou PES) et ensuite
réutiliser ces objets de la même façon. C'est pratique si vous n'avez pas accès à un fichier design (broderies achetées,
logiciels perdus, etc.). Ce sera expliqué à la fin de cet article.

Correction des points générés
Il paraît que la plupart des professionnels de broderie font quelques aménagements manuels aux résultats de la
"digitalization".
Le principe est le même que ci-dessus, sauf que nous ne copions pas les points de broderie. Supposons que vous
soyez parfaitement satisfait de vos objets de conception, mais pas des points générés. Dans ce cas, nous vous
suggérons de générer tous les packs de points et de les modifier sur place, c'est-à-dire dans le calque Stitch Plan (fr:
plan de broderie).
L'exemple suivant montre un petit œil modifié en bas à gauche. Nous avons déplacé un point de sous-couche et
avons également allongé un peu l'œil.
Important : Pour générer le fichier de broderie modifié, affichez le "stitch plan" et gardez masqués tous les autres
calques (ne pas régénérer le plan de broderie non plus). Vous pouvez créer un fichier de broderie machine à l'aide du
bouton "Enregistrer une copie sous".
L'image suivante montre un oeil qui sera légèrement modifié à gauche pour accentuer la pointe.
Vous trouverez ci-dessous une simulation, comme indiqué dans Wilcom Truesizer [2] (étant donné que nous utilisons
le format DST, les couleurs sont choisies au hasard). Les petits yeux au bas de chaque regard sont un peu différents.
Celui de droite a un coin gauche plus prononcé.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch_manual-stitches-3a.png
https://www.wilcom.com/Products/TrueSizerProducts.aspx
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Importer du code machine
Ink/Stitch permet d'importer plusieurs formats machine. Cela permet de réutiliser des modèles achetés ou trouvés
gratuitement sur Internet. Le format ls plus simple à utiliser est probablement DST, car il s'agit d'un format industriel
qui marche avec pleines de machines (y compris notre Brother). Par contre, vous ne pouvez pas beaucoup changer
les dimensions de ces objets, puisqu'ils sont définis comme des lignes de points à broder. On discute un exemple
réel que vous pouvez reproduire.
Essayons d'importer un cœur pour basketteurs [3] trouvé sur le site de embroideres.com [4] et qui ne demande pas de
s'enregistrer. Le fichier fait 10.3 x 84.3 mm, une bonne taille pour couvrir un gros trou de mites sur un pull mais trop
gros pour rentrer dans un patch qu'on fabrique à TECFA dans les événements "outreach".
À notre avis on peut agrandir ou diminuer un plan de broderie de 10% (c'est ce que certaines brodeuses autorisent).
Si on diminue de 20-30%, la broderie devient dense, donc environ 5 linges/mm au lieu de 4 et 1.2mm d'espacement
entre les points au lieu de 1.5. La simulation suivante montre le coeur dans un patch de 8cm. On l'a diminué à 70%,
donc en principe pas brodable sans changer de fil et d'aiguilles plus fins. On l'a brodé sur un patch avec des aiguilles
et du fil standard et il est effectivement voilé ....

Basket heart 70% réduit

Basket heart 70% réduit (simulation)

Patch voilé Basket heart 70% - fichier SVG à télécharger

https://embroideres.com/free-embroidery-designs/individual-free-embroidery-designs/home-and-hobby-free-embroidery-design/basketball-heart/
http://embroideres.com
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cfao
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ABasket-heart-2.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ABasket-heart-1.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ABasket-heart-3.jpg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3ASVG_logo.svg
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Si vous n'arrivez pas à importer un format machine (DST, PES, JEF, etc.), essayez d'abord de convertir votre fichier
en un autre format. Il existe plusieurs convertisseurs gratuits, voir une liste dans EduTechWiki anglais. On conseille
par exemple Wilcom TrueSizer ou Pulse Ambassador ou MyEditor. À noter que vous pouvez aussi utiliser ces
logiciels pour convertir un fichier produit par Ink/Stitch (on conseille d'exporter en DST dans ce cas) en un format un
peu exotique.

Clipart
Puisque les logiciels de broderie ont des difficultés à créer des points à partir de très petits objets de broder, on
conseille de créer une bibliothèque de certains objets.
Voici un exemple (provisoire) pour créer des yeux. Notez qu'on peut plus facilement créer des toutes petites formes
en utilisant un fil 60 et une aiguille 60. Dans l'image suivante, les yeux noirs sont brodés avec du fil 60 et on voit
qu'on peut encore serrer pas mal la plupart des dessins ...

Fichier SVG à télécharger (access direct [5])

http://edutechwiki.unige.ch/en/Embroidery_software#Free_converter_tools_and_other_utilities
http://edutechwiki.unige.ch/fmediawiki/images/9/95/AAA-SVG-assets.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AAAA-SVG-assets.svg
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Photo. Rouge = fil 40, noir fil 60 avec une aiguille 60

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AAAA-SVG-assets.jpg


InkStitch - points manuels 262

Fichiers
Si vous voulez jouer avec certains des exemples présentés, vous pouvez commencer par l’un des fichiers SVG
suivants (cliquez deux fois sur le fichier - ouvrir la page image et encore cliquer sur l'image. Lorsque vous voyez la
page SVG affichée dans votre navigateur, enregistrez la page web "sous").

   
Les fichiers SVG pour fabriquer des patchs sont ici pour le moment, bientôt dans ce wiki francophone.

Liens
• Modifier un fichier machine dans Inkstitch [6], consulté le 11 Avril 2021, Publié par lyogau (alternative et

complément, actuellement mieux à jour)
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https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier:Institch-manual-stitches-3.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier:Institch-manual-stitches-2.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier:Inkstitch-manual-stitches-eyes.svg
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier:AAA-SVG-assets.svg
http://edutechwiki.unige.ch/en/InkStitch_-_embroidery_patch#Patch_templates_for_download
https://lyogau.over-blog.com/2021/04/modifier-un-fichier-machine-dans-inkstitch.html
https://inkstitch.org/docs/stitches/manual-stitch/
https://www.wilcom.com/Products/TrueSizerProducts.aspx
https://embroideres.com/free-embroidery-designs/individual-free-embroidery-designs/home-and-hobby-free-embroidery-design/basketball-heart/
https://embroideres.com/free-embroidery-designs/individual-free-embroidery-designs/home-and-hobby-free-embroidery-design/basketball-heart/
http://embroideres.com
http://edutechwiki.unige.ch/fmediawiki/images/9/95/AAA-SVG-assets.svg
https://lyogau.over-blog.com/2021/04/modifier-un-fichier-machine-dans-inkstitch.html
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InkStitch - points programmables

Guide de tutoriels de broderie machine

Module: InkStitch

⚐ à améliorer ☸ avancé

⚒ 2022/09/27
Prérequis

•• Inkscape

Objectifs

•• Créer des remplissages avec des motifs non-standards Créer des points programmables avec des fonctionnalités divers de
InkScape

Autres pages du module

•• InkStitch
•• InkStitch - installation
•• InkStitch - utilisation de base
•• InkStitch - broderie ondulée
•• Inkstitch - textures de remplissage
•• InkStitch - lettrage
•• InkStitch - colonnes satin
•• InkStitch - exemples colonnes satin
•• InkStitch - broder un emoji
•• InkStitch - broder une image issue de The Noun Project
•• InkStitch - broder des codes QR
•• InkStitch - broder des patchs et des appliqués
•• InkStitch - astuces et problèmes courants
•• InkStitch - bases SVG
•• Inkscape - édition des chemins
•• InkStitch - broder avec du gros fil
•• InkStitch - broderies à partir de dessins faits à la main
•• InkStitch - points manuels
•• InkStitch - points programmables
Catégorie: InkStitch

Cet article est une ébauche à compléter. Une ébauche est une entrée ayant un contenu (très) maigre et qui a donc
besoin d'un auteur.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Guide_de_tutoriels_de_broderie_machine
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Inkscape
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Cat%C3%A9gorie:InkStitch
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Introduction
Inkstitch, à l’été 2018, fournit 4 types de points de broderie: lignes, colonnes de satin, remplissages tatami et points
manuels. La plupart logiciels de broderie offrent la possibilité de remplir des polygones avec des points dits
programmables ou spéciaux, c’est-à-dire des remplissages radiaux, hachures, de petits objets, etc.
Depuis la versions 2.2 (été 2022), on peut créer des broderies ondulées, des remplissages selon le contour ou encore
ajouter des "textures" aux tatami et satins. Il n'existe donc pas encore de point programmé au sens étroit du terme et
les quelques explorations ci-dessous peuvent toujours intéresser des "geeks".
Inkstitch ne prévoit pas d’inclure ceci dans un futur proche. Toutefois, des extensions d’Inkscape permettent des
remplissages « non-standard ». Comme nous allons tout d’abord l'expliquer, le remplissage standard selon un motif
ne fonctionne pas bien car il ne peut pas être traduit en chemins (à moins qu’il y ait une méthode que nous n’ayons
pas pu identifier)

Utilisation des motifs d’Inkscape - ne fonctionne pas
Selon le Inkscape manual [1] de Tavmjong Bah, tout objet ou groupe d’objets peut être transformé en motif et utilisé
pour le remplissage d’un objet. Le motif peut être déplacé, tourné et étiré si nécessaire. Inkscape inclut un ensemble
de motif accessible dans le Fond et Contour [2] dialog [3]. On peut utiliser au choix, les motifs inclus ou bien ceux
qu’on a soi-même fabriqués. Malheureusement, il n’y a pas moyen de traduire un remplissage selon un motif en
chemins puisque le motif est considéré comme une couleur. Et, bien sûr, Inkstitch ne peut pas manipuler les couleurs
comme des chemins. Le seul contournement possible que nous pouvons concevoir, (mais nous devrons tester cela)
est d’exporter vers Illustrator ou la création d’un bitmap que nous pourrions ensuite tracer.

Traceback (most recent call last):

  File "inkstitch.py", line 20, in <module>

    if script_name.endswith('.py'):

  File "inkscape-0.92.2/share/extensions/inkex.py", line 283, in affect

  File "lib/extensions/embroider.py", line 84, in effect

  File "lib/stitch_plan/stitch_plan.py", line 28, in 

patches_to_stitch_plan

  File "lib/stitch_plan/stitch_plan.py", line 168, in color

  File "lib/threads/color.py", line 17, in __init__

ValueError: Invalid color: 'url(#pattern5514)'

Other extensions, e.g. Generate from path -> Voronoi pattern are also using patterns as colors and cannot be used
either.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Points_de_broderie
http://tavmjong.free.fr/INKSCAPE/MANUAL/html/Attributes-Fill-Stroke.html#Attributes-Patterns
http://tavmjong.free.fr/INKSCAPE/MANUAL/html/Attributes.htmldialogue
http://tavmjong.free.fr/INKSCAPE/MANUAL/html/Attributes.htmldialog
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Impossible de traduire des remplissages InkScape en chemins, donc pas brodables avec Ink/Stitch

However, this can be achieved manually as we shall explain below.
D’autres extension, par exemple « Générer » depuis le chemin => motif de Voronoi utilisent aussi des motifs comme
couleurs et ne peuvent pas non plus être utilisées directement. Il existe toutefois une possibilité de travailler avec les
motifs de Voronoï.
Cependant, cela peut être réalisé manuellement comme nous l'expliquerons ci-dessous.

Utilisation de pavages de clones et de division de chemins
Au lieu d’utiliser des remplissages de motifs pour remplir une forme avec des motifs, nous pouvons multiplier un
motif manuellement et ensuite soustraire celui-ci de la forme. La procédure est un peu pénible et requiert un peu
d'organisation si vous ne voulez pas refaire les opérations. Toutefois, cela semble assez simple. Basiquement, on crée
une forme de motif plus grand que la forme qui doit être remplie et ensuite on utilise cette forme pour découper la
même forme dans la forme de motifs. Consultez les schémas ci-dessous.
Remarque : si la division de chemin de ne fonctionne pas, alors créez juste le motif et supprimez manuellement les
morceaux qui sont en dehors de la forme. Ça ne prend que 2 ou 3 minutes…
Remplissons un cœur avec des petits cœurs.
Etape 1 : créer une grande forme de cœur

•• Nous avons seulement importé ce cœur depuis The Noun Project (qui est dans le domaine public)
•• Changez la dimension pour une largeur de 5 cm
•• Enlevez le fond et créez une bordure de 2,5 mm
• "Enregistrez le fichier sous" version 1 pour continuer (vous aurez besoin de reprendre la forme après l’étape 3).

Sinon créez un nouveau "calque dessin" et faites y une copie.4

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APentagram-4.svg
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Note : Si vous importez un autre objet, assurez-vous qu’il s’agit d’un polygone, c’est-à-dire quelque chose avec une
bordure et un remplissage.
Étape 2 : Créez une zone avec des petits cœurs qui sont tous connectés.

•• Créez un petit cœur, supprimez le remplissage et faites la bordure en pointillés. Nous utilisons le même objet et
faisons un cœur de 0,5 largeur. Afin d'avoir un motif suffisamment grand pour soustraire du cœur, nous l'avons
cloné 11 X 11 fois.

•• Sélectionnez le petit coeur ou tout autre motif. CTRL-K groupes d'objets, les opérations seront plus rapides.
• Édition -> Cloner -> Créer des clones en mosaïque.

•• Définir 12 lignes, 12 colonnes
•• Dans l'onglet Décalage, créez des décalages X alternés de 10 mm, soit 20 %.
•• Alternativement, nous aurions pu décaler de 2,5 cm plus quelques décalages dans la direction Y.
•• "Enregistrer le fichier" comme version 2

•• Créez un chemin unique à partir de tous ces
• Dissocier les clones : Sélectionnez l'original et Menu Édition->Cloner->Dissocier
• Sélectionnez tous les clones et combiner (CTRL-K), c'est-à-dire faire un seul chemin. Cela peut prendre un

certain temps pour fonctionner, en particulier si vous créez des mosaïques à partir d'objets groupés. Dans ce
dernier cas, vous devrez peut-être également supprimer les groupes vides.

• Retirer le coeur d'origine en position 1,1. Dans le gestionnaire d'objets (Objet->Objets), vous ne devriez voir
que les objets "utiliser"

•• Vous devriez maintenant avoir un chemin pour le motif et un autre à remplir

Après les étapes 1 et 2 : un cœur plus des petits cœurs en mosaïque (pas encore combinés)

Étape 3 : Remplissez le grand cœur avec les petits.

•• Déplacez les tuiles sous le cœur
• Sélectionnez à la fois les tuiles et le grand cœur (dans n'importe quel ordre) et Chemin -> Division
•• Vous allez maintenant voir un gros coeur plutôt noir. Dans d'autres cas, vous ne verrez rien.
•• Sélectionnez tous les objets (si ce n'est déjà fait) et définissez le style de trait sur petit et pointillé
•• "Enregistrer le fichier sous" version 3
• Combinez-les (encore), CTRL-K. Selon vos motifs, cela peut ne pas être une bonne idée, car InkStitch peut ne pas

savoir comment router les motifs qui se chevauchent. Si tel est le cas, ne combinez pas.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-tile-fill-1.png
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Après l'étape 3 : un remplissage de chemin en forme de cœur

Étape 4 : Ajoutez à nouveau le grand cœur et rendez-le satiné

•• Ouvrez la première version du fichier et copiez/collez à la place le gros coeur.
•• Assurez-vous que vous êtes satisfait de la largeur de la bordure.
• Chemin-> Contour vers chemin
•• Supprimer le remplissage
•• Ajoutez un petit trait, par ex. 0,2 millimètres
• Rendez-le satiné, c'est-à-dire ajoutez des lignes directrices aux rails ou égalisez les points (lisez InkStitch - des

colonnes satinées aux remplissages avec des bordures satinées) si vous ne comprenez pas cela. En particulier,
assurez-vous que les deux rails ont la même direction, coupez les deux rails si nécessaire (j'ai dû le faire).

Étape 5 : Paramétrer

•• Un point bourdon avec sous-couche pour le grand coeur
•• Un point de haricot pour le motif de remplissage.
•• Définir une couleur pour chaque objet.

Fichier SVG à télécharger

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-tile-fill-2.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=InkStitch_-_des_colonnes_satin%C3%A9es_aux_remplissages_avec_des_bordures_satin%C3%A9es
https://edutechwiki.unige.ch/fmediawiki/index.php?title=InkStitch_-_des_colonnes_satin%C3%A9es_aux_remplissages_avec_des_bordures_satin%C3%A9es
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-shape-tiles-division-3.svg
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Fait intéressant, les points sautés sont différents selon le format de fichier

Simulation (fichier DST) Simulation (fichier PES)

Améliorer:
•• Faites quelque chose au sujet des gros points sautés. Sur une machine à plusieurs aiguilles, un simple pourrait

séparer chaque petit cœur, puis ajouter des garnitures.
Tuiles alternatives
• Vous pouvez jouer avec différents paramètres dans la fonction Clone -> Créer un clone.
par exemple. vous pouvez utiliser des remplissages au lieu de lignes et également faire pivoter les formes.
• Attention les petites chaleurs avaient des noeuds qui se chevauchaient, chose que Ink/Stitch n'aime vraiment pas.

Utilisez la fonction Ink/Stitch -> Troubleshoot Objects et corrigez un par un. Dans notre cas,
appuyer sur CTRL-L était suffisant. N'utilisez pas CTRL-L pour tous les objets ensemble !

Coeurs remplis....

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-shape-tiles-division-3.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-shape-tiles-division-3-PES.png
https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-shape-tiles-division-3c.jpg
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Fichier SVG à télécharger

Extension hatch fill de Eggbot
Les outils Eggbot ont été développés pour les soi-disant Egg-bots, les machines qui peuvent dessiner et graver sur
des formes ressemblant à des œufs. Depuis la version 2.2 on peut obtenir des résultats similaires avec la
paramétrage de broderie ondulée !
Cette extension "hatch fill" doit être installée.
• Obtenez-le sur EggBot's github site [4]

• Alternativement, on le trouver hatch_fill.zip dans le dossier de téléchargement de l'extension
"mightyspace" (Février 2022, le dossier peut changer)

• mightyscape-1.X-zipmirror [7] (attention il faut d'abord cliquer sur le fichier voulu, puis utiliser le bouton
download, comme ci-dessous).

• download [8] (il faut cliquer sur le bouton download)
•• Suivez les instructions

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AInkstitch-shape-tiles-division-3c.svg
https://github.com/evil-mad/EggBot/releases/latest
https://github.com/eridur-de/mightyscape-1.X-zipmirror
https://github.com/eridur-de/mightyscape-1.X-zipmirror/blob/master/hatch_fill.zip
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Eclosion
Vous pouvez facilement créer des diagonales et des points de croix. Pour les deux, vous avez la possibilité de
connecter les extrémités, ce que nous recommandons. Voir aussi l'exemple "carotte" discuté dans InkStitch - broder
avec du gros fil
Tout d'abord, dessinez un cercle avec trait (0,1 à 0,2 mm) mais sans remplissage.

Créer un point de croix avec des fins de ligne connectées

Vous trouverez ci-dessous deux combinaisons différentes d'éclosion
•• En haut à gauche : hachures connectées
•• En haut à droite : hachures non connectées
•• En bas à gauche : hachures connectées au point de croix
•• en bas à droite : hachures de point de croix non reliées

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3AEggbot-intro.png
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Hatch fills create with eggbot

Conseil : Utilisez toujours des hachures connectées. Comme vous pouvez le voir dans la simulation ci-dessous, des
hachures non connectées créent des points sautés étranges.

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APentagram-6.svg


InkStitch - points programmables 272

Hatch fills create with eggbot - Stitch plan with some bizarre jump stitches

Voici un résultat rapide :

https://edutechwiki.unige.ch/fmediawiki/index.php?title=Fichier%3APentagram-6b.svg
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Améliorer:
•• lettrage
•• les points plumetis doivent avoir quelques échelons pour optimiser les coins, et une autre sous-couche plus légère.
Autre exemple :
•• en:InkStitch - data visualization

Références
[1] http:/ / tavmjong. free. fr/ INKSCAPE/ MANUAL/ html/ Attributes-Fill-Stroke. html#Attributes-Patterns
[2] http:/ / tavmjong. free. fr/ INKSCAPE/ MANUAL/ html/ Attributes. htmldialogue
[3] http:/ / tavmjong. free. fr/ INKSCAPE/ MANUAL/ html/ Attributes. htmldialog
[4] https:/ / github. com/ evil-mad/ EggBot/ releases/ latest
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